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Introduction

Virtualization is a concept that has evolved from what many first recognized as a niche tech-
nology to one that’s driving many mainstream networks. Evidence of virtualization exists in
nearly all aspects of information technology today. You can see virtualization in sales, educa-
tion, testing, and demonstration labs, and you can see it even driving network servers.

What's virtualization? Well, to keep it simple, consider virtualization to be the act of
abstracting the physical boundaries of a technology. Physical abstraction is now occurring in
several ways, with many of these methods illustrated in Figure 1. For example, workstations
and servers no longer need dedicated physical hardware such as a CPU or motherboard in
order to run as independent entities. Instead, they can run inside a virtual machine (VM). In
running as a virtual machine, a computer’s hardware is emulated and presented to an operat-
ing system as if the hardware truly existed. With this technology, you have the ability to remove
the traditional dependence that all operating systems had with hardware. In being able to emu-
late hardware, a virtual machine can essentially run on any x86-class host system, regardless of
hardware makeup. Furthermore, you can run multiple VMs running different operating systems
on the same system at the same time!

Virtual Machines

Storage Area
Network

Database
Server

VM Host

Load-Balanced Cluster

-

Server Cluster

Figure 1. A virtualized information system xxiii
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Virtualization extends beyond the virtual machine to other virtualization technologies
such as clustering. Clustering allows several physical machines to collectively host one or
more virtual servers. Clusters generally provide two distinct roles, which are to provide for
continuous data access, even if a failure with a system or network device occurs, and to load
balance a high volume of clients across several physical hosts. With clustering, clients won'’t
connect to a physical computer but instead connect to a logical virtual server running on top
of one or more physical computers. Clustering differs from virtual machine applications in
that it allows for automated failover between physical hosts participating in the cluster. You
could view failover as the movement of a virtual server from one physical host to another.

Aside from virtual machines and clustering, you'll also see the reach of virtualization
extend to network file systems and storage. In reaching network file systems, technologies
such as Distributed File System (DFS) allow users to access network resources without know-
ing their exact physical location. With storage virtualization, administrations can perform
restores of backed-up data without having to know the location of the physical media where
the backup resides.

Now, if your head is already spinning, don’t worry, because you're probably not alone.
With such as vast array of virtualization technologies available, it can be difficult to first tell
one from another and also come to an understanding as to which technologies are right for
you. That’s why we decided to piece together a reference that explains each available virtual-
ization technology, whether you're interested in running virtual machines on your desktop or
are planning to add virtualization layers to an enterprise network environment. In this book,
we’ll guide you through all aspects of virtualization and also discuss how to fit any and all of
these complex technologies into your IT life. Let’s start by looking at the format of each chap-
ter in this book.

Chapter 1: Examining the Anatomy of a Virtual Machine

Two major software vendors, EMC (Legato) and Microsoft, are leading the virtual machine
software charge. In spite of their products’ architectural differences, the terminology and the
theory that drives them are similar.

In Chapter 1, we'll start by explaining the buzzwords and the theory associated with virtual
machines. We'll address such topics as virtual networks, virtual hard disks, and CPU emulation.
We'll also give you an overview of the major virtual machine products, outlining the differences
between EMC’s VMware Workstation, GSX Server, and ESX Server products, as well as
Microsoft’s Virtual PC and Virtual Server 2005.

Chapter 2: Preparing a Virtual Machine Host

With an understanding of the ins and outs of virtual machines, the next logical step in VM
deployment is to prepare a host system. Several factors determine a host’s preparedness to
run a VM application, including the following:

e Physical RAM
* CPU

e Hard disk space
* Networking
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When selecting a host, you'll need to ensure that the host meets the VM application’s mini-
mum hardware requirements and also that enough resources are available for the number of VMs
you plan to run simultaneously on the host. Properly preparing a host prior to running virtual
machines on it will almost certainly result in better stability, scalability, and long-term perform-
ance for your virtual machines. After finishing Chapter 2, you will not only be fully aware of the
techniques for preparing a host system for virtual machines but will also be aware of the many
gotchas and common pitfalls that often go unrecognized until it's unfortunately too late.

Chapter 3: Installing VM Applications on Desktops

When deciding to run virtual machines on workstations, you have two choices of workstation
application: VMware Workstation (shown in Figure 2) and Virtual PC (shown in Figure 3).
VMware Workstation is supported on Windows NT 4.0 (with SP6a) or higher Windows operat-
ing systems and can also run on Linux (Red Hat, Mandrake, or SuSE). Microsoft Virtual PC is
supported on Windows 2000 Professional, Windows XP Professional, and Windows XP Tablet
PC Edition.
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As you can see, your current operating system may decide the VM application you
choose. Chapter 1 will also help with the VM application decision, as it will outline all of the
differences between each program. Once you've decided on a VM application, you'll be able
to use this chapter to get you through any final preparations and the installation of VMware
Workstation and Virtual PC.

Chapter 4: Deploying and Managing VMs
on the Desktop

Chapter 4 provides guidance on deploying specific VM operating systems on your workstation
system, including examples of both Windows and Linux VM deployments. Once your VM is up
and running, you can perform many tasks to optimize and monitor their performance and to
also ease future VM deployments. Topics in this chapter include the following:

* Monitoring the performance of VMs

» Staging and deploying preconfigured VMs
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* Running VMs as services
* Configuring VMs to not save any information

* Administering through the command line and scripts

As you can see, this chapter is loaded with information on VM management. This is the
result of years of experience, so you'll find the tips and techniques presented in this chapter
to be as valuable as a microwave oven. Although they may not heat your food any faster, they
definitely will save you plenty of time managing your virtualized network.

Simply installing and running virtual machines is really just the tip of the iceberg. Once
your VMs are configured, you can perform many tasks to make them run better and run in
ways you never thought possible. In Chapter 4, you'll see all of this and more.

Chapter 5: Installing and Deploying VMs
on Enterprise Servers

Chapters 5 and 6 are similar in format to Chapters 3 and 4. In Chapter 5, we'll walk you through
the installation and deployment process of VM applications on server systems, with the focus
on using the VMs in a production role.

As with Chapter 3, in this chapter we devote time to both VMware GSX Server deployments
on Linux and Windows operating systems and Microsoft Virtual Server 2005 deployments on
Windows operating systems. With the decision to run VMs in production comes a new list of
responsibilities. Whether you're looking to run domain controllers, file servers, or even database
servers as VMs, you must consider several performance factors for each scenario before setting
up the VMs. Many of us have learned the sizing game the hard way, and we don’t want you to
have to suffer as well. An undersized server can sometimes be the kiss of death for an adminis-
trator, as it may be difficult to get additional funds to “upgrade” a server that’s less than two
months old, for example. Sizing a server right the first time will not only make VM deployment
easier but it may also help to win over a few of the virtualization naysayers in your organization.
When deploying cutting-edge technology, you'll always have pressure to get it to run right the
first time, so pay close attention to the advice offered in this chapter. We've made plenty of the
common deployment mistakes already, so you shouldn’t have to do the same!

Chapter 6: Deploying and Managing Production
VMs on Enterprise Servers

Running VMs in production may involve managing fewer physical resources, but the fact that
multiple OSs may depend on a common set of physical hardware can cause other problems.
For example, rebooting a VM host server may affect four servers (a host plus three VMs) instead
of one. Problems such as this put more pressure on you as an administrator to consider how an
action on one server can impact several other servers.

With VMs in production, keeping the host system happy will likely result in well-running
virtual machines. Again, with many systems depending on the hardware of one system, a hung
CPU, for example, could have devastating consequences. This is why monitoring and mainte-
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nance is still crucial after deployment. To help ease your mind, in this chapter we’ll give you
guidance on all the most common VM server administrative tasks, including the following:

e Automating the startup and shutdown of virtual machines

* Monitoring VM and host performance and alerting when performance thresholds are
passed

* Using Perl and Visual Basic scripts for management, monitoring, and alerting

* Spotting host system bottlenecks and taking the necessary corrective action

As with its predecessors, you'll find Chapter 6 to have valuable information for managing
production virtual machines.

Chapter 7: Backing Up and Recovering Virtual
Machines

Now that you have your VMs up and running, you can'’t forget about protecting them. In this
chapter, we'll cover all the methods for backing up and recovering virtual machines. We'll dis-
cuss the following:

* Backing up VMs with backup agent software
* Backing up VMs as “flat files”
* Backing up the VM host

* Using the available scripted backup solutions

As you can see, you'll have plenty of alternatives when deciding on how to best protect
your virtual machines. In this chapter, we'll not only show you each VM protection methodol-
ogy but we'll also outline the common pitfalls that exist with certain choices.

Chapter 8: Using Virtual File Systems

While the first half of the book is devoted to the design, deployment, and management of virtual
machine solutions, the second half deals with the remaining virtualization technologies currently
available. Chapter 8 leads off by explaining virtual file systems. With virtual file systems, you can
manage files and file shares transparent to their physical location. For users, this means they
won't need to know where a file is physically located in order to access it. For administrators, this
means that if a file server needs to be brought down for maintenance, you can move its data tem-
porarily to another server so that it remains available to users, without the users ever noticing a
difference. Also, it’s possible to configure replication with your virtual file system solution, which
can allow for both load balancing and fault tolerance of file server data.

To tell the complete virtual file system story, we’ll explain the most widely employed solu-
tions available today, including both DFS and Andrew File System (AFS).
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Chapter 9: Implementing Failover Clusters

The general concept of clustering is to allow multiple physical computers to act as one or
more logical computers. With server or failover clusters, two or more physical servers will host
one or more virtual servers (logical computers), with a primary purpose of preventing a single
point of failure from interrupting data access. A single point of failure can be any hardware
device or even software whose failure would prevent access to critical data or services. With
the server cluster, a virtual server will be hosted by a single node in the cluster at a time. If
anything on the host node fails, then the virtual server will be moved by the cluster service
to another host node. This allows the virtual server running on the cluster to be resilient to
failures on either its host system or on the network. Figure 4 shows a typical server cluster.
One aspect of the server or failover cluster that’s unique is that all physical computers,
or nodes, can share one or more common storage devices. With two nodes, this may be in the
form of an external Small Computer System Interface (SCSI) storage array. For clusters larger
than two nodes, the shared external storage can connect to the cluster nodes via either a Fibre
Channel bus or an iSCSI bus.
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Figure 4. Two-node mail server cluster

In Chapter 9, we'll fully explain server clustering, outlining its deployment options and
common management issues. To tell the complete clustering story, we'll cover the deployment
and management of both Windows and Linux clustering solutions.

Chapter 10: Creating Load-Balanced Clusters

Load-balanced clusters give you the ability to relieve some of the load on an overtaxed server.
With load balancing on Microsoft servers, you can configure up to 32 servers to share requests
from clients. On Linux, you can even go beyond the 32-node limit imposed by Microsoft
server operating systems.

In short, load balancing allows you to configure multiple servers to act as a single logical
server for the purpose of sharing a high load of activity imposed by network clients. In a load-
balanced cluster, two or more physical computers will act as a single logical computer, as
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shown in Figure 5. Client requests are evenly distributed to each node in the cluster. Since all
clients attempt to access a single logical (or virtual) server, they aren't aware of the physical
aspects of the network server they're accessing. This means a client won't be aware of which
physical node it’s in communication with. Configuring load-balanced clusters will give you a
great deal of flexibility in a network environment that requires a high level of performance and
reliability. Because of its natural transparency to clients, you can scale the cluster as its load
increases, starting with two nodes and adding nodes to the cluster as the demand requires.
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Figure 5. Four-node load-balanced Web server cluster

Since load-balanced clusters don’t share a common data source (as with server or failover
clusters), they're typically used in situations that require fault tolerance and load balancing of
read-only data. Without shared storage, writing updates to a load-balanced cluster would be
difficult to manage, since each node in the cluster maintains its own local copy of storage.
This means it’s up to you to make sure the data on each cluster node is completely synchro-
nized. Because of this limitation, load-balanced clusters are most commonly a means to
provide better access to Web and FTP services.

In Chapter 10, we'll take you through the complete design and implementation process
for load-balanced clusters. We’'ll show you examples of when to use them and also detail how
to deploy load-balanced clusters on both Windows and Linux operating systems.
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Chapter 11: Building Virtual Machine Clusters

Although many organizations have or plan to run clusters in production, few have resources
to test cluster configurations. That’s where building virtual machine clusters can help. With
virtual machine clusters, you can build and test working cluster configurations on a single sys-
tem. Having this ability gives you several advantages, including the following:

* The ability to have others train on nonproduction equipment
* The ability to perform practice restores of production clusters to virtual machines

 The ability to perform live demonstrations of cluster configurations using a single system

Before virtual machines, most administrators had to learn clustering on production sys-
tems, if at all. Few organizations had the resources to run clusters in lab environments. When it
comes time to test disaster recovery procedures, many organizations can't practice recovery for
clusters, again because of limited resources. By being able to run a working cluster inside of vir-
tual machines, organizations now have a means to test their backups of server clusters and in
turn prepare recovery procedures for the production cluster. Applications and resources that
run on server clusters are often the most critical to an organization. Oftentimes, when a disas-
ter occurs, it’s the clusters that must be restored first. Without having the ability to test recovery
of the cluster and thus practice for such an event, recovering a cluster in the midst of a crisis
can be all the more nerve-racking.

After reading Chapter 11, you'll understand the methodologies needed to configure
nearly any cluster configuration using virtual machine technology.

Chapter 12: Introducing Storage Networking

The development of storage virtualization has been fueled by the rapid growth of storage net-
working. In short, storage networking allows you to network storage resources together for the
purpose of sharing them, similar to a TCP/IP network of workstations and servers.

To understand the methodologies and benefits of virtualized storage resources, you must
first be comfortable with storage networking technologies. This chapter lays the technical foun-
dation for Chapter 13 by fully dissecting storage networking. Topics covered in Chapter 12
include storage area networks (SANs), network-attached storage (NAS), and direct-attached
storage (DAS). Several modern storage networking protocols will be discussed, including the
following:

¢ Fibre Channel Protocol (FCP)
¢ Internet Fibre Channel Protocol (iFCP)
¢ Fibre Channel over Internet Protocol (FCIP)

¢ Internet SCSI (iSCSI)
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In addition to covering all the relevant storage networking protocols, we'll also dive into
the hardware devices that drive storage networks. The following are some of the most com-
mon storage networking hardware devices that will be examined in this chapter:

¢ Fibre Channel switches
* Fibre Channel bridges and routers
 Fibre Channel host bus adapters (HBAs)

* Gigabit interface converters (GBICs)

Many in IT don'’t find storage to be the most thrilling topic, but nearly all realize its impor-
tance. Because of the inherently dry nature of storage, you may find that this chapter serves
dual purposes: it lays the foundation for understanding storage virtualization, and it may sub-
stitute as an excellent bedtime story for your children, guaranteed to have them sleeping
within minutes!

Chapter 13: Virtualizing Storage

Storage virtualization stays within the general context of virtualization by giving you the ability
to view and manage storage resources logically. Logical management of storage is a significant
leap from traditional storage management. For many backup administrators, having to restore
a file often meant knowing the day the file was backed up and also knowing the exact piece of
backup media on which the file was located. With storage virtualization, many backup prod-
ucts now abstract the physical storage resources from the administrator. This allows you as an
administrator to simply tell the tool what you want, and it will find the file for you.

With data continuing to grow at a near exponential rate, it can be easy to become over-
whelmed by the task of managing and recovering data on a network. As your data grows, so do
the number of storage resources you're required to track. Having the right tools to give you a
logical view of physical storage is key to surviving storage growth without having to seek men-
tal counseling. Okay, maybe that’s a stretch, but you'll certainly see how much easier your life
as an administrator can become after you finish reading this chapter.

Chapter 14: Putting It All Together: The Virtualized
Information System

Following a theme common to most technical references, Chapters 1-13 cover virtualization
technologies one at a time, making it easy for you to find specific information on a particular
topic. However, although it’s nice to understand and appreciate each technology, it’s also cru-
cial to understand their interrelationships. In this chapter, you'll see examples of networks
running several combinations of virtualization technologies simultaneously.

Many find relating virtualization technologies to their organization’s networks to be chal-
lenging. Some common questions we run into quite frequently include the following:

e How can I justify an investment in virtualization to upper management?

e What are the best uses for server-class virtual machine products?
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* What are the best uses for workstation-class virtual machine products?

* How can I optimize data backup and recovery between VMs and my production storage
area network?

* What situations are best suited for clustering solutions?
* What questions should I ask when sizing up suitable hardware and software vendors?

* What precautions must be observed when integrating different virtualization technologies?

In addition to answering the most common questions surrounding running virtualization
technologies in production and test environments, we’ll also provide examples of the methods
other organizations are using to make best use of their virtualization investments. This chap-
ter wraps up with a detailed look at a process for maintaining standby virtual machines that
can be automatically brought online if a production VM fails.

Appendix

Although virtualization product vendors such as EMC and Microsoft will go far to aiding you
with support utilities, several other vendors also offer products to add virtualization layers to
your existing network and to also aid in managing virtualized network resources.

In this appendix, we'll shower you with examples of some of the latest and greatest virtu-
alization products on the market today. Several of these vendors have allowed us to include
evaluation versions of their products on the book’s companion CD. With so many virtualiza-
tion software and hardware vendors contributing to the virtualized information system, you'll
probably find managing your virtual resources to be much simpler than you ever imagined.

Summary

Virtualization is no longer an umbrella for disconnected niche technologies but is rather
what’s seen by many as a necessity for increasingly complex information systems. Virtual
machine technology has broad appeal to many different levels of IT professionals. Sales
associates can run software demonstrations on virtual machines. Instructors now have a
tremendous amount of flexibility when teaching technical classes. They can now demonstrate
several operating systems in real time, and their students no longer have to team up with a
partner in order to run client-server networking labs. Now students can run client and server
operating systems on a single computer in the classroom.

VM technology today has reached several other IT professionals as well. Network archi-
tects and administrators can now test software deployments and design solutions on virtual
machines, prior to introducing new technologies to a production environment. For our own
testing, we've found that our wives are much happier since we no longer each need half a
dozen computers in the home office. Now a single computer with several virtual machines
works just fine. However, both of us no longer receive a Christmas card from the electric com-
pany thanking us for our high level of business each year.

Although the savings on electricity might be a bit of a stretch, the expanded roles of virtual-
ization certainly aren’t. When approaching this book, start with Chapter 1 if your first interest is
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virtual machines. This will set a solid foundation for Chapters 2-7. Following Chapter 7, you'll find
that the remaining chapters serve as independent references on the various technologies that
drive virtualization. Since Chapter 14 focuses on making all virtualization technologies seam-
lessly operate together in the same information system, you'll want to read it after Chapters 1-13.
To safely integrate virtualization technologies into your IT life, you first need to have a
good understanding of what’s available, when to use each technology, and also how to use
them. That being said, let’s not waste any more time discussing how great virtualization tech-
nology is. Instead, turn to Chapter 1 to get started with the anatomy of a virtual machine.



CHAPTER 1

Examining the Anatomy
of a Virtual Machine

In the preface, you learned how to quickly slice and dice this book to get good, quick results.
Now you’ll look at what’s going on under the hood of virtual machines (VMs). At the compo-
nent level of VMs and physical hardware, you'll revisit some fairly basic concepts, which you
might take for granted, that contribute to the successful virtualization of a physical computer.
By taking a fresh look at your knowledge base, you can quickly tie the concept of virtualized
hardware to physical hardware.

Wrapping your mind around the term virtual machine can be daunting and is often con-
fusing. This stems from the varying definitions of the term virtual machine. Even the term
virtual brings unpredictability to your understanding if you don’t understand virtual to mean
“essence of” or “properties of.” In short, if a list of specifications is equal to a machine (think:
personal computer), and if software can create the same properties of a machine, you have a
VM. If you further reduce a computer to its vital component, electricity, it’s easier to under-
stand a VM: the entirety of a computer deals with “flipping” electricity on or off and storing an
electrical charge. If software exists such that it can provide the same functionality, a hardware
emulator, then a VM exists.

Hardware virtualization offers several benefits, including consolidation of the infrastruc-
ture, ease of replication and relocation, normalization of systems, and isolation of resources.
In short, VMs give you the ability to run multiple virtual computers on the same physical
computer at the same time and store them on almost any media type. VMs are just another
computer file offering the same ease of use and portability you've grown accustomed to in a
drag-and-drop environment.

Virtualization software protects and partitions the host’s resources, central processing
units (CPUs), memory, disks, and peripherals by creating a virtualization layer within the host’s
operating system (OS) or directly on the hardware. “Running on the metal” refers to virtualiza-
tion software that runs directly on the hardware: no host operating system is required to run
the software. Every virtual machine can run its own set of applications on its own operating
system. The partitioning process prevents data leaks and keeps virtual machines isolated from
each other. Like physical computers, virtual machines require a physical network, a virtual net-
work, or a combination of both network types to communicate.



CHAPTER 1 ©/ EXAMINING THE ANATOMY OF A VIRTUAL MACHINE

The virtualization layer abstracts the hardware for every guest operating system: abstrac-
tion is the process of separating hardware functionality from the underlying hardware. Because
the operating system is built on idealized hardware, you can change physical hardware without
impacting the function of virtual machines. The virtualization layer is responsible for mapping
virtualized hardware to the host’s physical resources. Moreover, the further an operating system
is abstracted from the hardware, the easier it is to recover. You can think of abstracted operating
systems in terms of software applications. Traditional operating systems abstract hardware so
software can be written independent of hardware. Without an operating system, programmers
would have to write the same program for every system that wasn't identical to the develop-
ment machine.

Virtualization software takes the concept of abstraction one step further—it abstracts the
hardware by employing a virtualization layer. This creates an extra layer between the hardware
and operating system. One of the duties of the virtualization layer is to create virtual hardware.
Despite that the hardware is really software, operating systems see the virtual hardware as
physical devices. Assuming the virtualization software is installed on a host system, a guest
operating system can be copied from disparate physical systems, and the VM will function
as if nothing happened.

Introducing VM Types

VMs come in several varieties and are defined by how the virtualization process is performed.
You accomplish virtualization by completely emulating the hardware in a computer system or
by mapping resources from the physical computer to a virtual machine. Emulating a virtual
machine is the process of duplicating the physical structure by using software, and mapping is
the process of trapping software routines and passing instructions to the physical hardware.
Both approaches work well and render the same result, a VM. In this chapter, we'll cover hard-
ware emulators, application VMs, mainframe VMs, operating system VMs, and parallel VMs. In
general, aVM describes a complete end-user computing environment created by software.

Hardware Emulators

Hardware emulators programmatically duplicate physical architectures to provide native
functionality for software. For instance, Microsoft Virtual PC for Mac emulates the i386 archi-
tecture for the PowerPC chip. With Virtual PC, it’s as if a fully functioning x86 computer has
been reduced to an icon. Hardware emulators are useful for re-creating hardware that no
longer exists, sharing expensive resources, and porting software to different computing sys-
tem architectures. Hardware emulators, unlike VMs, focus on running software written for a
specific type of processing architecture on a completely different architecture. For instance,
Transitive’s QuickTransit emulator allows code written for Sun Solaris to be executed on an
Intel x86 processor and allows an operating system written for the Intel processor to run on
the PowerPC chip.
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Application Virtual Machines

An application virtual machine (AVM) is software that isolates a running application from

the computer hardware. The result of the isolated application computing environment is that
application code is written once for the virtual machine, and any computer capable of running
the VM can execute the application. AVMs save developers from rewriting the same application
for different computing platforms: only the AVM is ported to different computing platforms.
Examples of AVMs are Java and Microsoft’s .NET.

Mainframe Virtual Machine

A mainframe virtual machine (MVM) is a software computing environment emulating the
host computer. Virtual machines copy not only the host’s software environment but also its
physical environment. For computer users, the VM creates the illusion that each user is in
command of a physical computer and operating system. For owners of expensive mainframes,
the virtual machine allows efficient sharing of valuable computing resources and the security
settings that prevent concurrently running guest VMs from interfering with one another. Any
number of IBM mainframe systems fall into this category, such as System/370 or System/390.

Operating System Virtual Machines

Operating system virtual machines (OSVMs) create an environment of an operating system
for the computer user. Unlike the MVM emulation, OSVMs achieve virtualization by mapping
the physical computer environment on guest operating systems. The computer on which the
OSVM runs executes its own operating systems—a virtualized computer and operating systems
within a physical computer and operating system. VMware Workstation and GSX Server, as
well as Microsoft Virtual PC and Virtual Server, fall into this category.

Parallel Virtual Machines

It may be difficult to differentiate between parallel virtual machines (PVMs) and parallel
processing. PVMs consist of one computing environment running on multiple computers
employing distributed processing. PVMs create the illusion that only one computer is being
used rather than many. On the other hand, distributed processing is the act of several if not
thousands of computers working together for a greater good. In general, networked computers
conquering a large processing task. This task is split into small chunks whereby each computer
in the group is charged with completing an assignment and reporting the results. Distributed
processing doesn't have a single-user interface for an end user. Recent famous distributed
processing projects are the Seti@Home project (http://www.seti.org) and Project RC5 (http://
www.distributed.net). Examples of PVMs include Harness and PVM (http://www.csm.ornl.gov).
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OPEN-SOURCE VIRTUAL MACHINES

As with the meaning of any word subjected to the passing of time and cultural impacts, definitions change.
The term open source isn’t immune to this. The traditional definition of open source has grown beyond its
typical meaning referring to software whose code is free to use, look at, modify, and distribute. To get a good
feel for the true spirit of the terms open source and free, you can visit the Open Source Initiative definition at
http://www.opensource.org/docs/definition.php or the Free Software Foundation definition at
http://www.gnu.org/philosophy/free-sw.html. Despite what you know open source and free to
mean, no excuse exists for not reading the license (contract) packaged with software. License compliance
becomes even more important in corporate production environments, especially when using open-source
VMs or emulators. We'll briefly discuss several open-source virtualization applications: Xen, Multiple Arcade
Machine Emulator (VAME), Bochs, and DOSBox.

A popular open-source VM gaining momentum in the open-source community is Xen. It originated at
the University of Cambridge and is released under the terms of the GNU General Public License (GPL). Not
only are the independent developers involved, but recently Xen has been endorsed by several major corpora-
tions, including Hewlett-Packard, IBM, Intel, Novell, Red Hat, and Sun Microsystems. Xen uses virtualization
techniques that allow you to run multiple Linux-like operating systems at nearly native speeds. Currently, Xen
doesn’t support Microsoft Windows. You can read more about Xen at http://www.cl.cam.ac.uk/
Research/SRG/netos/xen/.

Arcade emulators are popular in the gaming community and are a great way to “win back” some
youthful memories without having to pump quarters into an arcade game. Gaming emulators, such as MAME
(http://www.mame.net), have been around since the early 1990s and mimic long-lost or aging arcade
game hardware. MAME employs a modular driver architecture supporting more than 5,000 roms (games)
and nearly 3,000 arcade games. By emulating the hardware, the game code stored in the rom of arcade
games can run on a modern computer. Because MAME takes the place of the stand-up arcade console, you
can play the actual game. Though the code stored in rom can be easily extracted and saved to the Internet,
patents and copyrights protect many games. Protect yourself from any legal ramifications if you choose to
download and play the thousands of roms available on the Web.

Bochs (pronounced box) is an open-source computer emulator written in C++ with its own custom
basic input/output system (BIOS). It's capable of emulating x86 processors, including 386, 486, AMD64 CPU,
and Pentium Pro. It can also emulate optional features such as 3DNow, MMX, SSE, and SSE2. Known operat-
ing systems it’s capable of running with common input/output (I/0) devices include Linux, DOS, Windows 95,
Windows NT 4, and Windows 2000. Bochs is generally used in Unix environments to emulate a computer. The
emulated computer is executed in @ window with your desired operating system. With Bochs, a Unix user can
run software packages not normally associated with Unix environments, such as a Windows operating system
loaded with Microsoft Office. Bochs is a project supported by SourceForge.net; you can download it at
http://bochs.sourceforge.net/.

DOSBox is open-source code that emulates a 286/386 CPU in real or protected mode. It uses the Sim-
ple DirectMedia Layer (SDL) library to gain access to components on the host computer, such as the mouse,
joystick, audio, video, and keyboard. DOSBox can run on Linux, Mac OS X, and Windows operating systems.
The main focus of DOSBox is gaming and is consequently not sophisticated enough to take full advantage of
networking or printing. If you have a hankering to revisit your favorite game or application, dust off your
floppy disks and fire up DOSBox.
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Deploying VMs

VMs are comparable to physical machines in many ways, and these similarities make it easy
to transfer existing knowledge of operating system hardware requirements to VMs. Decisions
that will drive you to use VMs include the need to demonstrate application or network config-
urations on a single computer, such as showing students or seminar attendees how to install
and configure operating systems or applications. You may decide that investing in a complete
test network is cost prohibitive and realize that VMs are a practical way to safely test upgrades,
try service releases, or study for certification exams. You can also increase your infrastructure
uptime and ability to recover from disasters by deploying clustered VMs on individual server
hardware.

When preparing to virtualize, remember that more memory, faster processors, and plenty
of high-performance hard disk space make for better VMs. Don't expect to have good or even
fair performance from a VM if only the minimum system requirements for the guest operating
system are satisfied. It's always important to check the minimum and best-practice specifica-
tions for any operating system prior to installation. When considering host hardware for guest
VMs, bigger is better! You can refer to the tables later in this chapter for the minimum physical
hardware and host operating system requirements for running VM applications.

Please note that the hardware on the host computer must have the minimum requirements
to support its operating system and the guest operating system. The minimum specifications
don’t necessarily represent the absolute minimum hardware configurations. The following mini-
mums represent manufacturer minimums and reflect their desire to have owners of old hardware
be able to upgrade to the next-generation operating system. When using Virtual PC, for example,
to run Windows NT 4 as a guest on a Windows XP host, you'll need 1.5 gigabytes (GB) of disk
space and 128 megabytes (MB) of random access memory (RAM) for the host and an additional
1GB of disk space and 64MB of RAM for the guest operating system. In total, if you don't have 2GB
of disk space and 192MB of RAM, the guest operating system won't function. Attempting to run
resource-starved VMs is an exercise in futility and defeats every benefit VMs have to offer.

When loading a host with guest VMs, too many is as bad as too few—too many will cause
host hardware resource usage to approach 100 percent, and too few will underutilize resources,
wasting money and increasing administrative overhead. Ideally, enough VMs should be loaded
onto a host system to consume 60-80 percent of the host’s total resources; this allows for
resource usage spikes without sacrificing performance or hardware investment.

Choosing VM Hardware

You can choose from a myriad of computer commodities in today’s marketplace. Whether you
decide to deploy a virtual infrastructure on inexpensive white boxes, moderately priced com-
mercial systems, or expensive proprietary computers, no excuse exists for not doing your
homework with regard to hardware compatibility lists (HCLs). You know operating system
vendors publish HCLs, so you should use them to ensure that your choice of host virtualiza-
tion hardware has been tested thoroughly and will perform satisfactorily.
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As with everything, exceptions do exist to HCLs, particularly with regard to operating sys-
tems listed as end of life (EOL). Your VM host will invariably have new hardware that wasn't
around for legacy operating systems when it was in its prime, such as DOS, Windows NT 4,
and NetWare 3.11. Despite that newer hardware may be absent on HCL listings for EOL oper-
ating systems, you can still run these systems as VMs. Table 1-1 shows Microsoft’s choice of
virtual hardware for guest operating systems, and Table 1-2 shows VMware’s.

Table 1-1. Microsoft Virtual Hardware Specifications

Virtual Device Virtual PC Virtual Server

Floppy drive 1.44MB 1.44MB

BIOS American Megatrends American Megatrends
CD-ROM Readable Readable

DVD-ROM Readable Readable

ISO mounting Yes Yes

Keyboard Yes Yes

Mouse Yes Yes

Tablet No No

Maximum memory 4GB 64GB

Motherboard chipset Intel 440BX Intel 440BX

Parallel port LPT1 LPT1

Serial port COM 1,COM 2 COM 1,COM 2
Processor Same as host Same as host

Sound SoundBlaster No

Video 8MB S3 Trio 4MB S3 Trio

IDE devices Upto4 No

SCSI No Adaptec 7870

NIC Intel 21141 Multiport 10/100 Intel 21141 Multiport 10/100
USB Keyboard/mouse only Keyboard/mouse only

PCI slots

5

5
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Table 1-2. VMware Virtual Hardware Specifications

EXAMINING THE ANATOMY OF A VIRTUAL MACHINE

Virtual Device Workstation GSX Server ESX Server

Floppy drive 1.44MB 1.44MB 1.44MB

BIOS Phoenix BIOS Phoenix BIOS Phoenix BIOS

CD-ROM Rewritable Rewritable Rewritable

DVD-ROM Readable Readable Readable

ISO mounting Yes Yes Yes

Keyboard Yes Yes Yes

Mouse Yes Yes Yes

Tablet Yes Yes Yes

Maximum memory 4GB 64GB 64GB

Motherboard chipset Intel 440BX Intel 440BX Intel 440BX

Parallel port LPT 1and 2 LPT 1and 2 LPT1and2

Serial port COM 1-COM 4 COM 1-COM 4 COM 1-COM 4

Processor Same as host Same as host Same as host

Sound SoundBlaster SoundBlaster SoundBlaster

Video SVGA SVGA SVGA

IDE devices Upto4 Upto4 Upto4

SCSI LSI 53c1030, BusLogic BT-358 LSI53c1030, LSI53c1030,
BusLogic BT-358 BusLogic BT-358

NIC AMD PCnet-PC1I 10/100 AMD PCnet-PCII  AMD PCnet-PCII
10/100/1000 10/100/1000

USB USB 1.1 USB 1.1 USB1.1

PCI slots 6 6 5

Though you may have success with hardware not found on an HCL in a test environment,
best practices dictate thorough testing of non-HCL equipment before deploying the system in
a production environment. Despite all the HCL rhetoric, it’s sufficient to be aware that hosted
operating systems work with each manufacturer’s given portfolio of hardware.

Just keep in mind that the purpose of an HCL is to ensure hardware driver compatibility
with an operating system. So that you don’t have to extensively test hardware before deployment,
operating system vendors employ rigorous certification programs for hardware manufacturers.
Given that so much time and money is already spent on testing and compiling lists of hardware
compatible with an operating system, it makes sense to build or buy computers listed on manu-

facturer HCLs.
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Choosing computer systems and components surviving certification testing and thereby
earning the right to appear on a manufacturer’s HCL saves time, money, and aggravation; in
addition, it saves countless hours of troubleshooting “weird problems” and ensures successful
implementation in the enterprise. Taking the time to verify HCL compliance is the difference
between hacks and professionals. Let manufacturers retain the responsibility for testing: if
not, you're stuck holding the “support bag” when a system fails. You can find popular manu-
facturer HCLs at the following sites:

* Microsoft’s HCL: http://www.microsoft.com/whdc/hcl/default.mspx
* VMware’s HCL: http://www.vmware.com

* Red Hat’s HCL: http://hardware.redhat.com/hcl

When testing new operating systems, it’s tempting to recycle retired equipment and think
you're saving money. Be careful; old equipment goes unused for specific reasons, and such
hardware has reached the end of its useful life. In addition, old equipment has hours of exten-
sive use probably reaching the failure threshold; using retired equipment is a false economy
trap. What money you save initially will surely be wasted in hours of aggravating work later
and deter you from embracing virtualization. Being cheap can lead to missing out on the
complete rewards of VMs, as discussed earlier. If you're still inclined to drag equipment from
basements and overcrowded information technology (IT) closets, be sure to verify HCL com-
pliance or virtual hardware compatibility, clear your schedule, and have plenty of spare parts
on hand.

Unlike retired computer equipment, using existing production equipment often provides
some cost savings during operating system testing or migration. A hazard of using production
equipment is that it may be nearly impossible to take a system offline. In addition, attempting
to insert test systems into a production environment can have adverse impacts, and the time
invested in reconfiguring systems negates any hard-dollar cost savings. However, if you have
the luxury of time and are able to jockey around resources to safely free up a server meeting
operating system HCL compliance, you not only save some money but have reason to ask for
araise!

The best solution for VM testing is to buy new equipment and create an isolated test net-
work that won't impact your production environment. A good test network can simply consist
of a cross-connect patch cable, a basic workstation, a server meeting HCL compliance, and
the best-practice RAM and CPU configurations. A new test network makes experimenting
enjoyable, and it will ensure your success when rolling out VMs.

Introducing Computer Components

In the following sections, we'll briefly cover the computer components involved with VMs.
Whether you're refreshing your memory or coming to your first understanding of computer
components, the following information can help you troubleshoot and optimize VM perform-
ance issues that will inevitably arise.

Most of us are already aware of the typical function and structure of basic computer com-
ponents; however, those of us who are grappling with how virtualization takes place will need
some of the granular explanations that follow. These sections distill the functions of computer
components to their basic properties. This will help you connect the dots to realize that VMs
are just files.
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CPU

VMs employ a virtual processor identical to the host computer and accomplish virtualization
by passing nonprivileged instructions directly to the physical CPU. Privileged instructions are
safely processed via the VM monitor (VMM). By allowing most commands to be directly exe-
cuted, guest VMs will approximate the speed of the host. Each guest VM will appear to have
its own CPU that’s isolated from other VMs. In addition, every virtual CPU will have its own
registers, buffers, and control structures. If the host system is Intel x86-based, the guest oper-
ating systems will use an Intel x86 architecture; the same goes for compatible processors
(such as AMD).

Depending on the software version and the manufacturer, such as VMware ESX Server
and Microsoft Virtual Server 2005, you may be able to use multiple CPUs if the host hardware
physically contains multiple CPUs. While configuring the guest OS, you simply choose as
many processors as the guest will use, up to the number in the host OS. Table 1-3 gives you a
quick look at the maximum number of processors Microsoft and VMware VMs can handle on
the host hardware and the maximums that can be allocated for guest VMs.

Table 1-3. Virtual Machine Maximum CPU and Memory Specifications

Virtual Machine Host Processors  Guest Processors ~ Host RAM  Guest RAM
Virtual PC 2004 Upto2 1 4GB 3.6GB
Virtual Server 2005 Upto4 1 64GB 3.6GB
Virtual Server 2005 Enterprise ~ Up to 32 1 64GB 3.6GB
VMware Workstation Upto2 1 4GB 3.6GB
VMware GSX Server Upto4 1 64GB 3.6GB
VMware ESX Server Upto 16 2 64GB 3.6GB
RAM

We all know the most celebrated type of computer memory, the type of memory that’s ephemeral
and loses the contents of its cells without constant power, the type of memory we're always in
short supply of—RAM. Like CPU virtualization, guest VMs access RAM through the VMM or virtu-
alization layer. The VMM is responsible for presenting VMs with a contiguous memory space. The
host VM, in turn, maps the memory space to its physical resources. The management of the vir-
tual memory pool is completely transparent to the guest VM and its memory subsystems.

From a performance and scaling capability, you'll be most concerned with how VMs han-
dle nonpaged and paged memory. Both memory types are created on system boot. Nonpaged
memory consists of a range of virtual addresses guaranteed to be in RAM at all times, and
paged memory can be swapped to slower system resources such as the hard drive. The ability
to use paging will allow you to create and run more VMs on a physical computer. However,
swapping memory from the hard disk to RAM will reduce performance.

VMware can use a memory pool consisting of paged and nonpaged resources: swapped
pages, shared pages, contiguous and noncontiguous physical pages, and unmapped pages.
When creating guests with VMware products, you have a choice of running the VMs in RAM,
running them in mostly RAM and some paging, or running them in mostly paging and some
RAM. In performance-driven environments, shove all your VMs into RAM. If you want to max-
imize hardware investments, you may want to take a small performance hit and allow some
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paging to be able to consolidate more servers on one box. In a test environment where it’s
necessary to have many systems running to simulate a complete network, more paging is
acceptable.

Virtual PC and Virtual Server both prohibit memory overcommitment. They prevent the
host operating system from swapping virtual guest RAM to the physical hard disk. Being that
the physical resources available to Virtual PC and Virtual Server are limited to nonpaged host
RAM, both experience maximum performance at all times.

Excessive paging can paralyze the host computer and cause guest operating systems to
appear to hang. Nonpaged memory, on the other hand, will limit running VMs to the amount
of physical RAM installed. Although you may not be able to turn up as many VMs as you could
with paging, you'll experience increased performance by having VMs in RAM at all times.
When you start testing and benchmarking VMware and Microsoft virtualization applications,
be sure to compare apples to apples by using the RAM-only feature in VMware.

When using Virtual Server in the enterprise, you may be boosting the physical memory
of servers beyond 4GB. If this is the case, you'll have to use physical address extensions (PAE)
and know that Microsoft limits its support to PAE systems listed on the Large PAE Memory
HCL. Table 1-4 lists the supported operating systems and RAM configurations.

Table 1-4. Microsoft Operating Systems and RAM Configurations

Operating System PAE Memory Support
Windows 2000 Advanced Server 8GB of physical RAM
Windows 2000 Datacenter Server 32GB of physical RAM
Windows Server 2003, Enterprise Edition 32GB of physical RAM

Windows Server 2003, Datacenter Edition 64GB of physical RAM

Hard Drive

Unlike RAM, a hard drive is considered the primary permanent storage device of VMs. Despite
having apparently the same function, Microsoft and VMware use different terminology to
describe their virtual disks. In the next section, we'll discuss each term independently. Under-
standing virtual drives is as simple as being able to make the logical leap from knowing that

a physical drive is a group of rotating magnetically charged platters to understanding that a
virtual hard drive is like one big database file that holds a lot of stuff.

To make that leap, first contemplate a traditional installation of an operating system: the
operating system maps the blocks of hard disk space into a file system and prepares the drive
to store files. The file system is the way files are organized, stored, and named. File storage is
represented on the platters as magnetic patterns of noncontiguous blocks. If the blocks were
made contiguous, or linked in a single arrangement, the sequential blocks of data could repre-
sent a single file nested in an even larger file system. The virtualization layer constructs a
virtual hard drive using this approach, encapsulating each virtual machine disk into a single
file on the host’s physical hard drive. This is a strict virtual disk and is the abstraction of a hard
drive.
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Virtual disks are robust and mobile because the abstraction process encapsulates disks
creating a file. Moving a disk is as easy as moving a file from a compact disc (CD) to a hard disk
or floppy disk. You can achieve this despite the myriad of disk and controller manufacturers. A
virtual disk, whether Small Computer System Interface (SCSI) or Integrated Drive Electronics
(IDE), is presented to the guest operating system as a typical disk controller and interface.
Virtualization software manufacturers employ just a handful of drivers for guest VMs when
creating disks. By using a handful of rigorously tested drivers, VMs don't have as many problems
as traditional operating system drivers. In the next section, you'll look closely at Microsoft’s and
VMware’s implementations of virtual disk types.

Introducing Virtual Disk Types:
Microsoft and VMware

VM disks come in several forms, such as physical, plain, dynamic, and virtual. Each disk type
offers benefits and drawbacks. Determining which type of disk to use will be based on the func-
tion of the guest VM. Once again, be alert that Microsoft and VMware use different nomenclature
to describe similar or identical disk types. Table 1-5 and Table 1-6 compare and contrast the disk
naming conventions between the manufacturers for each virtualization application.

Table 1-5. Virtual Disk Types

Disk Type Virtual PC Virtual  Workstation GSX ESX
Server Server  Server

Virtual hard drive X X

Dynamically expanding X X

Fixed X x

Linked X x

Undo disk x X

Differencing X x

Virtual hard drive X X X

Physical X x x

Dynamically expanding X X

Preallocated X x

Independent persistent X X

Independent nonpersistent X X

Persistent X

Nonpersistent X

Undoable X x x

Append x

11
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Table 1-6. Functionally Equivalent Virtual Disk Types

Disk Type Virtual PC  Virtual Workstation GSX ESX
Server Server  Server

Virtual hard disk/virtual disk X X X X X
Dynamically expanding/dynamic x X x x x
Fixed/preallocated X x x x X
Linked/physical x x x x X
Undo disk/undoable x X x x x
Differencing X X

Independent persistent/persistent x x x
Independent nonpersistent/nonpersistent X x X
Append X

Virtual disks, whether configured as SCSI or IDE, can be created and stored on either SCSI
or IDE hard drives. VMware guest operating systems currently support IDE disks as large as
128GB and SCSI disks as large as 256GB for Workstation and GSX Server. ESX Server can sup-
port a total of four virtual SCSI adapters each with fifteen devices limited to 9 terabytes (TB)
per virtual disk. Microsoft’s Virtual PC and Virtual Server offer you the ability to create up to
four IDE disks as large as 128GB, and Virtual Server can support up to four SCSI controllers
hosting seven virtual disks at 2TB. If you're doing the math, that’s more than 56TB for Virtual
Server and more than 135TB for ESX Server. Are your enterprise-class needs covered? Who's
thinking petabyte?

You can also store and execute virtual disks over a network or on a storage area network
(SAN)! In addition, you can store virtual disks on removable media: floppy disk, digital video
disk (DVD), CD, and even universal serial bus (USB) drives for VMware VMs. Despite the
portability of a virtual disk with removable media, you'll want to stick with faster access media
to maintain reasonable performance. When creating virtual disks, it isn’'t always necessary to
repartition, format, or reboot. You can refer to Tables 1-2 and 2-2 to view the disk media types
that Microsoft and VMware support.

Virtual Hard Disk and Virtual Disks

The easiest way to think of a virtual hard disk is to think about what it isn't, a physical disk.
Microsoft refers to its virtual disk as a virtual hard disk (VHD), and VMware refers to a virtual
disk as a virtual disk. In either case, virtual disk is a generic term that describes all the disk
types and modes of virtual disks utilized by VMs. In general, virtual disks consist of a file or

set of files and appear as a physical disk to VMs. Microsoft VM disks end with a .vhd extension,
and VMware VM disks end with . vmdk.

Dynamically Expanding and Dynamic Disks

When creating virtual disks, it's necessary to determine the maximum size of the disk you
want to create. By not allocating the entire disk space initially, you can create what'’s referred
to as a dynamic disk. Microsoft refers to a dynamic disk as a dynamically expanding disk, and
VMware refers to it as a dynamic disk. Dynamically expanding and dynamic disks start out
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small (just small enough to house the guest operating system) and grow to the maximum
specified size as data is added to the guest OS. The advantages to using dynamic disks are that
they consume a lot less real estate on your physical media, effortlessly move between physical
systems, and are easier to back up. The trade-off for the convenience of being able to have
dynamically expanding disks is that overall VM performance decreases. The dynamic disk
setting is the default for Virtual PC and Workstation. Dynamic disks are great for using in edu-
cational labs, development and test environments, and demonstrations. Because dynamic
disks tend to significantly fragment your physical hard drive, it’s generally not a good option
to deploy them in performance-sensitive environments.

Fixed and Preallocated Disks

Unlike dynamic disks, fixed and preallocated disks start out at their predefined size at the time
of creation. Fixed disks are still virtual disks; they just consume the entire allotted disk space
you specify from the beginning. Microsoft refers to predefined disks as fixed, and VMware
refers to them as preallocated. This type of disk is the default for GSX Server. The advantage

of using fixed disks is that space is guaranteed to the VM up to what you originally specified.
Because the file doesn’t grow, it will perform better than a dynamic disk. Unfortunately, it will
still fragment your hard drive. You can use fixed disks in a production environment where high
performance isn’t critical, such as for a print server.

Linked and Physical Disks

Virtual machines have the ability to map directly to a host’s physical hard drive or to a physi-
cal partition. VMware refers to this disk type as a physical disk, and Microsoft refers to it as a
linked disk. Physical disks allow guest and host operating systems to concurrently access the
physical hard drive. You should take care to hide the VM’s partition from the host operating
system to prevent data corruption.

You can use physical disks for running several guest operating systems from a disk or for
migrating multiboot systems to a VM. When using physical disks to port operating systems to
aVM, you should take extreme care. Porting existing operating systems to a VM is like swap-
ping hard drives between different computers—the underlying hardware is different, and
peripheral drivers are absent from the new marriage, which usually ends with an unbootable
system.

VM physical disk usage is beneficial in terms of performance because the VM can directly
access a drive, instead of accessing a virtual disk file. Using this disk type makes a lot of sense
for performance-hungry enterprise applications such as a VM running Oracle or Exchange. If
you're of the mind-set that anything you can do to tweak performance is a plus, physical disks
are the way to go.

Undo and Undoable Disks

Undo means to revert to a previous state, and if you apply this to VMs, you get what's referred
to as an undo disk for Microsoft and an undoable disk for VMware. Undoable disks achieve
their magic because the guest operating system doesn’'t immediately write changes to the
guest’s disk image. Changes made during the working session are instead saved to a tempo-
rary file. When the current session terminates, the VM shuts down, and you're interactively
prompted to save the session changes or to discard them. If you desire to save the changes,
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you must commit the changes. Committing the changes merges the temporary file data with
the original image. If you don’t commit the session, the temporary file is discarded.

Undo disks are great to use if you're going to be making changes to a VM without knowing
the outcome, such as performing an update, installing new software, or editing the registry.
Undo disks are also good to use when it’s necessary to have the original state of a virtual disk
unchanged, such as in educational institutions, test environments, or kiosks.

Differencing Disks

Microsoft Virtual PC and Virtual Server have a disk type called differencing. Differencing uses a
hierarchical concept to clone an existing disk image. Differencing starts with a baseline virtual
disk image to create additional virtual images. These additional images may be referred to as
child disks; they record the difference between the baseline parent disk image and the child
differencing disk. Because multiple VMs can be created with only one parent disk, differencing
saves physical space and time.

Differencing is handy for creating similar VMs and is useful for creating Web servers host-
ing different sites, identical file servers, or multiple application servers. When differencing
disks are stored on a network, multiple users can access and use the disks simultaneously.
When the sessions have ended, changes can be directed to the local computer for storage. As
a precaution and because of the chained effect of differencing, remember to write-protect the
parent disks: better yet, burn it to a CD-R/CD-RW or DVD-R/DVD-RW. Virtual Server will warn
you that changes to the parent disk can cause corruption and may render parent and child
disks useless. Differencing disks are good to use when you need to quickly roll out identical
or near identical guest VMs.

Like Microsoft’s differencing disk technology, VMware has the ability to share the base
image of a virtual disk. Concurrently running VMs can use the same base image. Differences
from adding and removing applications are saved to independent redo log files for each VM.
Sharing a base image requires the following steps:

1. Create a VM with all necessary preinstalled software. This becomes the base image that
won't change.

2. Next, use the undoable disk mode to create new redo logs.

3. Now, direct VMware to use the redo logs as the new disk for any number of virtual
machines. The new VMs write to the redo file as a virtual disk and leave the base image
unfettered.

Having the ability to share the same base image helps maintain a level of standardization,
saves time, and saves disk space. After creating the base image, it should be write-protected
and not edited.

Persistent and Nonpersistent Independent Disks

Independent disks require you to explore the concept of a snapshot. We all know that a snap-
shot is a photograph, and photographs trap a given point in time to capture an event. When
applying the word snapshot to a VM, you're preserving the state of aVM at a given point in
time. For instance, after installing and running a piece of software, the snapshot allows you
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to roll back time as if the software were never installed. The VM is restored to the point in time
when the snapshot was taken.

Persistent and nonpersistent are two disk types employed in VMware’s virtualization
products. Persistent and nonpersistent disks don’'t employ snapshots. When you direct VMs to
use persistent disk mode, the virtual disk acts like a conventional physical hard disk. Writes
are written to the disk without an option for undo and are made at the time the guest operat-
ing system writes or removes data. Persistent independent disks can’t be reverted to a previous
state after disk writes take place. Whether or not a snapshot is taken, the changes are immedi-
ate, and on system reboot the changes still exist. Persistent disks are good to use when you
want to most closely approximate the function of a typical computer; for instance, you could
benchmark the overhead of virtualization. Configure one computer like a typical computer,
and configure the other for virtualization. The difference between system scores will provide
the overhead involved with the virtualization layer.

Nonpersistent independent disks are generally associated with removable media. Despite
when the guest operating system is running and disk writes take place, the changes to the disk
are discarded, and the disk reverts to its original state on reboot. This is like reverting to a snap-
shot on every power cycle. Nonpersistent independent disks are an excellent way to distribute a
preinstalled operating system with applications. Also, this is great way to distribute software
that’s complicated to set up or where the known end-user environment goes unsupported.

Append Disks

Append mode disks are used with VMware ESX Server and are similar to undoable disks. A redo

log is maintained during a running session. Upon termination, you aren’t prompted to save

the session’s changes to the virtual disk. The system automatically commits the changes to

the redo log. If at any time you want to revert to the VM’s original state, delete the log file.
Append mode comes in handy when it isn’t necessary to roll back session changes on

each reboot but youd like to have the option at some point in the future. Append disks are

an excellent way to systematically learn the differences between two different states of a VM,

such as in the study of network forensics. Because you have the ability to know the exact state

of a system before and after an event, such as when figuring out how viruses or Trojans work,

you can analyze the changes in individual files.

Resizing Disks

Sometimes it’s difficult to size fixed and expanding disks for future growth in an enterprise.
Traditionally, when you deplete your hard drive resources, you've earned yourself a format
and reinstall. In the virtual world, the solution to increasing a VM'’s disk size is use-imaging
software such as Norton Ghost. Power down your VM, and add a virtual disk that’s the size
you need. Boot the VM to your imaging software, and proceed to create a disk-to-disk image.
When you're satisfied with the results, delete the undersized virtual disk.

Fixed disks generally offer performance close to that of a traditional operating system and
are best suited for task-intensive applications. Fixed and expanding disks can also span sev-
eral physical disk partitions. Because fixed disks consume their entire allocated space upfront,
they take longer to back up and can be difficult to move to a different host. Dynamic disks
offer smaller file sizes consuming less physical storage space, better portability, and easier
backups. Because dynamic disks expand on the fly, performance decreases for disk writes.
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Playing it safe with regard to dynamic and fixed disks can be difficult. When creating vir-
tual disks, pay particular attention to the default disk mode Microsoft and VMware preselects
for you: fixed or expanding. As a rule of thumb, server-class products default to fixed disks,
and workstation-class products default to dynamic. You'll want to specify a disk type based on
the VM’s purpose. For instance, for demonstration and testing purposes, you may want to use
dynamic disks. Dynamic disks won’'t needlessly consume space and will allow you to easily
turn up several servers on restricted disk space. Unfortunately, dynamically expanding disks
are slower and in the long run fragment hard drives, impacting performance. When perform-
ance is the major concern (as with production servers), fixed disks are always the best bet.

Introducing Networking

A network, at minimum, consists of interconnected computers or hosts. A host refers to a
device that has an Internet Protocol (IP) address and uses networking protocols to communi-
cate. An IP address is like a Social Security number because it uniquely identifies a single
entity—a Social Security number identifies a citizen in the United States, and an IP address
identifies a host (think: computer). IP addresses are grouped into two ranges and five classes:
public and private, and A-E. Private addresses are prohibited from directly communicating on
the Internet, but public addresses can.

Though it isn’t necessary to memorize the categories and groups of IP addresses, it’s a
good idea to be aware of them. Understanding computer addresses is vital to your success in
virtualization. Not knowing the two ranges and five classes makes it difficult to use Network
Address Translation (NAT) and route virtualized computer traffic. In addition, you may want
to break out your notes on subnetting before setting up virtual networks or studying for your
VM certification. To serve as a quick reminder, Table 1-7 outlines the structure and uses of
IPv4 classes.

Table 1-7. IPv4 Classes

Class IPs for Private Range IPs for Public Range Subnet Mask Purpose

A 10.0.0.0-10.255.255.255 1.0.0.0-127.255.255 255.0.0.0 Used on
large
networks

B 172.16.0.0-172.255.255.255 128.0.0.0-191.255.255.255  255.255.0.0 Used on
medium
networks

C 192.168.0.0-192.168.255.255  192.0.0.0-223.255.255.255 255.255.255.0 Used on
small
networks

D 224.0.0.0-239.255.255.255 255.255.255.255 Reserved
for
multicast
traffic

E 240.0.0.0-254.255.255.255 Reserved
for experi-
mental use
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VM Networking Protocols

Interconnected computers can exist that don’t require IP addresses, but they aren’t considered
hosts unless they have an IP assignment (strictly speaking). VMs use virtual hardware to build
networks that consist of network interface cards (NICs), bridges, and switches. Other than

the computer language of the Internet that most networked computers use to communicate,
Transmission Control Protocol/Internet Protocol (TCP/IP), VMs use Dynamic Host Configura-
tion Protocol (DHCP) and NAT. In the following sections, we'll briefly cover these protocols
before discussing how VMs handle these services.

TCP/IP

TCP/IP is a framework of globally agreed on directives that control communications between
two hosts. TCP/IP is a suite of several protocols. TCP is responsible for monitoring the transfer
of data, correcting errors, and breaking computer data into segments. The segmented data is
forwarded to IP, and IP is responsible for further breaking the data into packets and sending it
over a network. The conventions used by TCP/IP allow hosts to communicate reliably over the
Internet and on typical computer networks.

Note Without giving yourself some context, virtualization will continue to be an abstract word. For
instance, it may help if you start thinking about the theoretical approach to networking protocols with the aid
of the International Standard Organization Open System Interconnect (ISO 0SI) model. Even though you may
think you’ve escaped the wrath of the OSI model after passing that last IT certification exam, it’s a serious
approach that will help you understand the concepts of virtualization. As you're reading this book, quiz your-
self on what’s currently being discussed, and note how it relates to one of the seven layers of the OSI model.
Making yourself familiar with how the virtual equates to the physical will later help you troubleshoot VMs.
For instance, when you have a host-only virtual network and two hosts aren’t able to communicate, which
VM device file are you going troubleshoot?

DHCP

DHCP provides an automated way for passing network configuration information to hosts. DHCP
can inform a host of many things, including its name, gateway, and IP address. Network adminis-
trators often use this protocol to centrally manage hosts, and using DHCP alleviates the necessity
of physically keying information into every network computer (which can be tedious and time-
consuming). In addition to reducing administrative overhead, DHCP makes it easy to physically
move a computer from one network to another. Without an IP address, a computer can’t connect
to a network or the Web. Table 1-8 outlines the DHCP lease process; knowing this process makes
it easier to troubleshoot VMs in host-only mode or VMs requiring the services of NAT.
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Table 1-8. DHCP Process

Process State Purpose

Discover The host computer broadcasts an announcement to any listening DHCP servers.

Offer All DHCP servers receiving the announcement broadcast an IP address offer to
the host.

Request The first offer to reach the host is the winner. The host broadcasts a request to
keep the IP address.

Acknowledgment  The “winning” DHCP server acknowledges the host’s request to use the address.

VMware and Microsoft virtualization products are capable of providing a DHCP service
for host-only and NAT-configured virtual networks. Like a traditional DHCP server, the virtual
DHCP device allocates IP addresses from a pool of specified networking addresses. So that the
VM will function correctly, the DHCP device assigns an IP address and any other necessary
networking information including the NAT device information—default gateway and DNS
server addresses. The DHCP server that’s bundled with Microsoft and VMware is limited. If
you need a DHCP server for a test environment, the supplied server should be sufficient.

If you expect your virtual machines in a host-only network to be bridged to a production
network, you'll run into some difficulties. For instance, if you're relying on the DHCP service
to register a host’s name in DNS, the bundled server isn’t up to the task.

You know that it's important to not have multiple DHCP servers on a single network with
conflicting lease information. In addition, you know that when using a DHCP server it's impor-
tant to not have its broadcast traffic cross into other networks. Packet leakage from virtual
networks can occur if bridged network adapters aren’t properly configured. If a physical host
receives an offer from the DHCP server supporting a virtual network, it won't be able to commu-
nicate because it will be configured with information from the virtual network. This scenario is
possible when using DHCP servers built into Microsoft and VMware virtualization applications
if IP forwarding is configured on the host network adapter. In this case, though host-only and
NAT networks are intended to keep their traffic in the virtual environment, packet leakage
occurs if the physical host is actively forwarding traffic. This can occur because the host adapter
is placed in promiscuous mode for NAT to route traffic from the outside physical network to the
internal virtual network. In general, built-in DHCP devices are good to use when you don’t need
the extended scope options provided by a production server.

NAT

The NAT protocol is a lot like nicknames. For instance, Alaska is known as the Last Frontier or
Land of the Midnight Sun. Though the nicknames aren'’t identical to the word Alaska, they
directly translate to the uniquely identifying characteristics of the state. To further illustrate,
it'd be difficult to confuse the Sunshine State with the Lone Star State. To draw another anal-
ogy, what language translators are to foreign diplomats, NAT is to IP addresses. NAT is like the
aforementioned because it can uniquely identify a host across two networks: it’s the transla-
tion of IP addresses used within one network to a different IP address in another network.
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Networking computers with NAT creates a distinction between internal and external net-
works. Traditionally, NAT maps a private local area network (LAN) to a global outside network.
The mapping process of NAT creates a security barrier qualifying the movement of network
traffic between the two. This is how nearly all corporate networks running on private LANs
access the public Internet—by NATing either through a router or through a firewall. When
NAT is used, networks can be any mix of public, private, internal, or external configurations.
Figure 1-1 illustrates the NATing process.

Private
Network
Public Address Public
4 65.16.1.150.100 Network
Private Address Translation Table
192.168.1.1 Leaving
192.168.1.1 = 65.16.150.100
Entering

65.16.150.100 = 192.168.1.1

Figure 1-1. The NATing process

The terms private and public strictly refer to whether the network traffic generated by an
IP address is capable of being routed on the Internet. If the address is public, it'’s routable on a
private network and on the Internet: if it’s private, it’s routable on a private network and not
the Internet. If Internet connectivity were required in the latter case, NAT would have to be
used to translate the private address into a public address.

The NAT device connects VMs to external networks through the host’s IP address. A NAT
device can connect an entire host-only network to the Internet through the host’s computer
modem or network adapter. Using a NAT device tends to be the safest and easiest way to
connect VMs to physical networks. The NAT device is responsible for tracking, passing, and
securing data between host-only and physical networks. For instance, NAT identifies incom-
ing data packets and forwards them to the intended VM. Conversely, NAT identifies and
passes information destined for physical networks to the correct gateway.

The practical application of NAT devices built into Microsoft’s and VMware’s virtualiza-
tion applications comes in handy when only the host’s IP address is available to connect a
virtual network to a physical network. You can leverage NAT to connect a virtual network to
the Web through the host’s network adapter or dial-up adapter using Microsoft Internet Con-
nection Sharing (ICS). In addition, you can use NAT to connect virtual networks to your host’s
wireless adapter or even connect a virtual network to an asynchronous transfer mode (ATM)
or Token Ring network with the aid of Microsoft Routing and Remote Access Service (RRAS) or
proxy software.
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Introducing Networking VMs

You probably graduated from sneakernet a long time ago, and whether you use wireless or
traditional copper technology to network physical and virtual hosts, the same hardware and
communication protocols you already know are required. VMs use physical and virtual NICs
to create four common network configurations. Table 1-9 summarizes the virtual NICs used
and maximum quantity available for use in Microsoft’s and VMware’s virtualization applica-
tions. The maximum number of virtual NICs to be installed in a guest VM can'’t exceed the
number of available Peripheral Component Interconnect (PCI) slots, and the total that can
be installed will be reduced to the number of free slots. For instance, if three virtual SCSI
adapters are installed in GSX Server, despite that it can handle four network adapters, only
three PCI slots are available for NICs.

Table 1-9. Virtual Machine Network Interface Card Specifications

Virtual Machine NIC Speed Maximum PCI Slots
Virtual PC 2004 Intel 21141 10/100 4 5
Virtual Server 2005 Intel 21141 10/100 4 5
Virtual Server 2005 Enterprise Intel 21141 10/100 4 5
VMware Workstation 10/100 AMD PCnet-II 3 6
VMware GSX Server 10/100/1000 AMD PCnet-II 4 6
VMware ESX Server 10/100/1000 AMD PCnet-II 4 5

The following are the four virtual network types supported by Microsoft and VMware vir-
tualization applications (sans the “no networking” networking option):

Host-only networking: Entire virtual networks can be created that run in a “sandboxed”
environment. These networks are considered sandboxed because the virtual network
doesn’t contact existing physical networks. The virtual network isn't mapped to a physical
interface and is called host-only networking.

NAT networking: NAT networks employ NAT to connect virtual machines to a physical
network. This is achieved by using the host’s IP address. NAT is responsible for tracking
and delivering data between VMs and the physical LAN.

Bridged networking: Bridged networking is the process of connecting (bridging) a VM to
the host’s physical LAN. This is accomplished by placing the host’s NIC in promiscuous
mode. A bridged VM participates on the same LAN as the host as if it were a peer physical
machine.

Hybrid networking: Using variations of host-only, NAT, and bridged networking, you can
create complex hybrid networks. Hybrid virtual networks can simultaneously connect
several physical networks and host-only networks. Hybrid networks are an excellent
choice to create test environments.
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Configuring the four types of networks varies from one VM application to the next.
Though we'll discuss the required steps to create each network in later chapters, now is a good
time to point out that varying degrees of difficulty (and lots of “gotchas”) will be encountered
as we step through the configurations of each. For example, Virtual PC and Virtual Server
require you to manually install a loopback adapter on the host in order to allow the host to
talk to the VMs on a host-only network. This is in contrast to VMware installing its own virtual
network adapter on the host to do this automatically.

Connecting physical and virtual computers is a great way to share data, increase resource
utilization, and learn. Knowing which network configuration to create, in the end, will be based
on its purpose. If a network is being created to test and upgrade to a new operating system or
roll out new software, it’s best to keep experimentation confined to host-only networks. If host-
only networks need access to external resources, NAT can be safely implemented to mitigate
liability through limited communication to a physical network. On the other hand, if you're
building highly reliable and portable VMs, physical/bridged networking is the way to go.

Note Host-only networks, because of their sandboxed environments, are a great way to emulate and
troubleshoot production network problems, learn the basics of networking protocols, or teach network secu-
rity with the aid of a sniffer (network analyzer). In the host-only sandbox, everyone wins: you aren’t exposed
to a production network or the traffic it creates in your broadcast and collision domains, and others are safe
from your experimentation. For instance, with the aid of two to three VMs, you can quickly audit and identify
the four broadcast messages involved with the DHCP lease process, or you can view the process of “steal-
ing” information by performing a man-in-the-middle attack with the analyzers built into Microsoft operating
systems, free Internet downloadable analyzers such as Ethereal, or commercial products such as Network
Instruments’ Observer.

Introducing Hardware

Computer hardware, for example, encompasses monitors, keyboards, RAM, CPUs, and sound
cards. The word hardware should conjure up images of computer parts that can be touched
and moved. Because VM software is capable of abstracting the physical computer into virtual
hardware, fully loaded virtual machines can be created. VM manufacturers have successfully
virtualized every major component of a computer, such as network adapters, switches, SCSI
adapters, I/0 devices, and even the BIOS.

Being that computers are generally useless without the ability to communicate with other
computers, the ability of a VM to be networked is extremely important. Interconnecting VMs
into the varieties of networks available requires using physical and virtual hardware. Tradi-
tional physical networks rely on network cards, bridges, switches, routers, and servers to get
the job done, and VMs are no different.
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Network Interface Card

A NIC, or network adapter, is a device that connects a host to a network. The network connec-
tion can be wireless, wired, or optical. An IP address is assigned to a NIC, which enables a host
to communicate on IP-based networks.

In addition to a network adapter having an assigned IP, it also has a unique 48-bit address.
This address is like a Social Security number in that it uniquely identifies one entity. As depicted
in Figure 1-2, the address is expressed as an alphanumeric sequence in hexadecimal format and
is referred to as a media access control (MAC) address. The first 24 bits of the number uniquely
identify the manufacturer, and the last 24 bits identify the card. Hosts use MAC addresses to
directly communicate with each other.

00-0C-29 - CA-95-1B

N

Manufacturer (OUI) Manufacturer Serial Number
00-0C-29 CA-95-1B
VMware, Inc Unique Computer ID

Figure 1-2. MAC address breakdown

Virtual networks cards, like physical adapters, have their own MAC and IP addresses. The
guest operating system uses a virtual network card as if it were a physical NIC. NICs fall into
categories: physical and virtual. The virtual NIC can be mapped to a dedicated physical net-
work interface, or many virtual NICs can share a single physical interface. The VMM manages
security, isolation of traffic, and guest NICs. Sending and receiving network-based informa-
tion for virtualized computers generates an extra load for the host computer. To some degree,
the increased overhead of networking will impact the overall performance of the host and
guest operating systems.

Switches

You can think of the function of a switch in terms of the hub-and-spoke scheme of airline
carriers. Passengers board an airplane at outlying airports and fly to distant interconnecting
hubs. At the hub, passengers change planes and fly to their final destination. Air-traffic con-
trollers orchestrate the entire process.

Switches connect multiple networking devices together to transport traffic, and hosts use
a protocol called Carrier Sense Multiple Access/Collision Detection (CSMA/CD) to ensure no
collisions take place. A collision occurs when two hosts use the same data channel simultane-
ously to send network traffic. If a collision is detected, the host will wait for a specified random
period of time and attempt to retransmit the data. Microsoft and VMware both support VM
virtual switches; the following lists highlight the limitations of the virtual switches included
with each VM.
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Virtual PC’s virtual switches have the following limitations:

e Virtual PC supports nine virtual Ethernet switches; three are reserved for host-only,
bridged, and NAT networking.

* Windows hosts can support an unlimited number of virtual network devices to a virtual
switch.

e Linux hosts can support 32 devices.

e Virtual PC supports most Ethernet-based protocols: TCP/IP, NetBEUI, Microsoft
Networking, Samba, Network File System, and Novell NetWare.

Virtual Server’s virtual switches have the following limitations:

e Virtual Server supports nine virtual Ethernet switches; three are reserved for host-only,
bridged, and NAT networking.

¢ Windows hosts can support an unlimited number of virtual network devices to a virtual
switch.

¢ Linux hosts can support 32 devices.

¢ Virtual Server supports most Ethernet-based protocols: TCP/IP, NetBEUI, Microsoft
Networking, Samba, Network File System, and Novell NetWare.

Workstation’s virtual switches have the following limitations:

* Workstation supports nine virtual Ethernet switches; three are reserved for host-only,
bridged, and NAT networking.

¢ Windows hosts can support an unlimited number of virtual network devices to a virtual
switch.

¢ Linux hosts can support 32 devices.

¢ Workstation supports most Ethernet-based protocols: TCP/IP, NetBEUI, Microsoft
Networking, Samba, Network File System, and Novell NetWare.

GSX Server’s virtual switches have the following limitations:

* GSX Server supports nine virtual Ethernet switches; three are reserved for host-only,
bridged, and NAT networking.

¢ Windows hosts can support an unlimited number of virtual network devices to a virtual
switch.

¢ Linux hosts can support 32 devices.

¢ GSX Server supports most Ethernet-based protocols: TCP/IPB, NetBEUI, Microsoft
Networking, Samba, Network File System, and Novell NetWare.
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ESX Server’s virtual switches have the following limitations:

» ESX Server supports nine virtual Ethernet switches; three are reserved for host-only,
bridged, and NAT networking.

* Windows and Linux hosts can support 32 devices.

» ESX Server supports most Ethernet-based protocols: TCP/IP, NetBEUI, Microsoft Net-
working, Samba, Network File System, and Novell NetWare.

Virtual switches connect VMs and are logically similar to physical switches. Switches
place individual hosts into separate data channels, called collision domains, and are utilized
in virtual or physical networking. The following are the types of switch devices available,
based on the protocols employed:

* Bridged connects VM directly to the host’s network.
e NAT uses traditional NAT techniques to connect the VM to the host’s network.

* Host-only virtual machines are networked in a sandboxed network and don'’t affect
the host.

Switches speed up the process of network communication by tracking the port and MAC
addresses of connected hosts and storing the data in a table. When traffic is sent to the switch,
the switch looks up the destination MAC address in the table and forwards the traffic to the
associated port. If a switch doesn’t know where to directly send incoming traffic, it will func-
tion like a hub and forward the traffic out all ports except the source port.

BIOS

A physical computer’s BIOS is like the VMM in that it maps hardware for use by the operating
system. Like physical machines, VMs have a BIOS. The BIOS maps your computer’s hardware
for use by software and functions the same for virtual machines as it does for a physical
machine. It’s a set of instructions stored in nonvolatile memory, a read-only memory (ROM)
chip, or a variant thereof that interacts with the hardware, operating system, and applications.
Moreover, BIOS software consists of a group of small software routines accessible at fixed
memory locations. Operating systems and applications access the specific memory areas with
standardized calls to have I/0 functions processed. Without BIOS, a computer won'’t boot.
Microsoft and VMware VMs are each packaged with different BIOSs:

* Microsoft: American Megatrends BIOS (AMIBIOS) APM1.2 and Advanced Configuration
and Power Interface (ACPI) version 08.00.02

e VMware: Phoenix BIOS 4.0 Release 6-based VESA BIOS with DMI version 2.2/SMBIOS

The type of BIOS each manufacturer uses impacts the hardware that’s inevitably available
to the VMs, including the virtualized (synthetic) motherboard. Like physical machines, the
BIOS of aVM can be edited. The ability to edit each VM allows you to customize the compo-
nents available to the VM after boot. You may find it necessary to edit a VM’s BIOS to change
the boot device priority from a floppy disk to a CD, configure a bootup password to protect a
VM from unauthorized access, or disable power management for VM production servers.
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Because VMs will encounter the same problems as a physical machine, now is a good
time to review the boot process of a computer. If a system fails to properly boot, knowing the
boot process will help you quickly identify the cause of the failure.

The boot process begins with the BIOS when a computer initializes. After power is applied,
the BIOS performs several tasks: starting the processor, testing hardware, and initializing the
operating system. Let’s quickly review the sequence:

1. When the computer is first turned on, the computer’s power supply sends a signal to
the main board informing it to initialize the CPU and load the BIOS bootstrap.

2. The BIOS checks the computer hardware through a series of small tests, called a
power-on self-test (POST).

3. After an error-free POST, the BIOS searches for an operating system. Depending on
how the BIOS is configured, any number of devices can be booted: floppy drives, hard
drives, CD drives, and USB drives.

4. Once the BIOS locates a bootable medium, it searches for the boot sector to start the
operating system.

Network booting is an additional option and is accomplished after the computer gets its
IP address from the DHCP server. The client receives a bootable disk image over the network
and executes it. Microsoft and VMware virtualization applications both support booting from
a network adapter.

Generic SCSI

Generic SCSI is important to VMs being able to support the entire spectrum of hardware in
the enterprise infrastructure. Generic SCSI affords VMs the ability to utilize SCSI devices, such
as tape drives, DVD-ROM drives, CD-ROM drives, and even scanners. The prerequisite to a
SCSI device working on a VM is that the guest operating system must support the device.

You can add generic SCSI support by giving VMs direct access to attached SCSI devices
through the VMM. Though generic SCSI is supposed to be device independent, you may expe-
rience difficulties depending on the particular SCSI device and guest operating systems used.
For instance, you might find your 12-head tape library appears as a single drive. At the time of
this writing, only VMware virtualization applications support generic SCSI.

I/0 Devices

Computers would practically be useless to us without our favorite I/0 devices. What would
we do without our optical mice, keyboards, color laser printers, and flat-panel displays? Virtu-
alization software provides similar device support for getting data in and out of aVM as a
physical computer; however, Microsoft and VMware vary on supported devices. The following
list details what both manufacturers support natively:

e Virtual floppy drives
e Virtual serial ports

e Virtual parallel ports
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Virtual keyboard

e Virtual mouse and drawing tablets

Virtual CD drives (CD-R only for Microsoft and CD-R/CD-RW for VMware)

Virtual USB ports (keyboard and mouse emulation only for Microsoft)

Virtual sound adapter (not available for Microsoft Virtual Server)

Introducing VM Products

Virtualization software is useful for developing new applications in different operating envi-
ronments without having to simultaneously use multiple physical computers. In addition,
because you can create complex networks, it’s easy to test what if scenarios with operating
system service packs and software application patches. More important, virtualization prod-
ucts give you excellent disaster recovery capability and extreme portability for the corporate
infrastructure because a complete computer system is reduced to a file.

Microsoft and VMware have virtualization products in workstation and server varieties
and are robust enough to use outside a test environment and in the enterprise. VMware and
Microsoft offer a host of specialty products—for instance, VirtualCenter, P2V Assistant, and
Assured Computing Environment (ACE)—that ease the administration of a virtualized infra-
structure. In addition, a handful of open-source projects offer virtualization software and are
well worth investigating and using.

Virtual PC

Virtual PC was originally created to emulate a PC in a Macintosh environment. Microsoft
acquired Virtual PC from Connectix. Not only did Microsoft acquire a new product, it acquired
the needed experience to get up to speed in the exploding field of virtualization. Does anyone
remember what Microsoft accomplished with its $50,000 purchase of Tim Paterson’s QDOS?
At any rate, Microsoft continues to support the Mac with Virtual PC and affords Mac users

the ability to use PC-based applications, file structures, and peripheral devices. Virtual PC for
Mac is well worth the minimal investment for the luxury of running PC operating systems and
applications. If you've used Connectix’s product in the past, you'll find Virtual PC to be the
same powerful virtual machine it has always been—for the Mac or the PC.

Virtual PC is hosted by a conventional operating system, and once Virtual PC is loaded,
guest operating systems can be installed. Guest operating systems are controlled like normal
Microsoft applications: with a click of the mouse, you can switch between Windows 9x, Win-
dows NT, and even DOS. Being able to run legacy operating systems in a virtual environment
maintains compatibility with an established infrastructure without having to delay the migra-
tion to more advanced operating systems.

Because Virtual PC affords developers the ability to run several operating systems simul-
taneously on a single physical machine, development time and overall hardware costs are
reduced. Remember that the more operating systems you want to run at one time, the more
RAM you need to maintain reasonable levels of performance. Every virtual machine created in
Virtual PC will run in an isolated environment and uses standardized hardware. To run Virtual
PC, your host system will need to comply with minimum specifications. Table 1-10 lists the
hardware and operating system requirements.
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Table 1-10. Microsoft Virtual PC Minimum Supported Host Specifications

Requirements Minimum Specification

CPU 400MHz

SMP Host-only

Memory 128MB

Video 8-bit adapter

Disk space 2GB

Hard drive IDE or SCSI

Network card Optional

Audio Optional

Host OS support Windows XP or Windows 2000
Guest OS support 082, DOS 6.22 through Windows XP Professional

Connectix Virtual PC officially supported more operating systems than Microsoft Virtual
PC; however, you can continue to “unofficially” run several varieties of Linux operating sys-
tems successfully. Be aware that when you run unsupported operating systems, you're on your
own when it comes to support. It's important in the enterprise to have documented manufac-
turer support, so choose virtualization software accordingly. Microsoft continues to support
0S/2 in the Virtual PC environment.

Microsoft’s Virtual PC is a mature product and suitable for running multiple operating
systems, using legacy operating systems, training new employees, or allowing corporate tech-
nical support to test rollout and migration plans. In addition, Virtual PC is excellent for
training technical students on virtual networks using multiple operating systems without
impacting the entire school or when acquiring additional hardware is cost prohibitive.

One glaring difference between Virtual PC and Virtual Server is the availability of official
Microsoft support. Virtual PC is intended to be used with desktop operating systems, and Vir-
tual Server is intended for server operating systems. You can load server operating systems on
Virtual PC; however, you're on you own for support. If you're using it for a test environment,
then support isn't a big deal. In the physical world, would you use a desktop operating system
in place of a server operating system? Also, be careful when moving virtual machines—the
saved states between Virtual Server and Virtual PC are incompatible. Table 1-11 lists some
other differences between the two.

Table 1-11. Differences Between Virtual PC and Virtual Server

Virtual Machine Sound Card Virtual SCSI Support CD-ROM Drives

Virtual PC Yes No One
Virtual Server No Yes Many
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VMware Workstation

Microsoft Virtual PC and VMware Workstation are in the same single-user VM class and have
many similarities. Similarities between the two products are uncanny and include juicy stories
with regard to mergers and acquisitions. To fill you in a bit, after a brief courtship by Microsoft
ending in failure, EMC stepped up to the plate and acquired VMware. Since its inception at
Stanford in the late 1990s, VMware Workstation has become a mature and reliable product.

VMware Workstation, despite having a single-user license, is excellent for network adminis-
trators and developers who want a better, faster, and safer way to test in production environ-
ments. On the development side, programmers can test code across multiple platforms on one
workstation, ensuring application compatibility. Administrators can test complex network con-
figurations using a variety of network operating systems, including Microsoft, Novell, and Linux
products. In addition, administrators can create virtual networks to safely test how a new patch
or upgrade will affect production systems.

VMware accomplishes hardware virtualization by mapping physical hardware to virtual
machine resources. Every virtualized host is a standard x86 system with its own virtualized
hardware. For example, each VM will have its own memory, CPU, I/O ports, hard disk, CD
drive, and USB ports. Like Virtual PC, VMware Workstation is hosted by a conventional operat-
ing system. Workstation officially supports more than 20 operating systems and “unofficially”
runs many others. Because Workstation can support applications requiring legacy operating
systems, migrating to new operating systems and hardware won't impede enterprise work-
flows. Table 1-12 lists the minimum hardware and operating system requirements to run
VMware Workstation.

Table 1-12. VMware Workstation Host Specifications

Requirements Minimum Specification

CPU 400MHz

SMP Host-only

Memory 128MB

Video 8-bit adapter

Install footprint 100MB for Windows/20MB for Linux

Hard drive IDE or SCSI

Network card Optional

Audio Optional

Host OS support Windows NT4 SP6a through Windows 2003 Datacenter
Linux distributions including Mandrake, Red Hat, and SuSE

Guest OS support DOS 6.x through Windows 2003 Enterprise, Linux, Solaris, Novell,
and FreeBSD

When you want to begin transforming the business infrastructure into a virtual data cen-
ter or support the increasing demands on educational equipment, VMware Workstation is the
best place to begin. Workstation will reduce overall costs, decrease development time, and
provide programmers, network administrators, and students with an overall excellent test
bench.
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Microsoft Virtual Server 2005

Microsoft expands its virtual machine portfolio with the addition of Virtual Server 2005. Enter-
prise-class virtual machines, such as Virtual Server 2005, typically provide value by offering
the ability to consolidate multiple servers onto one piece of physical hardware, the opportu-
nity to re-host legacy applications, and increased assurance with regard to disaster recovery
capability.

Virtual Server comes in two editions, Enterprise and Standard. Both editions are identical
except for the number of processors each supports—four for Standard and up to thirty-two for
Enterprise. Microsoft’s Virtual Server is a hosted solution designed to run on Windows Server
2003 and Internet Information Services (IIS) 6 with ASPNET-enabled extensions. Virtual
Server can run many x86 operating systems; however, Microsoft officially supports the follow-
ing guest operating systems:

e Windows NT Server 4.0 with Service Pack 6a

e Windows 2000 Server

e Windows 2000 Advanced Server

¢ Windows Small Business Server 2003, Standard Edition
¢ Windows Small Business Server 2003, Premium Edition
e Windows Server 2003, Web Edition

e Windows Server 2003, Standard Edition

e Windows Server 2003, Enterprise Edition
Table 1-13 lists the minimum specifications for the guest operating systems.

Table 1-13. Virtual Server Minimum Specifications for Guest Operating Systems

Guest Operating System RAM Disk Space
Windows XP Professional 128MB 2GB
Windows XP Home 128MB 2GB
Windows 2000 Professional 96MB 2GB
Windows NT 4 SP6 or higher 64MB 1GB
Windows Millennium Edition 96MB 2GB
Windows 98 SE 64MB 500MB
Windows 95 32MB 500MB
MS-DOS 6.22 32MB 50MB

0S/2 (with exceptions) 64MB 500MB
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Because you'll be left to support unlisted operating systems such as Linux on your own,
Virtual Server may not be a good choice in production environments for unlisted operating
systems. In addition, if your VM implementation requires multiple processors, Virtual Server
2005 will leave you in the cold—it will virtualize only a uniprocessor configuration for any
given VM. Table 1-14 outlines the minimum hardware and software requirements for Virtual
Server.

Table 1-14. Microsoft Virtual Server Minimum Supported Host Specifications

Requirements Minimum Specification

CPU 550MHz

SMP Host-only

Memory 256-512MB Small Business Server (SBS)/512MB Datacenter 512MB
Video 8-bit adapter

Disk space 2-4GB (4GB for SBS)

Hard drive IDE or SCSI

Network card Optional

Audio Not supported

Host OS support Windows SBS 2003 through Windows 2003 Datacenter

Guest OS support 082, DOS 6.22 through Windows XP Professional and Windows 2003 family

Virtual Server has an easy-to-use Web interface where system resources can be leveraged
to allocate resources to guest operating systems as necessary. If a guest needs a bit more pro-
cessing time from the CPU or more RAM, simply adjust Virtual Server, and your problem is
solved. The scripted control of guest systems makes managing the systems straightforward,
and it has the characteristic Windows look and feel. Virtual Server also integrates with Win-
dows tools such as Microsoft Operations Manager (MOM) 2005, which is a performance and
event management tool, and Systems Management Server (SMS) 2003, which is a software
change and configuration management tool.

Getting your existing servers into a virtual environment will be the first hurdle in the vir-
tualization process. If all the servers in your infrastructure had to be formatted and reloaded,
making the leap from a physical environment to the virtual would be a near impossible task.
To aid in the migration, the Microsoft Virtual Server Toolkit (MVST) is available as a free down-
load as of this writing. It automates the process of moving the server operating system and
applications from a physical machine to a virtual machine running in Virtual Server.

Virtual Server is a solid addition to Microsoft’s line of products and affords homogenous
corporate environments the ability to stay that way. Though you’ll have to use an additional
server license to run Virtual Server guest operating systems, it’s an excellent way to start saving
by consolidating servers and to free time for support departments by reducing administrative
overhead. Virtual Server is easy to install and offers traditional Microsoft quality in its man-
agement of system resources.

Licensing may pose a hidden gotcha when it comes to software pricing. Some software
vendors base licensing fees on CPUs, but what happens if you run a single CPU-licensed
application on a quad processor box in a guest VM utilizing one virtual processor? You'll
want to check with your software vendors on the ramifications of using applications in VM
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scenarios. Don't get put in a position of pirating software. For the Microsoft folks, Microsoft
has alicensing brief available that’s well worth reading. As of this writing, you can download it
athttp://download.microsoft.com/download/2/f/f/2ff38f3e-033d-47e6-948b-8a7634590be6/
virtual mach_env.doc. The good news is that Microsoft doesn’t require redundant client
access licenses (CALs) for guest VMs and host VMs. You'll need only application CALs for guest
VMs because every user and device required to have an OS CAL must access the host operat-
ing system running Windows 2003 first.

VMware GSX Server

Like Microsoft’s Virtual Server, GSX Server can serve in the enterprise and affords similar
implementation benefits. GSX Server is x86-based and is great for server consolidation, for
expediting software development practices, and for disaster recovery purposes. Because GSX
Server is flexible, it supports a wide variety of server products, such as Microsoft Server prod-
ucts, Linux products, and even Novell NetWare.

GSX Server allows administrators to remotely manage VMs and provision new servers
through a Web interface based on Secure Sockets Layer (SSL) or through the host’s console. Each
new guest server is isolated and hosted on the same physical box, and communication between
the systems will be facilitated through the use of virtual or bridged networking. Provisioned
guest VMs can have direct or mapped access to host machine resources, such as memory, CPU,
networking devices, peripherals, and disk drives. GSX Server hosts can run on symmetric multi-
processor (SMP) systems; however, guest VMs can use a single processor. If you need scalability
for guest operating systems, you'll have to move up to ESX Server. Table 1-15 lists the minimum
hardware and host operating system requirements for GSX Server.

Table 1-15. VMware GSX Server Minimum Supported Host Specifications

Requirements Minimum Specification

CPU 733MHz

SMP Host-only

Memory 512MB

Video 8-bit adapter

Install footprint 130MB for Windows/200MB for Linux

Hard drive IDE or SCSI

Network card Optional

Audio Optional

Host OS support Windows SBS 2003 through Windows 2003 Datacenter
Linux distributions including Mandrake, Red Hat, and SuSE

Guest OS support DOS 6.x through Windows 2003 Enterprise, Linux, Solaris, Novell,
and FreeBSD

GSXis a hosted application and can be installed on Windows or Linux operating systems.
Hosted virtualization software means you'll sacrifice an operating system license to host guest
VMs: this is true for Microsoft virtualization products and VMware products except ESX Server.
If you're using all open-source products, then the cost of a license may be less important. If you
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have a heterogeneous environment, GSX Server will be your product of choice because of
VMware’s extensive operating system support.

If you want to start rolling out virtual servers in a production environment, GSX Server is
the easiest way to begin adding value and ease of management to your infrastructure. GSX
Server can be loaded onto an existing system without requiring you to invest in an additional
license or in more hardware. You may also want to start by not attacking critical systems first.
Try virtualizing a print server, application, or Web server first. Once you get the hang of GSX
Server system controls, you can attack the bigger projects and even look into the enhanced
benefits of ESX Server.

VMware ESX Server

VMware ESX Server is a seasoned and robust virtualization software package. It’s designed to
create data center—class, mission-critical environments. ESX Server, like Virtual Server, can
help consolidate the infrastructure, provide easier management, and increase resource uti-
lization. ESX Server treats the physical host as a pool of resources for guest operating systems
by dynamically allocating resources as necessary. All resources can be remotely managed and
automatically allocated. Table 1-16 lists the minimum hardware requirements for ESX
Server-hosted operating systems.

Table 1-16. VMware ESX Server Minimum Supported Host Specifications

Requirements Minimum Specification

CPU 900MHz

SMP Host and guest supported (requires additional software)

Memory 512MB

Video 8-bit adapter

Install footprint 130MB for Windows/200MB for Linux

Hard drive SCSI disk, RAID logical unit number (LUN), or Fibre Channel LUN with
unpartitioned space

Network card Two or more Intel, 3COM, or Broadcom adapters

Audio Optional

Guest OS support FDOS gsx Dthrough Windows 2003 Enterprise, Linux, Solaris, Novell, and

ree

ESX Server separates itself from the rest of the pack with its ability to cluster VMs across
physical systems and to provide scalability for guest operating systems with SMP support.
Unfortunately, to have the advantages of SMP, you have to purchase VMware’s virtual SMP
product (Virtual SMP). VMware Virtual SMP, despite being an add-on module, truly scales the
infrastructure by allowing for the division of multiple physical processors across many virtual
hosts. ESX Server really leverages existing hardware that’s underutilized and easily handles
resource-hungry applications, such as Exchange and Oracle. Moreover, you can increase the
value of ESX Server by creating a virtual infrastructure with the aid of VMware’s additional
tools and management packages: P2V Assistant, VMotion, and Virtual Center.
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Virtual Infrastructure

You learned about the process of abstraction earlier in this chapter, and now you'll apply the
term to utility computing, or computing on demand. To make service and application software
immediately available (utility computing) in the enterprise, you have to treat the entire infra-
structure as one resource, and you therefore need an extra layer of abstraction.

To achieve this layer of abstraction between networking, storage, and computing resources,
VMware uses several products to create a virtual infrastructure node (VIN). AVIN consists of an
ESX Server loaded with VMware VirtualCenter, VMotion, and Virtual SMP. VMs cobbled from the
varying systems in the enterprise infrastructure appear to be a single, dedicated resource.

VMware VirtualCenter and VMotion

VMware VirtualCenter is a set of globally accessible management tools that will give you a sin-
gle administration point for ESX Server and GSX Server VM resources. Because VirtualCenter
can provide immediate relocation of resources, end users experience virtually no downtime
with respect to services and applications. VirtualCenter is able to accomplish this by using a
database backend.

VirtualCenter requires one of three different databases to function—Oracle 8i, SQL
712000, or Access—and it maintains a copy of each system’s environment. In addition, Virtual-
Center can run prescheduled tasks such as rebooting guest VMs. VirtualCenter, running as a
service on Windows 2000, Windows 2003, and Windows XP Professional, uses a single dash-
board-type interface that continuously monitors performance and system resources. You can
equate VirtualCenter to a virtual keyboard-video-mouse (KVM) switch that’s capable of restor-
ing and provisioning servers.

VMware VMotion can move active VMs between running host systems. With VMotion,
hardware maintenance no longer impacts production environments: prior to maintenance,
simply move the live VM to a different host with VMotion. To take advantage of VMotion, you
need to have previously created a VIN, have a VirtualCenter Server, and have a minimum of
two ESX Servers loaded with VirtualCenter, VMotion, and Virtual SMP. VMotion is responsible
for optimizing performance by balancing resources through workload management. Changes
to systems don’'t impact the end user.

VMware P2V Assistant

VMware P2V (read: Physical-2-Virtual) Assistant is a migration tool. It creates an image of a
physical system and transforms it into a VM. P2V Assistant creates an image of the physical
system using built-in or traditional imaging systems, such as Norton Ghost. P2V saves time by
eliminating the need to reinstall existing operating systems and applications, and created VMs
can safely run Workstation, GSX Server, and ESX Server. P2V uses an intuitive graphical user
interface (GUI) and begins the migration by creating a complete image of the physical system.
Next, P2V substitutes physical drivers for virtual. Lastly, P2V makes recommendations you
may need to act on prior to booting the system. Currently, P2V supports only Microsoft oper-
ating systems, and VMware recommends you purchase a rather pricey support contract
before attempting to virtualize a system via P2V Assistant.
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Migrating Between VMs

Though the following procedure isn’'t something you'd want to perform and place in produc-
tion, it certainly is a good way to exhibit the power of virtualization and disk imaging in a lab
or demonstration. As a last resort, it may bail you out of a tight spot. When deciding on which
virtualization product to standardize on in your infrastructure, you may be overwhelmed with
the choices. Microsoft supports its operating systems in Virtual Server, and VMware supports
the ever-increasing market of open-source operating systems. Is it a toss-up?

Well, if it’s a toss-up and you later change your mind on which virtualization software to
implement, a migration route exists that may help you “switch teams” using disk-imaging
software such as Norton Ghost. For instance, you can use Norton Ghost to migrate from a
Windows VMware VM to a Windows Virtual PC VM. Simply use the imaging software to create
an image, and then restore it to your desired destination. The only difficulty you may run into
in the restoration process is that Microsoft’s hardware abstraction layer (HAL) may get feisty.
If this is the case, you'll need to copy the original HAL from your OS installation medium. For
instance, you can boot off a Windows XP disk to the Recovery Console and copy the HAL over.
After booting your machine, Windows will autodetect the new VM hardware.

VMware ACE

VMware’s ACE provides an isolated end-user VM. ACE allows administrators to create VMs
strictly adhering to corporate polices and procedures that can be deployed to the end user
through removable media or over the network (think: abstracted BOOTP and Norton Ghost
images). The ACE is implemented by creating a VM loaded with an OS and any necessary
applications. ACE control polices are then applied to the packaged VM, which can then be
rolled out. Provisioning VMs and installing ACE is one seamless installation as far as the end
user is concerned. Some may see ACE as being similar to Citrix because administration occurs
from a central location, but ACE differs in that each user has their own complete x86 VM. With
Citrix, all users share the same hardware. It’s possible for an individual user session in Citrix to
impact other users on the system by depleting physical resources. Because ACE requires its
own hardware, no user can deplete the local resources of another.

Summary

In this chapter, we covered everything from basic hardware and networking to commercial
and open-source VM applications. You now have a good idea of how hardware can be virtual-
ized through emulation and mapping techniques and can readily visualize an entire VM as a
database with lots of stuff in it. More important, you recognize the value of virtualization soft-
ware in the enterprise and in education—virtualization can protect networks from disasters,
quickly deploy new systems, decrease administrative overhead, leverage existing hardware
investments, and simulate entire networks.

In Chapter 2, you'll learn how to prepare a host system for virtual machines, and you’ll
look at the many gotchas and common pitfalls that often go unnoticed. Then, with your
understanding of VM nomenclature and concepts, you'll be ready to tackle Chapter 3 and
the rest of this book.



CHAPTER 2

Preparing a Virtual
Machine Host

In Chapter 1, we visited important issues surrounding virtualization technology, including
hardware, software, virtualization theory, and manufacturer nomenclature. This chapter
will address the planning issues for selecting and preparing a host system to support virtual
machines. You'll need to confirm that your host computer meets the VM application’s mini-
mum hardware requirements, and you must verify that it has the available resources to
support the number of VMs you plan to run simultaneously. You'll look at preparation issues
for both Windows and Linux hosts. Several factors determine the readiness of a computer to
support a VM application, such as the motherboard, RAM type, CPU speed, hard disk type,
and network adapter speed. Using best-practice principles, we'll cover how to quantify host
requirements that will result in better stability, scalability, and performance for your guest
virtual machines.

Implementing Best Practices

Youd think with RAM, processing power, and storage space being so inexpensive it'd be fairly
easy to achieve some type of best-practice hardware implementation in today’s modern IT
infrastructure. Unfortunately, this has never been the case. Budgets, personal preference, and
“we always do it this way” all take a toll on the idea of a best practice. Though some may say a
best practice is what works for you, don’t buy into that definition. A best practice is always the
high road—the road less traveled. A best practice is a radical deviation from “if it ain’t broke,
don't fix it.” In general, best practices describe the activities and procedures that create out-
standing results in a given situation and can be efficiently and effectively adapted to another
situation. For instance, for us IT people, this means if studies and white papers find that com-
mercial-grade servers have less downtime and problems than white boxes, we should quit
building our own servers for the enterprise infrastructure. If studies and reports prove that
virtualization truly saves money, decreases administrative overhead, and better supports
disaster recovery strategies, we should implement it.

In test and educational environments, using the minimum available resources to learn
how to use VM applications, such as Microsoft’s Virtual PC and VMware’s Workstation, is okay.
In these environments, the luxury of time is on your side, and occasionally rebooting is no
big deal. In a production environment, though, end users don’t have time to wait, and reboot-
ing any major system can mean the loss of real money. Given this, take a moment to look at
best-practice hardware requirements for each VM application before deploying VMs in your
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infrastructure. Take the time to check your hardware against each manufacturer’s HCL, and
compare your hardware to the listed best practices in each section. Don’t be a victim: spend a
little time now checking out your deployment hardware; it will save you late nights and week-
ends later. Simply loading Microsoft’s Virtual Server or VMware’s GSX Server on an existing
system and “letting it eat” is a recipe for disaster.

Evaluating Host Requirements

When it comes to hosting VMs, bigger is always better. However, stuffing quad processors and
a Fibre Channel SAN into a notebook isn’t an option either. (We'll give you an in-depth look at
VMs and SAN interactivity in Chapter 13, but we’ll touch on the basics in this chapter.) Now,
let’s take a moment to put some perspective on the saying “bigger is always better.” Host hard-
ware—whether laptops, workstations, or servers—all perform different functions and will
have very real and different needs, so focus your budget on where it will produce the most
overall good. You can avoid bottlenecks by investing equally in a host’s three major systems:

¢ Storage systems: Hard drives, SANs, CD/DVD-ROMs, RAM, and cache
* Networking systems: NICs, switches, and routers

* Processing systems: CPU and front-side bus (FSB)

When sizing a computer to host VMs, you can easily pinpoint areas of concern by reflect-
ing on the system’s purpose and keeping the three major subsystems in mind. For instance,
laptops are great because they can be carried everywhere and utilized in sales presentations
or classrooms. For the convenience of shoving a mainframe system into the space of a book,
you can make performance and hardware longevity sacrifices. Because the space constraints
put on portable computers cause them to overheat, manufacturers use lower-spindle speed
hard disks, variable-speed processors, and smaller memory capacities. In this case, you'd want
to spend money on adding as much RAM as possible to your system, followed by as much
processing power as possible.

Workstations, on the other hand, have the dubious honor of being shin-bangers. The pur-
pose of a workstation has stayed consistent over time, and you know they provide fast, reliable
access to centralized network resources. Workstations employ higher-speed disk drives, larger
quantities of RAM, faster processors, and good cooling systems. To improve VM workstation
hosting, you'll want to add additional disk drives and controllers, followed by more RAM
quantities rather than add a second processor. Lastly, add a good, fast NIC. By placing the host
OS on one bus and hard drive, and the guest OSs on a second bus and hard drive, you more
closely approximate the structure of two computers in one physical box; this creates a much
better host.

Servers are different from laptops and workstations in that users will be depending on
VMs: accessibility and availability will be your highest priority. You'll want to use Redundant
Array of Inexpensive Disks (RAID)-configured hard drives (SAN if possible), several-gigabit
NICs in a teamed configuration, multiple processors, and maximum RAM quantities. In case
your mind is already racing ahead with what ifs (and to feed the supergeek in us), we’ll cover
more closely the mathematic justification for using multiple controllers and disks in the “Con-
sidering Storage Options” section toward the end of this chapter. We'll also discuss hard disk
and RAID selection.
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Table 2-1 is designed to help you begin prioritizing your VM hosting needs. Keep your eye
on what type of VM host is being built, and then make decisions that will adequately support
the host in its final environment. Table 2-1 summarizes our recommended priorities, but you
can prioritize resources according to your needs.

Table 2-1. Comparing VM Host System Priorities (1 = High, 6 = Low)

Resource Laptop Workstation Server
Multibus disks 1 2
RAID/SAN 1
RAM 1 2 5
Processing speed 2 3 6
Multiple processors 5 4
Networking capacity 3 4 3

When prioritizing investment and resource allocation for VM hosts, you want to deter-
mine what’s going to be the subsystem bottleneck and mitigate its impact on performance
by adding bigger, better, and faster technology. Bottlenecks will manifest based on the host’s
purpose:

* Will it be a portable or fixed system?
¢ Are resources local or available across networks?

* Is the host serving one person or one thousand?

Later in the “Considering Your Network” and “Considering Storage Options” sections, we'll
further discuss the impacts of direct-attached storage, SANs, teaming, and load balancing.

All the best-practice suggestions for sizing host systems will do you absolutely no good
without applying a good dose of common sense and experience—reference manufacturer OS
system requirements, and check hardware compatibility. This is particularly true with regard
to memory quantities and disk space. On any given server, the host and each VM both require
sufficient memory for the tasks each will perform. You can calculate your total memory needs
by simply calculating the number of VMs to be hosted, adding one for the host, and multiply-
ing the sum by no less than the OS’s minimum memory requirement. For example, if you plan
to host three Windows 2003 Web servers on one piece of hardware, you need enough RAM to
support four servers. But what version of Windows 2003 are you using? Windows 2003 has dif-
ferent minimum and maximum supported memory configurations, as listed in Table 2-2.

Table 2-2. Windows 2003 Server RAM Requirements

Memory Web Standard Enterprise Edition Datacenter Edition
Requirement Edition Edition

Minimum 128MB 128MB 128MB 512MB
Recommended 256MB 256MB 256MB 1GB

Maximum 2GB 4GB 32GB/64GB Itanium 64GB/512GB Itanium
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Assuming the host is using Windows 2003 Standard, you'll want to install 2GB of RAM
(4 servers x 512MB of RAM = 2GB). We'd also like to point out that if you're hosting VMs on
Windows 2003 Standard with Virtual Server or GSX Server, you'll be limited to a total of 4GB
of RAM for the host and its guest VMs. If you plan on taking full advantage of larger memory
pools, you'll want to move up to VMware’s ESX Server or Windows 2003 Enterprise.

Determining required disk space is similar to sizing memory but with a few added
gotchas. You'll need to include hard disk space for each guest’s operating system footprint, for
memory swap files, for dynamic disks, and for fixed disk storage. You'll also need to include it
for suspending running VMs (equivalent to the RAM allocated to the VM). For a disk-sizing
example, let’s use the three previously mentioned Web servers configured with fixed disks.
Table 2-3 lists the Windows 2003 install footprint for each edition.

Table 2-3. Windows 2003 Disk Space Setup Requirements

Web Edition Standard Edition Enterprise Edition Datacenter Edition

1.5GB 1.5GB 1.5GB/2GB Itanium 1.5GB/2GB Itanium

You'd need enough disk space to adequately cover four server OS installations
(1.5GB x 4 = 6GB), room for four swap files (1GB x 4 = 4GB), fixed disk data storage for four
servers (4 x ?), and room for three guest VMs to be suspended (512MB x 3 = 1.5GB). At the
moment, you'd need a minimum of 11.5GB just to get the servers loaded and running. The
one variable that may be difficult to contend with is the space for data storage: being that
needs vary, you'll need to rely on your experience and common sense for fixed disk space
sizing. Assume that the servers in this example will store graphics-intensive sites and need to
house documents for downloading (3 x 40GB = 120GB). You'll set aside a total of 8GB for the
host and its applications. After calculating fixed storage and adding the install, suspend, and
swap requirements, your host will need approximately a minimum 140GB of storage. If you're
implementing an IDE solution, mirrored 160GB hard drives will be adequate. A SCSI RAID 5
solution can squeeze by with three 80GB hard drives. If you think any of your VMs may run
out of space, you'll want to consider adding hard disk space so you can create additional fixed
or dynamic disks in the future.

It’s impossible to consider every scenario in which VMs will be installed. Therefore, you'll
have to rely on the manufacturer’s minimum requirements, on postings from Internet forums,
on trusted colleagues, and on your experience. In Chapters 3 and 5, where we cover installing
virtualization applications, we’'ll suggest best-practice minimums. The best-practice mini-
mums offered are merely a guide to point you in the correct direction for sizing a VM host
system.

Selecting a Motherboard

The motherboard, the centralized circuit board all other devices and chipsets connect to,
interacts with every subsystem of a computer. It’s largely responsible for an entire computer’s
performance, stability, and scalability. Choosing a motherboard to use for your VM host may
be less of an issue if you're purchasing a system from a major vendor, such as Dell, Sony,

or Hewlett-Packard. However, you'll need to make sure the motherboard supplied with a
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proprietary system supports your intended purpose and will scale as needed. Selecting the
correct motherboard will go a long way to ensuring that your VM host performs optimally.
Additionally, the right motherboard may reduce some of the cost involved by including inte-
grated NICs, hard drive controllers, video adapters, and sound cards.

Motherboards can be complicated and conceivably the most important part of any com-
puter. A plethora of motherboard manufacturers exist, so carefully consider your available
options and narrow the field of choices by determining if a particular motherboard supports
the correct memory, CPU, I/0 device options, and reliability constraints you need. You can
buy motherboards for less than $20 and spend as much as several thousand. You don’'t have
to know the intricacies of every chipset and processor made, but you should know enough
to make sure your requirements and expectations are satisfied.

Good performance levels are critical for ensuring that data processing takes place in a
reasonable amount of time. But what’s performance without stability and reliability? You’'ll
want to stick with motherboard manufacturers that consistently produce quality merchandise
over time and continue to support EOF products: you'll eventually need to update a BIOS or
driver to fix a bug or to upgrade when a new OS or system patch is released. Because mother-
board drivers are provided in part by the chip manufacturer and the motherboard producer,
it’s critical you pick a well-known and respected brand to get the most out of available support—
Microsoft doesn’t build every driver in its operating systems. Because reputable motherboard
manufacturers will have already taken the time to thoroughly test their motherboards for sta-
bility and reliability over a sizable chunk of time, using respected brands will save you many
hours of research and testing time.

Determining hardware compatibility for motherboards can be difficult because of the
open nature of computers. Peripheral components that have been in use for longer periods of
time in the field are more likely to be supported by reputable manufacturers, such as Adaptec,
Intel, QLogic, ATI, and 3Com. If you need a particular device to function with a new mother-
board, you'll need to check and verify that the manufacturer has tested and supports the device.
Moreover, read the fine print in the warranty. Some manufacturers may void your hardware war-
ranty for not using proprietary or approved hardware.

So, given the preceding rhetoric on buying a quality motherboard, what should you have on
your checklist to help narrow the field to create the best possible foundation for your VM host?
During the motherboard selection process, you'll want to specifically look at the following:

* CPU speed and quantity
¢ Controller chipset

* Memory requirements

¢ Bus types

e Integrated devices

* Board form factor

e Overall quality

We'll cover each of these in the following sections.
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CPU Speed and Quantity

The speed and quantity of processors will significantly impact the overall performance of your
host. If you're building a production server, you'll definitely want to use multiple processors.
Microsoft virtualization applications don’'t support SMP for guest VMs, but the host can take full
advantage of multiple processors (assuming you're using a multiprocessor OS). VMware is similar
in that it doesn’t support SMP for guest VMs running on Workstation and GSX Server. Multi-
processor support is limited to the host machine’s OS. Where VMware differs from Microsoft is
that ESX Server supports SMP for guest VMs with SMP licensing. For instance, if your host server
has sixteen processors, you can configure four guest VMs, each having four processors.
Purchasing multiprocessor motherboards can be expensive: add the cost of each proces-
sor, and you could be in the range of an unrealistic budget. When contemplating using multiple
processors, you can keep the lid on runaway costs by avoiding purchasing the fastest proces-
sors. There’s little difference in performance between 2.8 gigahertz (GHz) and 3.2GHz. But
there’s a huge difference between 1.8GHz and 2.8GHz. By selecting processors that are two or
three steps down from the fastest available, you can keep your system selection within reason.
Also, you'll need to keep in mind that multiple processors don't scale linearly. That is, two 3GHz
processors aren’t twice as fast as a single 3GHz processor. You'll get diminishing returns for
each added CPU and each increment in speed. Rein in the desire to go for the fastest possible
CPU because there’s more to a fast host than clock speed. Additional information you'll want
to look for in the motherboard’s documentation is compatibility information, such as what
processors are supported with the chipset or the requirement of having to implement identical
CPUs using the same stepping level.

Caution Running multiprocessor servers with CPUs that have different stepping levels can and often
does create squirrelly computers.

When deciding which CPU to purchase, you'll also need to consider cache memory. With-
out cache memory, CPU data requests would all have to be sent over the system bus to the
memory modules. To avoid this bottleneck and achieve higher performance levels, CPU man-
ufacturers incorporate cache into their processors. Additionally, motherboard manufacturers
will incorporate cache into the motherboard. You'll see cache memory listed as Level 1, Level
2, and Level 3. Cache is fast and generally runs at the same frequency of the processor or
system bus. Manufacturers are able to produce inexpensive chips by cutting cache levels.
Conversely, manufacturers produce high-end chips by increasing cache levels. In general, the
more cache made available to the processor, the faster everything will run. You can find Intel
processors with cache levels as high as 4MB and as little as 128KB. If you stick with moderate
cache levels for production servers, 1-2MB, your guest VMs will be rewarded with significantly
better performance. If you want in-depth explanations of processor cache types, you'll want
to visit your CPU manufacturer’s Web site.

Controller Chipset

The chipset dictates the overall character of the motherboard; it'’s fundamentally responsible for
determining which CPU, memory, and peripheral types are supported. For instance, Intel, Via,
and Ali currently produce the majority of chipsets used, and each vendor typically is geared to
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support specific processor types, such as Intel or AMD. Communication between the mother-
board’s components is specifically controlled by the north and south bridge chips. The north
bridge chip is generally located near the CPU socket and interconnects the processor, memory,
video bus, and south bridge chip. The south bridge chip facilitates communication between the
north bridge, peripheral cards, and integrated devices. With so much riding on one chip, the
north bridge, it should come as no surprise that the speed at which the FSB functions signifi-
cantly impacts the host’s performance. When it comes to chipsets, you'll want to specifically
make sure your CPU selection is supported (including the type and speed) by the motherboard’s
FSB. You'll also want to look at the motherboard’s specifications to see which memory type is
supported. Fast processors and RAM require a fast FSB, and a mismatch can create a bottleneck.
If you're comparing off-the-shelf systems, you'll want to select a motherboard capable of sup-
porting a processor requiring FSB speeds of 400MHz or greater for production VM hosts. If
you're interested in knowing which Intel processors support which bus speeds, the site at
http://processorfinder.intel.com provides alist of CPUs and required bus speeds.

Memory Requirements

Despite your desires, the memory you choose for your system will be limited to what your
motherboard is capable of handling. If you have an idea of the type of memory you want to
use and the quantity, you must first make sure the motherboard supports the total memory
requirement for your host and guest VMs. Second, you must determine the number of avail-
able memory slots, the type of memory supported, and the memory module size supported.
Manufacturers are specific about which type of memory can be used in any given mother-
board. In large part, the type of memory available for you to choose will be tied to what the
CPU and chipset can support. Your motherboard will probably support several memory tech-
nology types—double data rate, second generation (DDR2); synchronous dynamic random
access memory (SDRAM); and DDR SDRAM. If your system mentions any of the older types of
memory—such as single data rate (SDR) SDRAM, fast page mode (FPM), or extended data out
(EDO)—choose another motherboard.

When looking at the performance characteristics of RAM, expect to pay more for mother-
boards using faster types of RAM. When deciding which type of RAM to use, speed isn't as
important as quantity in regard to networked VMs. The bottleneck will be the network and not
the read/write rate of your RAM. Table 2-4 lists performance data for several memory types.

Table 2-4. Memory Speeds

Technology Speed Bandwidth
DDR2 PC2-6400 6.4GB/sec
DDR2 PC2-5300 5.3GB/sec
DDR2 PC2-4200 4.2GB/sec
DDR2 PC2-3200 3.2GB/sec
DDR PC4000 4.0GB/sec
DDR PC3200 3.2GB/sec
DDR PC2700 2.7GB/sec
DDR PC2100 2.1GB/sec

DDR PC1600 1GB/sec
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If you plan on running VMs in RAM only, search for motherboards supporting faster RAM,
such as DDR2. Faster RAM will give your VM guests a little extra oomph. Being that your sys-
tem can be only as fast as the slowest link, you'll probably want to shoot up the middle when
it comes to speed and quantity for your host motherboard. That is, there’s no point in paying
for a motherboard supporting bleeding-edge memory speeds if you're trying to build a server
with a single SCSI adapter and hard drive for the host and guest VMs to share. You're better off
buying more SCSI controllers, hard drives, and RAM.

When culling the field of motherboard candidates, stick with the boards that come with
dual-channel technology. Dual-channel systems allow the bandwidth of two memory mod-
ules to be used simultaneously. In cases where dual-channel technology is implemented,
you're better off adding memory in pairs to get that added performance boost. For example,
if you need 1GB of RAM, get two 512MB modules rather than one large one—you want to
make that memory highway as wide as possible.

Caution Don’t get burned by using cheap or generic memory. In the long run, it just isn’t worth the
headache that junk memory causes. For a few extra bucks up front, you can purchase quality memory prod-
ucts from major memory manufacturers such as Crucial, Viking, and PNY. Quality memory will more than
pay for itself over time because it will keep you from troubleshooting the bizarre problems cheap memory
causes. Also, you'll find that the many discount vendors peddling heavily discounted memory will offer a
“lifetime warranty” with no intent of honoring it.

As a final consideration, you may want to install error correcting code (ECC) RAM in hosts
supporting production environments with mission-critical applications. ECC RAM utilizes an
extra chip that detects if data is correctly read from or written to the memory module. In many
cases, and depending on the type of error, ECC RAM can correct the error. Having the ability
to detect and correct errors means a server is less likely to crash, but you'll take a small per-
formance hit by implementing ECC memory.

Bus Types

The availability and quantity of Industry Standard Architecture (ISA), PCI, PCI Extended (PCI-X),
and Accelerated Graphics Port (AGP) bus types are extremely important when it comes to
hosting VMs. Small motherboards don't offer many expansion slots, and few come with ISA
capability. ISA expansion slots are an issue if you need to reuse expensive ISA devices, such as
multiport modems. Multiple AGP slots are important if your system requires high-performance
video and multiple monitors. Multiple monitors are extremely useful for managing a VM host
and guest in full-screen view without the aid of a KVM. A motherboard having only two or three
PCI expansion slots limits your ability to correctly equip your servers with sufficient hardware
for hosting. For instance, if you need two RAID controllers and three network adapters, you'll
need five PCI slots on your motherboard. If five slots aren’t available, you'll have to depend on
integrated devices or expect less in the performance department. PCI-X is an enhancement
over the traditional PCI bus in that the speed of the PCI bus is increased from 133MB/sec to a
whopping 1GB/sec. In addition, PCI-X is backward compatible with traditional PCI adapter
cards running at the lower speeds. PCI-X was designed to provide the higher performance lev-
els Gigabit Ethernet and Fibre Channel technology demanded. For VM hosts, including PCI-X
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technology substantially increases performance and is something you'll need to consider in
environments with high network utilization or where SAN interactivity is required.

You'll need to plan for the maximum number of expansion cards your server requires in
order to correctly size a motherboard. If you find a motherboard that falls short on available
and necessary slots, you'll need to turn to using expansion cards that offer increased capabil-
ity. For instance, you can use multiport NICs and multihead video adapters in situations
where slots are limited. Additionally, you can use integrated AGP video in situations where
more PCI expansion slots are a priority. In the end, you need to know how many NICs, SCSI,
RAID, and video adapters your host will require.

Integrated Devices

Integrated peripherals can seriously cut the cost of a system. You can safely run a computer
without a single expansion card, but you won't generally get the same performance of a system
using some or all expansion cards. Typically speaking, integrated video, networking, audio,
USB, and hard drive controllers work well for most systems. As important as it is to have inte-
grated devices, it's equally as important to be able to disable them in case of failure or poor
performance. You'll find systems that share installed RAM. You'll want to avoid this if possible
because the integrated devices will be taking away from what'’s available for the host and guest
VMs. A few megabytes chewed up for video here and a few megabytes for a caching disk con-
troller there can equal one less hosted VM. RAM is cheap, and good-quality manufacturers
don’t hesitate to provide the appropriate resources for integrated devices. Where integrated
devices can really pay off for virtualization is with integrated RAID. Integrated RAID normally
doesn’t have huge amounts of cache, which therefore makes it perfect for running the host
operating system. You can purchase a second RAID controller for guest VMs and scale the add-
on cache to meet your data processing needs.

You'll want to specifically look for a minimum of integrated components to support your
guest VMs. In particular, a good-quality motherboard will have two Enhanced Integrated Digi-
tal Electronics (EIDE) controllers with one being Serial ATA (SATA) capability. SATA controllers
and hard drives can give you near-SCSI performance. With VM applications in a workstation
configuration, the primary controller and hard drive can be used for the host operation sys-
tem, and the secondary controller and hard drive can be used for guest VMs and a CD-ROM.
On servers, you'll want at least one SCSI interface and one EIDE interface. In a server situa-
tion, you can hang a CD-ROM off the EIDE controller, use the SCSI controller for memory
swap files, and use SCSI adapter cards for your host’s and guests’ main execution and storage
locations. Integrated Ethernet adapters may not be so important in a tower workstation, but
in pizza box—type servers where space is at a premium, integrated NICs are essential. If you're
looking at a motherboard with integrated NICs, make sure it has two. You can team the inter-
faces; if one fails, the host continues to support the networking needs of your hosts. Integrated
USB isn't necessarily important, but it’s nice to have. If you opt for integrated video or can’t
find a motherboard without it, make sure the motherboard comes equipped with an AGP.
Some manufacturers integrate an AGP video card but don’t provide the AGP expansion slot.
You'll be forced to use the slower PCI video technology, which may cause a bottleneck on the
system bus. Integrated video support on a motherboard isn't uncommon and is generally a
good way to save a few dollars. Integrated video isn’'t usually a problem with servers in that
most servers don't require much more than 4-8MB of RAM. If you plan on playing graphics-
intensive games on your host machine and using guest VMs for business, integrated video will
prove to be useless.
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Many new motherboards are capable of booting from USB, and this is a great alternative
to booting a computer from a floppy disk or CD-ROM. USB also allows you to use external
storage. Backing up your VMs to an inexpensive USB drive is a great way to add a layer of dis-
aster recovery capability. Also, USB-attached storage is an excellent way to move VMs from a
test environment to a production environment: it’s oftentimes faster than pushing 20-30GB
across the network. Lastly, integrated audio is something you may want to consider for basic
acoustics. Integrated audio won't give you the advanced features of an adapter card. So, if
you're looking to use a VM as a stereo, you can forget about using integrated audio.

Other integrated features you may want to look for in a motherboard are system monitoring
and jumperless configurations. System monitoring includes the ability to read BIOS post codes
for troubleshooting and the ability to track case and processor temperatures for reliability and
performance reasons. Being that VM hosts will be consuming much more of a processor’s avail-
able cycles than normal, it's important to keep operating temperatures at an optimum level. You
can have a server that was once reliable easily become unstable with the addition of three or
four VM guests. Being able to track system temperatures is a great way to stay out of the red zone
when loading up a server on the road to moderate hardware utilization (60-80 percent). Jumper-
less settings are more of a convenience than anything else. They prevent you from having to
open the system case to make a change on the motherboard. Also, jumperless settings mean
that those of us with fat fingers no longer have to worry about dropping little parts in the case.
For people who want to tweak performance with overclocking (not recommended in a produc-
tion environment), jumperless motherboard configurations are a great way to quickly reconfigure
the system.

Board Form Factor

If you have a computer case to host your hardware, you want to make sure you get a mother-
board to fit it. Nothing is worse than spending a week researching the optimum motherboard,
purchasing it, and finding it doesn't fit. Motherboards all require a specific power supply and
are designed to fit a particular case. The power connectors differ from older-style AT mother-
boards to the newer ATX type. Moreover, newer motherboards use soft-off functionality, where
power switching takes place on the motherboard instead of the power supply. As mother-
boards begin to support more integrated devices and power-attached peripherals, and as
cases take on show-car characteristics, the power supply needs to have a rating sufficient to
power the motherboard and everything beyond—hard drives, CD/DVD-ROM drives, fans,
cameras, lights, and so on. If you require redundancy or are deploying your VMs in a produc-
tion environment, you'll want to make sure your motherboard and case support redundant
power supplies with high watt ratings (350-500).

Overall Quality

Price isn’t necessarily a good indicator of quality, but good-quality products generally cost
more. There’s a lot of truth in the saying, “You get what you pay for.” Nobody goes out of their
way to purchase shoddy products, but if you don’t research your motherboard purchase, you
may think the product is substandard because it doesn’t follow through on your expectations.
Poor-quality motherboards can cause VMs to perform strangely and spontaneously reboot.
You don’t want to spend countless hours troubleshooting software problems when it’s really a
quality issue with hardware. Ferreting out quality requires looking at technical documentation
from manufacturer Web sites and seeking advice from trusted professionals, Web forums, and
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articles from reputable periodicals. You'll find that trustworthy motherboard manufacturers
quickly stand out in your search.

Features that indicate good-quality motherboards are good component layout, good
physical construction, a replaceable complementary metal oxide semiconductor (CMOS)
battery, and extensive documentation. Nothing should get in the way of adding more RAM or
processors to a system. Conversely, motherboard electronic components, such as capacitors,
shouldn'’t get in the way of housed peripherals. Good motherboards have a general “beefy”
quality about them. The board will be thick, capacitors will be big, and plenty of real estate
will exist between everything to allow for adequate cooling. Lastly, the CMOS battery should
be something you can replace from the local electronics store. When the battery goes bad,
you’'ll want an immediate replacement part. A reboot on a bad CMOS battery could mean
having to set the configuration for every integrated device manually. After figuring out RAID
settings, interrupt requests (IRQs), and boot device priority because of a bad battery, you'll
want immediate restitution. Fortunately, guest VMs aren't really affected by CMOS batteries
other than that the guest VMs may set their system clocks to that on the physical host. Assum-
ing you don’t care about time stamps in log entries, you may be all right. If you host secure
Web sites, you may find that your SSL certificates become temporarily invalidated because
of an erroneously reported date. In the end, if you reboot your servers with some regularity,
you'll want to immediately replace a bad CMOS battery.

Whether you choose to purchase a system or build your own, spend some time researching
available options, and make sure the motherboard and vendor can deliver your expectations.
Download the motherboard’s manual, and make sure it's well-documented; for instance, make
sure jumper configurations are clearly marked, processor and RAM capabilities are listed, and
warranty information is noted. Being that the motherboard is the most important component
in a system, purchasing the best possible motherboard will give you an excellent foundation for
VM hosting and further your success with virtualization.

We understand that we're giving you a lot to consider, and at this point you may be com-
pletely overwhelmed with all this information. However, all major computer vendors publish
data sheets for their systems. Using these data sheets gives you an easy way to compare the
hardware features of multiple systems, which in turn will enable you to make a more informed
decision. Additionally, reliable vendors will supply presales support to address all your concerns.

Considering Your Network

Building and deploying VM networks isn't really any different from deploying typical physical
networks. In fact, the same issues that affect physical networks apply to virtual networks. Know-
ing how the devices from Chapter 1 function will help you determine what should be included
in your VM networking plan. Before utilizing VMs, you'll need to decide on some networking
priorities. Specifically, you'll need to decide if your VM implementation requires privacy, per-
formance, fault tolerance, or security. You'll look at these networking requirements in the
context of host-only, NAT, and bridged networking.

Public or Private VMs

The first thing you'll have to decide is if your VM network will be public or private. If you're
building a private network of VMs, you'll want to use host-only networking. In a private net-
work, you're creating a completely isolated environment in which you’re required to supply all
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traditional networking services, such as DHCP, Domain Name Server (DNS), Windows Internet
Naming Service (WINS), Network Time Protocol (NTP), NetBIOS Name Server (NBNS), and so
on; in other words, you'll be building a complete network from the ground up. The advantage
to building a private VM network is that it will have zero impact on existing networks, and exist-
ing networks will have no impact on it. Host-only networking is a great way to learn about VMs
and new operating systems. Host-only networks are also good for engaging in the practice of
network forensics: you can analyze the behavior of network applications, ferret out nuances of
communication protocols, and safely unleash the ravages of viruses, malware, and scumware
for thorough analysis. In private networks, nothing leaves the sandbox.

Note In the future, if you ever need to connect the private network to production, you can maintain the
integrity of your private network by configuring the VM host system to act as a router, for instance, by using
Windows RRAS or ICS. This is also useful if you're limited on IP addresses. We’ll cover the reconfiguration of
host-only networks and NAT in Chapter 4.

If you're building VMs and need to access the outside world, it’s still possible to keep a
level of privacy and security for your VMs. NAT provides the basic firewall protection you'd
expect to get from address translation because network communication can'’t be initiated
from the host (public) network to the private (VM) NATed network.

After building and completing the configuration of your private network, you can use
NAT to connect to your host’s network. Whatever the host is connected to and has access to,
your VMs will be able to access. Oftentimes, the best way to connect VMs to the Internet or
local LAN resources is to use NAT. If you're testing new services and want hosts outside your
virtual network to have access, you can use port forwarding to direct traffic to the VM hosting
the service. Because all VMs share the host’s IP address, port forwarding is your only option
to open the private network for virtualization applications that support it, such as VMware
products. Be advised that using NAT will adversely affect overall networking performance;
however, it’s a small price to pay for the security benefits. We'll discuss the configuration of
port forwarding and NAT in more detail in Chapter 7.

While contemplating if and how you’re going to integrate your VMs into your existing
infrastructure, you may need to consider the performance impact of each VMware networking
model and contrast it with the ease of configuration. The host-only network model provides
the best possible performance for guest VMs. This is because network traffic doesn'’t pass
across any communications medium, including the physical network adapters. Virtual hard-
ware is employed to facilitate communications, and, despite the speed rating of the virtual
network adapter, VMs in host-only networks pass traffic as fast as they can read and write to
the host’s memory. Host-networks can be simple to configure because virtualization applica-
tions will provide DHCP: you won't need to configure a separate server for this.

NAT networks incur latency during the translation process. This is because NAT is a fairly
sophisticated protocol and tracks information entering and leaving the host. The NAT process
puts enough overhead on the host system to negatively impact guest VM performance. Addi-
tionally, building NAT networks requires a bit more time during the configuration process and
can cause some problems with regard to inbound traffic. Generally, inbound traffic is prohib-
ited. In situations where port forwarding can be configured, members of the physical LAN
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may still have problems gaining access to resources in the NAT network because not all
protocols are supported. NAT networks are best used for private LANs that need access to the
outside world while retaining their private state. Members of NAT networks have the speed
benefit of host-only networking when communicating with peer members, but NAT networks
take a performance hit when outside communication is required.

Bridged networking directly connects your guest VMs to the host network adapter(s).
Many organizations use this to place their VMs right on the production LAN. Bridging guest
VMs has several benefits:

* First, bridging a guest VM to the host is often the fastest way to connect to an existing
network.

* Second, the guest will experience better network performance in that no additional
routing protocols, such as NAT, are required.

Like physical computers, bridged VMs require unique settings, such as a host name, an
IP address, and a MAC address. With bridged networking, you’ll be limited to the speed of the
physical adapter. For instance, if you have a guest with a virtual gigabit NIC and the physical
NIC is rated at 100Mb, transmission will take place at 100Mb. Also, if you have a physical NIC
rated at 1Gb and a guest’s virtual NIC is rated at 100Mb, you can expect to take a performance
hit. It isn’t that your physical NIC is going to slow down; it’s because of the driver technology
utilized by the virtualization application.

Availability and Performance

Good networks can be characterized as fast, predictable, and highly available. Good networks
limit user wait times and streamline infrastructure operations. Good networks are created
over time by embracing simplicity and using redundancy techniques to achieve maximum
uptime. The first milestone to cross on the way to the high-availability finish line requires
load balancing and teaming; without these, you'll never be able to achieve high-availability
performance goals.

The theory behind network performance tuning and high availability is to build fault tol-
erance into all systems to eliminate any single point of failure for hardware and software while
maintaining fast service. Because building good network performance is inclusive of load bal-
ancing and teaming, high-performing networks readily lend themselves to high availability
and disaster recovery requirements in that failover and standby systems are already present
in the network configuration.

With this lofty network performance/availability definition set, what part do VMs play?
VMs play into network availability and performance by supporting what you'd expect of a
highly available and good-performing server:

* The virtualization layer neutralizes hardware dependence. If the VM application can be
installed on new hardware, your VM server will run.

* Clustering on single-server hardware eliminates single-server failure. If one server pan-
ics or blue-screens, the other keeps working.

* The single-file design of VMs supports the portability needs of disaster recovery. Copy
and save a server like any other file, and then run it anywhere.
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* VMs take advantage of teamed NICs to increase throughput and prevent a common
single point of failure. Caveats exist, though! We'll discuss this in further detail in a
moment.

We already established server portability and virtualization concepts in Chapter 1. In the
following sections, while touching on some commonsense networking tips, we'll cover the
specifics of network adapter teaming; we’ll save server clustering for Chapter 9. Despite the
performance promises of adapter teaming and server clustering, keep in mind that simple is
almost always better. As networking professionals, we know that needlessly complicated sys-
tems are just needlessly complicated systems. If a problem can be solved, corporate objectives
can be upheld, and budgets can be satisfied with two tin cans and a piece of string, then
you've built a good network. No excuse exists for not building reasonably fast, predictable,
and accessible networks—this is the purpose of VMs, and you can add VMs to your bag of
tricks for creating and supporting highly available networks employing internetworking best
practices.

Simplicity

If you're looking to build a quick network of VMs capable of interacting with your existing
infrastructure, then keep IT simple (KITS). Configure your VMs using the defaults of VM appli-
cations that are utilizing bridged networking. Microsoft and VMware have considered many of
the common options and scenarios network professionals need to have a VM quickly viable;
therefore, you can capitalize on the manufacturers’ research and development efforts and
reap the rewards. You can make virtual disk adjustments as necessary.

When you've outgrown boxed-product tuning and need to increase the load and redline
on your servers, you'll have to spend a bit more time testing NIC teaming and server clustering
in the lab to achieve the higher levels of reliability and performance you may be accustomed
to getting. For instance, if you're looking to ease the bottleneck on a loaded-up VM server or
achieve the possibility of increased uptime, you'll want to pursue adapter teaming and server
clustering.

You have much to gain from the initial implementation of simple VM workgroup-type
networks, but if you want enterprise-class disaster preparedness, you'll have to employ mesh
networks using redundant switching and redundant routing. If you want enterprise-class
performance, you'll have to employ network adapter teaming and VM server clustering.

Mesh Networks

Implementing redundant switching and routing really isn’'t within the scope of this book, but
we wanted to mention it because of load balancing and teaming. You can achieve redundant
switching and routing by using multiple physical NICs, switches, routers, and multiple inter-
network connections utilizing teaming and load balancing. Load balancing and teaming are
technologies used to keep mesh networks running in the event of a system failure. For instance,
if you're building a highly available Web server, you'll need multiple physical servers with multi-
ple physical connections to multiple switches connecting to multiple physical routers that
connect to at least two different carriers using two different connectivity fabrics; you shouldn’t
use a major carrier and a minor carrier that leases lines from the major carrier. If you lose the
major carrier, you also lose the minor carrier, and you can kiss your redundant efforts and
mesh network goodbye.
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The idea with redundant switching and routing is to ensure that your subnet’s gateway is
multihomed across truly different links. In the event of a NIC, switch, or router failure, multi-
homing maintains connectivity to your subnet and everything beyond your subnet using
alternate hardware and routes to get the job done.

Teaming and Load Balancing

To gain some of the redundancy benefits and all the performance advantages of teaming and
load balancing, you don't have to liquidate the corporate budget to create mesh networks. You
can achieve the act of teaming in networked environments by aggregating servers or NICs
together. In both cases, the end result is more reliable network communications by removing
the physical server or NIC as a single point of failure and gaining the advantage of being able
to potentially process more client requests (traffic) by having multiple devices performing
similar service tasks. For those not in the know, joining multiple servers into a teamed group
is called clustering, and joining multiple NICs together is termed network adapter teaming.

Load balancing is often confused with teaming; however, load balancing is the act of pro-
cessing client requests in a shared manner, such as in a round-robin fashion. One network
adapter services the first client request, and the next adapter services the next; or, one server
processes the first request, and the next server processes the second client request. Standby
NICs and servers are different from load-balanced ones because in the event of a NIC or
server failure, you'll have a brief service outage until the server or NIC comes online. Con-
versely, service failures on networks using clustering and adapter teaming are transparent to
the end user.

A network load balancing cluster combines servers to achieve two ends: scalability and
availability. Increased scalability is achieved by distributing client requests across the server
cluster, and availability is increased in the event of a server failure in that service requests are
redirected to the remaining servers. Server clustering technology is available in both Microsoft
and Linux operating systems. We'll discuss clustering at length in Chapter 9 and focus on net-
work adapter scalability and availability here.

Network Adapter Teaming

Network adapter teaming provides servers with a level network hardware fault tolerance and
increased network throughput. Teamed adapters are logically aggregated by software drivers.
The teaming driver manipulates each adapter’s MAC address and logically assigns a new MAC
address so the team acts like a single NIC. A teamed NIC is transparent to guest VMs. If one
physical network adapter fails, automatic failover seamlessly processes network traffic on the
remaining NICs in the team. The software drivers involved with teaming manipulate the MAC
address of the physical NICs, and this is generally why OS manufacturers avoid supporting
related issues with teaming and even suggest avoiding them in server clusters.
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Caution VMware doesn’t support network adapter teaming for GSX Server hosts running on Linux, and
VMware has yet to officially test it as of this book’s publication. Additionally, Microsoft doesn’t support the
teaming of network adapters and sees it as something beyond the scope of its available 0OS support serv-
ices. Both VM application manufacturers lay the responsibility for network adapter teaming at the feet of
your NIC vendor.

VMware does offer limited adapter teaming support for GSX Server running on Windows
OSs. The Windows-hosted GSX Server supports Broadcom-based network adapters and team-
ing software in three modes:

* Generic trunking (Fast EtherChannel [FEC]/Gigabit EtherChannel [GEC]/802.3ad-Draft
Static)

* Link aggregation (802.3ad)

* Smart load balance and failover

Additionally, VMware supports the Windows-hosted GSX Server utilizing Intel-based net-
work adapters running Intel PROSet version 6.4 (or greater) in five modes:

* Adapter fault tolerance

* Adaptive load balancing

FEC/802.3ad static link aggregation

GEC/802.3ad static link aggregation

IEEE 802.3ad dynamic link aggregation

From the ESX Server install, adapter bonding, the functional equivalent of teaming, is
available. ESX Server doesn’t support teaming for the console interface.

Assuming you run into problems with teaming, and keeping in mind that teaming has
traditionally been the domain of hardware manufacturers and not OS manufacturers, you'll
want to start your research at the NIC vendor’s Web site, and you'll want to consult any
accompanying network adapter documentation. In addition, most vendor Web sites have
good user communities in which knowledgeable people are eager to help share information
and solve problems. Be sure to implement any suggestions in a test environment first.

Don't be discouraged by the lack of OS manufacturer support for adapter teaming; the
redundancy and performance benefits are too great not to support team adapters. Teaming
software from enterprise-class vendors comes with excellent support, seamlessly installs, and
functions smoothly with supported switches. Some switches must be configured before team-
ing can be properly implemented. You'll need to research the specifics regarding the switch
to which you’ll connect teamed adapters. The trick to ensuring your adapter team is bound to
your guest VMs is making sure the bridge protocol is bound to the teamed NICs and unbound
from the physical network adapters. If you set up teaming prior to installing VM application
software, you'll have solved nearly all your teaming problems before they ever happen.
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If, after teaming NICs in a server, you don't experience a fair level of increased network
performance, you may have a server that’s suffering from high CPU utilization or just experi-
encing nonlinear scaling of teaming. For instance, if a server is consistently near 90 percent
utilization on a 1GHz processor, availing the server to increased network capacity does noth-
ing for packet processing. If you use the metric that 1Hz is required for every 1bps of data
being processed, then in the previous scenario, potential throughput is limited to 1bps—
that’s a 100Mb NIC running at half duplex. Additionally, you’ll find that teaming 100Mb NICs
improves performance more than gigabit NICs. The reason for this is that 100Mb NICs are
generally overtaxed initially, and installing 5Gb NICs in a team doesn’t equal a fivefold
increase in performance. With basic network adapter teams, you make available the potential
to process more traffic and ensure network connectivity in the event of an adapter failure.

Note Virtual NICs support different throughput ratings. Currently, Microsoft’s Virtual PC and VMware’s
Workstation can support emulated NICs rated 100Mb. Microsoft’s Virtual Server and VMware’s GSX Server
and ESX Server support emulated gigabit NICs. Whether your VMs are server or workstation class, your VMs
will probably never see their rated available bandwidth, but the potential is there.

VM Networking Configurations

From Chapter 1, you know that Microsoft and VMware can accomplish several types of net-
working with VMs. Determining the network mode you need to use with your VMs is based

on whether interactivity with the outside world is required, such as physical LAN access or
Internet connectivity. If the physical LAN needs access to your VMs, you’'ll want to stick with
bridged networking. If you require an isolated network of VMs devoid of external connectivity
and invisible to the physical LAN, then host-only networking will be your best choice. If you
want a network of VMs that are invisible to the physical LAN and you require external Internet
connectivity, you'll want to use NAT networking.

VMware controls the configuration of network types by using virtual network adapters
and virtual switches. VMware’s VM application software has ten available switches, VMnet0-9,
and can use up to nine NICs. The NICs are in turn mapped to a switch. The network configu-
ration of the switch will determine the network access type for the VM. VMware preconfigures
three switches, one each for bridged (VMnet0), host-only (VMnet1), and NAT (VMnet8) net-
working. You can configure the remaining switches, VMnet 2-7 and 9, for host-only or bridged
networking. You can create complex custom networks by using multiple network adapters
connected to different switches. For instance, by using proxy-type software, a VM can be
multihomed on a host-only network and NATed network to create a gateway for an entire
virtual LAN.

Bridged networking makes VMs appear as if theyre on the same physical network as the
host. With bridged networking, you’ll impact the production network as if you just set up and
configured a new physical machine. For instance, your VM will need an IP address, DNS/
NBNS/NetBIOS server configuration, virus protection, and domain configuration settings:
if your VM is to be a server, you'll configure it like a typical server, and if it's a workstation,
you'll configure it like a typical workstation. It’s that easy. The major performance impact
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you'll experience is a decrease in network performance from having to share the host’s
physical network adapter with the host.

Host-only networking is the act of building a private network between guest VMs and the
host. These private networks aren’'t natively visible from the outside world. For instance, you
can build a host-only network with multiple VMs, complete with domain controllers, mail
servers, and clients, and the traffic will never leave the host computer. Host-only networks are
an excellent way to test new software in a secure sandboxed environment. With host-only net-
working, you can safely experiment with different networking protocols, such as TCP/IP and
Internetwork Packet Exchange (IPX)/Sequential Packet Exchange (SPX), and test solutions on
isolated prototypes.

NAT can connect a VM to virtually any TCP/IP network resource that’s available to the host
machine. NAT is extremely useful in situations where a production network DHCP pool is nearly
exhausted, Token Ring access is desired, Internet access is required, and security is an issue. NAT
performs its magic by translating the addresses of VMs in private host-only networks to that of
the host.

Microsoft controls the configuration of virtual networks through the use of virtual network
adapters and a preconfigured emulated Ethernet switch driver. You can find the driver in the
properties of the physical computer’s network adapter settings; it's called the Virtual Machine
Network Services driver. If you find yourself troubleshooting network connectivity for Virtual
PC guest VMs, you may want to begin fixing the problem by removing the driver and then rein-
stalling it. The driver file is labeled VMNetSrv. inf and is located in the VMNetSrv folder of your
installation directory.

Virtual PC VMs can support up to four network interfaces, and each VM can be config-
ured for network types that Microsoft refers to as Not Connected, Virtual Networking, External
Networking, or Machine-to-Host Networking. Of the four adapters available to you, the first
adapter can be set to Not Connected, Local Only, Bridged, or Shared (NAT). The rest of the
adapters can be configured as Not Connected, Local Only, and Bridged. Microsoft VM applica-
tions allow you to create complicated virtual networks by using the virtual network adapters
that include firewalls, routers, and proxy servers.

When you configure a VM as Not Connected, it’s a stand-alone computer and is isolated
from all machines (including the host). Configuring a VM as Not Connected is a good way to
test software or learn new operating systems.

Virtual networking is local-only networking in Microsoft’s VM applications, and it’s the
same as host-only networking for VMware. Local-only networks allow guest VMs to communi-
cate using virtual Ethernet adapters via the host’s memory. Local networks don’t generate traffic
on the physical network; therefore, local networks can't take advantage of the host’s network
resources.

External networking, or the Adapter on the Physical Computer setting, bridges traffic to
the physical adapter, and it’s the same as bridged networking for VMware. External network-
ing allows VMs to act as if they were a standard physical computer on your LAN. For example,
the physical LAN is responsible for providing a DHCP address and Internet connectivity.
External networking is inclusive of shared networking. Shared networking, known as NAT in
VMware, provides VMs with a private DHCP address and network address translation services
that connect the VM to the host’s physical network.

With shared networking, VMs are invisible to the physically attached LAN. Unlike VMware,
Microsoft doesn't support port mapping for inbound traffic. Computers that aren’t on the virtual
network won't be able to access virtual machine services or any of the VM’s ports. Additionally,
shared networking doesn'’t directly support host or guest VM intercommunication.
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Virtual machine-to-host networking allows VMs to communicate with the host system via
the Microsoft Loopback adapter. You'll have to manually configure the Microsoft Loopback
adapter to take advantage of virtual machine-to-host networking. You'll configure Microsoft
Loopback adapters in Chapter 3. VMware automatically configures a loopback adapter for
VM-to-host communication. Assuming that the proper proxy or routing software is installed,
as in ICS, you can use host-only networking and loopback networking to connect VMs to the
Internet via the host’s dial-up adapter. You can also connect to non-Ethernet-type networks,
such as Token Ring.

Supporting Generic SCSI

To provide support for physical SCSI devices, such as tape drives, tape libraries, CD/DVD-ROM
drives, and scanners, VMware employs a generic SCSI device for Linux and Windows OSs.
Generic SCSI allows a VM to directly connect to the physical SCSI device. Assuming the guest
OS can supply a driver for the attached physical SCSI device, then VMware VMs can run the
SCSI device after installing the appropriate driver. Microsoft virtualization software doesn'’t cur-
rently support generic SCSI devices. The only other thing you need to worry about with generic
SCSI is troubleshooting. We'll show how to install some generic SCSI devices in Chapter 3.

Windows Guests

Generic SCSI is intended to be device independent, but it may not work with all devices.
Therefore, when using generic SCSI (as with anything new), test your configurations in the
lab. To get generic SCSI to properly work with your VM host and guest VMs, as in Windows XP,
you may need to download an updated driver from the VMware Web site. Though rare, if, after
adding a generic SCSI device to a Windows VM, the guest doesn’t display your desired device,
you’ll have to manually edit the VM’s configuration file (filename.vmx). Listing 2-1 shows a
typical configuration file.

Listing 2-1. Typical VM Configuration File

config.version = "7"
virtualHW.version = "3"
scsio.present = "TRUE"
scsio.virtualDev = "lsilogic"
memsize = "128"

scsion:0.present = "TRUE"
scsio:0.fileName = "Windows Server 2003 Standard Edition.vmdk"
ide1:0.present = "TRUE"
ide1:0.fileName = "auto detect"
ide1:0.deviceType = "cdrom-raw"
floppyo.fileName = "A:"
Etherneto.present = "TRUE"
usb.present = "FALSE"
displayName = "W2K3"

guest0S = "winNetStandard"
priority.grabbed = "normal"
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priority.ungrabbed = "normal"

powerType.powerOff = "default"

powerType.powerOn = "default"

powerType.suspend = "default"

powerType.reset = "default"

ide1:0.startConnected = "FALSE"

Etherneto.addressType = "generated"

uuid.location = "56 4d f2 13 f1 53 87 be-a7 8b c2 f2 a2 fa 16 de"
uuid.bios = "56 4d f2 13 f1 53 87 be-a7 8b c2 f2 a2 fa 16 de”
etherneto.generatedAddress = "00:0c:29:fa:16:de"
etherneto.generatedAddressOffset = "0"

floppyO.startConnected = "FALSE"

Etherneto.virtualDev = "vmxnet"

tools.syncTime = "FALSE"

undopoints.seqNum = "0"

scsio:0.mode = "undoable"

scsion:0.redo = ".\Windows Server 2003 Standard Edition.vmdk.REDO a03108"
undopoint.restoreFromCheckpoint = "FALSE"
undopoint.checkpointedOnline = "TRUE"floppyoO.startConnected = "FALSE"
tools.syncTime = "FALSE"

We hope you won't have to manually edit VMware configuration files to fix issues related
to generic SCSI. In the event that you find yourself poking around in a text file similar to List-
ing 2-1, you can count on four reasons for the SCSI device not properly installing for Windows
guests:

* The device isn't physically configured correctly (is it plugged in and turned on?).
e The driver isn't installed on the host.
* The host driver prevents the SCSI device from being detected by the guest.

* The guest requires a device driver that doesn't exist for the host system.

After eliminating any of these reasons for generic SCSI failure, you'll need to use a text
editor, such as Notepad or Vi (Vi can be used in Windows and is even available on a Windows
Resource Kit), and modify the VM’s configuration file to solve the problem. To start, you'll
need to locate the VM’s configuration file: it uses a . vmx extension, and it should be edited
only while the VM in question is powered down.

VMware suggests that only experts edit VM configuration files, but you can safely edit the
file if you make a copy before making changes. If something goes awry during the reconfigura-
tion process, you can simply write over your changes with the previously copied file and start
again. When troubleshooting generic SCSI for Windows, you’ll want to focus on one of three
things:

e [s this the installation of a new SCSI adapter?
e Is this the installation of a new SCSI device?

¢ Is this a failure of the Add Hardware Wizard?
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In the first instance, if you're troubleshooting the installation of a new SCSI adapter
(meaning this isn't a preexisting SCSI adapter), make sure the downed VM’s configuration file
contains this:

scsiZ:Y.present = "true"
scsiZ:Y.deviceType = "scsi-passthru”
scsiz:Y.fileName = "scsiX:Y"

In the second instance, if you're troubleshooting the installation of a new SCSI device on
an existing VM-recognized SCSI adapter, make sure the downed VM’s configuration file con-
tains this:

scsiZ:Y.deviceType = "scsi-passthru”
scsiz:Y.fileName = "scsiX:Y"

In the third instance of troubleshooting, you may have to address failures related to the
Windows Add Hardware Wizard. The wizard often doesn’t properly recognize newly installed
or preexisting SCSI adapters and devices. If this is the case, make sure the downed VM’s con-
figuration file contains this:

scsizZ:Y.fileName = "scsiX:Y"
In all three troubleshooting scenarios, X, Y, and Z will be defined according to the following:
* Xis the device’s SCSI bus on the host system.

* Yis the device’s target ID in the virtual machine and on the host. It must be identical to
function correctly.

e Zis the device’s SCSI bus in the virtual machine.

When determining which numbers to use for X, Y, and Z, keep in mind that SCSI buses are
assigned numbers after available IDE buses, and the device target ID is normally assigned via
switches or jumpers on the device.

Linux Guests

Like Windows operating systems, VMware supports generic SCSI for Linux VMs. Generic SCSI
is nothing more than pass-through access to physical SCSI devices for which the host loads
drivers. Assuming a driver has been successfully loaded, guest VMs can use any SCSI device
that the host can. The generic SCSI driver is responsible for mapping attached SCSI devices in
the /dev directory. To take advantage of generic SCS], it requires driver version 1.1.36 (sg.0)
and must be used with kernel 2.2.14 or higher. Each device will have an entry in the directory
beginning with sg (SCSI generic) and ending with a letter. The first generic SCSI device would
be /dev/sga, the second would be /dev/sgb, and so on. The order of the entries is dictated by
what'’s specified in the /proc/scsi/scsi file, beginning with the lowest ID and adapter and
ending with the highest ID and adapter. You should never use /dev/st0 or /dev/scd0. You can
view the contents of the /proc/scsi/scsi directory by entering cat /proc/scsi/scsi at the
command-line interface (CLI).
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Juggling host and guest connectivity to disk drives (sd), DVD/CD-ROM drives (scd), and
tape drives (st) can be tricky. If you permit simultaneous connectivity for the host and guest
systems, your Linux system may become unstable and data corruption/loss can occur. If you
don’t have two SCSI disk controllers, one for the guest and one for the host, this is a good time
to rethink your configuration strategy.

Simultaneous access becomes an issue because Linux, while installing the generic SCSI
driver, additionally recognizes SCSI devices, such as the previous devices, as sg entries in the
/dev directory. This creates a dual listing for SCSI devices. The first entry was created during
the install of the host’s Linux OS. Though VMware does an excellent job of arbitrating access to
a single resource, it isn't always successful in making sure the dual device listings aren’t simul-
taneously accessed under the /dev and /dev/sg listings. Therefore, don’t use the same device
in a host and guest concurrently.

After adding a generic SCSI device under Linux, you'll need to check the permissions on
the device. For the device to be of any use to guest VMs, read and write permissions must be
assigned to the device. If standard users, other than the superuser, will need access to the
device, groups should be created for access control. We'll show how to install and set permis-
sions on generic SCSI devices in Chapter 3.

Considering Storage Options

Determining which hard disk type and configuration to use for hosts and guests is based on
the purpose of the final VM system. Presentation, educational, test, and production environ-
ments all have different reliability and availability requirements and widely differing budget
constraints. Correctly identifying the purpose of a VM host will help you budget available
resources so you can prioritize host needs, as shown in Figure 2-1.

High Priority—RAID SCSI Drives
Production Networks
Workgroups
Test Benches
Educational Environments
Presentations

Low Priority—Inexpensive IDE Drives

Figure 2-1. Prioritizing host storage

In the following sections, we’ll cover physical and virtual SCSI/IDE disks and their relative
performance characteristics. We'll also briefly discuss the commonsense application of each.
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Physical Hard Drive Specifications

Physical hard drives have several specifications with which you need to be familiar. Being that
virtual hard drives are mapped to the physical drive, the performance of the virtual hard drive
is similar or equivalent to the physical drive. That is, you can’t have a better virtual hard drive
than you do a physical one. The hard drive you choose impacts the host and guest OSs equally.
With SCSI and IDE hard drives, you'll want to concern yourself with four specifications: spin-
dle speed, cache buffer size, access time, and data transfer rate.

Spindle Speed

Spindle speed is the rotation speed of the hard drive’s platters. Speeds generally step from
4,200 revolutions per minute (RPM), 5,400RPM, and 7,200RPM for IDE drives and from
10,000-15,000RPM for SCSI drives. The higher the speed, the better the performance you'll
experience. Conversely, more speed means more money and heat; therefore, you'll need to
increase your budget and ventilation. You generally will find low spindle speed (4,200-4,500RPM)
small form factor hard drives in notebooks, and these drives are sufficient only for testing or
demonstrating a handful of concurrently running VMs. Avoid using similar spindle speeds in
production VM host workstation and server systems, or you'll take a serious performance hit.

Cache

The buffer cache on a hard drive is similar to that found on a motherboard. The memory is
used to speed up data retrieval. Most hard drives come with a 2MB, 8MB, or 16MB cache. If
you're building a workstation for testing, then you can save some money by going with smaller
buffer sizes. For servers, video processing, and extensive data manipulation using spread-
sheets or large documents, you'll want to go with larger buffers to get that extra performance
boost. Moreover, if you're using RAID controllers, you'll want increased cache levels for file
servers. Cache creates performance differences significant enough for VM host applications
and guest VMs that investing in larger buffers is merited because it decreases overall system
response time, which allows you to more seamlessly run multiple VMs.

Access Time

The rate at which a hard drive can locate a particular file is referred to as access time. This
factor becomes extremely important for file server—type VMs. For instance, if a VM will be
frequently manipulating thousands or tens of thousands of files, being able to find each one
in a reasonable time becomes problematic on drives with high access times. High access
times will cause VMs to appear to hang while the hard drive searches for files. By sticking with
the lowest possible access times, you reduce latency. As you stack more VMs onto a single
host, this access time becomes more critical.
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Transfer Rate

Transfer rate generally refers to one of two types, internal and external. Internal transfer rate

is the rate a hard disk physically reads data from the surface of the platter and sends it to the
drive cache. External transfer rate is the speed data can be sent from the cache to the system’s
interface. Trying to compare the transfer rates among different manufacturers may be difficult;
they all typically use different methods to calculate drive specifications. You will, however, find
that the transfer rates of parallel ATA IDE drives are less than that of SATA IDE drives, and both
are less than that of SCSI transfer rates. When it comes to service life, SCSI will win in the war-
ranty and longevity department.

You'll get better sustained transfer rates from SCSI drives. If you want to keep the data
flowing on a busy VM, such as an e-commerce Web server, and sustain higher levels of per-
formance, transfer rates are critical. Transfer rates are less critical if a system operates in
bursts, such as a print server. Because external transfer rates depend on the internal rates
being able to keep the cache full, internal transfer rates are a better indicator of performance
when selecting drives for your VM host machines. You can download data sheets from hard
drive manufacturer Web sites to compare transfer rates for hard drives.

We mentioned earlier that having multiple disk controllers and disks provide for better
VM hosting, so let’s feed the supergeek in us and look more closely at the mathematic justifi-
cation for using multiple controllers and disks in your VM host. You'll need to pull hard drive
data sheets to compare throughput averages of disks to get a better feel for overall perform-
ance as compared to theoretical maximums. For this discussion, we’ll make some sweeping
generalities about average data throughput that many hard drives support. To that end, what
do the numbers look like between a VM host utilizing two Ultra 320 SCSI drives across two
channels compared to a VM host using two Serial ATA 150 drives across two channels? Serial
ATA drives have a maximum throughput of 150MB/sec and can sustain an average transfer
rate between 35MB/sec and 60MB/sec. Your total throughput for a two-channel system would
provide host and guest VMs with a maximum of 300MB/sec, and in constant data delivery
mode, VMs would see about 70-120MB/sec total. Looking at Ultra 320 SCSI drives using one
channel, maximum throughput could reach 320MB/sec and would average about 50-80MB/sec.
Using a two-channel Ultra 320 SCSI controller, theoretical maximum throughput would be
640MB/sec and would be 100-160MB/sec for constant data delivery. To get equivalent speeds
from SATA devices, you'd need a five-channel adapter and five hard drives: this would put you in
the price range of a SCSI solution. The upshot with SATA is that storage is inexpensive. In fact,
SATA storage is so inexpensive that it's not uncommon for disk-to-disk backup systems to be
composed entirely of SATA drives. If you combined the space of five 350GB hard drives, youd
have 1.7TB. To get the equivalent from 143GB SCSI drives, youd have to purchase 13 hard drives!
When you look at SCSI and SATA for large storage solutions, you can’t question the cost bene-
fit of using SATA. When it comes to performance, SCSI blows the doors off SATA technology.
Determining if you should go with SCSI or SATA can be difficult, though. You can use Table 2-5
as a guide to help determine if your host implementation situation should use SATA or SCSI
technology.

Note VMware’s ESX Server requires SCSl-attached storage for running guest VMs. However, you can
store guests on IDE devices.
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Table 2-5. Hard Disk Implementation Situations

System Usage Storage Disk Type
Desktops Office suites/games All SATA

Workstations Engineering/ CAD Mostly SATA/some SCSI
Entry-level servers Web/e-mail/automation All SATA

Mid-level servers Web/e-mail/automation Partly SATA/partly SCSI
High-end servers Web/e-mail/automation/databases All SCSI

Enterprise servers Disk-to-disk backup Mostly SATA/some SCSI

We also want to point out that the performance increase SCSI drives experience over
IDE drives isn't all attributed to drive design. The increase in performance is generated by the
structure of the SCSI bus. The SCSI controller bus can manage hard drives without having to
interrupt the processor for support, and the controller can use all drives attached to the bus
simultaneously. IDE drives are limited to sharing the IDE bus. For instance, if you connected
two IDE drives to the same bus, the drives would have to take turns communicating over the
IDE bus. IDE drives are ideal for single-user computers, low-end servers, and inexpensive
storage. If you're building a VM host that will be pounded in a multitasking environment, the
extra expense of SCSI drives is well worth the performance boost your VMs will experience.

RAID

To create a RAID group, you can use one of two approaches: RAID implemented in software or
RAID implemented in hardware. As with anything, each RAID type has positive and negative
points. When considering RAID for your VM solution, you're looking to increase capacity, gain
a performance edge, or add fault tolerance.

Hardware RAID vs. Software RAID

If you want the best performance and security from a RAID solution, you'll want to implement
a hardware solution. You obviously will not get more performance from a software implemen-
tation, as it makes the VM host do more work. The independent architecture of hardware
RAID, meaning that the operating system functions independently of the management fea-
tures of the RAID controller, will deliver better performance and security for VMs. Software
RAID is implemented within the host’s operating system. Many operating systems come with
a software RAID capability as a standard feature, and using it will save you the cost of a RAID
controller. Unfortunately, software RAID adds overhead to the host by loading up the CPU and
consuming memory. The more time the CPU spends performing RAID tasks, the less time it
has to service guest VMs. The extra overhead may be a moot point in low utilization environ-
ments where you gain the redundancy advantage RAID has to offer.
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Note Let’s take a quick reality check with software RAID implementations. If you’ve purchased server-
class virtualization applications to use VMs in a production environment, money exists within your budget for
a hardware RAID controller. If you don’t have a hardware RAID controller for your host and insist on using
software RAID, do everyone a favor and return the VM software. Buy a hardware RAID controller first.

You implement hardware RAID using a special controller card or motherboard chipset.
This is more efficient than software RAID. The controller has its own processing environment
to take care of RAID tasks. Hardware RAID is managed independently of the host, and all data
related to the creation and management of the RAID array is stored in the controller. Software
RAID stores RAID information within the drives it’s protecting. In the event of operating sys-
tem failure, which solution do you think is more likely to boot? In the event of disk failure,
which solution is more likely to preserve the state of your data? If you choose to use a software
implementation of RAID, it should be used only for redundancy purposes and when hardware
RAID is cost prohibitive. For better all-around performance and security, hardware RAID is
your best choice.

In the not-too-distant past, RAID controllers were available only for SCSI hard drives.
With the increased throughput of SATA technology and the need for inexpensive RAID con-
trollers, manufacturers are making hardware RAID available for SATA technology. In situations
where hardware RAID is needed and the budget is looking thin, SATA RAID is an excellent
choice. These new breeds of RAID controllers come equipped with several disk interfaces,
some as high as 16 ports! Like their SCSI counterparts, SATA controllers can have hotswap
capability, allowing for the replacement of failed disks on the fly. It isn't uncommon for new
entry-level or mid-level servers to come equipped with an SATA RAID option.

RAID Types

With RAID implementation selection out of the way, let’s look at the available RAID types and
how they impact the performance and redundancy of your VM solution. RAID types com-
monly found in production environments are RAID 0, RAID 1, and RAID 5, and each offers
specific benefits and drawbacks.

RAID 0 isn’t really a RAID type because redundancy isn't available (no parity). Despite the
lack of redundancy, RAID 0 offers the best possible performance increase for VMs. RAID data
is striped across two or more disks. Striping is the process of splitting data into blocks and dis-
tributing it across the drives in the array. Distributing the I/0 load across the disks improves
overall VM performance. RAID 0 is great to use where a single hard disk is normally used and
the loss of data isn't critical. Generally, you'll find RAID 0 implemented for a computer-aided
drawing (CAD) or video-editing workstation.

RAID 1, or disk mirroring, maintains an identical copy of all data on different disks in the
array. At a minimum, you must use two disks. If one disk goes bad, service availability of the
host and guest VMs will be maintained. RAID 1 provides for faster disk reads because two data
locations are working to service one request. Conversely, RAID 1 negatively impacts disk write
performance because data must be written to two locations. RAID 1 is good for protecting
servers that don't require lots of disk space or where extensive file writing will not be an issue,
such as for a server hosting a read-only database. In terms of using RAID 1 for a host, itisn’'t a
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bad choice for redundancy when drives are limited. You'll see a noticeable decrease in per-
formance for guest VMs that use virtual disk files.

RAID 5, also known as block-level striping with distributed parity, stripes data and parity
information across a minimum of three hard drives. RAID 5 has similar performance charac-
teristics as RAID 0 save for the overhead of writing parity information to each drive in the
array. The performance impact of having to write the parity information isn't as significant as
having to perform disk mirroring. Fault tolerance is derived from data blocks and its parity
information being stored on separate drives in the array. If one drive should fail, the array
would continue to function because the data parity is stored on a different disk. When a drive
fails in a RAID 5 array;, it functions in a degraded state until the failed drive is replaced. RAID 5
is common in production environments and offers the best of all worlds—excellent capacity
potential, good performance, and better fault tolerance for your host and VMs.

Host Disk Sizing

Sizing system storage is extremely important for both virtual and physical machines. Because
you'll be collapsing the infrastructure onto one box, your storage needs in a single host com-
puter will be a multiple of the servers you want to run on it. If you have four servers with
100GB storage capacity, for example, you'll need a host with a minimum of 400GB of space
and additional room for the host operating system. If you're using dynamic disks, you'll find
that VMs will quickly consume your attached hard drive space. When choosing permanent
storage for your hosts and guests, you need to decide if the final solution is for portable
demonstrations and academic situations, for a test bench, or for the production environment.

Presentation and educational environments are generally restricted to small budgets and
lower-end hardware. VMs typically will be loaded onto inexpensive large-capacity IDE devices
and notebooks with limited quantities of RAM. In these cases, rather than spending your
budget on SCSI drives, investing in more RAM is the key to getting three or four reasonably
responsive dynamic disk VMs running simultaneously in host mode-only networks. For
instance, if you need to turn up four VMs, you'll need 256MB for the host and 128MB for each
guest, totaling 768MB. Running Windows 2000 and 2003 on 128MB is painful. In practice,
you'll find you slide by fairly nicely by running Windows VMs with 192MB of RAM. In the
previous situation, that now requires you to have 1GB of RAM.

Being that a test bench should more closely approximate an existing network environ-
ment, and being that VMs are often built on the test bench and then copied into production,
you'll want to use SCSI drives in this case. Moreover, SCSI drives are a prerequisite if you plan
on testing ESX Server. To get the most out of the two to three servers you may have available
for testing, you'll want to have two SCSI controllers in your server (one for the host and one
for guests) and a moderate amount of RAM: both SCSI controllers and ample quantities of
RAM (256-512MB per VM) are required to adequately support a test domain of six to ten
VMs and any enterprise applications, such as Oracle, Lotus Notes, or Exchange.

Note You'll also want to have similar, if not identical, NICs in your existing production environment to
avoid undue network complications. You'll also want to have enough physical NICs to test any teaming or
load balancing implementations that may be in production.
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Production environments require high availability, good reliability, and good response
times. It's necessary to have multiple RAID controllers per host (or SAN access), high-end SCSI
drives, plenty of NICs, and tons of RAM. The more closely you can approximate the contents
of multiple servers in one box, the better the VM host you'll have. The key to successfully
deploying VMs is to consistently utilize 60-80 percent of the total physical server resources.
The extra 30-40 percent is a buffer to offset utilization spikes. The more a server approaches
100 percent utilization, the more it appears to be frozen to an end user. Fast RAID controllers
and SCSI disks with large buffers can easily feed a hungry network. RAID drives are more
important than ever during the event of system failure because it isn’t one server going
down—it’s a host and all its VMs! Determining the amount of drives you need is as easy as
figuring the total number of fixed-disk VMs plus room for the host. You may find yourself
“specing out” a physical server with a terabyte of storage or investing in a SAN.

Guest Disk Sizing

IDE device controllers are limited to four devices total, two each for the primary and second-
ary channels. You can use any CD-ROM and hard drive combination, but you can’'t exceed the
limit of four devices: this is true for physical and virtual machines. All the VMs in this chapter
are limited to 128GB virtual IDE devices, whereas physical systems can use IDE drives larger
than 350GB. If you have a guest VM that requires more than 384GB of storage, using virtual
IDE hard drives isn't a viable option. However, you can run virtual SCSI drives from a physical
IDE drive to meet your sizing demands. The virtual SCSI disk performs better than the virtual
IDE disk because of the difference in driver technology. Using virtual SCSI disks reduces the
impact of virtualization overhead and will more closely approximate the physical perform-
ance characteristics of the hard drive.

Virtual SCSI disks are available for VMs in Microsoft Virtual Server and all VMware virtual-
ization applications. Microsoft allows you to configure up to four virtual SCSI adapters with a
maximum of seven virtual SCSI disks for a total of twenty-eight virtual SCSI disks. Each virtual
SCSI disk can be as large as 2TB. Virtual Server emulates an Adaptec AIC-7870 SCSI controller.
For VMware, you can configure up to seven virtual SCSI disks across three virtual SCSI con-
trollers at 256GB per disk. VMs can directly connect to physical SCSI disks or use virtual disks.
In either case, you can’t exceed a total of 21 virtual drives. When configuring your VM, you can
choose between a BusLogic or LSI controller card. The LSI card provides significantly better
performance for your VMs. The trick to utilizing the LSI card for your VMs is to have the driver
available on a floppy disk while installing your OS. You can download the LSI driver from the
VMware Web site. When given the choice, opt for SCSI virtual disks.

The performance difference between mapping a VM to a physical disk and a virtual disk
file is an important component to consider in your system design. In the first scenario, the
VM treats the disk as a typical server would: it’s raw storage, and the VM interacts directly with
the physical disks. The VM reads and writes to the disk like a typical server with its own file
management system. The only overhead really experienced by the VM guest is that of the
virtualization layer.
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Virtual disks, in essence, emulate physical hard drives and are stored as files on the host’s
physical hard drive. The guest VM will mount the file and use it like a hard drive. The guest OS
will use its own file management system to read and write to the file. All this reading and writing
takes place within the file management system of the host creating the extra overhead. If you opt
to use dynamically expanding virtual disk files, this creates additional overhead because the file
must be resized before data can be written to it. Dynamically expanding virtual disks also tend
to fragment the host’s hard drive, which further negatively impacts performance for the host and
guest VMs alike. The major advantage virtual disk files have over mapped drives is portability.
Moving or backing up a VM is like copying a regular file. In Chapters 4 and 6, we'll further discuss
virtual disk performance.

Storage Area Networks

A SAN generally consists of a shared pool of resources that can include physical hard disks, tape
libraries, tape drives, or optical disks that are residing on a special high-speed subnetwork (dif-
ferent from the existing Ethernet) and utilizing a special storage communication protocol, which
is generally either Fibre Channel Protocol (FCP) or Internet SCSI (iSCSI). Together, it’s all known
as the storage fabric. The storage fabric uses a SAN-specific communication protocol tuned for
high-bandwidth data transfers and low latency.

Most SAN interconnectivity is accomplished by using a collection of Fibre Channel
switches, bridges, routers, multiplexers, extenders, directors, gateways, and storage devices.
SANss afford connected servers the ability to interact with all available resources located within
the SAN as if the devices were directly attached. In a reductive sense, you can think of a SAN as
a network composed of interconnected storage components. We'll discuss SAN technology, as
well as its configuration options and relationships to VMs, in much further detail in Chapter 13.

Servers generally gain access to the SAN via fiber-optic cabling; however, connectivity is
also available over copper. What SANs offer VM is the same thing offered to physical servers:
increased performance levels, better reliability, and higher availability. These benefits are
achieved because the SAN is responsible for data storage and management, effectively
increasing the host’s capacity for application processing. Extra processing capability results
in lower latency for locally running VMs and faster access times for the end user. Disaster
recovery capabilities are enhanced in that the time to restore a VM is significantly decreased
and the physical data storage can be in a remote location.

Microsoft VMs and SANs

Microsoft VM virtual hard disks can be stored on a SAN. VMs don’t need anything in particular
to use a SAN because the host views the SAN as a local volume—the physical computer treats
the SAN as a typical storage device, assigning it a local drive letter. The host simply places all
files associated with VMs on the SAN via the assigned drive letter. If you're wondering if you
can use SAN as a physical disk, you can't. Virtual Server doesn’t provide emulation of SAN
host bus adapter (HBA) cards. Microsoft will treat a SAN as a locally attached device.
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VMware VMs and SANs

Like Microsoft, VMware treats a SAN as locally attached storage for GSX Server. Unlike
Microsoft, VMware allows for the mounting of a SAN LUN for ESX Server (using a SAN as a
physical disk). A LUN is a slice of the total SAN representing a section of hard drives that’s in
turn labeled to identify the slice as a single SCSI hard disk. Once the LUN is created, the host
or ESX Server guest can address the disks in that particular SAN slice. ESX Server supports up
to a maximum of 128 LUNs and can emulate QLogic or Emulex HBA cards.

ESX provides support for mulitpathing to help achieve a more highly available network by
maintaining connections between the SAN device and server by creating multiple links with
multiple HBAs, Fibre Channel switches, storage controllers, and Fibre Channel cables. Multi-
pathing doesn't require specific drivers for failover support.

When installing ESX Server, you'll need to detach the server from the SAN. Detaching
prevents accidentally formatting any arrays and prevents the SAN from being listed as the pri-
mary boot device for ESX Server. Moreover, VMware suggests you allow one ESX Server access
to the SAN while configuring and formatting SAN and VMFS volumes. In a SAN solution, you
want to install ESX Server on the local physically attached storage and then run all VMs from
the SAN via an HBA card. You'll get near physical server performance from your VMs by allow-
ing them sole use of the HBA cards. This also gives you a major backup advantage. Multiple
VMs can directly back up to a tape library in a SAN simultaneously. Additionally, don'’t place
ESX Server’s core dump file on the SAN, as it can make the system unstable.

LUN Management

On initialization or when a Fibre Channel driver is loaded, ESX Server scans the SAN for LUNs.
You can manually rescan for added or deleted LUNs by issuing vmkfstools -s at the CLL. If
you're using QLogic HBAs, you'll have to flush the adapter’s cache for entries in /proc/scsi/
gla2200 or /proc/scsi/qla2300. At the CLI, for example, enter the following:

echo "scsi-gqlascan" > /proc/scsi/qla2300/0
vmkload mod -u gla2300
vmkload mod /usr/lib/vmware/vmkmod/qla2300 604.0 vmhba

If, after creating your LUNs and them not appearing after a scan, you'll need to change the
DiskMaxLun field from Advanced Settings in the Management Interface. The number should
be equal to the total number of LUNs plus one. In Figure 2-2, the default value is set to 8. Notice
that the name of the server isn't using the default installation name; your system should have
FQDN listed.

By default, ESX will see 0-7; you achieve this by typing 8 in the Value field. Rescan to
detect the new LUNs. You can verify your result at the CLI by running 1s /proc/vmware/scsi/
<fiber channel adapter>.
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Figure 2-2. DiskMaxLun and DiskMaskLUNs s field settings

Before assigning SCSI or SAN storage to a virtual machine, you'll need to know the con-
troller and target ID used by the service console and the controller and target ID used by the
VMkernel. Though physically dismantling your system is an option for information regarding
the service console, you can determine controller and target IDs from the CLI. The boot log
file, /var/log/messages, and the SCSI file of the proc pseudo file system, /proc/scsi/scsi,
both contain valuable information. You can view the contents of each by entering the follow-
ing at the CLI:

cat /var/log/messages | less
cat /proc/scsi/scsi | less
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For data regarding the controllers assigned to the VMkernel, you'll want to look to the
/proc/vmware/scsi directory. This information will be available only if the VMkernel starts.
For every controller assigned to the VMkernel, a corresponding directory should exist in
/proc/vmware/scsi. The subdirectories of each controller will have a listing of devices, target
IDs, and LUNSs. For instance, if you had the vmhbao subdirectory with a 2:0 file, you'd want to
perform the following commands at the CLI to view the file contents:

cat /proc/vmware/scsi/hba0/2:0 | less

After collecting your data, you can use it to configure your VMs in the Management Interface.

LUN Masking

Masking is also available if you don’t want the VMkernel scanning or even accessing particular
LUNSs. Masking is generally performed for security reasons to prevent operating systems from
accessing LUNs. You can accomplish masking by setting the DiskMaskLLUNss field on the sys-
tem’s Options tab under Advanced Settings to this:

<adapter>:<target>:<comma separated LUN range>;

For example, if you wanted to mask LUNSs 3, 4, and 50-60 on vmhba 1, target 4, and
LUNSs 5-9, 15, and 12-15 on vmhba 2, target 6, you'll need to set the DiskMaskLUNs option
to vmhba1:4:3,4,50-60;vmhba2:6:5-9,12-15, as in Figure 2-2. You're prohibited from masking
LUN 0. When using QLogic HBAs, you'll need to select the correct driver version as well (IBM,
HP or EMC).

Bus Sharing

Unlike masking, ESX provides for bus sharing. The bus sharing feature is useful for high-avail-
ability environments, such as clustering, where you want two VMs to access the same virtual
disk. By default, ESX Server prevents this from happening: if you need to change the settings,
you can use the Management Interface to set bus sharing to one of three options:

¢ None: VMs don’t share disks.
¢ Virtual: VMs on the same host can share disks.

* Physical: VMS on different hosts can share disks.

You'll want to choose Virtual as the sharing type for building a cluster in a box, and you'll
need to choose Physical if you want to hedge against hardware failure. Using physical bus
sharing requires the virtual disk to be mutually accessible by each VM.

Persistent Binding

Persistent binding is also available for ESX Server VMs and affords the target IDs to be retained
during reboots. Persistent bindings, the assignment of target IDs to specific Fibre Channel
devices, are necessary if you're using the SAN for VM direct access: persistent bindings treat
the SAN as a physical disk by directly mapping the SAN LUN as locally attached storage. As
with all ESX Server administration, you can configure persistent binding at the console or
through the Management Interface. As a word of caution, persistent binding can create major
problems in FC-AL SAN topologies!
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Summary

In this chapter, we reviewed no-nonsense techniques for budgeting, building, and installing
Windows or Linux VM host solutions. We pointed out some network and system bottlenecks
along the way, and we showed how to avoid them in bridged or NATed networks by installing
and configuring multiple network and storage adapters in a teamed configuration. In addition,
you know that when you use teamed network adapters, you must configure the connecting
switch for Etherchannel and the appropriate teaming protocol. If you don'’t properly configure
your teamed NICs, you may wind up with flapping links or loops that adversely impact the
network, negating all performance gains.

Additionally, we discussed the importance and impact of network and storage considera-
tions for host and guest VMs, including locally attached storage and SANs.

Now that you're aware of the techniques for selecting and preparing hardware for host sys-
tems, you're ready to move onto the next few chapters where we'll focus on hosting and installing
VMs. We'll cover the techniques to help students, technology administrators, and sales profes-
sionals get the most out of virtualization by installing guest operating systems on both server and
workstation VM applications.
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CHAPTER 3

Installing VM Applications
on Desktops

With virtualization theory and host system selection considerations from Chapters 1 and 2
out of the way, it’s time to move onto installing some major workstation-class virtualization
applications. In particular, this chapter will focus on installing Microsoft Virtual PC and
VMware Workstation on desktop operating systems. This chapter will also cover installation
and optimization methods that will assist students, help-desk personnel, sales professionals,
and systems engineers in deploying and configuring virtual machines on desktop and laptop
computer systems.

Deploying VMs with Microsoft Virtual PC

Microsoft Virtual PC is intended to be installed on Microsoft desktop OSs (specifically, Win-
dows 2000 Professional, Windows XP Professional, and Windows XP Tablet PC Edition). Virtual
PC officially supports many Microsoft guest operating systems from MS-DOS 6.22 to Windows
2003 Server. It even officially supports OS/2. Though you can run many other operating sys-
tems without official support, this may be a moot point if you're in an all-Microsoft shop. In
the following sections, we’ll show you how to install Virtual PC on a Windows XP host com-
puter.

As a word of caution, installing Virtual PC requires administrative privileges. Except for
this, Virtual PC is a snap to set up. After the installation, you aren’t required to reboot your sys-
tem before configuring and installing guest VMs, but it’s a good idea to give the host system a
fresh restart. Perhaps the only hitch in the installation process is that the host computer will
temporarily lose network connectivity during the virtual switch driver installation.

After completing the install of Virtual PC, a whole host of configuration options are available
to you. These configuration options control the character of Virtual PC and its interactions with
the host system resources (for example, memory consumption, CPU utilization, and system
security).

We'll cover each setting in Chapter 4 while showing how to install guest operating sys-
tems. As a heads up, the easiest way to install an operating system in Virtual PC is to use the
setup program. The same techniques you use to load an operating system on a physical
machine, such as booting from a floppy disk or CD-ROM, are available to you with Virtual PC.
If you're just experimenting with Virtual PC, you can scrape by on some really thin hardware



70 CHAPTER 3 ! INSTALLING VM APPLICATIONS ON DESKTOPS

configurations. However, you'll find that you'll get the best results from Virtual PC by using
best-practice minimums that come near to or exceed the following suggestions:

e Two 100 AT Attachment (ATA) IDE interfaces (one for the host and one for guests)
¢ One 100/1000MB NIC interface

e One CPU at 1IGHz

1GB of RAM

* Two 80GB ATA IDE hard disks

e 133MHz FSB

After getting your hands on a copy of Virtual PC software, you can start the installation by

launching the scant 19MB executable. After some preinstallation churning, you'll be greeted
with the Virtual PC 2004 InstallShield Wizard.

Note You'll need an OS license for each guest VM you plan on installing and using with Virtual PC.

The install process will present you with a Customer Information screen where you’'ll
need to supply some standard preinstallation information, such as your username, organiza-
tion, and product key information. For an added layer of security, you'll also need to decide
for whom the completed install of Virtual PC will be available. If you're unsure, select Anyone
Who Uses This Computer (All Users).

After entering the license key, Virtual PC is ready to install. If you don't like the default
installation directory, change the path by selecting Change. Now is also a good time to sec-
ond-guess any selections and make changes to the install by selecting the Back button. When
you're satisfied with the configuration settings, select Install. The complete installation takes a
minute or two at most. Upon successfully completing the install, you'll be presented with the
InstallShield Wizard’s Completed screen.

When the installation is complete, you can find Virtual PC in the Programs menu. Being
that Microsoft left out the option to create a desktop icon, take a moment to create one. Better
yet, place a shortcut in the Quick Launch bar.

Microsoft has released Virtual PC 2004 Service Pack 1 (SP1), and it’s available for down-
load at http://www.microsoft.com/downloads. Take a moment to download SP1 (which is
about 25MB) to a convenient location. Before starting the setup, however, be sure that all
guest operating systems are turned off and aren't in the saved or paused state. VM saved states
aren't compatible from the base Virtual PC application to the upgraded Virtual PC SP1 prod-
uct. Virtual PC SP1 also includes an updated version of Virtual Machine Additions, so be sure
to update all your guest VMs to this newer version by first uninstalling the old version and
then installing the new. You should be aware that SP1 doesn’t update Virtual PC help files.

To get a better overview of what SP1 covers, you can download the SP1’s Readme files at
http://www.microsoft.com/downloads.
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Begin the SP1 installation by unzipping the downloaded file and selecting Setup. You'll be
greeted with the SP1 installation wizard. If you receive an error message, it may be the result
of trying to install SP1 on a trial version of Virtual PC. The install should take only two to three
minutes. When complete, you should see the Installation Completed screen. Microsoft
requires you to have a validly licensed copy of Virtual PC to install the service pack.

With SP1 in place, take a moment to verify Virtual PC’s version. You can determine the
version by opening the Virtual PC Console and selecting Help » About. Your Virtual PC 2004
SP1 version should be 5.3.582.27.

Before moving onto VMware Workstation installation, treat the service pack installation
the way you would any other upgrade. Take a moment to browse through the help files and
menus to get a feel for what has changed in Virtual PC. You'll want to have a bit of control of
the software before installing guest VMs and reading Chapter 4.

Installing VMware Workstation for Windows

Installing VMware Workstation isn’'t much different from installing Virtual PC or any other
hosted virtualization application. As you learned in Chapter 1, VMware supports many more
OSs for its virtualization products than Microsoft, and this will be a critical factor for you if
official support is required for Linux guest VMs.

Despite that you can really load up Workstation with many guest servers and still get good
performance, keep in mind that it’s licensed per user. For instance, if five people are going to
be accessing guest VM servers on your VM Workstation implementation, you need five work-
station licenses (in addition to any guest OS licensing). Workstation is approximately $200 per
license, and GSX Server is about $1,400 for a two-CPU server. On the other hand, GSX Server
provides for unlimited user access to guest VM servers, uses gigabit NICs, and supports an
unlimited number of processors. You could probably save a few dollars with Workstation in
a small network of five or six users, but it’s really designed for a single user.

Before beginning to install VMware Workstation, quickly compare your host’s hardware
to these suggested best-practice minimums for VMware Workstation:

e Two 100 ATA IDE interfaces (one for the host and one for guests)
e Two 100MB NIC interfaces (one for the host and one for guests)
¢ One 1GHz processor

¢ 1GB of RAM

¢ Two 80GB ATA IDE hard disks

133MHz FSB

If you come close to this configuration, you'll have guest VMs that perform well and are a
joy to use. Installing VMs on less hardware significantly increases latency and will waste what
lab time you may have.
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Tip To make sure you get the best performance from your IDE devices, make sure the IDE controllers in
Device Manager use direct memory access (DMA). You can verify the settings by right-clicking the primary
or secondary controller and selecting Properties. Select the Advanced Settings tab, and make sure that the
Transfer Mode setting is set to DMA If Available. DMA access is much faster than programmed input/output
(P10) access.

Without further ado, let’s begin installing VMware Workstation on your Windows host
running Windows NT 4.0, Windows 2000, Windows XP, or Windows Server 2003.

Like Virtual PC, you'll want to install Workstation using administrative privileges. Launch
the Workstation executable file from your install media. The file is about 40MB and will have a
filename like VMware-workstation-4.5.2-8848.exe. You'll be greeted with Workstation’s Instal-
lation Wizard.

The Destination Folder screen requires you to select the installation place for Worksta-
tion. Generally, the default is fine. If you want to change the install location, select Change,
and specify a new directory. The installation location doesn't dictate the storage location of
guest virtual disks, however. For performance reasons, you may want to specify your second-
ary IDE controller’s hard drive when you create these. (We'll cover how to set up guest VMs in
Chapter 4.)

You'll be given the opportunity to make changes on the Ready to Install the Program screen.
If you're satisfied with your previous selections, choose Install to continue the installation. Dur-
ing the software installation, you may be asked to disable the CD-ROM autorun feature. Autorun
can have a negative performance impact on your guest VMs, and it will cause unpredictable
behavior in guest VMs.

The Installation Wizard asks you if you want it to find and rename virtual disks from pre-
vious versions. If you're upgrading, you'll want to select Yes. If this is a fresh install, select No.
In addition, you'll be given the opportunity to supply registration information for the software
during the install. If you already have a validly licensed product serial number, you can enter
it along with your name and company information, or you can obtain a demo key from
VMware’s Web site. You'll have to register using a valid e-mail address to receive the trial key.
Once you receive it, you can cut and paste it into the Serial Number field. If you don’t have a
serial number, select Skip. You can enter this information later at VMware’s Management
Interface. If all goes well, you'll finally see the Installation Wizard’s Completed screen.

The Installation Wizard will create a desktop shortcut for Workstation. You can test the
installation by launching the application. You'll be presented with the Tip of the Day pop-up
box. If you want, you can disable this. After closing the tip window, Workstation’s Management
Interface launches.

As with any software installation, you'll want to check VMware’s download Web site,
http://www.vmware.com/download/, for any service releases regarding your new Workstation
installation. Take a moment to browse the menus and skim the help files. You'll want to be
familiar with configuration options and be aware of the breadth of help available to you when
you install guest VMs in Chapter 4.
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INSTALLING VMWARE’S DISKMOUNT UTILITY

If you go to VMware’s download Web site, you'll find a cool utility that allows you to mount VMware virtual
disks as drive letters for read and write access. If you use disk-imaging products, such as Norton Ghost,
DiskMount is similar to the Norton Explorer utility. DiskMount will give you access to all files on any powered-
off virtual disk created with VMware Workstation 4, GSX Server 2.5.1/3, and ESX Server 2. The utility is
designed for Windows 2000, Windows XP, and Windows Server 2003. Unfortunately, VMware doesn’t provide
support for DiskMount. Assuming storage space is available, be sure to back up the disk you want to mount
first. Then, work with the backup copy. You can make any permanent changes after running tests on the
backup first.

When mounting virtual disks, you’re limited to the following choices:

e Mounted virtual disks must have a unique drive letter greater than D.
¢ Only the file-allocated table (FAT)—12/16/32—and NT file system (NTFS) partitions are mountable.
e Permissions on the read-only disks must be changed to read and write.
e Compressed drives must be decompressed.
DiskMount is free, and you don’t need a VMware virtualization application installed, such as Workstation

or GSX Server, in order to use DiskMount. After installing the utility, you’ll need to go to the CLI to perform
DiskMount commands. The syntax for DiskMount is as follows:

vmware-mount [options] [drive letter:] [\\path\to\virtualdisk]

Table 3-1 lists its command options.

Table 3-1. DiskMount Command Options

Options Action Performed

/v:N Mounts volume N of a virtual disk (defaults to 1)

/p Displays the partitions/volumes on the virtual disk

/d Deletes the drive mapping to a virtual disk drive volume
/f Forcibly deletes the mapping to a virtual disk drive volume
/? Displays VMware mount information

Using the DiskMount utility is fairly simple. The following are examples of how to parse the command
syntax at the Windows CLI:

 To view mount virtual disks: vmware-mount
¢ To mount a virtual disk: vimware-mount R: "C:\My Virtual Machines\myvirtualdisk.vmdk"

* To mount a second volume on a virtual disk: vmware-mount /v:2 R: "C:\My Virtual
Machines\myvirtualdisk.vmdk"

¢ To dismount virtual disks: vmware-mount R: /d
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Caution |If you fail to dismount virtual disks after using the DiskMount utility, guest virtual machines
won'’t be able to gain access to their disks.

Installing VMware Workstation for Linux

To get the most out of VMware Workstation for Linux, you should have similar best-practice
minimums available for your host to those listed for Virtual PC. Also, be sure to have X Win-
dows installed. Without X Windows, you won't be able to easily install and manage guest VMs
from the console. If your hardware merely meets but doesn't exceed the manufacturer’s mini-
mum requirements, your guest VMs will appear to freeze under average load. You'll also need
to make sure your version of Linux has the real-time clock function compiled in the kernel
and the port PC-style hardware option (CONFIG_PARPORT PC) loaded as a kernel module.

Caution Whether you're installing from a CD-ROM or a file downloaded from VMware’s Web site, you
need to make sure your file paths are reflected correctly in installation command statements. If you’re
unfamiliar with the Linux CLI, now is a good time to pick up an Apress book on Linux, such as Tuning
and Customizing a Linux System by Daniel L. Morrill (Apress, 2002).

To begin installing Workstation for Linux, go to the CLI and make sure you have root
permissions. If you're in a testing lab, it will be easier if you're logged in as root. In production
environments, you'll need to log in with the account for which the install is intended and then
issue the su - command.

Note If you're upgrading from a previous version, you’ll need to remove the prebuilt modules’ RPM pack-
age by executing rpm -e VMwareWorkstationKernelModules before proceeding with the installation.

You can install VMware Workstation for Linux using RPMs or TAR files. Choose the
method that supports your version of Linux. We'll cover both in the following sections,
starting with the RPM method. As a small heads up, sometimes the configuration program,
vmware-config.pl, will appear to hang; you can press Q to advance to the next configuration
prompt.
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Installing the RPM

To install the RPM, follow these steps:

1.

10.

11.

12.

If you're installing from a CD-ROM, you'll need to mount it first. At the CLI or in a ter-
minal window, enter this:

mount /dev/cdrom /mnt/cdrom

. Next, you'll need to browse to the installation directory on the CD:

cd /mnt/cdrom

. Now, locate the Linux directory containing the install files:

find /mnt/cdrom -name VMware*.rpm

. Change your present working directory to the location of the RPM file:

cd /mnt/cdrom/<directory name>

. Now, enter the following for the RPM install:

rpm -Uvh /mnt/cdrom/<directory_name>/VMware-<version and build number>.rpm

You should see some hash marks advancing across the screen indicating installation
activity.

. After delivering the package, run the configuration program. You can verify the instal-

lation of the RPM by querying the package management system:

rpm -qa | grep 'VMware'

. The system will respond with the package and version number installed. It should

match the RPM you specified with the rpm -Uvh command in step 5.

. With installation out of the way, you’ll now need to run the configuration program.

Enter the following at the CLI:

vmware-config.pl

. You'll be asked to read the license agreement. You'll need to use the space bar to

advance through the document. Assuming you agree to its terms, type yes and press
the Enter key.

The configuration program will question if a network is required for your VMs. The
default is Yes. If you need networking, simply press the Enter key.

If you have multiple network adapters, the program will ask you which adapter should
be bridged to VMnet0. If you're happy with the default selection, press Enter to continue.

Next, you'll be asked if you'd like to configure any additional bridged networks. No is
the default. Being that you can configure more bridged networks later, accept the
default by pressing the Enter key.
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13.

14.

15.

16.

17.

Next, you'll be asked if NAT networking is necessary. Select the default (Yes) for now by
pressing the Enter key.

The program will then ask to probe for an unused private subnet. The default is Yes. If
you’re happy with the system scanning your network, press the Enter key. The scan can
take a couple of minutes, and upon completion, it will reveal what appears to be avail-
able for use.

The system will query if you'd like to use host-only networking in your VMs. The
default is No. If this is what you want, press the Enter key. However, if you don’t select
Yes now, bridged and host-only networking won't be available to your VMs.

You'll next be asked if you'd like to share the host’s file system with the guest VMs. If
you have Samba already configured, you can select No; otherwise, you'll need to select
Yes to have the configuration program configure it for you. To complete the configura-
tion of Samba, you may be prompted for the username and password of the account
that will use VMware.

The system will take a moment to configure VMware and then start all related services.
The system ends the install by announcing that you can run VMware Workstation by
running /user/bin/vmware. Take a moment to test your configuration. Conversely, if
you want to uninstall the program, issue rpm -e VMwareWorkstation at the CLI.

Installing the TAR

If your OS doesn’'t use RPMs, you'll need to use the TAR installation of VMware for Linux.
Follow these steps:

1.

Before installing the software, create a temporary directory for the installation TAR file:
mkdir /tmp/vmlinux

Next, copy the TAR file to the newly created temporary directory on your hard drive.
Be sure that your file paths correctly reflect the directories on your host system:

cp VMware-<version and build number>.tar.gz /tmp/vmlinux
Next, change to directory where the copied files reside:
cd /tmp/vmlinux

Because the install file is an archive, you'll need to unpack it by issuing the following
command:

tar zxf /tmp/vmlinux/VMware-<version and build number>.tar.gz
Once the decompression is finished, find the installation directory:
find /tmp/vmlinux -name vmware-distrib

Next, navigate to the installation directory:

cd /tmp/vmlinux/vmware-distrib



10.
11.

12.
13.

14.
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. Finally, execute the installation program:

./vmware-install.pl

. You'll be prompted several times during the install. Generally, the defaults are suffi-

cient for most installs save a caveat or two. The first prompt asks you to confirm the
install directory, /usx/bin.

. Next, the install program will ask you the location of the init directories, /etc/rc.d.

You're then prompted for the init scripts directory, /etc/rc.d/init.d.

The install program will then create the installation directory for the library files,
/usr/lib/vmware.

The system will want to create the /usr/share/man directory for the manual files.

Next, you'll be asked to supply the directory for the VMware documentation files,
which is /usr/share/doc/vmware. Press the Enter key to continue with the default. You
may be prompted to confirm the creation of additional parent directories. Assuming
this is okay, press Enter to continue.

Unlike the RPM install, the TAR install asks if you'd like to run the configuration pro-
gram, /user/bin/vmware-config.pl. The default is Yes; press the Enter key to run the
VMware configuration program.

Configuring the TAR version of VMware for Linux installation is identical to that for the
RPM configuration. You'll be asked to read the license agreement, configure networking, set
up VM bridging, set up NAT, and so on. The installation ends the install by announcing you
can run VMware Workstation by running /user/bin/vmware. Take a moment to test your
install. If you have problems, you can uninstall the program and give it another shot.

Regardless of the installation methodology, RPM or TAR, you can run the configuration
program at any time to reconfigure VMware Workstation. You'll also need to run the program
any time you upgrade the Linux kernel or when you want to change the character of Worksta-
tion, such as removing or adding host-only networks. If you run the configuration program
and it doesn’'t work, it’s probably because of a listing issue in the default path statement. You'll
need to check one of three locations depending on your needs. Table 3-2 lists the typical path
directories.

Table 3-2. Path Scripts

User Account Script to Modify

One user $HOME/ .bash_profile
All users except root /etc/profile

Root /root/.bash profile
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You can always run the program by using the absolute path (the installation script’s file-
name including its location starting from the / of the file system, /usr/bin/vmware-config.pl).
After the configuration program has completed configuring your host, be sure to exit from the
root account by using the exit command.

The help system built into VMware Workstation for Linux depends on a Web browser
being accessed from the /usr/bin/netscape directory. If your browser is located elsewhere
(Netscape, Mozilla, or otherwise), be sure to create a symbolic link to it at that location (for
example, In -s <browser path> /usr/bin/netscape).

VM Host Tuning Tips

Demands placed on high-load multiprocessor servers are extremely different from the loads
placed on a single-processor notebook. Knowing how to tweak your system to get dramati-
cally better performance is no secret. Many knowledge-base articles, white papers, forum
discussions, and magazine articles are littered all over the World Wide Web regarding perform-
ance tuning. Surf the Web, and see what can help you the most. Please be advised, though:
although you can experience significant performance gains by turning a few software knobs
for your OS, you should test any performance tweak in a test environment first. You're better
off having a slow server than no server; therefore, thoroughly test all your system changes in
the lab first.

The tuning tips in this section cover hardware, Linux OSs, and Microsoft OSs. These tips
will give you a general idea of where you can begin to start squeezing horsepower out of your
hosts for the benefit of guest VMs. Some of these tips are common sense; not all will apply to
you, but the following tips will get you into the mind-set that a custom install can be a whole
lot better than the default configurations that manufacturers offer you:

¢ Download and install the latest BIOS for your host hardware.
¢ Delete existing partitions, including manufacturer support partitions.

e Create one large host system partition and format using modern partition types—
NTES, ReiserFS, EXT3, or XFS.

¢ Install a better host OS: Windows XP or Windows 2003/Red Hat Workstation or
Advanced Server.

e Install updated manufacturer drivers, and stay current with new versions.

* Install current service release, hotfixes, and security patches (including antivirus).
* Review, stop, and remove any unneeded services.

* Upgrade to Gigabit Ethernet, and team multiple network adapters.

* Perform a clean operating system install from scratch; don't install unneeded packages
or applications.

¢ Stop unneeded applications from initializing by removing them from startup or dese-
lecting them during the setup.
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* Religiously remove temporary files and spyware; eliminate command/Web histories
and file caches.

* Remove unnecessary networking protocols, and change the protocol binding order as
necessary.

* Remove unused TTY virtual consoles from /etc/inittab.
* Performance-tune your hard drive with defrag or hdparm.

* Compile a custom kernel.

Though most of the tuning tips in this section can be used across many of Microsoft’s OSs,
we'll specifically address Windows XP because of its ubiquity. This section contains a basic per-
formance recipe specifically geared to give you the most bang for the time you spend wrenching
on your OS. Before moving ahead, start with a fresh install of Windows XP, and before tweaking
any machine in a production environment, always test your performance changes in the lab
first. This section touches on some knob turning and switch flipping you can do to optimize an
operating system. The Internet also has many reputable sites and forums where you can find
valuable tuning information.

Windows Update: Use Microsoft Windows Update to ensure your computer is patched
with the latest service and security releases and any critical hotfixes. You may need to run
Windows Update several times, and you may need a few reboots as well.

Hardware updates: With the operating system taken care of, you can look to your com-
puter’s hardware. If your computer is produced by a major manufacturer, such as Dell or
Hewlett-Packard, you can download updates from their support Web sites. If you're your
own master, you can download updated adapters and motherboard drivers from compo-
nent manufacturer Web sites, such as Intel, 3Com, Creative, and Nvidia. Device Manager
will list the components installed in your computer and is a good place to begin figuring
out what hardware needs updating. You may have to crack your system case open to get
chipset identification numbers. If you can’t find the manufacturer of your devices, use a
good search engine for help, such as Google.

Desktop settings: If you have an extra pretty desktop, you'll need to do with less to get the
last bit of performance from your computer. Each time Windows boots, it keeps the back-
ground in memory, and you can kiss those resources goodbye. Go with a black background.
(it’s really easier on the eyes) or limit yourself to a small tiled picture—one that’s nearer to 0
kilobytes (KB) than 1KB. If you're convinced it's okay to do away with the pictures, select the
Display icon in Control Panel, and follows these steps:

1. From the Themes tab, Select Windows XP Theme.

2. From the Desktop tab, set Background to None and Color to Black.

3. From the Screen Saver tab, select None.

4. Click the Power button, and choose Presentation under Power Schemes.

5. Ensure that the Enable Hibernation setting is disabled on the Hibernation tab.
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6. From the Appearance tab, select Effects. Deselect all the check boxes.
7. From the Settings tab, select a resolution that allows for good guest viewing.

Delete unused applications: Windows XP, like many modern operating systems, suffers
from application bloat. You should uninstall unneeded or useless applications to recover
disk space as well as reduce the amount of things firing off on system boot. The sysoc. inf
file, generally found in the c: \windows\inf directory, is a good place to begin putting XP
on a diet. You'll need to edit it with Notepad. Removing the HIDE option allows previously
unviewable applications to be displayed in the Add/Remove Windows Components utility
in the Control Panel. You can blow away everything you don'’t think you'll need, such as
MSN Explorer, Pinball, and so on. You can always reinstall them later; follow these steps:

1. Select Edit » Replace.
2. In the Find What field, type HIDE, and leave the Replace With field empty.
3. Select Replace AlL

Startup applications: You can do without nearly all the applications next to the system
clock, except antivirus. If you want to get a good idea of how much space these applica-
tions are using, launch Task Manager and look in the Mem Usage column. Add the totals
from instant messengers, CD-burning software, personal information devices, sound and
video card add-ons, and so on. You really don’t need all those applications running, so
create a shortcut to these applications in the System menu and then blow them out of the
registry and the Startup menu. Before editing, be sure to back it up. The registry key you
want to focus on to prevent these applications from starting is HKEY _CURRENT USERS\
Software\Microsoft\Windows\CurrentVersion\Run.

Recycle Bin: The Recycle Bin can needlessly chew up disk space with today’s hard drives
exceeding 300GB. For instance, the default reserved size is 10 percent of the total disk. If
you have a 250GB hard drive, your Recycle Bin will be a whopping 25GB in size! If you're
worried about losing things you delete, you can back up things you think you may need
later to a CD-ROM. Set your Recycle Bin to as close to zero as you're comfortable with, as
in 1-3 percent of the total disk space.

Remote desktop: Because virtualization applications give you remote access to your VMs,
you probably won’t need Remote Desktop Sharing. In addition, if you're your own help
desk, you can go ahead and disable Remote Assistance. To disable these two services,
follow these steps:

1. Right-click the My Computer icon, and select Properties.

2. Select the Remote tab.

3. Deselect the Remote Assistance option and the Remote Desktop option.
4. Click OK to finish.

Windows firewall: In our highly litigious society, manufacturers are trying to idiot-proof
everything. For Microsoft, this means including a bulky firewall. Though most of us will
agree that this is a service that’s long overdue, you can disable the firewall. Before doing
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so, make sure you're aware of the risks involved and you have another firewall (hardware
or software) in place. We don’'t necessarily recommend disabling the firewall and are
intentionally not covering the option to disable it, but you can use the Microsoft Knowl-
edge Base, or you can perform a quick search on a good search engine for assistance.

Disable extraneous services: XP fires up many services on boot to make using the com-
puter a bit easier for novices. If you're a long-time computer user, you may just be too
tired to worry about all the overhead Microsoft throws on a stock operating system. Take
the time to trim a few seconds off your boot time and give your processor more idle time
by stopping unnecessary services. You can view the running services on your computer by
going to the Control Panel and selecting Administrative Tools and then Services. Before
stopping services and setting the Startup Type field to Disabled, you may want to take a
screen shot of your current settings and print it out in case it’s necessary for you to revert
to any previous settings. Assuming you don’t need them, you can safely stop the following
services and set them to Disabled:

o Alerter

¢ Automatic Updates (do manual updates instead)
¢ Background Intelligent Transfer Service
¢ ClipBook

¢ Error Reporting Service

¢ Fast User Switching

¢ Indexing Service

¢ Messenger

* Portable Media Serial Number

e Smart Card

¢ Smart Card Helper

¢ System Restore

¢ Terminal Services

e Themes

¢ Uninterruptible Power Supply

¢ Upload Manager

¢ Volume Shadow Copy

e Web Client

During the process of paring down services, sometimes services fail to stop or hang, leav-
ing a slew of orphaned child processes. You'll find yourself performing triage at the CLI
with the stock Windows net start/stop command and praying you won't have to reboot.
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If this happens, you invariably will have to reboot and start the whole process again.
Rather than using the stock Windows legacy command, get your hands on pulist and
kill.If theyre not installed on your XP system (or other Windows OS), you can download
pulist from the Internet at http://www.microsoft.com/windows2000/techinfo/reskit/
tools/existing/pulist-o.asp or get it off the Windows 2000 Resource Kit. You can
acquire kill from many places, such as from the Windows 2000 Server CD-ROM in the
Support/Tools folder. You may have to use setup.exe to install the tools to get your copy
of kill.exe. After copying both commands to the root of your hard drive, use pulist at
the CLI to view the running process. Find the hanging process, and identify its process ID
(PID). Then type kill —f <process id>.Type pulist again to verify your results.

Assuming the process is still hanging on, you have a couple more choices before a reboot.
You can use the AT command to stop the service: at <time> /interactive cmd /c kill
-t <process id>. Lastly, you can use the Process Viewer (pview.exe) from the Windows
2000 Server CD-ROM to adjust the permissions of the process so that kill will work.
Gaining access to pview.exe is identical to that of the previous kill command.

If you have an application that refuses to quit working after reboot, you can use the
Microsoft Windows 2000 Scripting Guide to create a script at terminate processes. You'll
find the following link to be invaluable in helping suppress unruly applications: http://
www.microsoft.com/resources/documentation/windows/2000/server/scriptguide/en-us/
sas_prc_fgbg.mspx.

Listing 14.14, at that site, can suppress any service that launches. The script loops and will
eat up some processor time; however, it’s good at keeping a wily application under con-
trol. All you need to do is type the script into Notepad and save it with a . vbs extension.
Supply the script with the name of the application executable from Task Manager you
want it to monitor, and when it starts, the script will take care of the rest.

Memory tweaking: You can get added performance out of XP by tweaking the memory.
You'll need to edit your registry, so back it up first. Make only one change at a time to the
system, and then thoroughly test it. You may find that you get negative results. If this is
the case, you can reverse course and undo any changes. You can make three changes

to the registry key HKEY LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session
Manager\Memory Management to squeeze out a bit more performance:

* You can disable the Paging Executive to prevent XP from paging data from RAM to
the hard drive; this tweak keeps the kernel-mode drivers and system code in mem-
ory. Assuming you have a large amount of RAM, greater than 512MB, the net effect
of leaving the data in RAM may yield a performance increase. You'll need to change
the DisablePagingExecutive key value from 0 to 1. This tweak can negatively
impact hardware and is generally reserved for troubleshooting software, such as
debugging drivers. If you run into problems, you'll need to revert the setting to 0.

* You can run the Windows XP kernel in memory to provide a modest performance
boost. You can accomplish this by changing the value of the LargeSystemCache key
from 0 to 1. Windows XP will then allocate all memory, except 4MB, to the kernel.
The 4MB of memory is reserved for disk caching, and Windows XP is capable of
allocating more as needed. This registry tweak allocates memory-to-disk caching
and keeps changed pages resident in memory until available pages drop near 250.
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* You can increase I/0 performance for large file transfers by editing or creating a
REG_DWORD value labeled IoPagelockLimit. In general, a setting equal to 12MB will
find the performance sweet spot. However, you may have to use trial and error.
The value entered for the key needs to be in bytes (1MB = 1,048,576 bytes).

Paging file: For Linux and Windows operating systems, most computer professionals
agree that the paging file should be 1.5-2.5 the size of the physical RAM. Having a larger
paging file will help you to run more VMs under VMware VM applications, but it will do
little for you with Microsoft VM applications. Regardless of the multiple you choose, you
can increase performance by placing the paging file on a separate hard drive and disk
controller. You can optimize the paging file by opening the System icon in Control Panel
and following these steps:

1. In the Performance area, select Settings, and click the Advanced tab.
2. Under Virtual Memory, select Change. Set the paging file on the C drive to 0.

3. Now, select a different hard drive, and set the minimum and maximum sizes to
your calculated choices.

4. As abonus, on the Advanced tab, select Settings from the Performance section.
Select Adjust for Best Performance, and then click OK.

5. Reboot your system after this change.

DLLs: Windows XP generally doesn’t unload DLLs after programs close in order to speed
up subsequent restarts of an application. You can edit the registry key HKEY LOCAL MACHINE\
Software\Microsoft\Windows\CurrentVersion\Explorer and add the DWORD value,
AlwaysUnloadDLL, with a setting of 1 to force DLLs to unload on application close.

File system: Windows XP has the ability to use NTFS partitions. If you're using a FAT-
partitioned or FAT 32-partitioned hard drive, convert it to NTFS. You can convert the file
system on a hard drive by using the convert command at the CLI. If you need help with it,
type convert /2. Don't forget to regularly defragment your hard drive. Whether you use a
direct-attached single drive, an array of RAID disks, or a logical disk on a SAN, defragment
your systems. Don't get caught believing that defragmentation software directly rearranges
disk clusters: it doesn't. Disk defragmentation software defragments logical cluster numbers
(LCNs) stored in a table. It’s possible that the logically contiguous LCNs will be physically
fragmented by the RAID or SAN disk controllers; however, performance is realized because
the file is in the best possible place for physical access, and the file system can access the file
at a single logical location.

Networking: Assuming you have a network adapter with an intelligent processor, you can
offload processor tasks to the network adapter by editing or creating DisableTaskOffload
as a REG_DWORD value in HKEY _LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\
Parameters and setting its value to 0.

Some people may have you believe that performance tuning is a secret black art, but it
really is just the application of experience. The trick to making sure you're building the fastest
and most reliable operating system to host your guest VMs is testing each change before mak-
ing additional changes and clearly documenting all your changes. If you find a secret formula
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that works for your environment and you can’t duplicate your success, you've wasted a lot of
time and effort. Don't fall into the trap of thinking you'll remember what you've done—you
probably won't. The IT field is saturated with so much good information that it's impossible to
keep everything mentally organized: a printed work journal will never let you down when it
comes time to reproduce a system in a disaster.

Summary

In this chapter, we covered installation and optimization techniques for deploying worksta-
tion-class VMs on desktop operating systems, including VMware Workstation and Microsoft
Virtual PC. We gave you general tips for tuning VM hosts and specifically covered how to opti-
mize Windows XP for added performance. In the next chapter, we'll cover installing and
managing virtual machines for workstation-class applications. This will include prestaging,
backing up, and monitoring guest VMs.



CHAPTER 4

Deploying and Managing VMs
on the Desktop

In this chapter, you'll build on your knowledge of desktop virtualization application installa-
tion from the previous chapter and turn to deploying and managing workstation-class guest
VMs. We'll continue to use “how-to recipes” and will cover the basics of backing up VM config-
urations, configuring VMs to run as services, and monitoring VM performance. We'll also give
you a dose of VM command-line administration. If you're looking for the complete treatment
of VM backups, you'll want to refer to Chapter 7 for details.

Deploying VMs with VMware Workstation

Creating VMs for VMware Workstation is a straightforward process and is dramatically simpli-
fied by virtualization software’s well-thought-out wizards. Though you should know what you
want in a VM before creating it, you can always edit the VM after it’s created. We'll go through
the process of creating VMs on Windows and Linux hosts; you can simply skip to the sections
you need. After discussing how to create guest VMs, we'll cover individual hardware options
and show how to migrate guest VMs between host systems.

Note With the introduction of ACE from VMware, you can bring best-practices enterprise-class manage-
ment to end users when deploying VMs. You can roll out standardized computing environments that adhere
to corporate security policies and application management strategies while simplifying support. ACE achieves
its magic by leveraging a VM and the policies you set for it. Visit VMware’s Web site to read more and down-
load a demo copy.

Building a Windows VM is identical to building a Linux VM. To start, launch VMware
Workstation. For Windows host systems, select Start » Programs » VMware » VMware
Workstation, and then select File » New Virtual Machine to launch the New Virtual Machine
Wizard. To launch VMware for Linux, make sure X Windows is started, type vmware in a termi-
nal window, and then select File » New Virtual Machine.
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As with all installs, you should customize the installation options. Wizards are great, but
you want to be in as much control of all installation procedures as possible. To that end, select
Custom as your choice for the initial VM configuration.

You'll be required to select which guest operating system type to install. For the example’s
install, we'll select the first choice, Microsoft Windows. If you want to install a Linux VM,
choose Linux.

From the Version drop-down menu, select the OS you'll be using for the guest VM. As
you've probably noticed, you have one heck of a selection for guest VMs (see Figure 4-1).
Though it’s not listed, you can install DOS 6.22 by selecting Windows 3.1. For the discussion’s
purposes, we'll be configuring Windows 2003 Server. Regardless of what you choose, these
directions will be identical to the choices you'll need to make.

Windows 3.1
Windows 95
Windows 98
Windaows Me
Windaws T
Windaws 2000 Professional
Windaws 2000 Server
Windaws 2000 Advanced Server
Windowz %P Home E dition
Wfindows #P Professional
'W'lnu:h:uws Sewer 2003 wieb Edition
- wer 2 tandard Edition
'W'lnu:h:uws Sewer 20032 Enterprize Edition
Wiindows Small Buziness Server 2003
Longhorm [experimental]

Figure 4-1. VM configuration selection type

You'll now have to select a name for your VM as well as a storage point for the guest VM’s
virtual hard disk. Though you can change the name and move the location of the virtual hard
disk later, it’s important to make wise choices now. First, you don’t want to have to create more
work for yourself than necessary. Second, changes disrupt workflow and don’t always turn out
as predicted. Not to be too didactic, but work smarter and plan your work. If you need to take
a few moments to figure out what to call your system, take the time. If you need to decide on a
virtual disk storage location, take additional time to create necessary directory structures now.

Naming conventions for computer systems should be meaningful. Some network admin-
istrators use cryptic host names in an effort to achieve a greater level of security; however, you
don’t get much security through obscurity. (Fingerprinting the TCP/IP stack of a host will
pretty much tell anyone what they want to know anyway!) Conversely, you don’t want to give
out more information in a host name than necessary. A host name should have enough infor-
mation to help you manage your systems. For example, naming computers after trees or
planets might not be helpful if you're dealing with many systems or working late in a disaster
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situation. Many corporations name systems after an office’s physical location and include
some type of IP addressing scheme information. For instance, a host might be named
LAXVM2K10, where LAX stands for the Los Angles office location and VM2K stands for a Win-
dows 2000 VM. The last two digits, 10, represent the subnet ID. The Web has plenty of opinions
and good tips on naming conventions. In the end, settle on something other than chaos, and
stick to it.

As you can see in Figure 4-2, the guest VM for this example is named vmw2k3-1. We also
created a separate storage directory for this VM, D:\VirtualMachines\vmw2k3-1. For Linux
systems, adjust your pathing constraints as necessary (for example, /root/VirtualMachines/
vmw2k3-1). As you probably already noticed, this isn’'t the default directory. Remember from
the discussions in previous chapters that you don’t want the host OS and guest VMs to use
the same hard disks or same controllers. In this example, we're using the secondary SATA
controller and an additional hard drive to increase VM performance. If you're in a lab or edu-
cational environment and don’t have access to expanded resources, simply use the default
directory—just create a custom directory for each guest VM. It makes management so much
easier by having all the files for each VM stored in one place. Once you're satisfied with your
naming conventions, continue with the install.

New ¥irtual Machine Wizard

Hame the ¥irtual Machine
YW'hat name would pou ke to usge for this situal machine?

r Wirtual machine name
Ivmw2k3-‘|

- Location

ID:WirtuaI t achines w2l 31 Browse... |

< Back I Heut » I Cancel

Figure 4-2. VM name and storage directory
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The wizard will recommend the amount of RAM to use for the guest VM. Notice that in
Figure 4-3, the wizard reveals the minimum, recommended, and maximum amount of RAM
to use for the guest. These are merely recommendations. You should perform a bit of research
to determine the amount of RAM your guest OS requires. In lab and learning situations where
RAM is limited, feel free to throttle memory back. In production environments, be sure to
allocate as much RAM as you'd normally provide for a system. As depicted in Figure 4-3, our
example will use 256 MB of RAM. Select Next to continue.

New ¥irtual Machine Wizard

Memory for the ¥irtual Machine
Howw much mernany would you ke to use for thiz situal machine?

r bemory

Specify the amaount of memory allocated ta this virtual machine. The memary size
muzt be a multiple of 4 MB.

Memary for thiz wirtual machine:

| =1
i i 296 = MB
YRR i 1024
A Guest 05 recommended minimum 128ME
& Recommended memon ZHEME
& Maximum for best performance 412ME

< Back I MHext > I Cancel

Figure 4-3. VM memory allocation

You'll now be required to select the type of networking you want to make available to your
VM. If you want to hook up your guest VM as quickly as possible to your test or production
network, select Use Bridged Networking. If you want this guest VM to be in a private network,
select Use Host-Only Networking. Choosing NAT will grant you the ability to have a private
VM network that has access to your production LAN: this is a one-way relationship. As shown
in Figure 4-4, we'll use the default of bridged networking.

You'll now have to select which I/0 adapter type to use in your guest VM. An easy way out
is to use the BusLogic default. However, you'll get a little better performance from the LSI
Logic option. As a word of caution, you'll need to have the driver available for when you install
the actual operating system on the guest VM.
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Tip It's a good idea to download the LSI Logic driver for your VMware guest VMs. It’s well worth the effort.
Additionally, you’ll want to copy the driver to a floppy disk and make an ISO image of the disk. You can then
mount the image as if it were a physical floppy drive and have it available during the guest 0S install. You
can download ISO image-making software, such as MagiclSO from http://www.magiciso.comor
Undisker from http://www.undiskexr.com, on the Internet for a trial period.

New ¥irtual Machine Wizard

Hetwork Type
What type of network do you want to add?

— Metwark connection
&

Give the guest operating system direct access to an external Ethernet networl,
The guest must have itz own P addrezs on the extermal netwark.

™ Use network, address translation [NAT]

Give the guest operating system access to the host computer's dial-up or
external Ethernet netwark connection using the host's |P address.

™ Use host-only networking
Connect the guest operating zwstem to a private virtual network, on the host
cormpuker,

" Do mot use & network. connection

< Back I Meut » I Cancel

Figure 4-4. Network type

Because we don’t want our workstation to mount a physical disk in this example, we’ll
use the default disk type selection of Create a New Virtual Disk. Now, you need to decide
which type of disk to use with your VM. You have the option of using a virtual IDE or SCSI disk
despite the physical medium in the host. Virtual IDE is limited to two devices per channel,
and virtual SCSI is limited to seven. For this example, we’ll choose SCSI.

On the Specify Disk Capacity screen, you'll need to decide the total maximum amount of
space to be used by the guest VM. You'll also need to decide if you want the disk to be dynami-
cally expanding, which is the default, or fixed. Fixed disks have the space allocated up front,
and the space will always be available to the guest. Dynamic disks expand as necessary. This
means the disks will grow to the maximum size specified.
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You'll get better performance with fixed disks because dynamic disks tend to fragment
your hard drive. If you're in an educational or lab environment, dynamically expanding disks
tend to work well. For production environments, you'll want to stay with fixed disks. Because
our example is geared around a Windows 2003 Server and our test system has sufficient disk
space, we'll select the option Allocate All Disk Space Now.

As for how many gigabytes to use for the system disk, this is really a matter of preference
and experiential knowledge. In the NT days, 4GB was sufficient. Today, with the code bloat
involved with Windows 2000 and 2003, you'll find you’'ll want a disk with 8GB or even 12GB
reserved for the virtual hard disk. The value of having ample space is that you can copy the
1386 directory from the Windows CD, service packs, and drivers to the hard drive for future
use. Having plenty of room also allows you to keep log files longer.

Caution You have the option to split virtual disks into 2GB files. If your host’s operating system doesn’t
support files larger than 2GB, like EXT or VFAT, you’ll need to select this option during virtual disk creation.
For some Linux operating systems, the wizard will autoselect the Split Disk into 2GB Files option.

If you choose to preallocate space for your guest’s virtual disk up front, the system will
inform you that it will take a moment to create the disk. You'll be informed that the system
may appear to hang, so be patient during virtual disk creation.

The wizard will prompt you for the name of the virtual disk and the location where you'd
like to have it stored. Choose the same location and naming convention you established ear-
lier in the VM creation process. In our example, we used vimw2k3-1 as the name of the server,
so we'll also use it for the name of our virtual disk. Click the Browse button to specify the
destination directory for the virtual disk. For this example, our destination directory is
D:\VirtualMachines\vmw2k3-1\vmw2k3-1. For Linux, your path will look similar to /root/
VirtualMachines/vmw2k3-1/vmw2k3-1. When it comes time to service your VMs, you'll be
glad that all files related to any specific VM are in one folder.

Take a moment to click the Advanced button and explore these options. On this screen,
you can specify the virtual disk’s device node and the disk mode (see Figure 4-5). When using
virtual SCSI disks, the wizard creates the virtual machine with one SCSI device, 0. The virtual
disk in our example is the first hard disk, 0. You can select the virtual disk mode from the
Mode section. You can set the disk to Independent Persistent or Independent Nonpersistent.
If you want to easily use snapshots, leave the default disk mode as a persistent disk. Click
Back to continue, and then click Finish.

To help you better understand nodes, take a moment to look at Figure 4-6: this is what
the Specify Advanced Options screen looks like for virtual IDE disks. Notice it shows only four
nodes. You know that VMs support a maximum of two devices on each virtual IDE controller.
In Figure 4-6, the virtual disk is bound to the first controller, 0, and is the first device on that
controller, 0. The virtual CD-ROM drive is on the second virtual controller, 1, and is the first
device on that controller, 0.

VMware will present you with a progress indication during the creation process. Depend-
ing on the host’s hardware, it will take five to ten minutes to create an 8GB virtual disk.
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MNew ¥irtual Machine Wizard
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Figure 4-5. SCSI virtual disk advanced options
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Figure 4-6. IDE virtual disk advanced options
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When the disk creation process is complete, you'll be returned to the Workstation Man-
agement User Interface (MUI). Notice in Figure 4-7 that our newly created VM appears in the
left column under the Favorites heading. Favorites are merely shortcuts to your VMs.

B vmwzk3-1 - ¥™ware Workstation

| Ele Edt Wew WM Power Snapshat  Windows  Helb

’T mnpr & |B§1wshut Ereet ”EE‘

e T ]
(e =B
vmw2k3-1
Stake: Fawered aff
Guest 05 windows Server 2003 Stardard Ediion
Configuration file: CiiWirtuzl Machines|arwzk3- LisinietStandard v
Version: Curveni irtual machine for Wihvare Workstadon 4.5.2
Commands Devices
P Start this virtual machine B Memary 256 1B
& Edtvrtuzl machne setings S Hard Disk 1 (SCSL 0:0)
[23C0-Rom 1 (I0E 1:0) fuko detect
EBnicy Eridged
@ usE canaler Frasart
© o Default adapter

Notes

Type here to enter notes For this virtbual mackine

Figure 4-7. Newly created VM with virtual devices

Before powering on your new virtual machine, take a moment to look at the VM'’s hard-
ware settings using the Configuration Editor by selecting Edit Virtual Machine Settings.

Installing VM Tools

After installing an operating system on your guest VM, you'll want to install VMware Tools.
The VMware Tools package supplies significant enhancements to a VM and provides extra
functionality between a guest VM and the host system. For instance, adding VMware Tools
facilitates drag-and-drop support between a guest and the host, increases graphics perform-
ance with an optimized video driver, supports time synchronization between guests and the
host, and supports seamless mouse transitions between guest VMs and the host system.
VMware Tools is available for you to install by using ISO images compiled in VMware Work-
station, and it supports a gamut of Microsoft Windows OSs, from Windows 9x through Windows
2003, as well as many Linux distributions. As a technical note, during the installation process,
VMware Workstation temporarily mounts the ISO files as the guest’s first CD-ROM drive.
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VMware Tools for Windows

In the example that follows, we’ll install VMware Tools on a Windows XP guest VM. To initiate
the installation of VMware Tools for Windows, start by selecting VM » Install VMware Tools
from Workstation’s console menu. You'll be presented with a preinstallation pop-up menu
informing you that the VM to receive the tools must be running.

On the Setup Type selection screen, select Custom as your install choice. As a rule of
thumb, you really never want an application to automatically make choices for you. Even if
you opt for the defaults during a custom install, you'll be aware of the installation points and
the services to be loaded in case you need to troubleshoot any problems.

The Custom Setup configuration screen, shown in Figure 4-8, has three main options:
Toolbox, VMware Device Drivers, and Shared Folders. If you take a moment to click each
option, the Feature Description area will display some details about the option selected.
Briefly stated, though, the Toolbox feature improves the usability of a VM by using a group
of utilities; the VMware Device Drivers option installs performance-enhancing drivers for the
virtual video, mouse, SCSI, and network adapters; and the Shared Folders option facilitates
the sharing of files between the guest VM and the host. If this is your first installation, install
all the drivers; you'll want to experiment with each. If you're not satisfied with the installation
destination of the tools, click the Change button to select a different destination directory.
When you're done, select Next to continue.

% VMware Tools

Click on an icon in the lisk below to change how a Feature is installed.

Feature Descripkion

Ltilities to improve the
Furckionality af this irtual

SVGA Driver machinge.

Mouse Driver

251 Driver
: WMHNet MIC Driver This feature requires 471 1KE on
... =2 = | shared Folders wour hard drive.

Install to:

C:WProgram FilestyMwarehyMware Toolsh

[ Help ] [ Space ] [ < Back JL Mext = J [ Cancel ]

Figure 4-8. Custom setup configuration

93



94

CHAPTER 4 I/ DEPLOYING AND MANAGING VMs ON THE DESKTOP

The last step to install VMware Tools is to click Install on the Ready to Install screen. If you
doubt any selections you previously made, take a moment to review your choices by clicking
the Back button (and then click Install to begin the installation).

The wizard will take a moment to deliver the software packages, and during the delivery
process you'll receive several alerts, as shown in Figure 4-9. The alerts state that the VMware
Tools drivers haven't passed Windows Logo testing. This is okay, so select Continue Anyway on
each of the driver alerts. You'll also notice that some of the drivers, such as the mouse driver,
activate during the install. You can seamlessly move your mouse between the guest and host
windows. After completing the install, be sure to reboot the VM.

Hardware Installation

) L ": The software you are installing for thiz hardware:
Whdware SWGEA (]

has not pazsed Windows Logo testing to werify its compatibility
with Windows 2P, [Tell me why thiz testing is important. )

Continuing your installation of thiz software may impair
or destabilize the commect operation of your spstem
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
paszed Windows Logo testing.

[ Continue Anyray ] |l STOP Installation I|

Figure 4-9. Windows driver alert

If you don’t have VMware Tools installed, you'll have to press Ctrl+Alt to release the focus
of the mouse from the guest VM and return focus to the host system. The mouse will also
underperform in that it will appear to move erratically. Without the video driver, the guest’s
display will have limited resolution capabilities, and the SCSI drivers simply add better per-
formance characteristics for attached virtual devices. With the tools installed, take a moment
to optimize the performance of Windows XP by referring to Chapter 3.

Tip With virtualization application technology storming the IT front, you’ll want to read every possible
source of information you can. VMware’s online documentation and community forums are an excellent
place to get valuable information about configuring guest VMs. For instance, you can find detailed informa-
tion on installing VMware Tools for each Windows OS at http://www.vmware.com/support/ws45/doc/
new_guest tools ws.html.
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VMware Tools for Linux

The VMware Tools package for Linux is built into VMware Workstation and includes all the
same great benefits and ease of installation as Windows Tools. You don’t need to download any
additional software or use physical media. The easiest way to install the tools is to log into the
VM as the root user. If you don't, you'll need to invoke the su command with a typical user
account. Keep in mind that the example code that follows may not work with your particular
distribution; therefore, make adjustments as necessary.

To begin the installation, power on the guest VM to receive the packages in text mode; the
tools can'’t be installed if X Windows is running. After the guest VM has completely booted and
you've completed the login process, select File » Install VMware Tools from the Workstation
console menu.

You'll now need to mount the virtual CD-ROM and then extract the installer files. Before
installing the tools, you should also umount the CD-ROM, like so:

mount /dev/cdrom /mnt/cdrom

cd /tmp

tar zxf /mnt/vmware-linux-tools.tar.gz
umount /mnt/cdrom

You execute the installer by changing to the package delivery directory and executing a
Perl script, like so:

cd vmware-tools-distrib
./vmware-install.pl

Initiate the Linux GUI, and open a terminal session, where you can start the VMware
Tools background application:

vmware-toolbox &

If you want the tools to start automatically when the GUT initializes, add the vimware-toolbox
& command to your system’s startup programs. If after adding the tools your guest VM becomes
unstable, you can remove the tools by executing vmware-uninstall-tools.pl with root privileges.

VMware Virtual Hardware Options for Windows and Linux

Like physical computers, VMs have an array of peripheral options you can install or remove.
Additionally, you can even configure the BIOS of your VM after you power it on. To get the best
possible performance out of your guest VM, be frugal with your system’s resources. For instance,
do you need an audio device or USB device in a server? By paring down the devices in your VM
and disabling components in the BIOS, you can really start to ratchet up performance.

Removing devices from a VM is straightforward. Open the MUI, and select Edit Virtual
Machine Settings. Highlight the device to be removed, and then select Remove.

In Figure 4-10, our example VM has a USB and an audio device installed. We have no real
need for the devices, so we simply highlight each device, and select Remove. Once the device
is removed, it won't be available to the VM’s operating system. If at any time you need a device,
simply power off the VM and add the device.
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Figure 4-10. Virtual machine hardware settings

If the server you're building is lacking hardware, such as an additional virtual NIC or virtual
CD-ROM drive, you can add the components by clicking the Add button. Because VMs are
capable of connecting to ISO images as virtual CD-ROMs (or floppy drives), you may find it
useful to add a second virtual CD-ROM drive to your system. Before adding a second CD-ROM
device to this VM example, look at the Add Hardware Wizard that’s presented after clicking the
Add button. On the Add Hardware Wizard greeting screen, select Add to continue.

The Hardware Type selection screen, shown in Figure 4-11, presents you with VMware vir-
tual hardware options. You have the ability to add many virtual devices, including hard disks,
DVD/CD-ROM drives, Ethernet adapters, and serial ports. If this is your first time creating a
VM or adding hardware to an existing VM, take a moment to add one of each device to a VM
to get a feel for the process and to see what options are available to you.

Going through each device in the wizard may seem like overkill, and it will be tiresome
for some. However, we want to cover the options that may not be apparent. We'll discuss the
major points of each hardware option and show relevant figures. Additionally, you can skip to
the section you need for information on adding a particular device.
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Add Hardware Wizard

Hardware Type
What twpe of hardware do pou want to install?
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Figure 4-11. Hardware type selection

Hard Disk

When you add a hard disk using the Add Hardware Wizard, you'll get three choices: Create

a New Virtual Disk, Use an Existing Virtual Disk, and Use a Physical Disk. Adding a new hard
disk to an existing VM is virtually identical to the process of preparing a drive while creating a
guest VM. If you're creating a VM to connect to an existing virtual hard disk, simply browse to
the location of the preexisting virtual disk. Remember that virtual disks will end with a *.vmdk
extension.

Using a physical disk for a VM is really the only tricky option. Generally, using physical
disks should be left to advanced users. Conversely, you'll never become an advanced user if
you don'’t try to use physical disks. To that end, don't let the warning in Figure 4-12 scare you
away from the performance benefits of using physical disks for your VMs.

WARNIMG: Uze of this feature is for advanced users only and may cause loss of data or
inahility to boat, particulary when this raw disk partition iz used az the boot device. Only
lirmited support iz available for this feature.

Far the most curent documentation, pleaze see http: /Aaa, wrweare. com/info?id=15 and
click the link "lhztaling an Operating Syztem onto a Baw Partition from a irtual

Machine."

Figure 4-12. Physical disk usage warning
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On the physical disk selection screen, you'll need to choose between using a whole disk
and using a partition of one. If you choose to use the entire disk, you'll be asked to provide a
virtual disk filename that will store the partition access configuration information. Remember
to make any necessary directories to house the file, and be sure the filename is meaningful.

If you elect to use a physical partition, you'll be presented with a Select Physical Disk
Partitions screen. You'll need to select which partition on the physical disk will be used.

Tip If you find you have plenty of space on a single partition hard drive and wish you had partitions avail-
able for guest VMs, you can repartition an existing hard drive without losing your data using third-party
repartitioning utilities. Norton PartitionMagic is an excellent product to aid you in repartitioning a Windows
system. You can learn more about PartitionMagic at http://www.symantec.com/partitionmagic.

Remember to make necessary directory name and filename changes for the new virtual
disk. As always, make sure your naming conventions are consistent and meaningful. If you
need to configure the virtual disk to be independent, click the Advanced button during the
creation process on the Specify Disk File screen.

DVD/CD-ROM Drive

When adding a DVD/CD-ROM drive to your guest VM using the Add Hardware Wizard,

you have the option of using a physical device or a software image, as noted in Figure 4-13.
VMware Workstation has the ability to autodetect a physical device, or you can specify a
device. Additionally, you can employ legacy emulation by clicking the Advanced button on
the physical drive selection screen. If you use an ISO image, you'll need to specify the location
of the ISO file. Like virtual disks, you can specify the device node by clicking the Advanced
button on the Choose an ISO Image screen.

Add Hardware Wizard x|
Select a Drive Connection o
‘What media should the vitual diive access?
— CD-ROMADVD
Lol

Chooze thiz option to give the guest access to a CO-ROM or DVD on the host.

" Uze 50 image

A0 |50 image iz a file on the host that stores data in the same format as a
physzical CO-RORM.

< Back I et > I Cancel

Figure 4-13. DVD/CD-ROM drive connection
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Floppy Drive

Creating a virtual floppy drive is similar to creating a virtual disk. The wizard will present
you with three options: Use a Physical Floppy Drive, Use a Floppy Image, and Create a Blank
Floppy Image. There’s no real trick to using any of the three options. You just need to decide
what’s going to suit your needs and then decide if the guest VM will connect to the VM when
powering on. Using floppy images is a great way to keep from having to use sneakernet.

Ethernet Adapter

Adding Ethernet adapters to a VM will also require you to select the network connection type
to be used. You have four available options: Bridged, NAT, Host-Only, and Custom. If you're
unsure of which type to use, please refer to Chapter 2 where each network type is discussed
in detail. When you're done making your choices, select Finish to complete the process.

Sound Adapter

When adding a sound adapter to your guest VM, the only real issue you'll need to be con-
cerned with is if you have more than one sound adapter installed. If this is the case, you'll
want to specify the sound adapter by selecting it from the drop-down list under the Connec-
tion heading (see Figure 4-14).

Add Hardware Wizard |

Sound o
What kind of sound suppart would you like?

- Connection

" Use default sound adapter
% Specify sound adapter:

| Soundiax Digital Audia

- Device status

¥ Connect at power on

< Back I Finish I Cancel

Figure 4-14. Sound adapter installation

USB Controller

Adding USB support requires you to decide if you want the guest VM to automatically attach
to a USB device when it has focus on the host. If you desire this behavior, check the box under
Device Status. Select Finish to complete the install.
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Serial Port

Creating a serial port for a VM affords you the ability not only to have access to the host’s
physical serial port but also to have the ability to output information either to a file or to a
named pipe. You'll have three options: Use Physical Serial Port on the Host, Output to File,
and Output to Named Pipe.

If you elect to create a virtual port mapping to the host’s physical port, you'll need to
select which COM port you want to connect to using a drop-down menu. If you decide to send
the information of a virtual COM port to a file, you'll need to specify the filename and storage
location. The named pipes option, as shown in Figure 4-15, asks you to further configure the
relationship of the named pipe. The named pipes setting allows you to directly connect two
VMs; in addition, it allows you to create a connection between an application on the host VM
and the guest VM. It’s important to remember that the pipe name be identical on the client
and server and takes the form of \\.\pipe\<pipe name>. After making your choices, select
Finish to complete the install.

Add Hardware Wizard j x|

Specify Hamed Pipe
Wwhich named pipe should thiz serial port connect ta?

~Mamed pipe

IThis end iz the server. j
IThe other end iz a virtual machine. j
rDevice status

[V Connect at pOWEr Or

Advanced x> |
< Back I Finizh I Cancel |

Figure 4-15. Serial port named pipe configuration

Parallel Port

Adding a parallel port to a guest VM is similar to adding a serial port. You'll need to select
whether you want to use the host’s physical port or use VMware’s ability to write to a file. If
you have multiple parallel ports, the wizard will allow you to specify which port you want to
use. If the new virtual parallel port is to write to a file, you'll need to select the appropriate file
output destination.
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Generic SCSI Device

As shown in Figure 4-16, when adding a generic SCSI device to a guest VM, you'll need to
select the physical SCSI device to which you want to connect; additionally, you'll also have

to assign a virtual device node to use with the generic SCSI device. You can have the guest VM
connect to the physical device when powering on. To do this, select the Connect at Power On
option under Device Status.

Add Hardware Wizard '_ x|

Choosze 5C51 Device o
Which of the present SCSI devices would you like to add?

— Connection
Specify the physical SCS1 device to connect to

{ CaRom0 [

— Device statuzs

V¥ Connect at pOWET OF

—Yirtual device node

< Back I Finizh I Cancel

Figure 4-16. Generic SCSI device configuration

Note When editing a VM to add or remove virtual devices, be sure to click the OK button on the Virtual
Machine Settings dialog box. If you don’t, your settings will often not take effect.

Microsoft Virtual PC: Building a Windows VM

Building VMs with Virtual PC is wizard-driven. Select File » New Virtual Machine Wizard to
begin creating a guest VM. After acknowledging the splash screen, you have three options
to choose from on the Options window:

e Create Virtual Machine
» Use Default Settings to Create a Virtual Machine

* Add an Existing Virtual Machine
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The options are relatively self-explanatory and have no real gotchas associated with them.
If you choose to use the default setting to create a guest VM, you'll have to create a virtual hard
disk after the VM creation process has completed. Looking at Figure 4-17, notice that a default
machine has no disk configured for it.

Settings for YPCOL |

Setking | Current Yalue g Hard Disk 1

File Mame VPOl

B Memory 128 MB £+ Hone

L ¥Hard Disk 1 Mone = virtual hard disk File:

g Hard Disk 2 Mone

g Hard Disk 3 Mone

% Undo Disks Disabled EFOWEE .., |
@ COYDWD Drive Secondary conkraller

A Floppy Disk Auko detected To create & new wirkual disk or edit an existing
§ com Mone one, click the Yirtual Disk 'Wizard button,

5 comz Mone Virtual Disk Wizard |

Frm Mone

=L Metworking Metwork adapters: 1

@2. Sound Enabled

':') Mouse Mo poinker integration

Shared Folders Mok installed Hard disk 1 is the virtual machine's startup disk.
g Display Default

@) clase show message

Ok I Cancel

Figure 4-17. Default VM configuration for Virtual PC VM

During the creation process, at the Virtual Machine Name and Location prompt, you'll be
asked to supply a name for the VM and a location to store its files. You should create a separate
directory for every VM and name the directory after the VM is created. By keeping all the files
labeled with the VM’s name and in a separate directory, it’s easier to manage guests later.

On the Operating System screen, shown in Figure 4-18, simply select the guest operating
system you want to install from the drop-down list. All listed systems will be Microsoft
branded. If you're installing an OS not officially supported by Microsoft, select Other.

The Memory selection window, shown in Figure 4-19, offers a recommended amount of
RAM based on the OS chosen. Select Adjust to change your RAM requirements as necessary.
Make sure you adhere to best practices when creating production VMs. In lab environments,
you can slide by on minimum memory requirements for the guest OS.
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Figure 4-18. OS selection

New ¥irtual Machine Wizard

Memory
ou can configure the RAM on this virtual machine,

Figure 4-19. VM memory selection
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The Virtual Hard Disk Options screen and Virtual Hard Disk Location screen (shown in
Figure 4-20) allow you to choose between using an existing virtual hard disk and creating a
new one. If you're restoring a VM or using a copy of an existing disk, choose Existing; other-
wise, select New Virtual Hard Disk. When it comes time to specify the storage point of the VM,
be sure to create a unique directory named after the guest VM and name the virtual hard disk
after the VM. Having all the files of a VM in one location makes administration significantly
easier.

As shown in Figure 4-21, the wizard will finish the process by presenting you with a
summary window. Verify that all selections were registered correctly before completing the
process. Your VM should be viewable in the console; you can further configure the VM’s virtual
hardware by selecting Settings.

New ¥irtual Machine Wizard :

Virtual Hard Disk Location —4
This wizard creates a dynamically expanding virtual hard disk with a default size. E

Type a name for the new virtual hard disk, Unless you specify a different location, the
wirbual hard disk File will automatically be saved in the same location as the virtual
machine configuration file,

Mame and location:

I iles1iusersiehalteriiy Yirtual MachinesiYPCO3WPC03 Hard Disk,vhd Browse. .. I

To learn more abaut the different types of virtual hard disks, see Virtual PC Help, For
advanced virtual hard disk options, use the Virtual Disk Wizard,

< Back Mest » Cancel

Figure 4-20. Virtual hard disk location
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Completing the New Virtual Machine
ﬁ Wizard
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Wizard, Your virtual machine will be created with the
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Yirbual hard disk:  ¥PCO3 Hard Disk,vhd

Ta close the wizard and create this virtual machine, click
Finish.

Cancel

< Back

Figure 4-21. Completing the wizard
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Microsoft Virtual PC: Building a Linux VM

We realize that Microsoft doesn't officially support Linux operating systems as guest VMs on
Virtual PC, but you may find yourself in a test or an educational environment with the need to
have Linux running on Virtual PC. Virtual PC has the wherewithal to run many operating sys-
tems: it’s just that many operating systems are out of the scope of Microsoft’s support services.
If you find you want to run unsupported operating systems, just remember you'll be the first
line of support, and the Internet will be your next best friend. More important, Microsoft
dropped PC Additions for Linux operating systems after purchasing Virtual PC from Connec-
trix; therefore, you'll have to do without the convenience factors and performance benefits it
offered.

Just like building Windows VMs, building Linux VMs with Virtual PC is wizard-driven. Rather
than repeating a bunch of figures from the previous section, we’ll include only the ones impor-
tant to Linux. To begin, select File » New Virtual Machine Wizard. After acknowledging the
splash screen, you have three options to choose from on the Options window:

e Create Virtual Machine
* Use Default Settings to Create a Virtual Machine

* Add an Existing Virtual Machine

The options for Virtual PC are relatively self-explanatory. If you choose to use the default
setting to create a guest VM, you'll have to create a virtual hard disk after the VM creation
process has completed. During the creation process, at the Virtual Machine Name and Loca-
tion prompt, you'll be asked to supply a name for the VM and a location to store its files. You
should create a separate directory for every VM and name the directory after the VM being
created. By keeping all the files labeled with the VM’s name and in a separate directory, it’s
easier to manage guests later.

On the Operating System screen, select Other for the guest operating system from the
drop-down list. The Memory selection window offers a recommended amount of RAM based
on the OS chosen. Select Adjust to change your RAM requirements as necessary. Make sure
you adhere to best practices when creating production VMs. In lab environments, you can
squeak by on minimum memory requirements for the guest OS.

The Virtual Hard Disk Options and Location screens allow you to choose between using
an existing virtual hard disk and creating a new one. If you're restoring a VM or using a copy of
an existing disk, choose Existing; otherwise, select New Virtual Hard Disk. When it comes time
to specify the storage point of the VM, be sure to create a unique directory named after the
guest VM and name the virtual hard disk after the VM. Having all the files of aVM in one loca-
tion makes administration significantly easier. The wizard will finish the process by presenting
you with a summary window. Verify that all selections were registered correctly before com-
pleting the process.

When you go to install the Linux operating system on the guest VM, you'll have to con-
tend with several issues, including video, time synchronization, and sound. When it comes
to the point in the install process to configure X Windows, be sure that the S3 Trio64 card is
selected and the memory requirement is set to 8MB. The reason you want to set these values
as mentioned is because these are the virtual devices made available to the guest VM. In addi-
tion, stick with 8-bit or 16-bit video. Many Linux distributions have difficulty running in 24-bit
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mode. Because the time won't synchronize properly from the host system to the Linux guest
VM, you’ll have to rely on NTP; we'll cover using your host as a time source in Chapter 8. For
installation details on NTP you'll need to reference your distribution’s documentation. How-
ever, if you're using recently released Red Hat products, you can configure NTP by selecting
System » Date/Time Properties. From the application window, select the Enable Network
Time Protocol option, and enter the IP address of the server you want to use. If you don't
require sound for your VM, you're best off not enabling it for the VM; however, if you want to
configure it, you'll want to configure Linux to use the SoundBlaster SB16 sound card. In a ter-
minal window, execute the sndconfig sound configuration utility. If the utility fails to detect
the virtual sound card, you'll need to supply hardware configuration parameters to it during
the manual configuration process on the Card Settings screen. Specify the following values:

¢ I/0 Port: 0x220
e TRQ:5
e DMA1:1

e DMA2:5

MPU 1/0: 0x330

Virtual PC Virtual Hardware Options

Virtual PC offers an extensive array of virtual hardware options that you can add to leverage
the functionality of a VM or that you can remove to increase performance. Whatever your
needs may be, you can access hardware options by selecting Settings from the application
console. You can get a good idea of how each option is configured for a particular VM by
checking its *.vmc file before and after any deletions or additions. If you have any question
as to what a particular item in the Settings dialog box does, Microsoft provides a brief and
informative explanation in the lower-right corner of the application window.

File Name

The File Name option provides you with the ability to rename the virtual machine. It doesn’t
modify the names of the original installation directory or the VM’s virtual hard disk; however,
it does rename the configuration file.

Memory

The Memory option allows you to increase or decrease the amount of available RAM by using
a slide control or by entering the memory size. You can make adjustments in 1MB chunks.

Hard Disk (1-3)

You can enable or disable up to three virtual hard disks for any given VM. You have the option of
specifying an existing virtual disk or creating one with the assistance of the Virtual Disk Wizard.
If you're creating a disk with the wizard, be sure to adhere to good naming conventions.
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Undo Disks

Undo Disks is an option that can be enabled; it allows you to commit or discard changes to a
VM after you're done using it. You can delete, commit, or save the changes for the next time
you use the VM. Undo disks are great for being able to preserve the state of a VM, but they do
require additional disk space.

CD/DVD Drive

The CD/DVD Drive option connects to the host’s physical drive and is mapped to the guest
VM’s secondary IDE controller by default. If you clear the option box, the virtual CD drive will
be connected to the primary controller of the guest VM.

Floppy Disk

The Floppy Disk option is set by default to detect the host’s physical floppy disk. If you don’t
need access to the physical device, disable it for added performance.

COM Ports

Creating a serial port for a VM affords you the ability to not only have access to the host’s physi-
cal serial port but also to have the ability to output information either to a file or to a named
pipe. If you elect to create a virtual port mapping to the host’s physical port, you'll need to
select which COM port you want to connect to using a drop-down menu. If you decide to send
the information of a virtual COM port to a file, you'll need to specify the name of the file and
the storage location, and the named pipes option requires you to specify the named pipe.

LPT1
LPT1 allows the VM to connect to any of the host’s available physical parallel ports.

Networking

The Networking option contains the settings for the four available network adapters the guest
VM can use. You can elect to use any or all the adapters and set the network connectivity type
as well.

Sound

The Sound option is enabled by default. You can disable it for increased performance and to
eliminate any potential conflicts with applications.

Mouse

The Mouse Pointer Integration option is available only after the installation of Virtual Machine
Additions. Pointer integration is what allows the mouse to flow freely between the guest win-
dow and that of the host.
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Shared Folders

After the installation of Virtual Machine Additions, the Shared Folders feature enables the
guest to access data on the host. You can specify the location by selecting Share Folder.

Display

Like the Shared Folders and Mouse Pointer Integration options, the Display settings can be
used only after the installation of Virtual Machine Additions. The settings in Display allow
you to manipulate resizing characteristics of the guest VM’s window, from full-screen to
windowed. You can also set the visibility of the menu and status bars.

Close

The Close setting controls displaying messages when a guest VM is shut down, turned off, or
placed in a save state. Messages can be useful for troubleshooting purposes, so you may want
to leave them enabled.

Installing Virtual Machine Additions

Microsoft Virtual Machine Additions, available from http://www.microsoft.com/downloads,
increases the performance and flexibility of guest VMs running on Virtual PC and can be used
only after the guest OS is installed. Figure 4-22 shows the installation of Virtual Machine Addi-
tions. You can also programmatically install Virtual Machine Additions using an unattended
mode with setup.exe and its command-line options.

iz Virtual Machine Additions - InstallShield Wizard X]
Welcome to the InstallShield Wizard for
Yirtual Machine Additions
The Installshield{R) Wizard will install Wirtual Machine Additions
on vour computer, To continue, click Mext,
WARMING: This program is protected by copyright law and
international treaties.
13.40
< Back [ mewts [ Cancel

Figure 4-22. Virtual Machine Additions
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Table 4-1 lists the command-line options you can use during an unattended install
when using the setup program. The command should be in this format: setup.exe -s -v"/
gn [Reboot=ReallySuppress]".In addition, you can install the software by activating the
executable from within Windows Explorer and using the wizard.

Note If you move a VM created with Virtual PC to Virtual Server, be sure to reinstall Virtual Machine
Additions. Reinstalling the software ensures that the moved guest VM is using the server version of Virtual
Machine Additions and avoids any conflicts related to versioning.

The enhancements you can expect to experience from installing Virtual Machine Additions
include seamless use of the mouse from the guest window to the host, increased performance,
host-to-guest time synchronization, and optimized video drivers.

Table 4-1. Virtual Machine Additions

Option Action Performed

-s Runs setup program without a GUI
-v Passes options to Msiexec.exe

/gn Runs Msiexec.exe without a GUI
Reboot=ReallySuppress Prevents reboot after installation

Managing VMs

Managing VMs in a production or test environment is no different from in traditional physical
systems; you'll need to continue to adhere to the same best practices you probably already
use, such as backing up, installing antivirus software, monitoring log files, renaming VMs, and
performing routine maintenance. In the following sections, we’ll cover backing up, copying,
and moving VMs. In addition, we’ll show you how to run VMs as services and begin to cover
VM configuration files.

Backing Up and Modifying VM Configurations

Though we thoroughly cover backup strategies for VMs in Chapter 7, we'll briefly introduce
you to backing up VMs and their configuration files. In addition, we’ll cover modifying VM
configuration files.

When you first begin experimenting with VMs, you'll soon realize that at some point it
becomes necessary to rename a guest VM, its configuration file, and its virtual disk file. You'll
generally find yourself in this position when you're forced to move a VM from a test environ-
ment to a production environment. To ensure the integrity of the VM and a smooth transition,
you'll first need to back up your VM’s virtual disk and configuration files, rename them as nec-
essary, and then move them to the new host. Whether you’re renaming a Microsoft Virtual PC
or VMware Workstation VM, you can complete the procedure in a few steps.
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Renaming VMware Workstation VM

Prepping VMware Workstation to accept a new name for a guest VM is fairly straightforward.
The VM must be powered down and not in a suspended state before proceeding with the
renaming procedure:

1. Remove the VM from the console inventory by selecting the Management tab of the VM
to be removed. Right-click the tab, and select Remove from the favorites; this action
won't delete any files related to the VM to be renamed. Close VMware Workstation.

2. Locate the VM directory containing the guest’s VM configuration file and virtual hard
disk file. If you used the default installation directory and named the installation direc-
tory after your VM, the path to your VM will be similar to C:\Documents and Settings\
user\My Documents\My Virtual Machines\<VM Directory>. Rename the directory, the
*.vmdk file, and the *.vmc file to exhibit the new name.

3. Using a text editor, edit the *.vmx file to reflect the name change. You'll need to modify
two lines: the virtual disk configuration line and the display name line. For example, a
change may look similar to scsi0o:0.fileName = "<New Name.vmdk" and displayName =
"<New_Name>".

4, Start VMware Workstation, and open the renamed VM by selecting File » Open Virtual
Machine. You'll be prompted if you'd like to generate a new universally unique identi-
fier (UUID). If you need to maintain the MAC address for your VM, select Keep the
Existing Identifier; otherwise, select Create New Identifier.

Renaming Microsoft Virtual PC VM

Renaming a VM for Virtual PC follows approximately the same process as VMware VMs. The
VM must be powered down and not in a suspended state, the virtual hard disk file and config-
uration file will need to be renamed, and edits to the configuration file must be made. Follow
these steps:

1. Launch Virtual PC, and highlight the guest VM to be renamed. Select Remove from the
Service Console to remove it from the VM list. Close Virtual PC.

2. Locate the VM directory containing the guest’s VM configuration file and virtual hard
disk file. If you used the default installation directory and named the installation direc-
tory after your VM, the path to your VM will be similar to C:\Documents and Settings\
user\My Documents\My Virtual Machines\<VM Directory>. Rename the directory, the
*.vhd file, and the *.vmc file to exhibit the new name.

3. Using a text editor, edit the *.vmc file to reflect the name change. You'll need to modify
three lines, including the virtual disk configuration lines and the display name line:

<absolute type="string">C:\Documents and Settings\ehalter\My Documents\w
My Virtual Machines\New Virtual Machine\vpctest.vhd</absolute>

<relative type="string">.\vpctest.vhd</relative>

<name type="string">vpctest</name>
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4. Launch Virtual PC, and select File » New Virtual Machine Wizard from the menu. The
wizard will prompt you through the process of adding your VM. Be sure to select Add
an Existing Virtual Machine, and browse to the renamed directory. Select the VM’s
*.vmc configuration file.

5. Select Start from the console. Virtual PC may complain about the hardware standard
being changed, but you can select not to see the notice again.

6. If the VM is a copy of an existing VM, be sure to delete the Ethernet MAC address value
from <ethernet card address type="bytes">MAC ADDRESS</ethernet card address>
to avoid having duplicates on your network. On initialization, Virtual PC will create a
new unique MAC.

Backing Up VMware Workstation

One method of backing up VMs is to power down the guest VM and the virtualization applica-
tion. Then copy the entire VM to a new location. For VMware, if you need to recover a specific
file, you can mount the copy in the new location and restore files using VMware’s DiskMount
Utility. If you want to revert to using the state of the VM at the time of the backup, simply copy
it back to its running production location. This is a highly manual process, but this approach
is fine for personal use or in instances where time permits VMs to be down for the copying
process. Rather than firing up a copy of a VM to restore a file, you can restore an individual file
with the DiskMount Utility. You can use this utility on Windows 2000, Windows XPB, or Windows
2003 operating systems. VMware offers DiskMount as a free download from its Web site, and
installing a VMware virtualization application isn’t a prerequisite to installing and using it.
DiskMount is a command-line utility and can be accessed by running the command
at the CLI from its installation directory. The default directory for DiskMount is C: \Program
Files\VMware\VMware DiskMount Utility. If you want, you can change the path during the
installation process. After downloading and installing the application, go to the CLI; you can
take a moment to examine the utility’s usage syntax by executing vmware-mount /?.You'll see
a list of command options to mount a virtual disk, as shown in Table 4-2.

Table 4-2. vmware-mount Command Options

Utility Option Action Performed

/d Deletes virtual disk drive mapping

/£ Forcibly deletes virtual disk drive mapping

/viN Mounts a specific volume on a virtual disk

/p Lists volumes or partitions located on a virtual disk
’y Mounts a virtual disk even if it has a snapshot

/n Doesn’t mount a virtual disk if it has a snapshot

/? Displays command help

To mount a virtual disk, you'll need to execute the DiskMount Utility as follows:

vmware-mount [drive letter:] [path to virtual disk] [options]
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For example, if you want to mount a disk labeled VMTest1.vmdk in the C:\Documents and
Settings\user\My Documents\My Virtual Machines\VMTest1 directory, you'll first need to
choose an available drive letter to mount. You can use Windows Explorer or any available
command-line utilities to see what drive letters are in use. For instance, if you're using Win-
dows XP, and since you're already at the command line, you can use the diskpart utility.

Note If you need further assistance with the diskpart command, you can refer to Microsoft's resources
Web site at http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/
en-us/dm_drive_letter.mspx.

Assuming you're using Windows XP, type diskpart. This will start the diskpart utility
and place you at its command prompt. Next, type 1ist volume. The output will look similar to
Figure 4-23. Terminate the diskpart utility by typing exit. This will put you back at the normal
command prompt where you can continue mounting your virtual disk. Be sure to be in the
utility’s installation directory before continuing.

WINDOWS' system32 cmd.exe

C:v>diskpart

Microsoft DiskPart version 5.1.3565%

Copyright <G> 1999-2883 Microsoft Corporation.
On computer: PSLIB1

DISKPART> list wvolume
Uolume ##if Ltr Label i Status
Uo lume DUD—ROM
Vo lume Partition Healthy
Vo lume Partition 401 MB Healthy
Vo lume Partition 4081 MB Healthy
Vo lume Partition 4112 MBE Healthy

DISKPART > exit

Leaving DiskPart...

LHEAN

Figure 4-23. Windows XP diskpart utility output

For the vmware-mount utility to work properly, you'll need to select any drive letter not in
use that’s greater than D. In our example, the next available drive letter is H. With all the vari-
ables made known, you can execute the vmware-mount command. For our example, we'll need
to execute vmware-mount H: "C:\Documents and Settings\user\My Documents\My Virtual
Machines\VMTest1\VMTest1.vmdk". Notice the use of double quotes, which help the operating
system to correctly interpret spaces. If the command executes correctly, the command will
return with nothing. Rather than assuming all went well, run the vmware-mount command
from another instance of the command prompt. This will list all mounted virtual disks and
will look similar to Figure 4-24.
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WINDOWS' system32 . cmd.exe

C:5Program Files“UMuwaresUMuware DizkMount Utilitylumware-mount
H:~ =» C:=“Documents and Settings“user“My Documents My Uirtwal Machines“UMTestl
“UMTestl .vmdk

C:Program Files“UMuware“UMuware DiskMount Utility>_

Figure 4-24. vmware-mount output

To restore a file, you'll have to make sure you have the copied version of your VM disk
mounted as well as the production VM’s disk mounted. Remember that the VMs can’t be pow-
ered on. Now, browse to the VMs mounted virtual disk, and find the source file you need to
restore. Next, copy it over the existing file in the destination virtual disk. When you’re done
restoring your file(s), unmount both virtual disks with the /d option. For our example, we'd
need to run vmware-mount H: /d. Sometimes the utility will fail to dismount the virtual disk.

If this is the case, use the /f switch to forcibly dismount the disk.

Being able to mount a specific volume on a virtual disk comes in handy when the disk
partitions are formatted differently. For instance, you could have incompatible partition types
(UFS, EXT2, or EXT3) and FAT/NTFS partitions on a single virtual disk. Being that you can’t
mount certain types of partitions, you can single out the FAT or NTFS partitions. To mount a
specific partition, you'll need to use the /v option with vmware-mount. For instance, if you
wanted to mount the third partition on a virtual disk, you'd execute vmware-mount /v:3 h:w
"C:\Documents and Settings\user\My Documents\My Virtual Machines\VMTest1\VMTest1.vmdk".
But how do you find out what partitions are available? To determine partitions that are avail-
able on a virtual disk, you need to use the /p option with vmware-mount. The output will look
similar to Figure 4-25.

WINDOWS' sy¥stem32' . cmd.exe

C:~Program Files“UMuare“UMuare DizkMount Utilityl>umware—-mount ~p "C:5Documents amm
nd Settingsuser~My Documents™My Uirtual Machines“UMTesti1“UMTestl.vmdk"

Uolume 1 : 2455 Mb

Uolume 582 Mhb

Vo lume 258 Mb

Vo lume 385 Mb

Uo lume 588 Mb

C:Program Files“UMuware-UMuware DiskMount Utility>_

Figure 4-25. vmware-mount /p output

The DiskMount Utility is limited to mounting FAT or NTFS volumes, and if any virtual
disks are set to read-only or if they’re compressed, you'll have to change the disk’s attributes to
successfully use the DiskMount Utility.

Note VMware has a DiskMount Utility guide available on its Web site. If you need further assistance, you
can download it at http://www.vmware.com/download.
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Another “utility” you can use from VMware to aid in backing up VMware configuration
files is the vm-support script. You can find it in the VMware Workstation installation directory,
and it’s titled vm-support.vbs.

To run the script, use the command line, and browse to the install directory of Workstation.
Then execute the cscript vm-support.vbs command. The script can take quite a while to exe-
cute, so don't blow it by closing the window because you think the system has locked up. When
the script has completed, it will display the directory location of its output. In Figure 4-26, the
output is stored in the currently logged on user’s Temp directory.

WINDOWS' system32 cmd.exe

C:Program Files“UMware-UMuare I.Jm-k.,tatlun)c.,crlpt vm—support .vhs
Microsoft (R> Windows Script Host Uersion 5.
Copyright ¢C> Microsoft Corporation 1996- 2331 All rights reserved.

The output directory iz at "GC:“DOCUME™1“user~LOCALE"™1sTempsunsupport-1-8-2005-12
_5'?!!-

Please compress it and submit it to UMware support.

C:sProgram FilessUMwaresUMuware Workstation>

Figure 4-26. vm-support.vbs script output directory

Browse to the output directory, and take a look at the cache of files vm-support.vbs cre-
ated. You should have several files:

e Current User
* Global Config
* Misc

e SYSTEMP

e TEMP

e VM

Treasure troves of information lay in wait in each directory. Take a moment to browse
through the files and get acquainted with what'’s available to you. You'll find that there’s every-
thing from installation log files, installation directory settings, guest VM IP and MAC address
information, power-on log data, and user preferences files. In our particular example, because
we're interested in creating a backup of the VM’s configuration file, we want to point out that
it’s found in the VM directory, C:\Documents and Settings\user\Local Settings\Temp\
vmsupport-1-8-2005-12-57\VM\VMo. After locating the output of the service script, gather
the files into a single zipped file and store it on removable media.

Though the two techniques explored are fairly hands-on and not exceptionally practical,
they’re useful for individual users and workgroups. You may not use vm-support.vbs and
vmware-mount to back up your virtual machines, but you now have two exceptionally cool
and powerful tools to toss into your bag of tricks!
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VMware *.vix Configuration Files

In general, changing VMware configuration files isn't necessary. If you need to make changes, be
careful of typos and accidental deletions. AVM can be rendered worthless from a fat-fingered
configuration file. Manually modifying configuration files requires using a text editor. In Win-
dows, Notepad is sufficient for this purpose.

Every virtual machine has a *.vmx configuration file that contains the settings for the VM,
and you can locate the file with the aid of the Virtual Machine Editor. The Options tab displays
the location of the VM'’s configuration file. Use Windows Explorer to find it and then open it for
editing. As shown in Figure 4-27, you'll find that the configuration file looks similar to a tradi-
tional initiate file.

B ¥MTest1.vmx - Notepad I ] 4
File Edit Faormat Yiew Help
config.version = "7" =]
virtualHw.version = "3"
scsil.present = "TRUE"

memsize = "224"

ided:0.present = "TRUE"

jded:0,. filaename = "“vMTestl.vmdk"
jdel:0.present = "TRUE"
idel: 0. FileMame = "auto detect”
del: 0. deviceType = "cdrom-raw"
floppy0. present = "FALSE"
Ethernetl. present = "TRUE"

sound. present = "TRUE"

sound. filenMame = "-1"

displaymMame = “wMTestl"

guestos = "winxPPro”

priority. grabbed = "normal”
priority. ungrabbed = "normal”
powerType. powerofft = "default”
powerType. poweron = “default"
powerType. suspend = "default"
powerType.reset = "default”
Ethernet0. addressType = "generated”

uuid, Tocation = "5& 4d 51 73 7a 7b 75 f1-25 7a fd 3d 11 &e dd 57"
uuid.bios = "56 4d 51 73 Fa Fh 75 f1-f5 Fa fd 3d 11 6e dd 57"
ethernet(.generatedaddress = "00:0cC:259:6e:dd: 57"

ethernet (. generatedaddressoffset = "0"

sound.virtualoey = "esl1371"

idel:0. startConnected = "TRUE"
tools.syncTime = "FALSE"

| 2

Figure 4-27. VMware *. vmx configuration file

Advantages to being able to add virtual components to a VM using an editor is that it’s
fast, and you can script changes for a large-scale rollout. We’ll touch on some of the common
options found in a VM configuration file.
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Note You can add many undocumented options to a configuration file. Moreover, if you have a problem
with a VM not working, you probably aren’t the first person to have that problem. Visit VMware’s forums for
research and assistance. The Web site is at http://www.vmware.com/community/index.jspa. We'll
cover the configuration files in more detail in Chapter 6.

You can control most virtual device behavior by changing its value from false to true, or
vice versa. For instance, the configuration file will list devices as not being present by setting
its status to false. Look at the following snippet from a VM’s configuration file where no
devices are present:

scsio.present = "TRUE"
scsio.virtualDev = "lsilogic"
scsion:0.present = "FALSE"
scsio:0.fileName = "NoDevices.vmdk"
ide1:0.present = "FALSE"
ide1:0.fileName = "auto detect"
ide1:0.deviceType = "cdrom-raw"
floppy0.present = "FALSE"
usb.present = "FALSE"

Referring to the lines beginning with scsi, the VM won't have a virtual disk made avail-
able to it on boot because the scsi0:0.present line is set to FALSE. You can determine from
the scsi0.present, scsio.virtualDev, and scsio:0.fileName lines that the VM was originally
configured with a SCSI virtual disk using the LSI SCSI controller and was labeled NoDevices.
The lines beginning with ide tell you that no IDE devices are available to the VM because the
present setting is FALSE. If you want to enable the CD-ROM virtual device, change the setting
to TRUE. Moreover, if you want to enable the floppy drive or USB device, change their settings
to TRUE. As you can see, there isn't much to enabling or disabling a device.

In the code that follows, let’s look at a few more things in a typical configuration file:

memsize = "224"

ide0:0.present = "TRUE"
ide0:0.fileName = "VMTest1.vmdk"
ide1:0.present = "TRUE"
ide1:0.fileName = "auto detect"”
ide1:0.deviceType = "cdrom-raw"

The memsize entry sets the memory size for a VM. If you want to increase the virtual RAM,
simply change the line to reflect your needs. The ide entries detail the specifications for vir-
tual IDE devices. Notice the two numbers separated by a colon after the ide entry. The first
number is the virtual controller ID, and the second number is the virtual device ID. You know
that an IDE channel can have two devices, 0 and 1. You also know that motherboards generally
come with two IDE channels, 0 and 1. Therefore, you can determine that the virtual disk
labeled VMTest1.vmdk is on the master device on the primary controller, and the CD-ROM
device is the master device on the secondary controller. If you had a second CD-ROM on the
secondary controller, the ide entry would be ide1:1.
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Like virtual IDE devices, virtual SCSI devices are treated similarly with regard to syntax.
Looking at the following example, you can determine that the VM using this configuration
has the SCSI disk enabled because the first line is set to TRUE and it’s using the LSI Logic driver
(line 2):

scsio.present = "TRUE"

scsio.virtualDev = "lsilogic"

scsion:0.present = "TRUE"

scsion:0.fileName = "Windows Server 2003 Standard Edition.vmdk"

The third line tells you that the hard disk is configured as the first hard drive (0) on the
first SCSI device (0) and is made available to the VM. The fourth line informs you that the
default VMware nomenclature was used to label the disk field (*.vmdk).

The last thing we want to touch on in this section is the Ethernet entries in the configura-
tion file. In the following *.vmx code, the two Ethernet adapters are configured as present for
the VM with the TRUE setting in the first and fifth lines:

etherneto.present = "TRUE"

Etherneto.connectionType = "bridged"

etherneto.generatedAddress = "00:0c:29:6e:dd:57"
etherneto.generatedAddressOffset = "0"

Etherneti.present = "TRUE"

Ethernet1.connectionType = "bridged"

ethernetl.generatedAddress = "00:0c:29:6e:dd:61"
ethernetl.generatedAddressOffset = "10"

uuid.location = "56 4d 51 73 7a 7b 75 f1-25 7a fd 3d 11 6e dd 57"
uuid.bios = "56 4d 51 73 7a 7b 75 f1-25 7a fd 3d 11 6e dd 57"

The second and sixth lines tell you that virtual Ethernet adapters are bridged to a physical
NIC. The third and seventh lines list the 48-bit MAC address for each virtual NIC in the guest VM.
Lastly, the etherneto.generatedAddressOffset lines are used in calculating the UUID for the
VM, which generates the MAC address. If a MAC address is generated and a duplicate address
is found to exist by VMware, the offset value is added. VMware will continue to check for dupli-
cate addresses and continue to add the offset until a unique MAC address is derived. The MAC
addresses are represented in hexadecimal. To generate the next available MAC address, the offset
number (represented in decimal) is added to the last byte of the MAC address. In the example, 57
in hexadecimal is equal to 87 in decimal. Add the offset of 10 to 87 to arrive at the next value for
the last byte of the second MAC address, 97 decimal or 61 hexadecimal.

Virtual PC *.vinc Configuration Files

Virtual PC’s configuration file is stored in a text-editable XML format. It’s used to store a guest
VM’s configuration information and can be manually edited. Before editing the file, be sure
to make a backup of the file in case you enter errors during the editing process. Figure 4-28
depicts the layout of the file, which is difficult to edit using Notepad. You may want to use a
color-sensitive editor, such as Crimson Editor (http://www.crimsoneditor.com).
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:- Apress01.ymc - Notepad ;IEIEI
File Edit Format Yiew Help

k7xml wersion="1.0"7> =
<!—— Microsoft wirtual Machine options and Settings --»
<preferences:
<yersion type="string"=2.0< /version:
<alertss
<notificationss
<no_hoot_disk type="hoolean">true</no_boot_disk:>
</notifications:
<falertss
<hardware:>
<MEmarys
<ram_size type="1integer">128</ram_size>
</memory>
<pci_buss
<ethernet_adapters>
<controller_count types=' 1nteger "»l</controller_count>
<ethernet_controller id="0
<wirtual netwurk>
<id
type="hytes">A08367 904 20011D981EGIF 364 6EDES 7L</ Td>
<name type="string">Broadcom MWetxtreme 57xx

Gigabit Controller</name:
<Avirtual_networks
<ethernet_card_address
type="hytes">0003FFD4C41F < /ethernet_card_address:
</ethernet_controllers
</ethernet_adapters
<video_adapter:>
<vram_size type="integer":>8</vram_size>
</ video_adapters
<ide_adapter:>
<ide_controller d="1">
<location d="0">
<drive_type type="integer"»>2</drive_type:>
<pathname:>
<absolute type="string" />

Figure 4-28. Virtual PC *. vmc configuration file

Virtual PC’s configuration file is cryptic and can be difficult to edit. However, don't let this
deter you from experimenting or making necessary changes. In the configuration file, you'll
want to change the VM’s MAC address to avoid duplicates on your network. Unlike VMware’s
use of the UUID to help manage MAC addresses, Virtual PC will passively “allow” duplicates to
occur if you're making a copy of a VM to run concurrently with the parent image. If the VM is
just being moved, it’s not necessary to change the MAC.

To change the MAC address, find the section of the configuration file containing the
text string <ethernet card address type="bytes">0003FFD6C41F</ethernet card address>.
Remove the 48-bit address from the string, and save the file. In this example, the MAC address
is 0003FFD6C41F. On the VM’s next boot, Virtual PC will see that the MAC address has been
removed, and it will generate a new MAC for the VM.

Other entries in the *.vmc configuration file you may want to experiment with are the set-
tings to change the name and location of the *.vhd configuration file (ide_controller), screen
size and resolution (video), RAM allocation (memory), and mouse behavior (mouse). Because the
file is a text representation of the Virtual Machine Options and Settings dialog box, you can
programmatically add or remove devices on dozens of machines with little scripting effort.

Note If you want to add virtual devices to a guest VM and are unsure of the settings in the *. vmc file,
create a VM and remove all the devices. Next, add the device in question, and look at the changes made to
the *.vmc file.
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Copying and Moving VMware Workstation Guest VMs

Before you begin, make sure you have a good backup of the VM you intend to move to a differ-
ent host. If something blows out in the process, you'll want to be able to quickly revert to your
existing configuration. After confirming you have a good backup, ensure your user account
has sufficient privileges to complete all tasks. Next, you'll need to complete a few preliminary
tasks before moving the guest VM:

1. Power down the guest VM to be moved. Make sure it’s not in a suspended state: a sus-
pended VM is a recipe for disaster.

2. Close the VMware Workstation virtualization application.

3. Ensure a transfer medium exists for moving the guest’s files. Assuming your VM can fit
on a CD or DVD, you can use this type of medium, or you can use a mutually accessi-
ble network share: copy the files to the network share and then move them to their
final destination. If the guest is going to be placed on a new network host, the easiest
way to move the files is over your existing network, going point to point. To connect to
the host VM system, you can use the net use command to access to the hidden system
share to copy the files from an unshared directory. For example, to connect to a server
called NEWVMHOST using the default VMware Workstation VM directory, you'll want
to run the following at the CLI:

net use * \\NEWVMHOST\C$\Documents and Settings\<username>\w
My Documents\My Virtual Machines /user:localladministrator <password>

replacing the following:
¢ *: Use the next available drive letter.
* <username>: Insert the user account profile ID.

¢ local: Use the local account IDs for authentication (you could use a domain name
instead).

e administrator: Use the local administrator account to log in.
* <password>: Supply the local administrator account password.

With the preliminary steps checked off your task list, you can safely move the guest VM by
performing the following steps:

1. Ensure that the new host system has sufficient resources for the added load of the VM
to be moved. Next, make sure you have VMware Workstation correctly licensed and
configured on the new destination host machine and not running.

2. Create a directory on the new host to house the guest VM files. (If you're just moving
the location of the guest VM to a different directory on the current host, simply create
the new directory in your desired location and locate the VM'’s files within the new
directory.) If you're using the default directory of C:\Documents and Settings\user\
My Documents\My Virtual Machines, simply create a subdirectory with the same name
as the guest VM; for instance, use C:\Documents and Settings\user\My Documents\

My Virtual Machines\VMXPTEST. Remember that you want to create directories with
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meaningful names for your VMs and then store all related configuration information
in said directory.

3. Make sure the guest VM is powered down. Next, you'll need to find all the files on the
current host and copy them to the new host in the directory you just created. Files
you’ll minimally be concerned with are as follows:

¢ The configuration file, *.vmx
¢ The virtual disk files, *.vmdk

4, Start VMware Workstation, select File » Open, browse to the VM’s configuration file
(*.vmx) in the directory you created, and then select Open. Take a moment to check
the Virtual Machine Setting dialog box to verify that each device is properly configured
and is pointing to the correct file location.

5. Next, check to make sure the VM name, configuration file, and redo log file are all
correctly set. You can find this on the Options tab of the Virtual Machine Settings
dialog box, as shown in Figure 4-29.

¥irtual Machine Settings 5[
Hardware
Settings | Summary [ - ¥itual machine name
= General RedH atLinux2 IHedHatLinux2
D Power
£ Shared Folders  Enabled Yirtual machine configuration file
B Snapshot Ic:\Hed Hat Lirws 2vredhat. vins
B Guest isolation [irag and drop enabled
g Advanced Mormal/Mormal r Guest operating systern
| b inosoft Windows
=) [irue
| Wavell Netware
1 S Solars
= [Mther
“ersion;
Red Hat Linus j

—Working directorny
Suspend files, REDO logs, and the shapshat
will be: stored here.

Jc:\Red Hat Linus 24 Browse.. |

K I Catcel | Help |

Figure 4-29. VMware Workstation's Virtual Machine Settings dialog box

6. Now, select Power » Power On. If your guest VM fails to properly initialize, make sure
you copied every file from the source host, and then double-check that all settings are
pointing to the correct location. If you need to rename your VM, refer to the section
“Managing VMs” earlier in this chapter.
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VMware Universally Unique Identifiers

When you move a VM, you'll want to concern yourself with the system’s UUID. VMware uses the
UUID to generate a MAC address for a VM. The UUID is based on the host’s System Manage-
ment BIOS (SMBIOS) UUID and on the installation of the VMware application; it’s specifically
hooked to the *.vmx file’s home directory location the first time the guest VM is booted.

Note SMBIOS presents motherboard management and diagnostic information to a computer system and
its software. You can read more about the SMBIOS specification at http://www.dmtf.org/standards/
smbios.

If you move the location of the guest, VMware will know that the initial install directory has
changed because on each boot it compares the value of the UUID.LOCATION entry in the configu-
ration file to the value of the UUID.BIOS. If the directory has changed, the UUID changes, which
in turn changes the system’s MAC address. Typically, this may not be a problem, but if you're
using route maps based on MAC addresses, you may soon find that communications cease. In
addition, if you use software that uses SMBIOS (UUID.LOCATION) to identify servers, communi-
cations will get interrupted. Lastly, if you're issuing IP addresses based on MAC addresses, your
guest VMs will not be able to communicate if the UUID changes. You can find the UUID set-
tings for any given VM in its configuration file. It's generally nested within the Ethernet settings.
The following bit of code is from a VM'’s configuration file. Notice that each 128-bit value
matches for uuid.location and uuid.bios.

Etherneto.addressType = "generated"

uuid.location = "56 4d 51 73 7a 7b 75 f1-25 7a fd 3d 11 6e dd 57"
uuid.bios = "56 4d 51 73 7a 7b 75 f1-25 7a fd 3d 11 6e dd 57"
etherneto.generatedAddress = "00:0c:29:6e:dd:57"
etherneto.generatedAddressOffset = "0"

Foreseeing this issue, VMware configures its applications to ask you if you want to keep
the UUID after a virtual machine has been moved. What's the right choice for you? The answer
is, it depends. VMware suggests that if the VM is a copy, create a new UUID. Conversely, if
the VM has moved to a new location, keep the existing UUID. You just want to make sure no
duplicate MAC addresses appear on your network, because hosts identify each other via MAC
address. If duplicates exist, network errors will occur. If you want to permanently change the
behavior of the UUID warning, you have the option of always keeping or replacing the UUID
each time the VM moves.

Copying and Moving Virtual PC VMs to Other Hosts

Microsoft recommends two methods for backing up its VMs. The first method is to treat the
VM like a typical physical server or workstation to be backed up. For instance, if you're using
QiNetix from CommVault or Backup Exec from Veritas in your backup environment, load the
backup agent on the VM and include it in your existing backup process. The advantage to
using the first approach is that you won’t have to create any new administrative processes to
accommodate new guest VMs. The second method for backing up Microsoft Virtual PC VMs is
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to back up virtual hard disk and configuration files of a powered-down VM. You'll be treating
the VM as if it were a group of normal files, and you’ll want to specifically back up the virtual
hard disk image file (*.vhd), the configuration file (*.vmc), and the saved state file (*.vsv) if the
VM is suspended. The advantage of the second approach is that the entire state of a VM can be
restored by using a few files.

Note Be careful when backing up VMs in a suspended mode because the System State is saved to
memory in two locations: partly in the *.vhd file and partly in the *. vmc file. Restoring a VM saved in
suspend mode can and generally does create an unstable VM.

When it comes time to move a guest VM between hosts, power down the VM to be moved
and locate two files: the virtual hard disk file (*.vhd) and the VM configuration file (*.vmc). The
default location for Microsoft Virtual PC guest VMs and their associated files is C: \Documents
and Settings\user\My Documents\My Virtual Machines\<Guest VM Name>.Before you begin,
make sure you have a good backup of the VM to be moved. If the move process fails, you'll
want to be able to rapidly revert to your existing guest VM configuration.

After creating and confirming you have a good backup, ensure that your user account has
the necessary privileges to complete all tasks. Now, you'll need to complete a few preliminary
tasks before moving the Virtual PC guest VM:

1. Power down the guest VM to be moved. Make sure that it’s not paused: moving a
paused VM is a recipe for disaster.

2. Close the Microsoft Virtual PC application.

3. Ensure that a transfer medium exists for moving the guest’s files. Assuming your VM
can fit on a CD or DVD, you can use this type of medium, or you can use a mutually
accessible network share: copy the files to the network share, and then move them to
their final destination. If the guest is going to be placed on a new network host, the
easiest way to move the files is over your existing network, going point to point. To
connect to the host VM system, you can use the net use command to access the hid-
den system share to copy the files from an unshared directory. For example, to connect
to a server called NEWVMHOST using the default Microsoft Virtual PC directory, you'll
want to run the following at the CLI:

net use * \\NEWVMHOST\C$\Documents and Settings\<username>w=
\My Documents\My Virtual Machines /user:local\administrator <password>

replacing the following:

¢ *: Use the next available drive letter.
e <username>: This is the user account profile ID.

¢ local: Use the local account IDs for authentication (you could use a domain name
instead).

¢ administrator: Use the local administrator account to log in.

* <password>: Supply the local administrator account password.
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Having backed up the guest VM to be moved, you can safely move the guest VM by per-
forming the following steps:

1. Make sure the new host system has sufficient resources for the added load of the VM to
be moved. Next, make sure Microsoft Virtual PC is correctly licensed and configured
on the new destination host machine and not powered on.

2. Create a directory on the destination host to receive the guest VM files. (If you're just
moving the location of the guest VM to a different directory on the current host, create
the new directory in the desired location and place the VM'’s files within the new
directory.) If you're using the default directory of C: \Documents and Settings\user\

My Documents\My Virtual Machines, create a subdirectory with the same name as the
guest VM. When creating directories for VMs, use meaningful names to store all config-
uration files and information.

3. Ensure that the guest VM is powered down. Now, find all the files for the guest VM to
be moved on the current host and copy them to the new host in the directory you just
created. Files you'll minimally be concerned with are *.vmc, which is the configuration
file, and *.vhd, which is the virtual disk file.

4. Start Microsoft Virtual PC, and select File » New Virtual Machine Wizard. Complete
the wizard by selecting Add an Existing Virtual Machine and browsing to the location
of the moved VM’s *.vmc file. After creating the guest VM instance on the new host,
take a moment to check the VM’s configuration by selecting Settings from within the
Virtual PC console. Verify that each device is properly configured and virtual disks are
pointing to the correct file location.

5. Start the guest VM by selecting Start from within the Virtual PC console. If your guest
VM fails to properly initialize, make sure you copied every file from the source host,
and then double-check all settings are pointing to the correct location.

Running VMs As Services

Configuring VMware Workstation and Microsoft Virtual PC guest VMs to run as services isn't
natively supported. If you require a guest VM to run in a production environment as a service,
you should “buck up” and purchase server-class products. However, if you're on a budget,
we’ll show you how to cobble together a sound solution with a few tools.

The tools you need to use are srvany.exe and instsrv.exe; you can find them in the
Microsoft Windows 2003 Resource Kit. In particular, you can download the Windows 2003
Resource Kit tools from http://www.microsoft.com/downloads. Conveniently enough, the tools
can be loaded on a typical Windows XP host; previous versions are even located on legacy
resource kits. In addition to the Resource Kit tools, you need two more pieces of knowledge.
Specifically, you need to know the location of the virtualization application executable,
vmware.exe or Virtual PC.exe, and the location of the guest’s configuration file, *.vmx for
VMware or *.vmc for Virtual PC. Assuming you performed a vanilla install of your virtualiza-
tion application, you can find the executable for VMware Workstation in the C: \Program
Files\VMware\VMware Workstation directory and the *.vmx configuration file in the guest’s VM
subdirectory located in the C:\Documents and Settings\user\My Documents\My Virtual
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Machines directory. For Virtual PC, the executable is located in C: \Program Files\Microsoft
Virtual PC, and the *.vmc configuration file is located in the guest’s VM subdirectory of
C:\Documents and Settings\user\My Documents\My Virtual Machines.

After the tools are installed, you'll need to create the VM service. At the CLI in the direc-
tory where you installed the Resource Kit tools, C:\Program Files\Windows Resource Kits\
Tools, execute the following commands, where Service Name is what you want to call the VM
service and Srvany Directory Path is the directory location of the srvany executable:

instsrv <Service Name> <Srvany Directory Path>

Referring to Figure 4-30, you can see that we labeled our service VMTest1. Beginning a
service with an underscore will cause it to be listed first among all services. Listing your cus-
tom services first is a good way to keep track of any custom service you create. As a small
aside, notice that we specified the absolute path of srvany.exe and placed the entire string
in quotes; you'll need to do the same.

WINDOWS' system32 cmd.exe

GC:%>ed c:sProgram FilessWindows Resource KitssTools

C:“Program Files“Windows Resource Kits“Toolsl>instsrv _UMTestl “C:“Program Files“
Windows Resource Kits\Tools“srvany.exe"

The service was successfuly added?

Make zure that vou go into the Control Panel and use
the Services applet to change the Account Mame and
Password that this newly installed service will use
for its Security Context.

C:sProgram Files“Windows Resource Kits“Tools>

Figure 4-30. Creating the VMware Workstation service

You now need to take a moment to configure the newly created service so it can interact
with the desktop. Use the Services icon in the Control Panel to complete the task, and use
Figure 4-31 as an aid. Notice that the box you want to check is on the Log On tab.

You now need to do a bit of registry hacking. Locate the HKEY_LOCAL_MACHINE\SYSTEM\
CurrentControlSet\Services\<VM service name> subkey, and add a new key labeled
Parameters.

Next, add the string value called Application to the new Parameters subkey, and enter the
path to vmware.exe or Virtual PC.exe as its value, such as C:\Program Files\VMware\VMware
Workstation\vmware.exe for VMware or C:\Program Files\Microsoft Virtual PC\Virtual
PC.exe for Microsoft Virtual PC.
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_¥MTest1 Properties {Local Computer)

Figure 4-31. Enabling the VMTest1 service to interact with the desktop

You'll next need to add the path to the VM’s configuration file; for example, use C: \Documents
and Settings\user\My Documents\My Virtual Machines\VMTest1\VMTest1.vmx for VMware
Workstation or C: \Documents and Settings\user\My Documents\My Virtual Machines\VMTest\
VMTest1.vmc for Microsoft Virtual PC. The entire syntax for the string should look like one of the
following strings, including the quotes:

* VMware Workstation: "C:\Program Files\VMware\VMware Workstation\
vmware.exe"-x "C:\Documents and Settings\user\My Documents\
My Virtual Machines\VMTest1\VMTest1.vmx"

¢ Microsoft Virtual PC: "C:\Program Files\Microsoft Virtual PC\
Virtual PC.exe " -pc VMTest1 -launch
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Figure 4-32 details what your registry might look like for a VMware Workstation service
after completing the editing tasks.

e e )
Ble Bt Wew Fpomes tep
My Computer [ [ Type | Dea |
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{2 Y _CURRENT_LISER NG, CAPor o P e CiDocamar - y o
(20 PEY_LOCH, MAINE
) HARDWARE

‘e Testl|Farameters i

Figure 4-32. VMware service registry editing

You may find that these exact instructions won't work for your particular operating sys-
tem. For VMware, you may get an error similar to Figure 4-33. This error is generally caused
by extra spaces being passed to the vmware.exe command from the registry with the -x option.
For Windows XP in particular, make sure there’s no space between the double quotes after
vmware.exe and the -x. If it fails, try it again with a space. Virtual PC can be picky about letter
case, so type directory and VM names exactly how they appear.

¥Mware Workstation x|

e Unable to open configuration file """

Unable to get information about file "C:4s" The system cannat find the file specified,

Figure 4-33. VMware VM service error

Note Wnen editing the Application subkey’s Value data string to make syntax changes, you may
need to reboot between each registry edit to successfully commit your changes to your operating system.

If for some reason you can't get your VM service to function, it'’s okay. Some operating
systems just have difficulty parsing command-line options, so we have a secondary approach
to offer you. For VMware, if you have problems creating and running a VM as a service, run
the vm-support.vbs script. Browse to the SYSTEMP directory. Check the log files for anything
unusual. If you have typos in your registry settings, or if your OS is acting up, your log will
have some details. In the following output, the log notes that VMware is having difficulty
interpreting spaces:
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MAR 07 09:54:28:

vmui| Log for VMware Workstation pid=228 version=4.5.2
build=build-8848 option=Release.4.5.2

MAR 07 09:54:28:

vmui| Unhandled VMUI exception: There is a space character

in your options. Perhaps you are trying to pass two separate options
(such as -q -x) in the first line of your configuration file.

If so, you need to merge them (-gx).

If your VM is having extensive issues trying to run as a service with the current approach,
we have a workaround. You can create system shortcuts and use them with the cmd command.
When using the shortcut method, create a folder to house the shortcuts so they don't litter up
your desktop. Inside your VM service shortcut folder, create a shortcut by right-clicking your
mouse and selecting New » Shortcut. The Create Shortcut Wizard will appear. In the field pro-
vided, type the absolute path to your VMware Workstation or Microsoft Virtual PC executable,
and select Next.

The wizard requires you to provide a name for the shortcut. For the name, simply use the
name of the VM that’s to be run as a service. Select Finish to complete the shortcut creation.

You'll now need to edit the shortcut to reflect that you want a VM to start when you acti-
vate the shortcut. Right-click the shortcut, and select Properties. In the Target field, as in
Figure 4-34, you need to append the -x command switch and the location of the VM’s *. vmx
file. For Microsoft Virtual PC, you'll need to append the -launch switch and the location of the
VM’s *.vmc file.

¥MTest1 Properties ed |

General Shortout | Compatibilit}ll

'@'@ WM Test]
(7]

T arget tppe: Application

T arget location: M ware ‘wWorkstation

Target: Istation\vmware.exe{' - "C:ADocuments and Setti

Start in: I 'C:A\Pragram Files\WMware\WMware Warkstation

Shortcut key: IN ane

Bun: I MNormal window j

Comment: I

Find Tanget... | LChange lcon... Advanced... I

aK I Cancel | Apply |

Figure 4-34. Modifying the shortcut target
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In this example of creating a VMware Workstation service, the entire target line reads as
follows (notice the spaces before and after the -x option). Select Finish when you’re done, and
take a moment to test the shortcut and make sure it launches your VM as you intended it.

"C:\Program Files\VMware\VMware Workstation\vmware.exe" -xw»
"C:\Documents and Settings\user\My Documents\
My Virtual Machines\VMTest1\VMTest1.vmx"

If you were creating a Virtual PC shortcut, the target line should look like the following:
"C:\Program Files\Microsoft Virtual PC\Virtual PC.exe" -pc VMTest1 -launch

To complete the process of creating a VM service using this second method, follow the
previous steps. The only caveat is that you'll want the Value data for the Application string to
point toward your shortcut. For instance, it should look similar to the following snippet:

cmd /c "C:\Documents and Settings\user\Desktop\Service VMs\vmtest1.lnk"

The cmd /c command and option launches a command window and executes the short-
cut. The /c option tells the command window to close upon execution completion. The . 1nk
part is the file extension for a shortcut. Be sure to append it to your command string, or your
VM won't launch.

Whether you use the first or second option to create a VMware Workstation or Microsoft
Virtual PC VM service, the guest VM will launch automatically in its own window on boot. In
addition, the VM will continue to function even after you log off the host.

Note If you're just interested in having a VM power on when the host operating system boots, create a
shortcut with the appropriate command options and place it in the Startup folder. These VMs will terminate
when you log out of the host.

Things you’ll want to watch out for when running guest VMs as services are any pop-up
dialog boxes requiring your input, such as the VMware Tip of the Day. Assuming you're using
best performance practices by not allowing VMs to automatically attach to floppy disk drives
or CD-ROM drives, you won't have to worry about multiple VMs vying for device contention
and the hassle of dealing with pop-up windows. All such dialog boxes will prevent your VMs
from successfully running as unattended services. Lastly, if you can’t get either of the previous
approaches to work, take a moment to get help with the cmd command using /2.

Introducing VM CLI Administration
and Keyboard Shortcuts

We'll begin to touch on using the vmware.exe and Virtual PC.exe commands in this section
and cover some basic keyboard shortcuts. We'll cover other command-line utilities in Chapter
6, including vmware-vdiskmanager, vnetsniffer, and vnetstats. For Virtual PC, we'll discuss its
setup.exe file.
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VMware Workstation CLI

On Windows systems, to get an idea of the full range of options available with the vmware.exe
command, execute vmware.exe /? at the CLL If your host is based on Linux, execute man vmware
for command help. If you're going to be using command-line switches on a regular basis, you
may find that it’s easier to use the options in a shortcut. For instance, on a Windows host, all
you have to remember to do is add the option to the Target field and add the absolute path to
the VM’s configuration file. For example, on a Windows host, if you wanted to start aVM in a
maximized window, the Target path should read similar to the following:

"C:\Program Files\VMware\VMware Workstation\vmware.exe" -X "=
C:\Documents and Settings\user\My Documents\My Virtual Machines\VMTest1\VMTest1.vmx"

The -X option instructs the VMware Workstation executable to start the VM and maximize
the application window. When you’re modifying the Target field, be sure to enclose your text
strings in double quotes. If you don't, your operating system may have difficulty parsing the
spaces in filenames.

Let’s take a moment to touch on each command option individually before moving onto
keyboard shortcuts. For the most part, the Help window is self-explanatory.

e -vinstructs vmwware.exe to reveal the current VMware Workstation version and applica-
tion specifications. You can get the same information by launching VMware and
selecting Help » About VMware Workstation.

e -x powers on a given virtual machine and launches the VMware application in a normal
window.

e -Xis similar to -x: the difference is that -X will not only power on a virtual machine but
will also enter full-screen mode by taking over the desktop.

* -qcloses a virtual machine upon power off. What this means is that when you launch a
VM with the -q option, it will close the virtualization application when the guest VM is
powered off.

e -s NAME=VALUE sets the given variable name equal to the given value.

» —p sets the correct relationship between the parent disk and the child disk by correctly
pointing the child.

You can use multiple command-line options by concatenating them. On a Windows host,
for example, if you want a VM to launch in full-screen mode and close the VM application on
guest VM power down, you'll need to type something like this: vimmare.exe -Xq "C:\Documents
and Settings\user\My Documents\My Virtual Machines\VMTest1\VMTest1.vmx".

If you fail to string the option together correctly, VMware will respond with a warning ask-
ing you to correct your code. Moreover, the command and its parameters are case sensitive in
a Linux environment.

With the startup options explained, turn your attention to the keyboard. Like most
applications, VMware has included keyboard shortcuts for your convenience. You'll find
you can perform operations more quickly from the keyboard than by jockeying the mouse
around. VMware Workstation controls the nature of the keyboard from the Hot Keys tab under
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Edit » Preferences. As depicted in Figure 4-35, you can change the hotkey combinations to
your liking. If you have VMware tools installed, make sure your mouse doesn'’t place keyboard
focus on the guest VM—don'’t hover the pointer over the guest VM’s running window.

Preferences

Workspace I Inpuit

Memony I Friority I Lockout I

—Haot kep combination
o Chile
£ Chl-Shift-Alt
= Custom

machine is started.

Cul & Down € Up € Doncare
Shitt £ Down £ U € Don't care
Al & Down 0 g ) Don't care

Hat key changes will take effect the nest time this virtual

(] 4 I Cancel Help

Figure 4-35. VMware hotkeys

Table 4-3 details several useful keyboard shortcuts to aid in the administration of VMware

Workstation.

Table 4-3. VMware Keyboard Shortcuts

Keyboard Shortcut Keys Action Performed

Ctrl+Alt Releases mouse cursor from guest VM to host OS or returns guest to
normal screen mode.

Ctrl+B Powers on guest VM.

Ctrl+R Resets guest VM.

Ctrl+Z Suspends guest VM.

Ctrl+E Powers off guest VM.

Ctrl+Alt+Enter Allows guest VM to enter full-screen mode.

Ctrl+O Opens a VM by locating its *.vmx configuration file.

Ctrl+F4 Closes currently visible VM.

Ctrl+Alt+Fx Fx represents a function key to which a virtual machine is assigned.

Using this key combination you can toggle between guest VMs running
in full-screen mode. The full-screen mode title bar reveals the Fx key
assigned to a particular guest VM.
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Using the vmware command on a Linux host is similar to on a Windows host. Command-
line usage takes this format: vmware [-x] [-X] [-q] [-s <variable>=<value>] [-m] [-v]
[/<path_to config>/<config>.vmx ] [X toolkit options].Short of adding the -m option,
which starts VMware in quick switch mode, you'll have to contend only with the directory
structure and command-line usage of Linux.

Virtual PC CLI Administration

Virtual PC offers a few executables that are useful for scripting batch files, installing Virtual PC
using group policies, and running straight from the command line. We'll discuss two commands:
the first command, Setup. exe, is valuable for installing Virtual PC, and the second command,
Virtual PC.exe, is effective for launching VMs in a specific mode.

Note The CLI executable arguments are case sensitive, but the options for each aren’t. As a rule of
thumb, maintain the letter case of the commands, arguments, and options to avoid problems.

Let’s first look at the syntax and options for a working example of Setup.exe. The trick to
getting this command to do what you want is to strictly observe the spacing between the com-
mand and its available options and quotation marks. In the following example, notice that a
space precedes the parameters installdir and pidkey and that all information following the
-v parameter is enclosed in double quotes. Also, notice that there’s no spacing between the
other options and parameters. On some operating systems, you may find that you need a
space after defining the product key if you use additional options:

Setup.exe -s -v"-gn pidkey=<productkey>allusers=2"

Now, let’s look at the entire offering of Setup.exe using Table 4-4 and the complete com-
mand syntax before moving onto a couple more examples. The command and all possible
options that can be used with it are Setup.exe [-s] -v"[-qn] pidkey=<?>[allusers=2]
[username=?][organization=?] [installdir=?]".

Table 4-4. Setup.exe Command Options

Option Action Performed

-s Silently installs without GUI interface.

-v Passes parameters to Msiexec.exe.

-gn Instructs Msiexec.exe to run without the GUI

pidkey=<?> Supplies Microsoft Virtual PC product key code. Dashes aren'’t required.
allusers=2 Installs Virtual PC for all users. Exclude to install only for the current user.
username=<?> Supplies installation user account name. Exclude to use current user.
organization=<?> Supplies organization name. Exclude to use organization name from registry.

installdir=<?> Supplies custom installation directory. Exclude to use default.
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The following example will install Virtual PC in unattended silent mode for all users with
all possible customizations:

Setup.exe -s -v"-qn pidkey=12345123451234512345=
allusers=2username=administratororganization=Apressw=
installdir=c:\apress\testnetwork"

You can use the next example to install Virtual PC with the GUI for the current user:
Setup.exe -v"-gn pidkey=12345123123456712345"

The second command we want to explore is Virtual PC.exe.The command is located in
the installation directory and can not only be used to launch the Virtual PC application but
can also set asset tag numbers, set BIOS serial numbers, set screen resolution, and set the
launch methods of guest VMs. Before using the command, be sure to make a backup of the
configuration file so you can compare the results before and after command execution. The
gotchas that will keep you from successfully using this command are double quotes around
the command; also, some options work on VM launch only. Before jumping into the raw com-
mand syntax, let’s look at a couple of examples.

You probably have an idea of how the command works from the “Running VMs As Services”
section. Here, we'll expand on the capabilities of Setup.exe. The example to follow starts a
guest VM from the CLI titled Apress01 without the Service Console:

"Virtual PC.exe" -pc Apress01 -singlepc -launch

In the next example, the Virtual PC VM, Apress02, is configured to launch in full-screen
mode:

"Virtual PC.exe" -pc Apress02 -launch -fullscreen

After copying a VM to a new workstation, and you want it to appear in the list of available
VMs in the console, you'll need to use the -registervm option:

"Virtual PC.exe" -registervm Apress03.vmc

Table 4-5 lists the available options for Virtual PC.exe, and the entire syntax with possi-
ble options follows:

"Virtual PC.exe" [-singlepc] [-quiet] [-usehostdiskcache] [-VMName
[-disableclose] [-disableopt] [-s3bitclip] [-setbiosno <?>] [-setassettag <?>]
[-launch] [-extnetworking] [-fullscreen|-window] [-geometry widthxheight{+|-}x
offset{+|-}y offset] [-minimize|-restore] [-pause|-resume]] [-help]
[-registervm <VM.vmc>] [-startvm <VM.vmc>]
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Because the usage of some of these options may modify the contents of a VM’s configura-
tion file, be sure to back up the VM’s configuration file first.

Table 4-5. Virtual PC.exe Command Options

Option When Useable Action Performed

-singlepc Launch Starts VM without the console

-quiet Launch Disables autostarting VMs
-usehostdiskcache Launch Enables host disk caching to improve

-pc virtual machine name
-disableclose

-disableopt

-s3bitclip

-setbiosno bios serial number
-setassettag asset_tag
-launch

-extnetworking

—fullscreen
-window

-geometry widthxheight{+|-}w=
x offset{+|-}y offset

-minimize

-restore

-pause
-Tresume

-help

-registervm filename.vmc

-startvm filename.vmc

Launch or off
Off

Off

Launch

Off

Off

Launch

Launch

Running
Running

Running

Running

Running

Running
Running
Launch
Off

Launch

disk performance

VM to be acted on or modified
Deactivates the close button
Disables optimizations

Clips S3 bit coordinates to 12
Sets BIOS serial number

Sets chassis asset

Starts specified VM

Restricts access to external network
resources

Places windowed VM in full-screen mode
Places full-screen VM in window mode

Specifies location and size of VM window
in relation to upper-left corner of monitor

Minimizes VM

Places focus on background VM to now be
in foreground

Pauses VM

Resumes paused VM
Displays help
Registers VM with console

Registers VM with console on
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With the command-line executables explained, we’ll now cover Virtual PC’s use of key-
board shortcuts. You'll find you can perform operations more quickly from the keyboard.
Table 4-6 details several shortcuts you can use in the administration of Virtual PC. If you don’t
want to use the right Alt key to perform the shortcuts, switch the hotkey by selecting File »
Options » Keyboard from the Virtual PC Console. Highlight the Current Host Key box, and
then press the hotkey you want to use.

Table 4-6. Virtual PC Keyboard Shortcuts

Keyboard Shortcut Keys Action Performed

Rt. Alt+Del Signals VM Ctrl+Alt+Del

Rt. Alt+P Pauses or resumes VM

Rt. Alt+R Resets VM

Rt. Alt+F4 Closes VM

Rt. Alt+Enter Toggles full-screen/window mode
Rt. Alt+C Copies selected item(s)

Rt. Alt+V Pastes copied item(s)

Rt. Alt+] Installs Virtual Machine Additions
Rt. Alt+down arrow Minimizes VM

Rt. Alt+left arrow Switches to previous windowed VM
Rt. Alt+right arrow Switches to next windowed VM

Monitoring and Configuring VM Performance

You can keep guest VMs and their host computer systems optimized for performance and reli-
ability through good configurations and the maintenance of both. In addition, maintenance
includes routine monitoring. To get the most out of your systems, start with the foundation:
you can tweak every line of code in a VM, and it will perform miserably if the host is under-
powered and poorly managed. Moreover, you can pore over reams of management wallpaper,
system logs, and network traces, and it will be for nothing if you don't start off with a host sys-
tem configured with fast hard disks, powerful processors, and large quantities of RAM. If you
want to review some no-nonsense approaches to building a good foundation for your VM, be
sure to read Chapters 1 and 2.

Note A computer system that performs adequately as a non-VM host may quickly crash and burn when
it’s loaded up with VMs. Even if you have a cutting-edge processor and have maxed out the motherboard’s
RAM capacity, you'll need to contend with potentially more heat added by the increased CPU load. Make
sure your system isn’t suffering from inadequate cooling by checking heat sinks, fans, and ventilation.
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To keep both the host and its guests running optimally, you can start with a few basics:

* Defragment virtual and physical hard drives. Fragmentation affects the general per-
formance of virtual disks, snapshots, and the suspend/resume operations of VMs.

» Make sure your host operating system is optimized for performance and not conven-
ience. For instance, Microsoft operating systems poll the CD-ROM drive frequently
(about every second) to check for the insertion of media. This behavior isn't needed in a
production environment. You can get additional ideas from Chapter 5.

* Ensure the guest VM has the correct setting for the guest operating system selection on
the Options tab of the Configuration Editor. Having the correct operating system set
ensures that the best possible running environment is employed for the VM. VMware
optimizes internal configurations based on the choice you make for the guest.

* Using snapshots with VMs decreases performance. If you don’t need the snapshot fea-
ture, disable it. From the application menu, select Snapshot » Remove Snapshot.

e Verify the running mode of the VM. VMware provides two running modes: normal and
debug. Debugging mode is significantly slower than the normal running mode. Check
the setting of your guests by selecting VM » Settings » Options from the application
menu. Select Advanced, and make sure Run with Debugging Information isn’t selected
under settings.

To help monitor your VMs, you can use Microsoft’s Performance console. The Perfor-
mance console is an application that consists of three management tools: System Monitor,
Performance Logs and Alerts, and Task Manager. You can use data gathered from these tools to
observe trends in workflow and resource utilization, test performance tweaks to the computer
system, and troubleshoot system components. You'll look at VMware’s performance counters
and Virtual PC’s performance options in the next sections. In Chapter 6, we'll cover how to use
the Performance console with VMs.

VMware Performance Counters

VMware uses performance counters that can be managed through the host’s System Monitor
interface (formerly known as Performance Monitor). Unfortunately, the counters are available
only for Microsoft hosts. You can, however, monitor the performance of a Linux VM. The per-
formance counters included with VMware Workstation allow you to monitor memory usage,
virtual hard disk access, and VM network traffic. To track the performance of a VM, it must be
powered on. At the time of this writing, Microsoft Virtual PC doesn’t include performance
counters to specifically monitor its VMs. The VMware performance counters track the status
of the virtual machine and not that of the guest OS.
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To use the counters in Windows XP, launch the Performance console from the Control
Panel. You can find it located in Administrative Tools, and it should look similar to Figure 4-36.
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Figure 4-36. Microsoft Performance console

By default, it will open with three counters installed. To remove the counters, highlight
each one, and press the Delete key on your keyboard. To add a counter, right-click in the gray
graph display area, and select Add Counters. You can also add counters by selecting the plus
button or by pressing Ctrl+I on the keyboard. The Add Counters dialog box will appear. You
can monitor remote hosts as well as the local host. Connecting to hosts over a network can
inflate certain counters and increase latency.

Though it’s convenient to get an idea of what'’s going on with a particular system over a
network, use counters locally if you're performing any type of baseline work. Make sure you've
selected Use Local Computer Counters, and then select VMware from the Performance Object
drop-down box. Now, to get an idea of what each counter reports, highlight it from the list,
and then select Explain. Take a moment to go through each counter, so you'll know what’s
available to help you measure guest performance.

If you have several VMs running, the Performance console has the ability to monitor all
VMs or a VM of your choice. If you want statistics from each running VM, select All Counters
and All Instances. If you desire to monitor a specific counter on a specific VM, choose Select
Counters from the list and then choose Select Instances from the list. When you use the Per-
formance console, you really should be looking for something specific. If you add all counters
from all VMs, you'll generally wind up with too much data and an unnecessary increase in
overhead.
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Virtual PC Performance Options

Microsoft Virtual PC has the ability to let you quickly tune performance through its console.
To gain access to the Performance option, launch Virtual PC and select File » Options »
Performance. As in Figure 4-37, you'll see two categories with a few selections to aid in
managing performance.

¥irtual PC Options |
Options | current ¥alue & Performance
a Restore at Start Restore
L TPerformance Priotitize acti CPU Time:
J Full-Screen Mode Adjust resolution = all running virtual machines get equal CPU time
9?,- Sound Mute
_!& Messages Show ll ' allocate more CPL time ko the virbual maching in
) the active window

@3 Keyboard Right: Alt

-y N " Pause virtual machines in inactive windows

) Mouse Click to capture Nl N p

% Security Disabled ‘when Virtual PC is running in the background:
e Language English (o Give processes on the host operating system

priority
' Run ¥irtual PC ak maximum speed

‘fou can select which virtual machines will get CPU time:
from the physical computer when one or more virtual
machines are running. ¥ou can also prioritize CPU time
between the host operating system and Virtual PC when
Wirkual PC is running in the background.

Ok I Cancel

Figure 4-37. Virtual PC performance options

The two categories basically give you the ability to place your overall performance focus
either on the host or on the guest VMs. When determining priority for the guests, you can
favor the VM in the active window, distribute CPU resources equally, or pause VMs not in the
active window. When Virtual PC is running in the background, you can choose to give running
processes on the host priority or run Virtual PC at maximum speed all the time. Granted, the
choices aren’t real flexible, but they come in handy in an educational/test environment or on
hosts with limited resources. Table 4-7 details each option.

Table 4-7. Virtual PC Performance Options

Option Performance Action

All Running Virtual Machines Equally distributes resources across running VMs

Get Equal CPU Time

Allocate More CPU Time to the Distributes about 70 percent of resources to active VM
Virtual Machine in the Active Window

Pause Virtual Machines in Pauses all inactive window VM, releasing CPU
Inactive Windows capacity to active VM

Give Processes on the Reduces background VM performance by 50 percent

Host Operating System Priority

Run Virtual PC at Maximum Speed Allocates all CPU resources to all running VMs
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Deciding when to use what option in which category is something you should consider
when your needs change or when a system moves from a test environment to a production
environment. The first category, CPU Time, grants you the ability to manage the host’s CPU
time. Minimal considerations for selecting a particular option are based on the following:

e If you're running several VMs in a production environment on Virtual PC, you may
want to use the option to distribute resources equally. This ensures you won't experi-
ence excessive latency with nonactive window VMs.

e Ifyou're in a lab or educational type environment, you'll probably want to use the
70/30 split option; choosing this option will ensure you're not waiting for the active
window VM to catch up with your keystrokes and mouse movements.

e If you're running more than one VM, Microsoft suggests you use the pause VM option.
This option is useful if you need to access only one VM at a time and need to allocate all
possible CPU resources to the active window VM.

The second category, When Virtual CPU Is Running in the Background, affords you the
opportunity to configure the background performance of Virtual PC, and minimal considera-
tions for selecting a particular option are based on the following two choices:

e If you plan on using the host system and guest VMs concurrently, you should choose to
give the host operating system priority.

* If you're going to use the host system as a platform for guests only, then you’ll want to
allow Virtual PC to run at maximum speed.

Summary

We covered the deployment and management of guest VMs in this chapter and discussed

the available hardware options in Microsoft’s and VMware’s virtualization applications. You
now know how to install, back up, monitor, and run guest virtual machines as services. With
client-side virtualization products covered, you're now ready to move onto enterprise-class
virtualization products. In Chapter 5, you'll investigate the three server virtualization applica-
tions: Microsoft Virtual Server, VMware GSX Server, and VMware ESX Server. We'll continue
taking a step-by-step approach with the installation of each virtualization server application
as you move through the next chapter.



CHAPTER 5

Installing and Deploying
VMs on Enterprise Servers

N ow that your foundation in VM technology is firmly established, you'll learn about running
VMs in production environments. Specifically, you'll investigate three server virtualization
applications: Microsoft Virtual Server, VMware GSX Server, and VMware ESX Server. VM server
products will be a vital piece of your infrastructure; therefore, revisit the details regarding the
requirements of each product outlined in Chapter 1. Moreover, pay particular attention to the
suggested best practices in this chapter. You don’t want to deploy a server that impedes the
workflow of your customers and coworkers. In the end, you're better off overbuilding a VM
server than you are meeting the minimum requirements.

Being that we already showed how to install the workstation products for Microsoft and
VMware, you'll see many similarities between Microsoft Virtual PC and Microsoft Virtual
Server, as well as between VMware Workstation and VMware GSX Server. Some information
may be redundant, but we’ll cover all the installation information to be thorough. Like Chap-
ter 3, we'll take a step-by-step approach when showing how to install each virtualization
application in this chapter. You may not need to read each section; therefore, simply skip the
sections you don’t need.
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Installing Microsoft Virtual Server

Because it’s supported only on Windows 2003, our example installation of Microsoft Virtual
Server will be on Windows 2003. If you have large memory requirements, make sure you use
the version of Windows 2003 that meets your needs. Don't fall into the category of people who
think they can save a few dollars by using Windows 2003 Standard when you require 6GB of
RAM, because Standard supports only 4GB of RAM. If you're going to install Virtual Server on
an existing Windows system, take a moment to mentally compare the host’s hardware config-
uration with the following suggested best-practice minimums to ensure a successful Virtual
Server deployment:

¢ Two RAID controllers (RAID 1 for the Windows 2003 host and RAID 5 for the
Windows 2003 guests)

e Three 1Gb NICs

¢ Two 3GHz processors

* 4GB of ECC DDR RAM

¢ Five 15,000RPM 146GB SCSI hard disks

* 500-800MHz FSB

We also need to point out that Microsoft suggests disabling hyperthreading on Virtual
Server hosts. Microsoft’s rationale is that a load-stressed server may perform poorly during
workload spikes. You may want to make this call on your own. Try running your server with
and without hyperthreading, conduct some tests, and implement what'’s good for your envi-
ronment. Many servers do just fine with hyperthreading enabled. If you've installed Virtual
PC, then you'll be getting ready to experience a bit of déja vu with the install of Virtual Server.

If you're installing from a CD-ROM and autorun begins the installation process, take a
moment to disable it now. You can disable it by editing the registry and changing the value of
AutoRun to 0 in HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Cdrom. If autorun is
already disabled, you'll need to look for the setup.exe file, which is about 20MB in size.

Follow these steps to install Virtual Server:

1. On the setup screen, select Install Microsoft Virtual Server to begin the installation
process.

2. The Customer Information screen requires that you enter a valid product key to con-
tinue. Enter your information and key, and then click Next.

3. The Setup Type screen prompts you to select between Complete and Custom. The
Custom setup feature allows you to remove the following options: Virtual Server Ser-
vice, Documentation and Developer Resources, Virtual Machine Remote Control
Client, and Virtual Server Web Application. Leave the default selection of Complete,
and click Next.

4, The setup program will then configure Virtual Server’s Administration Web site. The
default configuration port is 1024 using TCP. You can change the port number to meet
your needs, but don’'t use the common ports less than 1024 (for instance, 25, 80, 110,
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443, and so on). Using a port already slated for an existing service will cause problems
for the existing service and for the Virtual Server Administration Web site. The Web

site is automatically added to your IIS configuration. You'll also have to decide if the
Administration Web site should run as the local system account or as the authenticated
user. The default is to run as the authenticated user and is generally sufficient for most
installs.

5. The Ready to Install screen is the end of installation configuration. Select Install to
begin the installation.

6. If you don’t have IIS installed and running, the install program will warn you to change
your install choice to reflect the status of IIS. You can continue the installation, but the
Administration Web site won't install. You'll need to rerun the installation program
after installing and configuring IIS to get the Administration Web site to function.

7. Ifyou elect to install IIS now, cancel the install of Virtual Server first. If you don't, the
installer won’t recognize the installation of IIS. You can install IIS by going to Add or
Remove Programs in the Control Panel. Select Add/Remove Windows Components.
Next, highlight Application Server, and select Details. But don’t select the box to the
left, as this will install all subcomponents. Highlight Internet Information Services
(IIS), and select Details; again, don’t select the box to the left, as this will install all sub-
components. Highlight World Wide Web Service, and select Details. Once more, don’t
select the box to the left, as this will install all subcomponents. Finally, check the World
Wide Web Service box, and then click OK. You'll need to select OK a few more times to
get back to the Windows Components Wizard’s main screen.

8. Assuming all goes well, the install finishes with the Setup Complete screen. Select Fin-
ish to complete the installation.

9. The summary window will open and detail several points, such as the location of the
installation, the address of the Administration Web site, and the location of documen-
tation.

10. To test your installation of Microsoft Virtual Server, from the summary window, select
the hyperlink to the Administration Web site. You'll be prompted to log in. By default,
only local administrators can log in. Therefore, be sure to supply a username and pass-
word from the Local Administrators group.

If you don't have SSL enabled for your IIS server, you'll see a warning at the bottom of the
login page stating that SSL isn’t enabled for the Administration Web site. It's important you
use secure communications with remote administration because you'll be passing passwords
and configuration information to the system. You don’t want to be the victim of someone
unscrupulously using a network analyzer. Take a moment to configure SSL for your server.

To get a certificate for the Administration Web site, you'll have to set up Certificate Ser-
vices from the Add/Remove Windows Components in the Control Panel, use a preexisting
certificate or certificate authority, or generate one using the makecert.exe self-signing certifi-
cate utility, using SelfSSL, or using OpenSSL. Microsoft recommends you use a certificate
server rather than using makecert.exe.
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makecert.exe is simple to use and saves time in a lab or testing environment; you can
download it by browsing to http://download.microsoft.com/download/platformsdk/Update/
5.131.3617.0/NT45XP/EN-US/makecert.exe. Because makecert.exe more closely approximates
the installation of a certificate obtained from a public certificate authority, we’ll use it for
securing our Administration Web site for this example.

Note The IIS 6.0 Resource Kit Tools also includes the easy-to-use self-signing certificate utility called
SelfSSL. You can download the IIS 6.0 Resource Kit Tools at http://www.microsoft.com/downloads/
details.aspx?FamilyID=56fc92ee-a71a-4c73-b628-ade629c894998displaylang=en. SelfSSL is a
bit easier to use because it automatically installs the certificate in IIS. To create a certificate, select SelfSSL
from the IIS Resources program menu. A command window will open showing all the options of the SelfSSL
command and will reveal the default behavior.

After obtaining makecert.exe, place it in an easy-to-find location from the command line,
such as the root of your hard drive (C). Follow these steps:

1. Navigate to the location of the executable, and create a self-signed certificate with the
following command:

makecert -r -pe -n "CN=<fully qualified domain name>" -b 01/01/2005
-e 01/01/2006 -eku 1.3.6.1.5.5.7.3.1 -ss my -sr localMachine -sky
exchange -sp "Microsoft RSA SChannel Cryptographic Provider" -sy 12

If you don’t know the fully qualified domain name (FQDN) of your server, run
ipconfig/all from the command line. Concatenate the host name line and the primary
DNS suffix line. Moreover, if you need to set the primary DNS suffix without joining
your host to a domain, open System in the Control Panel. Click the Computer Name
tab, select Change, and then click the More button. Enter the second-level and top-
level domain names. You'll have to reboot your server for the change to take effect.

2. View the certificate using the Microsoft Management Console (MMC). You'll have to
add the Certificates (Local Computer) snap-in. The certificate should be stored in the
Computer Account certificate under Personal.

3. After verifying the creation of the certificate, you'll need to install it by going to Web
Site Properties at the Administration Web site in IIS.

4, Select the Directory Security tab followed by Server Certificate.
5. The Web Server Certificate Wizard will start. Select Next to begin the configuration.
6. From the Server Certificate options screen, select Assign an Existing Certificate.

7. On the Available Certificates screen, select the certificate generated by makecert.exe.
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8. You'll be prompted to supply the port for SSL communications. The default is 443.

9. The Web Server Certificate Wizard will generate a summary screen. Check the data,
and make sure it’s correct.

10. The Completing Installation screen indicates the certificate assignment was success-
ful. Select Finish to end the install.

11. On the Virtual Server Properties window, select Edit under Secure Communications.
On the Secure Communications screen, check Require Secure Channel (SSL) and
Requires 128-Bit Encryption.

12. Close the Virtual Server Properties window, and then restart IIS to make the changes
take effect (by selecting Action » All Tasks » Restart IIS).

Test the Administration Web site to verify secure communications. When you're testing
your site, make sure to change the port number in the uniform resource locator (URL). The
default install port uses 1024 and can no longer be used because of the security settings you
made.

Note You may find that the Mozilla and Netscape Web browsers complain about certificates that are self-
signed, such as in the makecert.exe and selfssl.exe applications.

Like Virtual PC, Virtual Server installs seamlessly. Now, browse to Microsoft’s Web site
athttp://www.microsoft.com/downloads, and check for any patches or updates. If system
patches exist, install them before continuing. With post-installation maintenance completed,
you're now ready to start installing guest VMs, but before you begin, you should familiarize
yourself with the Management User Interface and skim the information available in the help
files. Knowing what options are available in Virtual Server and the scope of built-in assistance
will be invaluable during deployment.

Installing VMware GSX Server for Windows

Installing VMware GSX Server is similar to installing VMware Workstation. GSX Server is
licensed for unlimited user access and is a solid hosted virtualization product for small and
large network workgroups. You can’'t upgrade software packages from Workstation to GSX
Server. So, if you're upgrading a server from Workstation to GSX Server, be sure to uninstall
Workstation first. You don't have to worry about losing data during the uninstall process. By
default, VMware (and Microsoft) virtualization applications don’t delete virtual hard disks dur-
ing the uninstall process. You'll be prohibited from installing multiple instances of GSX Server
on a single host; in addition, you may not install it on a host already running the Virtual
Machine Console.
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VMware provides for that ability to silently install GSX Server using version 2.0 of the
Microsoft Windows Installer runtime engine. This is useful if you'll be rolling out GSX Server
to several servers. You can verify the version of Windows Installer by running msiexec.exe.
Assuming you've extracted the install packages for GSX Server by running VMware-gsx-server-
installer-<version number>.exe /a /s /x /d C:\temp\gsx at the CLI, you can begin a silent
install (including the license key and disabling autorun) by entering the following code at
the CLI:

msiexec -i "C:\temp\gsx\VMware GSX Server.msi" ADDLOCAL=ALL /qgn
SERIALNUMBER=<serialNumber> DISABLE AUTORUN = O

You can use the ADDLOCAL and REMOVE options with the following qualifiers:

e All:Installs all options

* Network: Installs all networking options

* NAT: Installs the NAT service only

* DHCP: Installs the DHCP service only

If you don’t want to install the DHCP and NAT services, you'll need to change the previous
installation command to the following:

msiexec -i "C:\temp\gsx\VMware GSX Server.msi" ADDLOCAL=ALL
REMOVE=DHCP,NAT /gqn SERIALNUMBER=<serialNumber> DISABLE AUTORUN = O

Unlike workstation virtualization applications, GSX Server requires substantially more
hardware to ensure that network availability and performance needs are met for guest VMs.
That’s why the following list of best-practice minimums for a VMware GSX Server deployment
shouldn’t be shocking. You should have a server equipped with a configuration that approxi-
mates the following:

¢ Two RAID controllers (RAID 1 for the Windows host and RAID 5 for the ESX Server
guest VMs)

e Three 1Gb NIC interfaces

e Two 3GHz processors

* 4GB of ECC DDR RAM

¢ Five 15,000RPM 146GB SCSI hard disks

* 500-800MHz FSB
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If you download your copy of GSX Server from VMware’s Web site, it’s about a 90MB file
that will decompress itself before running. Follow these steps to install it:

1. Use Windows Explorer to find the installation executable, vmware-gsxserver-
<version>.exe, and launch it. You'll first be presented with the GSX Server Master
Installer Wizard, so click Next to continue.

2. The Setup screen appears; you must choose between Complete or Custom for the
installation. The Custom selection allows you to remove the following:

e VMware GSX Server

* VMware Management Interface
e VMware VmCOM Scripting API
e VMware VmPerl Scripting API

The default value is Complete. Because the default is normally sufficient for most
installations, click Next.

3. The Destination Installation screen preselects a default directory to deliver the install
files. You can modify the directory path by selecting Change.

4. The Ready to Install screen gives you the option of making changes if necessary. If
you're satisfied with your previous choices, select Install to begin the software delivery
to the host.

The install process will take several minutes. VMware takes a moment to secure the
Web-based Management Interface for you and creates a couple of desktop shortcuts. Upon
completion, you'll be presented with the Installation Completed screen. Test your installation
by launching the VMware GSX Server console.

Note You can change the default port GSX Server for Windows uses for the MMC by editing the config.ini
file in C:\Documents and Settings\All Users\Application Data\VMware\VMware GSX Server.Add
authd.port = <portNumber> to the file, and change the port to the one you want to use. You may need to
reboot your host server.

After completing the install of GSX Server, don't forget to check VMware’s Web site,
http://www.vmware.com/download/gsx_security.html, for patches and security updates.
As of this writing, a security update exists for GSX Server to correct a handful of issues with
OpenSSL. The patch is smaller than a megabyte; you should install it in order to maintain the
integrity of secure communications between the Management Interface and console sessions.
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Installing VMware GSX Server for Linux

Installing GSX Server for Linux is similar to installing Workstation for Linux and can be performed
using a TAR or an RPM file. When using GSX Server for Linux, be sure to install the virtualization
application on an enterprise-class host OS, such as Red Hat Enterprise Server or Advanced Server.
Regardless of vendor and version, you need to make sure your Linux platform support conforms
to the following:

¢ The real-time clock function must be compiled in the kernel.
e The port PC-style hardware option should be loaded as a kernel module.
e The inetd process must start on boot.

* The gcc package must be installed.

As compared to a Microsoft server operating system, you can typically get similar
performance with less hardware using a Linux server operating system; however, it isn’t
necessarily a good idea to use less of a server in production. Average hardware choices yield
below-average performance. Your GSX Server Linux installation should be on hardware that’s
similar in nature to the following list of best-practice minimums:

» Two RAID controllers (RAID 1 for the Linux host and RAID 5 for the guest VMs)
* Three 1Gb NIC interfaces

¢ Two 3GHz processors

¢ 4GB of ECC DDR RAM

¢ Five 15,000RPM 146GB SCSI hard disks

¢ 500-800MHz FSB

Don't attempt to install Workstation and GSX Server on the same host system. If you
attempt to install GSX Server on a preexisting Workstation installation, it will be upgraded
to GSX Server. You'll also want to configure X Windows to manage guest VMs in a GUI console
session. GSX Server for Linux consists of three packages. You can choose to install as few or as
many as you need. If you're looking to approximate the same functionality as a Windows host,
you’'ll want to install all available packages:

e GSX Server (VMware-gsx-<xxxx>.tar.gz) for hosting VMs (Perl API installed by default)
* VMware Management Interface package (VMware-mui-<xxxx>.tar.gz) for remote control

e VMware Virtual Machine Console (VMware-console-<xxxx>.tar.gz) for local control

When managing systems remotely, you'll have to concern yourself with more than just
physical firewalls getting in the way. For instance, default installations of Red Hat Linux and
Windows XP SP2 use software firewalls. On the client side, firewalls can block you from using
the VMware Management Interface and the Virtual Machine Console by prohibiting connec-
tions to the GSX Server host machine. Port 902 must be opened for Virtual Machine Console to
access a GSX Server host. The Management Interface requires port 8333 to be open and 8222 if
SSLis disabled.
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Note To change the port GSX Server for Linux uses for the Virtual Machine Console, you must first deter-
mine if your system uses xinetd or inetd. For xinetd, edit the /etc/xinetd/vmware-authd file and
change port = 902 to reflect the new port number. If your system uses inetd, look for /etc/inetd.conf
and change 902 vmware-authd to reflect the new port number.

Whether you're installing from a CD or from a file downloaded from VMware’s Web site,
you need to make sure your file paths are reflected correctly in installation command state-
ments. To begin the installation of GSX Server for Linux, go to the CLI and make sure you have
root permissions. If you're in a testing lab, it will be easier if you log in as root. In production
environments, you'll need to log on with the account for which the install is intended and
then issue the su - command. As a small note, sometimes the vmware-config.pl configuration
program will appear to hang during installation; you can press Q to advance to the next prompt.
The step-by-step instructions for RPM and TAR installations follow. Refer to the section that sup-
ports your version of Linux.

Installing the RPM

Follow these steps to install the RPM:

1. Ifyou're installing from a CD, you'll need to mount it first. At the CLI or in a terminal
window, enter this:

mount /dev/cdrom /mnt/cdrom
2. Next, browse to the CD-ROM mount point:
cd /mnt/cdrom
3. To make sure the media is accessible, perform a directory listing:
1s -1
4. Now, locate the setup RPM:
find /mnt/cdrom -name VMware-gsx*.rpm

5. The system will respond with the location of the file. Change your present working
directory to the RPM’s directory:

cd /mnt/cdrom/<directory name>
6. Now, enter the following for the RPM install:

rpm -Uvh /mnt/cdrom/<directory name>
/NMware-gsx-<version and build number>.rpm

7. You'll see advancing hash marks across the screen that indicate installation activity.
After delivering the package, run the configuration program. Verify the installation of
the RPM by querying the package management system:

rpm -ga | grep 'VMware'
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8.

10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

The system will respond with the package and version number installed. It should
match the RPM you specified with the rpm -Uvh command in step 6.

. With installation out of the way, you'll need to run the configuration program. Enter

the following at the CLI:
vmware-config.pl

Press Enter to read the license agreement. You'll need to use the space bar to advance
through the document. Assuming you agree to its terms, type yes and press Enter.

The configuration program will question if networking is required. The default is Yes,
so press Enter.

If you have multiple network adapters, you'll be asked which adapter should be
bridged to VMnet0. If you're happy with the default selection, press Enter.

Next, you'll be asked if you'd like to configure any additional bridged networks. No
is the default. Being that you can configure more bridged networks later, accept the
default by pressing Enter.

Next, you'll be prompted if NAT networking is necessary. Select the default (Yes) for
now by pressing Enter.

The installation script will ask to probe for an unused private subnet. The default is
Yes. The scan can take a couple of minutes, and it will reveal what appears to be avail-
able for use.

The system will query if you'd like to use host-only networking in your VMs. The default
is No. If this is what you want, press Enter. However, if you don't select Yes now, bridged
and host-only networking won't be available to your VMs. You'll need to rerun the con-
figuration script to enable the feature. If you select Yes, the script will probe for unused
network IDs to use. After the probe, you'll be asked to configure any additional host-
only networks. The default is No. Press Enter to continue.

The script will prompt you for the port to use for remote console sessions. The default
is port 902. Press Enter to continue.

The script will then provide a location to store VM files. You can store virtual disks

on any Virtual Machine File System (VMES) partition. The default is generally a safe
choice. Press the Enter key to accept the suggested path. If necessary, the path will be
created. You'll be prompted to select the default Yes answer. Press Enter to continue.

Now, the install script will ask you for your 20-character serial number. Enter your
validly licensed product key, and press Enter to continue. If you choose not to enter a
serial number, the install will abort.

You'll be presented with some registration suggestions; simply press Enter to complete
the install.

After the installation is complete, you can test the install by restarting the VMware service.
At the CLI, run this:

service vmware restart
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The system should respond by stopping the GSX Server’s services and then starting them.
Upon the reinitialization of the services, an “OK” should appear at the end of the restart dialog

box.

Installing the TAR

If your OS doesn’'t use RPMs, you'll need to use a TAR to install VMware for Linux. The following
instructions are generally suitable for several versions of Linux, including Red Hat. However,
please remember that your system path structure may vary, so make changes as necessary.

1.

10.

Before installing the software, create a temporary directory for the installation TAR file:

mkdir /tmp/vmlinux

. Next, copy the TAR file to the newly created temporary directory on your hard drive.

Be sure your file paths correctly reflect the directories on your host system:

cp VMware-<version and build number>.tar.gz /tmp/vmlinux

. Next, change to the directory where the copied files reside:

cd /tmp/vmlinux

. Because the install file is an archive, you'll need to unpack it by issuing the following

command:

tar zxf /tmp/vmlinux/VMware-<version and build number>.tar.gz

. Once the decompression is finished, find the installation directory:

find /tmp/vmlinux -name vmware-distrib

. Next, navigate to the installation directory:

cd /tmp/vmlinux/vmware-distrib
Finally, execute the installation program:

./vmware-install.pl

. You'll be prompted several times during the install. Generally, the defaults are suffi-

cient for most installs save a caveat or two. The first prompt asks you to confirm the
install directory /usr/bin. Press Enter to accept the default.

. Next, the install program will ask you the location of the init directories, /etc/zc.d.

Assuming the default is correct, press Enter.

. You're then prompted for the init scripts directory, /etc/rc.d/init.d. If the default is

correct, press Enter.

The install program will then ask an installation directory for the library files,
/usr/1lib/vmware. Press Enter to accept the default.
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11. The system will want to create the /usr/share/man directory for the manual files. Press
Enter to confirm the default setting.

12. Next, you'll be asked to supply the directory for the VMware documentation files,
/usr/share/doc/vmware. Press Enter to continue with the default. You may be prompted
to confirm the creation of additional parent directories. Assuming this is okay, press
Enter to continue.

13. Unlike the RPM install, the TAR install asks if you'd like to run the configuration pro-
gram, /user/bin/vmware-config.pl. The default is Yes; press Enter to run the VMware
configuration program.

For both the RPM and TAR install, you can run the configuration program at any time.
You'll also need to run the program any time you upgrade the Linux kernel or if you want to
change the character of Workstation (for instance, to remove or add host-only networks). If
you go to run the configuration program and it doesn’'t work, it’s probably because of an error
with the search path.

The use of the search path in Linux is similar to that in Microsoft Windows. It’s a variable
configured during system initialization. Linux uses the PATH command to search for the pro-
gram that corresponds to input at the CLI. You can add a search directory to the path by
issuing PATH=${PATH}: /<directory>. You can use the command which to verify the existence of
a file in the search path, such aswhich vmware-config.pl.If you want to see what'’s currently
listed in the variable, type $PATH. If you need additional help configuring the search path, you
should refer to the distributor of your operating system.

Wrapping up this section, we want to point out that the help system built into VMware
GSX Server for Linux depends on a Web browser being accessed from the /usr/bin/netscape
directory. If your browser is located elsewhere (Netscape, Firefox, Mozilla, or otherwise), be
sure to create a symbolic link to it at that location (for example, 1n -s <browser path> /usr/
bin/netscape).

Installing the VMware Management Interface

To be able to manage guest VMs on the local host with a GUI, you'll want to install the VMware
Management Interface. The Management Interface requires that the 1ibdb.so.3 library be
installed first. You can search for it by issuing find / -name libdb.so.3 at the CLI. The operat-
ing system should respond with its location. The Management Interface comes as a TAR and is
readily downloadable from VMware’s Web site. Follow these steps:

1. To begin the install, go to the CLI or open a terminal window. If your user account
doesn’t have superuser permissions, you'll need to issue the su - command.

2. Next, browse to the location of the installation file. If it's on a CD-ROM, be sure to
mount the CD-ROM first:

mount /dev/cdrom /mnt/cdrom
3. Create a temporary directory to extract the file:

mkdir /tmp/vminterface
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. Now, copy the TAR to the temporary location:

cp VMware-mui-<versionnumber>.tar.gz /tmp/vminterface

. Change to the directory holding the TAR archive:

cd /tmp/vminterface

. Extract the archive:

tar xzf VMware-mui-<versionnumber>.tar.gz

. Change your present working directory to the location of the installation directory:

cd /tmp/vminterface/vmware-mui-distrib

. Finally, run the installation script:

./vmware-install.pl

. You'll be asked to read and accept the license agreement. Press Enter to display the

agreement, and use the space bar to scroll through the agreement. Type yes, and then
press Enter.

The script will ask for a directory to install the binaries. The default is normally sufficient.

You'll next be asked to supply the destination location of the initd directories. You can
change the default if necessary.

Next, you'll be prompted for the location of the init scripts. Press Enter if the default is
sufficient.

The install script will then provide a default location to install the Management Inter-
face files. Press Enter to continue. If the directory doesn't exist, the script will ask if it’s
okay to create the directory.

You'll have to supply a location for the documentation files. The default is normally
sufficient. Press Enter to continue. If the directory structure doesn’t exist, the system
will ask if it can create the directory. Select the default of Yes.

The script will finally end the installation by evoking the configuration script for the
Management Interface.

The configuration script will ask you to set a limit for session timeouts. It defaults to 60
minutes. Press Enter to complete the install.

When finished installing the Management Interface, be sure to log off with exit.

With the Management User Interface (MUI) installed, it’s time to test its functionality.
Start XWindows, and launch the Management Interface.
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Working with the VMware Virtual Machine Console

You can download the VMware Virtual Machine Console from VMware’s Web site, from the
Status Monitor tab of the Management Interface, or from the GSX Server CD-ROM. After gain-
ing access to the VMware-console-<version number>.exe program, you're ready to begin the
installation of the Virtual Machine Console. The following steps are designed for installation
from a CD-ROM:

1.

10.

11.
12

The install requires you to use the CLI or a terminal window. If your user account
doesn’t have superuser permissions, you'll need to issue the su - command.

. If necessary, mount the CD-ROM:

mount /dev/cdrom /mnt/cdrom

. Next, find the Virtual Machine Console file:

find / -name VMware-gsx-server-linux-client-<versionnumber>.zip

. Browse to the directory with the file:

cd /mnt/cdrom/<directory name>

. Create a temporary location to copy the file to for extraction purposes:

mkdir/tmp/vmconsole
cp /mnt/cdrom/<directory name>
/VMware-gsx-server-linux-client-<xxxx>.zip -d /tmp

. Decompress the archive in the /tmp/vmconsole directory:

unzip VMware-gsx-server-linux-client-<version number>.zip -d /tmp

. Navigate to the /tmp directory:

cd /tmp/vmconsole

. Based on your needs, install the RPM or TAR file as needed:

rpm -Uhv VMware-console-<version number>.i386.rpm
tar zxf VMware-console-<version number>.tar.gz

. Finally, locate the installer directory:

find / -name vmware-console-distrib

From the console-distrib directory, execute the installation script. If at any time
during the installation the script appears to hang, press Q to advance the script:

./vmware-install.pl
You'll first be asked to read and accept the license agreement.

If you used the RPM version of the install, you'll need to run the configuration
program for the Virtual Machine Console by running this:

vmware-config-console.pl
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Note If you used a TAR file to install GSX Server for Linux, the script will automatically launch
the vmware-config-console.pl script.

13. You'll be prompted as to what port you want to use for the remote console. Port 902 is
the default. If the server you're going to manage uses a different port, change the port
to match. If you used the defaults, press Enter to continue.

14. After the installation completes, be sure to log off the system with the exit command.

With the installation of all three packages completed, test your host’s ability to set up and
manage guest VMs locally. Execute /user/bin/vmware at the CLI. Take a moment to explore
every menu, including the built-in help. VMware has excellent documentation for its virtual-
ization software, and its Web site support is even better.

Changing GSX Server’s Remote Console Port Number

If you're wondering if you can force the Remote Console authentication daemon (vmware-authd)
to use a different port number, you can. In addition, if you want to take a minute to beef up
security on your GSX Server, you should change the default port. Though a ping-sweep on your
network may enumerate open ports on your server, changing the default port of GSX Server’s
Remote Console port will keep someone from specifically targeting the default port of 902. Don't
select a common port, such as ports less than 1024. These ports are already assigned to common
services, such as ports 25 (SMTP), 80 (HTTP), and 443 (HTTPS). To change the port, you'll need
to follow these steps at the CLI:

1. Typevi /etc/xinetd.d/vmware-authd.
Find and change the port number to what you want. We'll use 9876 in this example.

Type vi /etc/vmware/config.

> @ DN

Change the authd.client.port entry to match your desired port number (9876).
5. Restart xinetd with service xinetd restart.

6. Restart the Management Interface with httpd.vmware restart.

GSX Server guests will be managed from the port you specified. Now, you'll need to use
the VMware Remote Console application to connect to guest VMs. When connecting to the
server, you'll need to specify your port number in the Connection field in addition to the IP
address (for example, 10.10.5.136 9876). After entering your information, select Connect to
proceed.

After connecting to your GSX Server though the Remote Console application, you can verify
the port change. For instance, from within a Windows operating system such as Windows XP,
you can execute the netstat command at the command line with the -n option, netstat -n.
Under the Foreign Address column, locate your server’s IP address and verify that the port being
used is correct.
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If you don’t want to have to specify the port number to use when using Remote Console,
you can configure it to use a specific port automatically. For Windows systems, create a file
and label it config.ini. Place the file in C: \Documents and Settings\All Users\Application
Data\VMware\VMware Remote Console.The file should have one line of code:

authd.client.port = <portNumber>

If you're using a Linux client to connect to your host, you'll need to modify either
/etc/vmware-console/config or /usr/lib/vmware-console/config. Add the following line
of code:

authd.client.port = <portNumber>

Installing VMware ESX Server

We'll spend a bit more time on ESX Server than the other VM applications because it’s a
stand-alone product, which means an operating system isn't required to host the ESX Server
virtualization application. ESX Server directly communicates with your system’s hardware
and is said to run on the metal. Additionally, we’ll cover two configuration scenarios. The first
scenario covers what might be involved with a troubled installation, and the second scenario
details what you'll experience with a typical configuration.

If you escaped having to use Linux operating systems, you'll have to learn them if you
want to take advantage of the power and scalability ESX Server offers. If you're familiar with
Red Hat Advanced Server 2.1, you'll feel right at home with VMware ESX Server 2.1. If you're
not really familiar with Linux, we’ll give you a crash course in survival commands later in this
chapter. You will, however, need to get your hands on a good Linux book for further investiga-
tion, such as Beginning SUSE Linux: From Novice to Professional by Keir Thomas (Apress,
2005).

ESX Server can be expensive to implement and is designed for enterprise-class internet-
working needs. Though you don’t need to be in a Fortune 500 company to use ESX Server,
you’'ll want to install as much RAM and as many processors as you can; in addition, you'll
need SMP licensing to run guest VMs with multiple virtual processors. The host will need at
least two RAID controllers, one for ESX Server and one for guest VMs. Preferably, you'll want
to store your guest VMs on a SAN. The network throughput needs of your ESX Server will be
no different from the number of guests you'll host plus the needs of ESX Server. You'll want
to have at least two network adapters, but install as many as possible—you’ll want to take
advantage of ESX Server’s teaming features. This lofty rhetoric boils down to the following
for best-practice minimums for ESX Server deployment:

¢ Two SCSI RAID controllers (RAID 1 for the ESX Server host and RAID 5 for the ESX
Server guests)

e Four 1Gb NIC interfaces

e Two 3GHz processors

¢ 4GB of ECC DDR RAM

¢ Five 15,000RPM 146GB SCSI hard disks

¢ 500-800MHz FSB
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Short of an extra RAID controller and a few NICs, you may notice that best-practice speci-
fications aren’t much different from what you'd specify for a new file server. At 60 percent
utilization, you can expect to minimally run four to ten servers on the hardware listed.

If you're bent on using IDE devices for ESX Server, be aware that you can store VMs only on
IDE devices with VMFS. It isn’t that ESX Server can’t run on IDE devices; it’s just that VMware
forces you to host on SCSI devices. With SCSI devices, you're assured the best possible perform-
ance for your guest VMs. Though SATA is clearly as good as some SCSI drives, and though it
doesn’t have the heat problems associated with extremely high spindle speeds, you won't get
the ESX Server VMkernel to start after an IDE-only install. If SCSI drives are cost prohibitive and
you need to leverage existing IDE drives, such as test lab equipment, you can invest in a SCSI-
to-IDE bridge, such as the one available from Acard. It allows you to run IDE devices on a SCSI
controller, so ESX Server will install just fine. Additionally, ESX readily installs on IDE Fiber
Channel-attached storage devices.

Now that you know what you can expect from your hardware based on how it measures
up to best-practice minimums, you can turn to the actual install. ESX Server has two installa-
tion modes, graphical and text. During the graphical mode installation of ESX Server, the
setup wizard may utilize extremely low video resolution for your install. If this happens, you
won't be able to view the contents of the entire install screen because online help is consum-
ing a third of your viewable real estate. This will become a particular problem when it’s time
to enter your product serial numbers. You can close the help window by selecting Hide Help
in the lower-left corner of your display. As a word of caution, don't close the help just to close
it; if you keep it open, you'll be presented with helpful information that will answer many
questions and refresh your memory on install topics.

VMware doesn’t support running nested virtual machines, which are virtual machines
running within virtual machines. The complexity introduced by nested virtual machines can
cause complications with regard to the host’s resources. Attempting to run a nested virtual
machine will end in failure.

Though ESX Server is extremely quick to install and VMware recommends reading the
entire installation guide, just skim the guide prior to installation. You'll find it especially help-
ful if you're upgrading an existing ESX Server, installing in text mode, or performing a scripted
installation. We'll point out typical installation mistakes as we walk you through the setup
process. Whether you use graphical or text mode installation, you'll have to learn to navigate
the installation menus with a keyboard. The graphical install supports a mouse, but some-
times the install wizard won'’t correctly probe your hardware, only the keyboard functions. If
you already jumped ahead and booted off the installation CD-ROM, you may have noticed the
Red Hat logo during boot. If you're familiar with a typical Red Hat OS install, then you're
already familiar with the navigation keys outlined in Table 5-1.

Table 5-1. Red Hat Linux Installation Navigation Keys

Key Function

Tab Navigates options
Space bar Selects current option
Enter Selects current option

Arrow keys Navigates options
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With navigation out of the way, go ahead and boot from the CD-ROM. You may need to
adjust your host machine’s BIOS boot-device priority from a floppy disk or the hard drive to the
CD-ROM. If you have newer hardware, you can often change the primary boot device by using
the system’s boot menu: generally it’s a function key, such as F12.

Upon booting from the CD-ROM, you’ll be presented with the first installation screen
that requires you to choose a “noapic” and/or “text” installation. Normally, it’s sufficient to
just press Enter and use the default, APIC/graphical mode. Advanced Programmable Interrupt
Controller (APIC) mode avoids interrupt conflicts at the time of installation. APIC mode is
helpful to use because devices may fail to share interrupts gracefully. After installation, errors
related to devices contending for the same interrupt are generally resolved because one of the
devices is often dedicated to a virtual machine. If interrupt conflicts persist, you'll have to
resolve the issues by reconfiguring the hardware IRQs, swapping cards between different bus
slots, or removing the device altogether.

To install, follow these steps:

1. Once installation is underway, the installation wizard will present you with the wel-
come screen; click Next.

2. The Installation Options screen presents you with three choices:
¢ Install Default: Complete ESX Server install, formatting installation hard disks

¢ Install Custom: Complete ESX Server install, allowing for keyboard and mouse
customization

* Upgrade: Preserves existing data and upgrades the host software

Since you're performing a new install and want to explore the available options, select
Install Custom.

3. The Keyboard customization screen allows you to select your exact keyboard (if listed),
layout, and use of dead keys. When dead keys are pressed, no visible character output
is generated; they're generally used to make special characters (characters requiring
accent marks). If you're inclined to create passwords with nonprinting characters,
you’ll want to enable dead keys. For this install, choose the defaults.

4. The Mouse customization screen allows you to select your mouse type and, if you
want, emulate three buttons on a two-button mouse. Selecting the default is a good
choice. You can always change these settings after installation.

5. The License Agreement screen asks you to agree to the terms. Check the box; if you
don’t, you might as well turn off your computer now.

6. To install guest operating systems, you'll have to obtain a serial number. You can
request a demo license directly from VMware if you haven’'t purchased one. Enter your
license number information in the fields provided. If you want to use virtual SMP in
your guest systems, you'll have to obtain that license separately from the ESX Server
license. Depending on your physical hardware, the SMP license will allow you to
configure your guests with one to four processors. If you choose not to enter license
information at the time of installation, that’s fine. You'll be presented with a warning.
You'll have to enter license information prior to installing guest virtual machines.
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7. On the Device Allocation screen, you need to dedicate and/or share your physical
hardware between the ESX Server console and guest VMs. You'll also need to divvy up
your SCSI controllers and network adapters between the host system and guest VMs.
Remember that one network adapter must be dedicated to the Service Console. If you
share this network adapter with VM guests, you won't be able to remotely administer
the server.

8. You'll be required to specify the amount of RAM to be reserved for the console.
VMware makes suggestions on the amount of memory to be reserved based on the
total number of guest VMs. You can select the minimum if you're going to host only a
few VMs; however, to accommodate future needs and quell any issues regarding per-
formance, select a memory reservation setting one or two steps higher than you need.

If you didn't install two network adapters in the host computer, this is where your
actions will catch up to you. To manage ESX Server through the Service Console, one
Ethernet adapter must be dedicated for it to use. Once again, ESX Server minimally
requires two network adapters: one for the Service Console and one (or more) for the
guest VMs. Now is a good time to install any additional NICs you want to use.

Tip To gain remote command-line access to an ESX Server or a GSX Server Linux host machine,
use secure shell (ssh). This is a lot like Telnet except that communications are encrypted. If you're
running a Windows-based operating system, any number of ssh programs are available for use,
such as PuTTY. PuTTY is a Telnet and ssh client written for Windows operating systems and sup-
ports ssh v2. You can download it at http://www.chiark.greenend.org. uk.

If you insist on using one network adapter during your initial install, that’s okay. ESX
Server will automatically dedicate the only adapter to the Service Console. If you had
multiple adapters, you'd be given a choice of how to assign each of the cards—to the
console or to VMs. If you add more adapters after the install, don’t reassign the original
NIC dedicated to the console; ESX Server can experience trouble using the correct
driver for the new Service Console network adapter.

Though it isn’t necessary to have multiple SCSI controllers, your VMs will experience
better performance if you have one SCSI adapter dedicated to the Service Console and
one (or many) dedicated to your VMs. If you have one SCSI adapter, you can share it
with the console by dedicating it to the Virtual Machines option and selecting Shared
with Service Console. The Service Console will be installed to the highlighted drive. It
can be either an IDE drive or an SCSI drive. However, VMs must be installed on SCSI
drive. The VMkernel will fail to start otherwise. When you're done allocating your hard-
ware, click Next.

9. If youreceive a warning indicating that ESX Server has to initialize your hard drive,
you’ll lose all the data on the disk. Assuming you don't need any of the data, select Yes
to initialize the drive. If you select No, that’s the end of your install and the beginning
of your data salvage project.



158 CHAPTER 5 I/ INSTALLING AND DEPLOYING VMs ON ENTERPRISE SERVERS

10. On the Disk Partitioning Setup screen, you can choose Manual or Automatic partition-
ing. If you're experienced and comfortable with Linux-like operating system disk
partitioning, select Manual and have at it. You'll be required to create a minimum of
three partitions:

¢ /boot partition: The mount point of the boot partition and location of the OS
loader

¢ swap partition: The space reserved for the memory swap file
¢ / partition (read: root): The location of file system and Service Console files

Assuming you're manually partitioning the system, you'll be limited to creating four
primary partitions (three of which ESX Server will consume). In the fourth partition,
you can create multiple logical partitions as your needs dictate.

If you want a guaranteed way to have ESX Server running in no time, choose Auto-
matic Partitioning. If you have a single SCSI device, sda, the autopartitioning process
will create the partitions in Table 5-2.

Table 5-2. The Six Partitions of the Autopartitioning Process

Partition Label
/dev/sdal /boot
/dev/sda2 /
/dev/sda3 swap
/dev/sda4 extended
/dev/sda5 vmkcore
/dev/sdab vmfs2

When selecting Automatic, you'll be presented with the option to save any existing
VMES partition. VMFS partitions are where VMs are stored. If you're reinstalling ESX
Server and want to save preexisting VMs, select Remove All Partitions Except VMFS.
Because all partitions will be removed during automatic partitioning, the ESX Server
installation wizard will present you with a warning. Assuming you don’t mind losing
all the data stored on your hard drive(s), including manufacturer-installed utility/
management partitions, select Yes to continue.

11. The Defining Disk Partitions screen follows the Disk Partitioning screen. You can either
edit the choices made by the installation wizard or click Next to continue. Before you
continue jumping through the install, let’s take a moment to tweak a few partitions
using best practices. Adjust your /boot partition from 50MB to 100MB. Then highlight
/boot from the Mount Point column, click the Edit button, and enter 100 in the Size
(MB) field. Leave all other options as they are, and click OK.

The maximum any single swap partition can be is 2048MB, so you may need to create
multiple swap partitions to achieve your calculated partition size. In addition, don't
create a partition less than 256MB for performance reasons. Now, reconfigure the
memory swap file and create more as needed: highlight Swap from the Type column,
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and select Edit. Change the size of the partition to two times that of your installed
RAM. For instance, if you have 512MB installed, enter 1024 in the Size (MB) field.
Leave all other options as they are, and select OK.

With partitioning out of the way, the installation wizard provides you with the Network
Configuration screen. We highly advise you to use a statically assigned IP address for
your ESX Server. You really don’'t want to have to guess the IP address of the Service
Console from week to week, so select Static IP and enter the required host information.
Be sure to use an FQDN for the Hostname field (for example, www.apress.com). If you
don’t use an FQDN, you’'ll encounter host name resolution problems, and other systems
will have difficulty finding your new ESX Server. After entering the requisite informa-
tion, or if you're opting to use DHCP, click Next to move on with the installation.

On the Time Zone Selection screen, select the correct city and location where the ESX
Server will reside. Time synchronization between networked hosts is important for
authentication and logging purposes. For instance, some two-factor authentication
systems will fail to work if the two hosts involved have the incorrect time. If your sys-
tem clock uses Universal Coordinated Time (UTC), select the System Clock Uses UTC
check box.

If you want your system to account for daylight saving time, click the UTC Offset tab.
The Use Daylight Saving Time (U.S. Only) option is at the bottom-center of the screen;
choose it if necessary, and then click Next.

The Account Configuration screen is where the superuser/root (administrator) password
is configured. Be sure to do the following:

¢ Choose a password you can remember.
¢ Use an alphanumeric sequence.

¢ Create a password greater than the six-character minimum, with eight characters
optimally.

Security zealots may want to use nonprintable characters in passwords as well.

Tip If you have difficulty creating and remembering strong passwords, create a simple algorithm
you can use on common words to generate solid passwords. For instance, you can substitute vow-
els for prime numbers and turn the word football into f12b31. You can make your passwords even
stronger by starting and ending them all the same way. For instance, you could start all passwords
you create with a # and end them with a !; so football is now #f12b31!, baseball is now #b1s2b311!,
and password is now #p1ssw2rd!.

The root user account allows for the complete administration of ESX Server. It’s a
powerful account and can do anything to ESX Server you want—unlike Windows
OSs, the root administrative account can delete protected system files. Rather than
using the root account for administration, you should use a separate account and
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employ the su command to gain root-level commands only when it’s required. Though
using the root account in a training or test environment to help avoid complications is
conducive to learning, habitually operating ESX Server as the root user in a production
environment will inevitable result in damage to the file system. This happens because
the superuser account overrides system safeguards, and mistakes generally go unno-
ticed. During initial installation, create an additional account for general system usage
by selecting Add on the Account Configuration screen. When you're done, click OK and
then Next.

15. The system is now prepared for installation. Click Next to begin the package delivery.

16. The final installation screen points out some important information. It notes the loca-
tion of the setup log files:

e Installlog: /tmp/install.log
* Kickstart log (file containing preinstall choices): /root/anaconda-ks.cfg

You can refer to the log files after the setup for troubleshooting or documentation purposes.
Once the install begins, don't interrupt the process. If you do, you earned yourself a reinstall.

Tip Like the Blue Screen of Death, ESX Server has the Black Screen of Death. Any number of reasons
can cause the system to black-screen, including incompatible hardware, interrupted installs, and bugs in
the code itself. Make sure you do plenty of research before installing ESX Server to avoid black-screen
headaches. For instance, if you're installing Citrix on ESX Server, you'll receive the Black Screen of Death if
you don’t disable the COM ports in the guest VM’s BIOS. Moreover, you'll also experience the Purple Screen
of Death in the event of serious hardware failures.

If you hang out for the install, you can get an idea of what'’s being delivered to your system
by scanning the package summary. In total, it takes only five to ten minutes to install and only
about 700MB of disk space. The Congratulations screen declares the installation is complete.

Before selecting Next to reboot, let’s take a look at what’s going on behind the scenes. The
installation process has several sessions running that you can view by pressing Ctrl+Alt while
simultaneously pressing one of the 12 function keys (F1-F12). Cycle through the different ses-
sions saving F12 for last, because it may reboot your system. If your system doesn'’t restart,
press Ctrl+Alt+F7: this will return you to the Congratulations screen where you can click Next
to reboot. On reboot, you'll see the LILO Boot Menu screen. If you do nothing, the menu timer
will expire, and the system will start. If you're familiar with how Linux or Novell OSs boot,
you'll feel right at home while ESX Server initializes all its necessary processes; it ends in the
Welcome to VMware ESX Server screen.

Now that the installation is complete, you're ready to configure ESX Server to host virtual
machines. To configure the server, you'll need to have access to an additional networked com-
puter with a Web browser. Is it beginning to feel a little like NetWare? VMware recommends
that your Web browser be Internet Explorer 5.5 or 6.0, Netscape Navigator 7.0, or Mozilla 1.x.
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Verifying ESX Server Configuration Information

When ESX Server is booting, you can get a good idea of what services are being loaded. If
you've used Linux-type operating systems, you'll encounter a familiar boot process. Before
you start the configuration of ESX Server, let’s make sure the system is ready to communicate
on the network. For Unix and Linux users, this section will seem basic, but it’s essential for
Microsoft administrators. If you're familiar with the information, skim this section and use it
as areview.

You'll want to check the server’s basic configuration, so you'll need to gain shell access by
pressing Ctrl+Alt+F2. You can switch between shell sessions by pressing Ctrl+Alt+F1 through
F12. So you can get an idea of how it works, toggle between the Welcome screen and the shell
Login screen.

At the shell Login screen, enter the administrator’s username root, and use the password
you configured earlier for the account.

Gaution Unlike Micorosft 0Ss that are generally case insensitive, every command in Linux-like operat-
ing systems is CaSe sEnsiTive. Everything! For instance, ROOT isn’t the same thing as Root or root. These
are all three different user accounts, and only one is the superuser administrator account—root.

After logging into the ESX Server CLI, the first thing you'll want to check is the system’s
IP address information. Type ifconfig | less atthe command line. (You could use the pipe
with the more command, but less allows scrolling up and down with the arrow keys. Type q to
quit.) You should have information for the loopback address (1o) and a minimum of two Eth-
ernet controllers (etho and eth1). Remember that you need at least two NICs to bridge or NAT
VMs to your network. If you dedicate a single NIC to VMs, you'll lose the ability to connect to
the Service Console with a Web browser.

Confirm that your server’s information is correct, and then test the following using the
ping command. You can use Ctrl+C to break out of the looping echo requests and echo replies.

* Test the server’s TCP/IP stack by pinging the loopback address with ping 127.0.0.1.
* Test the server’s default gateway with ping <your gateway router IP address>.

» Test DNS by pinging a Web site with ping www.apress.com, for example. Some Web
servers block ICMP traffic, so you may get only the domain name to resolve to an IP
address.

Viewing Configuration Files

If you have a problem with the ping tests listed previously, you'll have a problem configuring
ESX Server through a Web browser. If no IP address information exists, you can attempt to use
the setup command to configure your IP address information. A better solution to verifying
configuration information is to check the configuration files from the command line. Though
we could easily turn this into a Linux tutorial, we’ll just walk you through the basics.
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Editing configuration files starts with a good text editor and enough knowledge to be
dangerous, so now is as good a time as any to discuss the Vi editor: some of us hate it, and some
of us love it. It comes with nearly every version of Linux; you can even find it in the Microsoft
NT Resource Kit. Whether you're a fan of Vi or not, it’s an excellent text editor that gets the job
done. Table 5-3 lists the commands you’ll need to memorize for ESX Server administration.

Table 5-3. Vi Survival Commands

Command Action

vi Starts the Vi editor

vi <filename> Starts Vi and opens the given file for editing

:q! Exits the Vi editor without saving changes (quit!)
iwq! Exits the Vi editor and saves changes (write and quit!)
:set nu Turns on line numbering

esc Exits text insert mode

i Enters text insert mode

Arrow keys Navigates the cursor

Backspace key Deletes previous character

Delete key Deletes selected character

Vi has two different running modes: command mode and edit mode. In command mode,
every keystroke is interpreted as a command and performs file functions such as editing and
saving. These commands are referred to as colon commands because they start with a colon.
You know you'’re in command mode because you won't see “INSERT” in the lower-left corner
of your display. The lower-left corner should display a colon when executing colon commands.
If you have any doubts as to what mode you're in, press the Escape key (several times) to enter
command mode.

In text mode, typed characters are echoed to the screen and temporarily become part of
the open document. Enter text mode from command mode by typing a lowercase i (for insert
mode). Use the arrow keys to navigate the cursor, and use the Backspace and Delete keys to
remove characters. To quit without saving your current work, or to save your current work and
quit, refer to Table 5-3.

Now that Text Editing 101 is out of the way, you can verify your ESX Server configuration
information using the filenames listed next. For each file, open and view your system’s infor-
mation. If anything is incorrect, take a moment to fix any errors and save your changes.

You can find configuration files relating to the host name (FQDN) of your system in three
places:

e vi /etc/sysconfig/network
e vi /etc/hosts
e vi /usr/lib/vmware-mui/apache/conf/httpd.conf

IP address configuration information for the first network adapter is located in
/etc/sysconfig/network-scripts/ifcfg-etho.
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The contents of the ifcfg-etho file will look similar to the following:

DEVICE=etho
BOOTPROTO=static
BROADCAST=X.X.X.X
IPADDR=X.X.X.X
NETMASK=X.X.X.X
NETWORK=X.X.X.X
ONBOOT=yes

IP address information for the second network adapter is located in /etc/sysconfig/
network-scripts/ifcfg-ethi.
The contents of the ifcfg-eth1 file will look similar to the following:

DEVICE=eth1
ONBOOT=yes

You can find DNS server configuration information in the resolv. conf file. Review the
contents of it by executing the following command:

vi /etc/resolv.conf

Default gateway information is located in the network file. Make sure the default gateway
is properly set. If not, you'll spend needless time troubleshooting your host. Verify your host’s
settings with the following:

vi /etc/sysconfig/network

After verifying and making any necessary changes, restart the networking service by
entering the following command:

service network restart

Continuing at the CLI, execute hostname <FQDN> (for example, hostname www.apress.com)
to make the host name change effective without a reboot.

Next, repeat the ping tests, and verify your system’s host name with uname -a.

With positive results from network connectivity and name resolution testing, the ESX
Server installation is complete. You can move onto your post-installation housekeeping. You'll
perform these tasks by configuring and using the MUI.

Using Linux Survival Commands

Now that the ESX Server installation out of the way, you need to look at a few Linux survival
commands. If you're accustomed to Linux operating systems, this section will be a snore;
however, if you're new to the world of Linux, this section should offer some much needed
information. Table 5-4 is a quick reference for the commands you can use at the Service
Console. A complete discussion of Linux and its wealth of commands are beyond the scope
of this book.
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Table 5-4. Linux Survival Commands

Command Purpose Example

man Displays extended help man reboot (the letter g quits help)

--help Displays basic help reboot --help

clear Clears console screen clear

su Switches to superuser or between users  su or su <userid>

1s Lists files in a directory 1s /
Lists long listing with hidden files 1s -al
Lists scrollable long listing 1s -1 | less

pwd Reveals present working directory pwd

cd Changes to new directory cd <directory>

mkdir Makes a directory mkdir <name>

rmdir Removes an empty directory rmdir <directory>

m Removes a file (or directory) tm <filename>, tm -1 <directory name>

mount Attaches to media, as in CD-ROM mount <device> <destination>
Mounts CD-ROM mount /dev/cdrom /mnt/cdrom
Mounts floppy drive mount/dev/fdo /mnt/floppy

eject Ejects CD-ROM eject

cp Copies a file or directory cp <source><destination>

mv Moves a file or directory mv <source> <destination>

find Locates a file or directory find / -name <name>

tar Creates a compressed file tar -czvf <source> <destination>

Extracts a compressed file

umount Disconnects from media or partition
Unmounts floppy drive
Unmounts CD-ROM

fdisk -1 Lists disk partitions

service Controls system services and stops
Starts system services
Restarts system services

passwd Manages passwords

ps Lists system processes

free Displays memory statistics
ifconfig Reveals IP addressing information
uname Reveals host name

ping Stands for Packet Internet Groper

reboot Restarts the ESX host server

tar -xzvf <source> <destination>

umount <directory or device>
umount /mnt/floppy
umount /mnt/cdrom

fdisk -1

service <service> stop
service <service> start
service <service> restart

passwd <user ID>
ps -efa | less
free -m

ifconfig -more
uname -a

ping <IP address>

reboot
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Working with the Management Interface

Now that you've confirmed and tested basic ESX Server functionality, let’s move onto config-
uring the system to host VMs. You'll conduct post-configuration tasks through the MUI. In a
nutshell, the MUI is ESX Server’s primary front-end management tool and is delivered by an
Apache-powered Web page. Because it requires a Web browser to function, be sure to turn off
any pop-up stoppers you may have running. Failing to allow pop-ups from the ESX Server will
result in you not being able to see VMware ESX Server’s configuration windows. In addition,
you'll need to be able to contact the ESX Server via its host name from your workstation, so
configure DNS or edit your local host file for name resolution. We'll cover five main post-
configuration tasks:

e Customizing the MUI port number

* Configuring initial MUI configuration settings
* Creating the VMFS swap file

* Assigning network cards

* Constructing virtual switches

Understanding MUl and SSL

You can configure ESX Server to use a certificate from your certificate authority or continue
to use the one ESX Server generates for itself during the install. If after installing ESX Server
you find it necessary to change the host name of the system, you should re-create the system’s
SSL certificate to avoid getting SSL security alerts while accessing the administrative interface
of ESX Server from your Web browser. An SSL alert proclaims that the name on the security
certificate is invalid. This occurs because the host’s name isn’t the same as the one on the
certificate. If you didn’'t supply an FQDN during the install, you'll find that the name on

the certificate is Iocalhost. localdomain. You can manually reconfigure ESX Server, or you
can use the enableSSL script provided by VMware to generate another self-signed certificate
with the correct host name. You can download the enableSSL script from http://www.vmware.com.
To use VMware’s script, you need to follow these steps:

1. Create a file with Vi, and name it enableSSL.pl:
vi enableSSL.pl
2. Type the text from the enableSSL.pl script into enableSSL.pl, and save it.
3. Rename the old SSL directory:
mv /etc/vmware-mui/ssl /etc/vmware-mui/ssl-old
4. Run the script you just created:

perl enableSSL.pl localhost root <root password>
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5. Verify that the new SSL directory was created:
1s /etc/vmware-mui/ssl

6. Restart the Apache daemon:
service httpd.vmware restart

7. When all proves to function, delete the old directory:
rmdir -R /etc/vmware-mui/ssl-old

Test your new SSL certificate by browsing to your host’s MUI. View the certificate, and
verify its name is the same as the host’s.

Configuring the ESX Server Installation: Part One

Sometimes things don't go as planned during the ESX Server installation. If something goes
awry, the System Configuration Wizard will present itself after logging into the MUI. The wiz-
ard generally launches for one of three reasons: the ESX Server has been installed without
being configured, ESX Server has been upgraded from a previous version, or the VMkernel
failed to load. If ESX Server proclaims, “Your system has not yet been configured, or the exist-
ing configuration is incomplete; the wizard will guide you through the system configuration
process,” hold onto your keyboard: ESX Server is throwing you a curveball. If you run into
problems with a new installation, repeat the install to see if you can duplicate the configura-
tion process. You don’'t want any anomalies related to software or hardware sneaking into
production.

After connecting to your ESX Server through a Web browser, select Yes to the SSL security
alert. If you want, you can view it and install the certificate. You'll next be presented with the
VMware Management Interface login screen. For now, enter root as your username and the
appropriate password. Check your Caps Lock key, and remember that everything is case sen-
sitive. Once you've logged into ESX Server’s MUI, you'll need to complete several post-install
tasks if something went wrong during installation, which may include the following:

¢ Accepting the license agreement

* Configuring the startup profile

e Setting up the storage configuration

* Configuring the swap configuration

¢ Setting up network connections and switches

¢ Adjusting security settings

If your install fails to provide the initial configuration pop-up—it’s a good thing! Keep
reading, though, because we'll cover a few things here that aren’t covered if you have an

uneventful installation of ESX Server. If something went awry during the installation, the
ESX Server Configuration screen will open in a new window.
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License Agreement

The first thing you must do is accept VMware’s license agreement on the End User License
Agreement screen. Be sure to check the box signifying your compliance and enter your serial
numbers. If you didn’t purchase Virtual SMP, leave the relative fields empty. If you don’t have
the proper licensing information, you won't be allowed to proceed with the server configura-
tion. You can get a demo license by registering with the VMware Web site.

View your license rights, and confirm the correctness of the license expiration, number of
supported host machines, number of supported host processors, and number of processors
supported for each virtual machine. If all is okay, click Next to continue.

Startup Profile

Before being presented with the Startup Profile screen, there will be a brief pause while the
startup profile is loaded. You'll need to specify how much memory is to be reserved for the system
console. This number will be based on how many VMs you intend to host on your server. Being
that RAM is cheap and you want to err on the side of performance, under System Startup, pick a
setting one greater than you need. For instance, if you plan to run eight virtual machines, use the
settings for sixteen virtual machines.

Under Hardware Profile, you now need to assign the network adapters to the Service Con-
sole or to VMs. If you have only one NIC, you can assign it for VMs to use, but you'll lose the
console’s network connection. For ease of administration, you should install two NICs. If not,
you’ll be forced to configure everything from the CLI or be left to hack together a locally run-
ning copy of XWindows. Though running X Windows locally is possible, it consumes valuable
resources and isn't officially supported; moreover, it’s a good way to cause your VMs to quit
functioning. After dedicating memory and NICs as necessary, click Next to continue your
installation.

Storage Configuration

ESX Server may take a moment to save your startup profile and reboot. On reboot, log back
into the MUI You may receive an error message stating that the system isn't configured or it
has an incomplete configuration. You have a choice to view the system logs, so take a moment
to explore them by selecting the System Logs hyperlink. Cycle through the four tabs, and make
note of any pertinent information. The logs can get quite long and be cryptic; if you're not a
Linux guru, be prepared to break out your Linux books to decipher the contents. Whether or
not you're required to troubleshoot the install process, you'll eventually see the Storage Man-
agement Disk and LUN configuration screen, assuming all the necessary partitions were
created during the install. You can take the opportunity to repartition the system, or you can
click Next to continue. If you have to create partitions, you'll need to know that guest VMs can
be stored only on VMES partitions or physical disks. You must have a least three partitions:
/boot, swap, and /. The partitions created during the install that contain the Linux file system
and the Service Console swap partition can’'t be changed.
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Swap File

On the Swap Configuration screen, select Create to make a memory swap file. You'll be pre-
sented with another swap file configuration screen. Generally, ESX Server does a good job of
determining the filename, size, and activation policy. If you'd like to change the storage vol-
ume or filename, now is a good time to do it. Make sure the swap file is a minimum of 256MB
and no larger than twice the server’s physical memory. If desired, you can direct ESX Server to
allow you to manually start the swap file. If you choose this as the activation policy, you'll have
to start it manually by entering vmkfstools -w at the CLI. Take a moment to activate your swap
file now. If you do, you won't have to reboot.

Network Configuration

After completing the Swap Configuration screens, you'll be presented with the Network
Connections/Virtual Switches dialog boxes. If necessary, you'll need to configure network
adapters that guest VMs will use. Before setting your speed and duplex, know how your switch
is configured. If you decide to team network adapters, know the team bonding type of your
connecting switch. As a rule of thumb, avoid autonegotiation and reconfigure your switch if
necessary. You can experience high latency intervals while the NIC and switch attempt to hash
out their respective settings.

If you have one NIC, you'll need to configure the adapter after completing the Configura-
tion Wizard. You'll need to perform the following steps:

1. Use Vi to edit /etc/module.conf. Comment out the alias etho line by placing a pound,
hash, square, gate, or number sign at the beginning of the line:

# alias etho e100

2. Connect to ESX Server from a Web browser, http://<hostname>. Select Edit, and under
Device Allocation, reassign the NIC to Virtual Machines. Reboot.

3. Login asroot at the console. Use Vi to edit /etc/rc.d/rc.local, and append the NIC’s
name. If you're unsure of your NIC’s name, you can use the findnic command as an aid.

insmod vmxnet console devName="vmnico0"
ifup etho

4. Reboot, and the single NIC sharing is complete. You'll now have to perform all admin-
istration of ESX Server at the console.

Binding NICs together to form a bond is the same as teaming NICs. When creating bonds,
be sure to use functionally similar physical NICs because ESX Server will support only what
they have in common, such as VLAN tagging, TCP segmentation offloading, and checksum
calculations. You're limited to bonding a total of ten physical adapters for any given VM. You
may also be required to create and configure a virtual switch. You'll need to supply a name for
the switch in the Network Label fields. Next, look at Outbound Adapters, and assign an avail-
able NIC from the list to the switch. Then click Create Switch.
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Similar to a physical switch, a virtual switch has 32 ports; it can be used to load balance and
team NICs and provide redundant links. You can connect one VM to each port. Virtual switches
have labels and can be renamed only when no VMs are using them, so take precautions when
doing this (double-check everything). If you rename a switch with a programmatically attached
VM, it won't boot. If you're creating a network of host-only VMs, deselect all NICs from the con-
figuration of the switch. In addition, you can create port groups, which are similar virtual local
area networks (VLANs). VLANSs logically group switch ports into a single network and allow for
secure communications amongst the hosts. Before creating a port group, you must have an
existing network created. You can have IDs between 1 and 4095. When you're done configuring
the switch and NIC, click Next to continue.

ESX Security

The ESX Server installation process will now present you with the Security Settings screen.
By default, the system selects high security for you. If it's necessary to make changes, choose
Custom to enable the minimum number of services you need. Though this should go without
being written, the more you open up ESX Server, the more vulnerable it is to attacks. When
you're done selecting your security settings, click Next to continue.

After completing the ESX Server Configuration screen, you should be presented with the
VMware Management Interface Login screen. Should your system continue to fail the config-
uration process, double-check your hardware configuration, and make sure it meets the
minimum requirements for ESX Server.

If you're still having problems, make sure you have at least one NIC and one SCSI hard
drive available for guest VMs: both are minimum requirements. You'll also notice that the
host name isn't properly configured. After triple-checking your system against the minimum
requirements and VMware’s HCL for ESX Server, give the installation another shot. You'll find
that it really is seamless, and you can move onto what you should expect to see from a suc-
cessful installation.

Caution Installing X Windows on ESX Server for educational or test purposes is okay. Don’t install X
Windows on a production ESX Server system—the overhead will ravage resources and render a production
server useless. Given the aforementioned warning, you can install X by installing it as well as its dependen-
cies by using RPMs from Red Hat 7.3.
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Configuring the ESX Server Installation: Part Two

In Part One, we touched on several problems you'll run into with the ESX Server install and
how to negotiate fixes with the aid of the Configuration Wizard. Now let’s look at what you
should expect to see when things go well. Connect to the MUI using your Web browser. You'll
be presented with two warnings, one stating that “No swap space is configured or none is
active” and the second stating that “No virtual Ethernet switches found.” Select Reconfigure
at the end of the first warning, and follow these steps:

1. Under the heading Configured Swap Files, select Create. The swap space on ESX Server
affords VMs the ability to use more memory than physically available. ESX Server does
a good job of recommending the amount of space to make available, but you should
adjust the File Size field to be atleast 2GB or two times the amount of physical
memory in the host system. Be sure that Activation Policy is set to Activate at System
Startup. If you don’t, you'll have to manually activate the swap space on each boot.
When you're done making changes, select OK to continue. You'll be returned to the
initial Swap Configuration screen. On this screen, under Configured Swap Files, select
Activate. If you don't activate the swap space now, it won't be active until the system is
rebooted. Select OK to continue.

2. On the Status Monitor page of the MUI, you should have one warning remaining.
Select Reconfigure at the end of the warning. The system will present you with the
Virtual Switches tab from ESX Server’s Network Connections settings. Take a moment
to read about virtual switches on this screen, and then select Click Here at the bottom
of the screen to create a virtual Ethernet switch. Under New Configuration, the system
will provide a suggested network label for the switch; you can make changes if neces-
sary. Under Bind Network Adapters, you'll then have to select which outbound adapter
should be bound to the new virtual switch. After making any changes, select Create
Switch to continue.

3. Next, select the Physical Adapters tab. You'll need to set the speed and duplex of the
network adapter bound to the new virtual switch in the Outbound Adapter settings
section. You can run into problems if you leave the setting on Auto Negotiate. When
you’re done making changes, select OK to continue. The system will return you to the
Monitor Status tab of the MUI. All warnings should now be gone.

Take a moment to explore the Memory tab. It displays a summary of physical and
reserved memory. In addition, it will summarize the memory consumed by any configured
and running guest VMs. Take a moment to explore the Options tab. The Options tab details
all configurable information as related to your ESX Server. Click through each field, and
read all available information. You'll want to be somewhat familiar with these settings as
you install guest VM's and make changes to support enterprise servers.
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Summary

Building on your knowledge of how to physically size and prepare enterprise-class servers
from previous chapters, you should now feel comfortable installing, configuring, and deploy-
ing server-class virtualization applications. You should also be able to prepare and install both
Windows and Linux hosts for running multiple production virtual machines, and you should
be able to troubleshoot basic installation issues for each of the server-class virtualization
applications. In the next chapter, you'll focus on managing production VMs on enterprise
servers. You'll look at management and monitoring issues regarding VMs running on produc-
tion servers and learn about VM scripting techniques.
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CHAPTER 6

Deploying and Managing
Production VMs on
Enterprise Servers

N ow that you know how to size hardware for VM servers and install VM server application
software, in this chapter you'll install guest VMs and learn about management and monitoring
issues regarding production servers. We'll use a step-by-step approach to expose techniques
for monitoring resource utilization, monitoring performance, scripting fault monitoring,

and scripting fault-tolerant VM recovery. We'll leave enterprise-class virtualization topics

to Chapter 14, where we'll discuss virtualization techniques to help manage the enterprise.

Deploying VMs with VMware GSX Server
and ESX Server

Creating VMs for VMware GSX Server and ESX Server is similar to creating them for VMware
Workstation. Though you should know what you want in the way of hardware and naming
conventions with a VM before creating it, you can always edit the VM after it’s created. We'll
show how to create VMs on Windows and Linux hosts for GSX Server and install a guest VM
on ESX Server. To make the most of this topic, skip to the section that interests you. After
discussing how to create guest VMs, we'll cover individual hardware options, and you'll
learn how to migrate guest VMs between host systems.

Building VMware GSX Server VMs

Building a Windows VM is identical to building a Linux VM. The major difference between the
two is the host’s operating system. To start, launch VMware Server. For Windows host systems,
select Start » Programs » VMware » VMware GSX Server/VMware GSX Server Console, and
select File » New Virtual Machine to launch the New Virtual Machine Wizard. To launch
VMware for Linux, make sure X Windows is started and type vmware in a terminal window;
then select File » New Virtual Machine.

During the installation process, you have the option of performing a default or custom
install. As with all installs, you'll want to customize your installation, so select Custom. Wiz-
ards are great, but you want to control as much of all installation procedures as possible. Then
select which guest operating system type to install.

173



174

CHAPTER 6 " DEPLOYING AND MANAGING PRODUCTION VMs ON ENTERPRISE SERVERS

For this sample install, we’ll select Microsoft Windows. If you want to install a Linux VM,
choose Linux. From the Version drop-down menu, select the OS you'll be using for the guest
VM. As you've probably noticed, you have one heck of a selection for guest VMs. Though it’s
not listed, you can install DOS 6.22 by selecting Windows 3.1. For discussion purposes, we'll
be configuring Windows 2003 Server. Regardless of what you choose, these directions will be
identical to the choices you'll need to make. As we explained in Chapter 4, you'll have to select
a name for your VM and a storage point for the guest VM'’s virtual hard disk that adheres to
best practices.

For example, a guest virtual machine named vmlinux2 would be stored in
D:\VirtualMachines\vmlinux2. For Linux systems, adjust your path statements as necessary
(for example, /root/VirtualMachines/vmlinux2). Remember, you don't want the host OS and
guest VMs to use the same hard disks or same physical controllers. If you're in a lab or educa-
tional environment and don’t have access to expanded resources, simply use the default
directory—just create a custom directory for each guest VM. It makes management much
easier by having all the files for each VM stored in a unique directory.

Caution If you use the default location for VM guests and use folder redirection for My Documents, you
may experience adverse performance when large virtual disks are copied to the redirected folder.

The Access Rights selection screen requires you to decide if you want the VM to be avail-
able to everyone using the machine or only under the account from which it’s being created.
If this will be a production server, be sure to uncheck the private selection.

On the Startup/Shutdown Options screen, you have the ability to manage the startup and
shutdown characteristics of the new guest and the account under which the VM will run. VMs
can run under the user account that powers it on, a local system account, or a preconfigured
user account. If you're building a server to be a LAN resource, it’s often best to set the VM to
run under the local system account. Additionally, you can select to have the guest start up
and shut down with the power cycles of the host.

Determining the power-up or power-down characteristics of a guest VM will be based on
individual circumstances. If you have VMs power on at host startup, you won’t have to manu-
ally start each one. Conversely, it may make servicing the host more difficult. Having guest
VMs automatically power down with the host is convenient, and this plays nicely into any UPS
management shutdown strategies. Moreover, to prevent the loss of data, it’s a good idea to
power down all VMs before bouncing the host.

The wizard will recommend the amount of RAM to use for the guest VM. Generally, the
wizard performs an okay job of selecting the amount of RAM for you. But before “mashing”
next, notice that the wizard reveals the minimum, recommended, and maximum amounts of
RAM to use for the guest. These are merely recommendations. You should have performed a
bit of research to determine the amount of RAM your guest OS actually requires.

In lab and learning situations where RAM is limited, feel free to throttle memory back.

In production environments, be sure to allocate as much RAM as you'd normally provide for
a system. If you have the ability to cycle your servers often, you can start with the minimum
amount of RAM and work your way up until you reach a satisfactory level of performance.
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The Network Type Selection screen lists the networking characteristics you can make
available to your VM. If you want to connect guest VMs as quickly as possible to your test or
production network, select Use Bridged Networking. If you want this guest VM to be in a private
network, select Use Host-Only Networking. If you have second thoughts as to the networking
types, please refer to Chapter 2, which covers the networking types thoroughly.

The I/0 Adapter Types selection screen designates whether a BusLogic or an LSI adapter
will be used in the VM.

An easy way out of this choice is to use the BusLogic default. However, you'll get a little
better performance from the LSI Logic option. As a word of caution, you'll need to have the
LSI driver available when you install the actual OS on the guest VM.

Tip It's a good idea to download the LSI Logic driver for your VMware guest VMs. It’s well worth the effort.
Additionally, you’ll want to copy the driver to a floppy disk and make an ISO image of the disk. You can then
mount the image like a physical floppy drive and have it available during the guest 0S install. You can down-
load ISO image-making software from several vendors on the Internet for a trial period; for instance, try
MagiclSO from http://www.magiciso.com or Undisker from http://www.undisker.com.

If you're creating a new VM, on the Select a Disk screen, leave the default choice to create a
new virtual disk. If you're setting up a VM to use physical disks, refer to the “Configuring
VMware GSX Server and ESX Server Virtual Hardware Options” section in this chapter.

The Select a Disk Type screen provides two options: IDE and SCSI. You'll generally want to
match the virtual hardware with the physical hardware.

You have the option of using a virtual IDE or SCSI disk despite the physical medium in the
host. Virtual IDE is limited to two devices per channel, and virtual SCSI is limited to seven. For
IDE devices, you're limited to four.

On the Specify Disk Capacity screen, you'll need to decide the total maximum amount of
space to be used by a guest VM. You'll also need to decide if you want the disk to be dynami-
cally expanding, which is the default, or fixed. Fixed disks have the space allocated up front,
and the space will always be available to the guest. Dynamic disks expand as necessary. This
means they’ll grow to the maximum size specified. If you're building a server, be sure to allo-
cate all the space up front. Dynamic disks fragment the host’s hard drive and will eventually
impact performance.

You'll get better performance with fixed disks because dynamic disks tend to fragment
your hard drive. If you're in an educational or lab type environment, dynamically expanding
disks tend to work well. For production environments, you'll want to stay with fixed disks.
Being that our example is geared around a Windows 2003 Server and our test system has
sufficient disk space, we'll select the Allocate All Disk Space Now option.

As for how many gigabytes to use for the system disk, this is really a matter of preference
and experiential knowledge. In the NT days, 4GB was sufficient. Today, with the code bloat
involved with Windows 2000 and 2003, you'll find you'll want a disk with 8GB or even 12GB
reserved for the virtual hard disk. The value of having ample space is that you can copy the
1386 directory from the Windows CD, service packs, and drivers to the hard drive for future
use. Having plenty of room also allows you to keep log files longer.
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Caution You have the option to split virtual disks into 2GB files. If your host’s operating system doesn’t
support files larger than 2GB, like EXT or VFAT, you'll need to select this option during virtual disk creation.
For some Linux operating systems, the wizard will autoselect the Split Disk into 2GB Files option.

If you chose to preallocate space for your guest’s virtual disk up front, the system will
inform you it will take a moment to create the disk. The system may appear to hang, so be
patient during virtual disk creation.

The wizard, on the Specify Disk File screen, will prompt you for the name of the virtual
disk and the location where you'd like to have it stored. Choose the same location and naming
convention you established earlier in the VM creation process.

Take a moment to click the Advanced button and explore these options. On this screen,
you can specify the virtual disk’s device node and the disk mode. Nodes reference a virtual
disk’s relationship to its bus and device ID. For instance, the first IDE device on the first chan-
nel is 0:0, and the first device on the second channel is 1:0. Specify the virtual disk mode from
the Mode section, and set the disk to Independent Persistent or Independent Nonpersistent.
If you want to easily use snapshots, leave the default disk mode selection.

When the disk creation process is completed, you'll be returned to the VMware Server
MUI. The newly created VM appears in the left column under Favorites, which are merely
shortcuts to your VMs. Before powering on your new VM, take a moment to look at the VM’s
hardware settings using the Configuration Editor by selecting Edit Virtual Machine Settings.

Building VMware ESX Server VMs

Building ESX Server VMs is similar for both Windows and Linux VMs. It’s a wizard-driven
process, and the initial setup completes as quickly as ESX Server can format the virtual fixed
disks. During the installation process, you have the option of performing a default or custom
install. As with all installs, choose to customize it. Wizards are great, but you want to be in as
much control of all installation procedures as possible.

To start, open your Web browser, browse to the ESX Server MUT login page, and log in
with an account that has superuser privileges, such as the root user account. Next, select
Add Virtual Machine from the bottom-right corner of the window, and follow these steps:

1. On the Add Virtual Machine screen, select Guest Operating System and supply a
Display Name option for the VM. In the Location field, remember to create a unique
directory for the guest VM and name it after the VM. Take caution not to delete the
configuration file’s extension.

2. The Virtual Machine Configuration screen gives you the opportunity to select the
number of virtual processors to make available to the VM and the amount of memory.
If you'll be running Terminal Services for Citrix Metaframe, be sure to select that
option under Workloads. This option allows ESX Server to reserve and allocate
memory for the VM.

3. On the Virtual Disk selection screen, select Blank, Existing, or System LUN/Disk.
Assuming you're creating a simple virtual disk, select Blank. Chapter 14 covers
SAN-attached disks.
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4, The configuration of the VM’s virtual disk ends at the Edit Virtual Disk Configuration
screen. When supplying a name for the Image File Name option, name the *.vmdk file
after that of the VM; it reduces administrative overhead in the future by making main-
tenance easier. Set the virtual SCSI node, and select the disk mode you want to use.
Persistent mode acts like a typical physical disk.

ESX Server will take a moment to create the virtual disk for the VM. Once the creation
process has completed, the MUI displays the VM’s configuration via the Hardware tab. Verify
each device. If you don’t need a device, remove it. If you need additional devices, click Add
Device.

Mounting ISO Images

If you have ISO images of your OS installation media, you can mount the ISO by selecting Edit
under DVD/CD ROM Drive. For the Device setting, select ISO Image, and specify the ISO
directory in Location. As a rule of thumb, the default installation of ESX Server doesn’t leave
much room for ancillary files such as ISO images to be hanging out. You can work around this
by using the mount command with the samba option to connect to network locations and
mount them as a local directory. Follow these steps:

1. Connect to the ESX Server console using a terminal session. You can use ssh from within
Linux, or you can use connectivity programs, such as PuTTY, to attach Windows OSs.

2. Create a mount point in the /mnt directory for the ISO:
mkdir /mnt/iso

3. Use the mount command to connect to the remote Server Message Block (SMB) share.
The command statement that follows is similar to what you'd need to run. All the
parameters are passed to the remote server to allow connectivity. Be careful when
sending passwords; they will be in plain text.

mount -t smbfs -o username=administrator,workgroup=<domain>,
password=123456 //RemoteServer/RemoteShare /mnt/ISO

4, Test the mount completed successfully by listing the contents of the /mnt/iso directory:
1s /mnt/iso

5. To install the guest OS, connect to the ESX Server MUI and edit the properties of the
CD/DVD-ROM drive. Set the mount location to /mnt/iso/<cdrom.iso>, and install the
guest’s OS.

If you want, you can put the mount command in a small Perl script to mount the remote
location on demand, and you can create a second script to unmount (umount) the remote
share when you're finished using the ISO. This is the Perl script to mount the remote share:

#!/usr/bin/perl

use strict;

" mount -t smbfs -o username=administrator,workgroup=<domain>,
password=123456 //RemoteServer/RemoteShare /mnt/ISO";

177



178

CHAPTER 6 ' DEPLOYING AND MANAGING PRODUCTION VMs ON ENTERPRISE SERVERS

This is the Perl script to unmount the remote share:

#!/usr/bin/perl
use strict;
“umount -f //RemoteServer/RemoteShare’;

Installing VM Tools for GSX Server
and ESX Server VMs

After installing an operating system on your guest VM, you'll want to install VMware Tools.
The VMware Tools package supplies significant enhancements to a VM and provides extra
functionality between a guest VM and the host system. For instance, adding VMware Tools
facilitates drag-and-drop support between a guest and the host, increases graphics perform-
ance with an optimized video driver, supports time synchronization between guests and the
host, and supports seamless mouse transitions between guest VMs and the host system.

VMware Tools is available for you to install by using ISO images compiled in VMware GSX
Server and ESX Server, and it supports a gamut of Microsoft Windows OSs, from Windows 9x
through Windows 2003, as well as many Linux distributions. As a technical note, during the
installation process, VMware GSX Server and ESX Server temporarily mount the ISO files as
the guest’s first CD-ROM drive. The procedures to install VMware Tools for Windows and Linux
guest VMs are virtually identical across GSX Server and ESX Server.

Using VMware Tools for Windows

To initiate the installation of VMware Tools for a Windows VM, start by selecting VM » Install
VMware Tools from the Server Console menu. You'll first be presented with a preinstallation
pop-up box, informing you that the guest VM to receive the tools must be running.

On the Setup Type selection screen, select Custom as your install choice. As a rule of
thumb, you really never want an application to automatically make choices for you. Even if
you opt for the defaults during a custom install, you’ll be aware of the installation points and
the services to be loaded in case you need to troubleshoot any problems.

The Custom Setup configuration screen has three main options: Toolbox, VMware Device
Drivers, and Shared Folders. If you take a moment to click each option, the Feature Description
area will display some details about the option selected. Briefly stated, though, the Toolbox fea-
ture improves the usability of a VM by using a group of utilities; the VMware Device Drivers
option installs performance-enhancing drivers for the virtual video, mouse, SCSI, and network
adapters; and the Shared Folders option facilitates the sharing of files between the guest VM and
the host. If this is your first installation, install all the drivers; you'll want to experiment with each.
If you're not satisfied with the installation destination of the tools, click the Change button to
select a different destination directory.

To install the tools, select Install on the Ready to Install screen. If you have doubt as to any
selections previously made, review your choices by clicking the Back button.

The wizard will take a moment to deliver the software packages, and during the delivery
process you'll receive several alerts. The alerts state that the VMware Tools drivers haven't
passed Windows Logo testing. This is okay; select Continue Anyway on each of the driver
alerts. You'll also notice that some of the drivers activate during the install, such as the
mouse. You can seamlessly move your mouse between the guest and host windows.
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On the Installation Wizard Completed screen, select Finish to complete the install, and
you’ll be prompted to reboot your guest VM system.

If you don’t have VMware tools installed, you'll have to press Ctrl+Alt to release the focus
of the mouse from the guest VM and return focus to the host system. The mouse will also
underperform in that it will appear to move erratically. Without the video driver, the guest’s
display will have limited resolution capabilities, and the SCSI drivers simply add better per-
formance characteristics for attached virtual devices. With the tools installed, take a moment
to optimize the performance of Windows XP by referring to Chapter 3.

Tip With virtualization application technology storming the IT front, you’ll want to find all possible sources
of information. VMware’s online documentation and community forums are an excellent place to get valuable
information about configuring guest VMSs. For instance, you can find detailed information on installing VMware
Tools for each Windows OS at http://www.vmware.com/support/ws45/doc/new_guest tools ws.html.

Using VMware Tools for Linux

The Linux VMware Tools package is built into VMware GSX Server and includes all the same
great benefits and ease of installation as Windows Tools. You don’t need to download any addi-
tional software or use physical media. The easiest way to install the tools is to log into the VM
as the root user. If you don’t, you'll need to invoke the su command with a typical user account.
Keep in mind that the example code to follow may not work with your particular distribution;
therefore, make adjustments as necessary:

1. To begin the installation, power on the guest VM to receive the packages in text mode;
the tools can’t be installed if X Windows is running. After the guest VM has completely
booted and you've completed the login process, select File » Install VMware Tools
from the VMware Server console menu.

2. You'll now need to mount the virtual CD-ROM and then extract the installer files.
Before installing the tools, you should also umount the CD-ROM, like so:

mount /dev/cdrom /mnt/cdrom

cd /tmp

tar zxf /mnt/vmware-linux-tools.tar.gz
umount /mnt/cdrom

3. You execute the installer by changing to the package delivery directory and executing a
Perl script, like so:

cd vmware-tools-distrib
./vmware-install.pl

4. Initiate the Linux GUI, startx, and open a terminal session where you can start the
VMware Tools background application:

vmware-toolbox &
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If you want the tools to start automatically when the GUI initializes, add the viware-toolbox
& command to your system’s startup programs. If after adding the tools your guest VM becomes
unstable, you can remove the tools by executing vmware-uninstall-tools.pl with root privileges.

Configuring VMware GSX Server and ESX Server
Virtual Hardware Options

Many similarities and differences exist between VMware GSX Server and ESX Server. This
includes differences ranging from GSX Server being a hosted application and ESX Server being
a stand-alone product to both virtualization applications utilizing a similar portfolio of virtual
hardware options you can install or remove. For performance reasons, you'll find that ESX
Server doesn’t contain unnecessary frivolities, such as sound and USB support. Like their
workstation counterparts, the server products utilize fully configurable BIOSs.

To get the best possible performance out of your guest VMs, don't overallocate guest
virtual hardware and undercommit host physical resources. As mentioned in Chapter 4, you
want to be frugal with resources but not miserly. For instance, do you really need an audio,
USB, or floppy device in a server? Do you necessarily need COM and LPT ports enabled? By
identifying your needs and the purpose of the server, you can eliminate overhead and wasted
resources by removing unnecessary virtual hardware devices in guest VMs and by disabling
components in the BIOS. The net effects of correctly sizing a guest VM are better performance
and increased reliability because there’s less resource consumption and fewer resources to run
awry.

Removing a VM hardware device is straightforward. For GSX Server, while the guest VM is
powered down, not suspended, open the MUI, and select Edit Virtual Machine Settings. High-
light the device to be removed, and then select Remove. For ESX Server, connect to the MUI,
and click the display name of the VM to be modified. On the Hardware tab, select Remove for
the device in question.

For GSX Server, if the VM you're building is lacking hardware, such as an additional virtual
NIC or virtual CD-ROM drive, you can add the components by clicking the Add button. ESX
Server requires you to click the display name of the guest VM in the MUI and choose Add
Device from the Hardware tab. Add Device is located at the bottom of the screen. One reason
to add a floppy disk or CD-ROM drive is to use VMware’s ability to mount an ISO image.

To avoid excessive redundancy, we’ll discuss adding virtual hardware for both GSX and
ESX together, and we’ll point out significant differences as necessary.

GSX Server hardware, like VMware Workstation, employs the Add Hardware Wizard to
help you install virtual hardware devices. If you need assistance with the wizard, please refer
to Chapter 4. The ESX Server wizard relies on your ability to know what you're clicking and
assumes you have some knowledge of Linux. If you don’t know what to do, every hardware
device type has a Help button in the lower-left corner of the screen to aid you in the configura-
tion process. Before building VMs for a production environment, you should thoroughly
examine each piece of virtual hardware that’s made available for guest VMs. Being familiar
with the VMware’s interface makes administration significantly easier down the road. For
each device in GSX Server and ESX Server, we'll highlight its installation procedure.
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Hard Disk

Three hard disk choices are presented for GSX Server: Create a New Virtual Disk, Use an Exist-
ing Virtual Disk, and Use a Physical Disk. Adding a new hard disk to an existing VM is virtually
identical to the process of preparing a drive when creating a guest VM. If you're creating a VM
to connect to an existing virtual hard disk, all you have to do is browse to the location of the
preexisting virtual disk. Remember that virtual disks will end with a *.vmdk extension.

ESX Server has three choices as well: Blank, Existing, and System LUN/Disk. The Blank
and Existing options are similar to GSX Server in configuration, and you can elect to set the
Blank Disk Mode option to Persistent, Nonpersistent, Undoable, or Append. Chapter 2 dis-
cusses each type if you're unsure of what to select. If you're connecting to a SAN or a raw SCSI
disk on an ESX Server, choose System LUN/DISK. Don't forget—we thoroughly cover SANs in
Chapter 14. For both GSX Server and ESX Server, remember to make any necessary naming
changes for directories and files for the new virtual disk. As always, make sure your naming
conventions are consistent and meaningful. If you need to configure the virtual disk to be
independent, click the Advanced button during the creation process on the Specify Disk
screen.

Physical Disk Creation for GSX Server

Using a physical disk for a GSX Server VM is really the only tricky option during the VM creation
process. Generally, using physical disks should be left to advanced users. Conversely, you'll
never become an advanced user if you don't try to use physical disks. To that end, don't let the
physical disk creation warning scare you away from the performance benefits of using physical
disks in your VMs.

On the Physical Disk selection screen, you'll need to choose between using a whole disk
or a partition thereon. If you choose to use the entire disk, you'll be asked to provide a virtual
disk filename that will store the partition access configuration information. Remember to
make any necessary directories to house the file and be sure the filename is meaningful.

If you elect to use a physical partition, you'll be presented with a screen to select which
partition on the physical disk to use.

Physical Disk Creation for ESX Server

Using physical disks are a great way to add that extra bump in performance that high-load
servers require, such as e-mail or database servers. To add a physical disk to ESX Server, on
the Add Hardware page of the guest VM, select Add Device » Hard Disk » System LUN/DISK.
Select Use Metadata, specify the directory of the *.vmdk file location, and supply the filename.
Select SCSI ID from the Virtual SCSI Node list, and then choose Physical Compatibility or Vir-
tual Compatibility. The Physical Compatibility option gives the VM direct access to the disk or
LUN, and the Virtual Compatibility option allows you to choose between the different disk
modes, such as Persistent, Nonpersistent, Undoable, and Append.
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DVD/CD-ROM Drive

When adding a DVD/CD-ROM drive to your guest VM, you have the option of using a physical
device or a software image. GSX Server has the ability to autodetect a physical device, or, as
with ESX Server, you can specify a device. Additionally, GSX Server can employ legacy emula-
tion; click the Advanced button on the physical drive selection screen. If you use an ISO image,
you’ll need to specify the location of the ISO file. For GSX Server, you can specify the device
node by clicking the Advanced button on the Choose an ISO Image screen.

MOUNTING ISO IMAGES WITH MICROSOFT OPERATING SYSTEMS

Like Linux and guest virtual machines, you can mount ISO images from within Microsoft 0Ss with the aid of
a small utility called Virtual CDrom. It's available for download at http://download.microsoft.com/
download/7/b/6/7b6abd84-7841-4978-965-bd58dfo2efa2/winxpvirtualcdcontrolw
panel 21.exe. Microsoft doesn’t go into any great detail in its documentation except for a small blurb

on its MSDN site, http://msdn.microsoft.com/subscriptions/faq/default.aspx. Follow

these steps:

1. Aiter downloading the compressed file, extract it; then copy the VCdRom. sys file to the %systemroot’\
system32\drivers directory.

2. Launch the VCdControlTool executable, and select Driver Control » Install Driver. Browse to the
VCdRom. sys file, and select Open » Start » OK.

3. To mount an IS0, select Add Driver » Mount. Select the ISO to be mounted. If necessary, you have the
following options: Suppress UDF, Suppress Joliet, and Persistent Mount.

4. You can now access the ISO like a physical CD drive.

Note You can use network-mapped shares to mount ISO images but not UNC path names. If you'd like
to use UNC path names, try downloading (for free) Virtual CloneDrive from http://www.slysoft.com.

Floppy Drive

Creating a virtual floppy drive is similar to creating a virtual disk. The wizard will present
you with three options: Use a Physical Floppy Drive, Use a Floppy Image, and Create a Blank
Floppy Image. There’s no real trick to using any of the three options. You just need to decide
what’s going to suit your needs and then decide if the guest VM will connect to the VM when
powering on. ESX Server has two options: System Floppy Drive and Floppy Image. Using
floppy images are a great way to keep from having to use sneakernet.
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Ethernet Adapter

Adding Ethernet adapters to a VM will also require you to select the network connection type
to be used. You have four available options: Bridged, NAT, Host-Only, and Custom. If you're
unsure of which type to use, please refer to Chapter 2 where we discuss each network type in
detail. ESX Server is making sure you select the correct network connection if you have multi-
ple virtual switches created.

Sound Adapter

When adding a sound adapter to your GSX Server guest VM, the only real issue you'll need to
be concerned with is why you think your server needs sound. Short of having audio alarms for
intrusion detection systems, there’s no real need for sound in a server—it’s just one more thing
to go wrong and eat up valuable resources. Don't even ask about ESX Server sound support.

Configuring Legacy Devices

Guest VMs for GSX Server and ESX Server can use COM and parallel ports—VMware refers to
these as legacy devices. ESX Server disables these devices by default for performance reasons
and discourages using them for both server products. Unfortunately, newer USB technology
isn't supported for ESX Server, but we’ll cover how to use it in the “Scripting ESX Server USB
Connectivity” section.

Serial Port

Creating a serial port for a GSXVM affords you the ability to not only have access to the host’s
physical serial port but also to have the ability to output information either to a file or to a
named pipe. If you elect to create a virtual port mapping to the host’s physical port, you'll
need to select which COM port you want to connect to using a drop-down menu. If you
decide to send the information of a virtual COM port to a file, you'll need to specify the name
of the file and the storage location. The named pipes option asks you to further configure the
relationship of the named pipe. The named pipes setting allows you to directly connect two
VMs; in addition, it affords you the ability to create a connection between an application on
the host VM and the guest VM. It’s important to remember that the pipe name is identical

on the client and server and takes the form of \\. \pipe\<pipe name>.

To enable serial port support on ESX Server (just in case you have UPS requiring COM
connectivity), ensure that the host’s BIOS has the serial port enabled and the guest VM is in a
powered-off state. Edit the guest VM’s *.vmx configuration file, and add serial port support,
like so:

serialo.startConnected = true
serialo.presen t= true
serialo.file = device
serialo.fileName = "/dev/ttySo"

When the VM boots, the serial port will be automatically connected.
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Parallel Port

Adding a parallel port to a GSX Server guest VM is similar to adding a serial port. You'll need to
select whether you want to use the host’s physical port or use VMware’s ability to write to a file.
If you have multiple parallel ports, the wizard will allow you to specify which port you want to
use. If the new virtual parallel port is to write to a file, you'll need to select the appropriate file
output destination.

You may find it necessary to enable parallel port connectivity so that the ESX Server guest
VM can use a software security dongle. To enable parallel support on ESX Server, ensure that the
host’s parallel port is set to PS/2 or Bidirectional in the BIOS. In the VM’s *.vmx configuration file,
make sure the virtual hardware version is config.version = 6. Then, follow these steps:

1. At the CLI of the ESX Server, load the parallel port modules:

insmod parport
insmod parport pc
insmod ppdev

2. Modify the VM’s *.vmx configuration file to add parallel port support:

parallelo.present = true
parallelo.fileName = "/dev/parporto”.
parallelo.bidirectional = true.

3. Launch the VM and edit its BIOS by selecting F2. Set the parallel port mode to
Bidirectional.

Note Only one 0S and one VM can use the parallel port at any given time. If you don’t want to load ESX
Server modules on each host reboot, add the module commands to the rc.local file.

Configuring Generic SCSI Devices

To use SCSI peripherals, such as a tape device or scanner, you'll need to add a generic SCSI
device to a guest VM. This requires you to select the physical SCSI device from the Device
Connection list and then specify a virtual device node to use with the generic SCSI device.

Tip You can find many excellent white papers, notes, and compatibility guides dealing with everything
from generic SCSI to configuring blade servers on VMware’s Web site: http://www.vmware . com/support/
resources/esx_resources.html.

If you're connecting to a tape library, be sure to select every physical tape device, or the
library won't appear correctly in the guest VM. You can have the guest VM connect to the
physical device at power on. To do this, select the Power On option under Device Status.
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Note When editing a VM to add or remove virtual devices, be sure to click the OK button on the Virtual
Machine Settings dialog box. If not, your settings will often not take effect.

Configuring a USB Controller

For GSX Server, adding USB support requires you to decide if you want the guest VM to auto-
matically attach to a USB device when it has focus on the host. If you desire this behavior,
check the box under Device Status, and that’s it.

On ESX Server, USB support is disabled on the console OS because of potential chipset
incompatibilities. These incompatibilities are created by the USB controller sharing interrupts
with other controller types and the I/0 Advanced Programmable Interrupt Controller I0OAPIC)
forwarding masked interrupts. Disabling USB support gives the VMkernel control over inter-
rupts. Because it's becoming increasingly important for servers to have access to USB support
for application dongles, external hard drives, and other peripherals, you'll learn how to enable
USB support in this section.

Note VMware fully documents disabling USB support in ESX Server in its knowledge base under Answer
ID 1326. If you're using an older version of ESX Server, 2.1.2 and earlier, you'll definitely want to look at the
article. If you’re unsure of your version, you can execute the issue command.

To enable USB support on ESX Server, you'll need to make sure VMkernel manages the
host’s PCI devices and that the kernel loads before any USB drivers. You'll need to reassign any
controllers dedicated to the console as shared devices. In general, most PCI devices can be
assigned to one of three categories: dedicated to VMkernel, dedicated to the Service Console,
or shared between both. To set the device category, you'll need to use the vmkpcidivy com-
mand with the s option to specify the sharing of devices. You should execute the vmkpcidivy
command-line utility as root; it's used to modify memory and device allocation on ESX Server.
The following is its usage, and Table 6-1 shows its options:

/usr/sbin/vmkpcidivy [-i] [-1 name] [-m memsize] [-q] [-v bus:slot:fcn]

Table 6-1. vmkpcidivy Options

Option Action Performed

-1 Interactively assists with the “divvy” process

-1 Performs operations on given label

-m Allocates memory, in megabytes, to given guest OS

-q Runs a query: vmkmod, vmkdump_part, or vmkdump_dev labels vmfs part

-V Assigns device to VMs
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To get an idea of how the command works, run vmkpcidivy -i.The command will take
you through any existing configuration files and lets you make changes. If you make mistakes
during the process, you have the opportunity at the end of the configuration update to not
commit the changes. You can configure several items with the command:

* The name of the configuration
* Memory allocation to the Service Console

¢ SCSI controllers and network adapters

After experimenting with the vmkpcidivy command, run it again. This time, reassign all
controllers dedicated to the Service Console as shared. In general, shared controller interrupts
are VMkernel managed and then forwarded to the Service Console on an as-needed basis. You
should leave VMkernel-dedicated controllers alone.

The second half of the procedure for enabling USB support for ESX Server requires that
you delay the loading of USB drives by editing the /etc/modules. conf file. If you're unsure of
editing procedures in ESX Server, please refer to Chapter 2, which explains the Vi editor. When
editing files, don't forget to save your work.

Note Though not supported by VMware, you can try using USB drives to run guest VMs. Being that USB
devices are seen as SCSI devices in Linux, you can try loading the USB device before the VMkernel loads to
make the disk available to guest VMs.

Follow these steps:

1. Mark every line in modules.conf containing USB controller references, such as Univer-
sal Host Controller Interface (usb-uhci), Open Host Controller Interface (usb-ohci),
and Enhanced Host Controller Interface (usb-ehci). UHCI is generally used to support
the Intel PIIX4 and VIA chipsets, and OHCI generally supports Compagq, iMacs, OPTi,
and SiS. For instance, at the beginning of every line containing a reference to usb-ohci,
usb-uhci, or usb-ehci, place a pound symbol (#). Make a note of each line; you'll need it
for step 3. For example, if modules.conf has a line containing the alias usb-controller
usb-ohci, change it to look like the following:

#alias usb-controller usb-ohci

2. Create the given file in the specified directory, /etc/rc3.d/S91usb. If you don’t want the
USB OHCI module activated on boot, don't create the file. You can load the module
using the modprobe command at any time.

3. For each line you marked in the modules. conf file, you'll need to create a similar line in
the S91usb file preceded by the modprobe command. In our example, the line reads as
follows:

modprobe usb-ohci
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Note USB devices aren’t supported within ESX Server guest VMs, and VMware briefly explains this

in Answer ID 1015 in its knowledge base. You'll be able to use USB devices only from within the console
0S. If you need to make USB devices available to guests, you can try using USB-to-IP technology,

such as Digi AnywhereUSB. If you're a bit more adventurous, you can look into the USB/IP Project
athttp://usbip.naist.jp.

Reboot ESX Server. On reboot, the /etc/rc3.d/S90vmware file will run before the
/etc/rc3.d/S91usb file. This ensures that the VMkernel is ready before the USB drivers
are loaded.

Execute cat /proc/interrupts, and verify that an interrupt is assigned to usb-ohci.
Run 1smod|grep -i usb. You should see two USB modules, usb-ohci and usbcore.

Mount your USB device.

You may be asking yourself what you can do with a console-only USB device, but it really
has some value. For instance, you can mount a USB hard drive (or CD-ROM drive) at the con-
sole and make it available to guest VMs by using WinSCP3 to copy the files back and forth.

To mount a USB CD-ROM drive, complete the following steps:

1.

3.
4,

Run the mount command to see what's already in use from the mtab file. If you want to
see what's in mtab, execute cat /etc/mtab. Run fdisk -1 to see the system partitions.
Use the results from all commands to avoid creating duplicate names.

Create a directory to mount the USB CD-ROM drive:
mkdir /mnt/usb/cdrom
Plug in and power on your USB device:

Verify that the correct module is loaded for your device. Not all CD-ROM drives are
supported. Run tail -n50 /var/log/messages, and pay particular attention to the last
few lines of the output. The log messages will tell you if the requisite supporting mod-
ules were loaded and will tell you the device ID.

Jan 14 16:15:39 VA1ESX2 kernel: scsi4 :w
SCSI emulation for USB Mass Storage devices
Jan 14 16:15:39 VA1ESX2 kernel: Vendor: w
SONY Model: DVD RW DRU-710A Rev: BY01

Jan 14 16:15:39 VA1ESX2 kernel: Type: w=
CD-ROM ANSI SCSI revision: 02

Jan 14 16:15:39 VA1ESX2 kernel: =
Attached scsi CD-ROMws

sr0 at scsi4, channel 0, id 0, lun 0

Jan 14 16:15:39 VA1ESX2 kernel: =

scsi register host starting finish

Jan 14 16:15:54 VAL1ESX2 kernel: w
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sr0: scsi-1 drive

Jan 14 16:15:54 VA1ESX2 kernel: w=

scsi register host done with finish

Jan 14 16:15:54 VA1ESX2 /etc/hotplug/usb.agent: =
no drivers for USB product 54c/1f6/1

Jan 14 16:24:58 VA1ESX2 kernel: Device not ready. =
Make sure there is a disc in the drive.

Jan 14 16:25:49 VALESX2 sshd(pam unix)[4401]: w»
session opened for user root by (uid=0)

5. If youlook through the output and stop at the fourth line, you'll find that the CD-ROM
drive is listed as device sr0 on scsi4. Despite that the device is listed as sr0, there’s no
s10 device in /dev. You'll need to use scdo to mount the USB CD-ROM drive. Further
down, the output reveals that a driver isn’'t loaded. Load the usbserial module to use
the CD device:

insmod usbserial

6. You can get additional information about your device by executing cat /proc/scsi/scsi.
You should have output similar to the following:

Host: scsi2 Channel: 00 Id: 00 Lun: 00
Vendor: DELL Model: PERCRAID RAID5 Rev: V1.0
Type: Direct-Access ANSI SCSI revision: 02
Host: scsi4 Channel: 00 Id: 00 Lun: 00
Vendor: SONY Model: DVD RW DRU-710A Rev: BYO1
Type: CD-ROM ANSI SCSI revision: 02

Note If you want to verify that ESX Server correctly found the USB device, you can visit the Web site
athttp://www.linux-usb.org/usb.ids and look up the device’s ID from the information found in
the messages file. You'll also find excellent support information on the site.

7. To mount CD-ROM device serial 0, execute mount -r -t 1509660 /dev/srcdo/mnt/usb/
cdrom. Your media should now be accessible from /mnt/usb/cdrom.

8. List the contents of the drive:
1s /mnt/usb/cdrom

9. When you're done using the device, be sure to use the umount command to unmount
the USB device before unplugging it. If you need help with the umount command, use
the manual pages, man umount.

umount -f /dev/srcdo

If you want a device to be mounted each time the system is rebooted, place startup com-
mands in the rc.local file. Add the mount commands to be executed to the end of the file.
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Assuming you make the packages available to ESX Server, you can even burn disks. If you
have access to the Red Hat 7.3 installation CDs, you can install the listed RPMs (and any
dependencies) for CD-burning purposes. Remember that using USB under ESX Server isn't
supported by VMware and should be used only for experimental and temporary/emergency
purposes. Here’s how to do it:

cdda2wav-2.0-11
cdrecord-2.0-11
cdrecord-devel-2.0-11.
dvd+rw-tools-5.17.4.8.6-0
dvdrecord-0.1.4-4
mkisofs-2.0-11
xcdroast-0.98a14-3

Note If you need help burning data to a CD-ROM, visit Linux Headquarters to brush up on the basics:
http://www.linuxheadquarters.com/howto/basic/cdrecord.shtml.

You can also make USB thumb drives and external USB hard drives available to the ESX
Server console by performing these steps:

1. Run the mount command to see what’s already in use from the mtab file. If you want to
see what's in mtab, execute cat /etc/mtab. Execute fdisk -1 to view system partitions.
Use the results from all commands to avoid duplicate names.

2. Create a directory to mount the USB thumb drive:
mkdir /mnt/usb/thumbdrive
3. Plugin your USB drive.

4. Verify that the correct modules are loaded for your device by checking the messages
file. Pay particular attention to the last few lines. A SanDisk drive, for example, would
have the ID (vend/prod 0x781/0x5150). The messages file will tell you if the requisite
supporting modules were loaded:

tail -n50 /var/log/messages

5. If you see error messages, you'll need to manually load the modules for your device.
You can find the USB modules available with a standard ESX Server by executing find
/ -name *usb*.o:

/1ib/modules/2.4.9-34/kernel/drivers/bluetooth/hci_usb.o
/1ib/modules/2.4.9-34/kernel/drivers/media/video/cpia_usb.o
/1ib/modules/2.4.9-34/kernel/drivers/net/irda/irda-usb.o
/1ib/modules/2.4.9-34/kernel/drivers/usb/ov511/i2c-algo-usb.o
/1ib/modules/2.4.9-34/kernel/drivers/usb/dabusb.o
/1ib/modules/2.4.9-34/kernel/drivers/usb/hpusbscsi.o

4

/1lib/modules/2.4.9-34/kernel/drivers/usb/serial/usbserial.o
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/1ib/modules/2.4.9-34/kernel/drivers/usb/storage/usb-storage.o
/1lib/modules/2.4.9-34/kernel/drivers/usb/usb-ohci.o
/1lib/modules/2.4.9-34/kernel/drivers/usb/usb-uhci.o
/1lib/modules/2.4.9-34/kernel/drivers/usb/usbcore.o
/1lib/modules/2.4.9-34/kernel/drivers/usb/usbnet.o
/1lib/modules/2.4.9-34/kernel/drivers/usb/usbvideo.o
/1lib/modules/2.4.9-vmnix2/kernel/drivers/usb/dabusb.o
/1lib/modules/2.4.9-vmnix2/kernel/drivers/usb/serial/usbserial.o
/1ib/modules/2.4.9-vmnix2/kernel/drivers/usb/storage/usb-storage.o
/1lib/modules/2.4.9-vmnix2/kernel/drivers/usb/usb-ohci.o
/1lib/modules/2.4.9-vmnix2/kernel/drivers/usb/usb-uhci.o
/1lib/modules/2.4.9-vmnix2/kernel/drivers/usb/usbcore.o

6. To load the correct module for a USB thumb drive, enter the following at the command
line:

modprobe usb-storage

7. You can verify the successful attachment of your USB drive to the system by executing
cat /proc/scsi/scsi. (Also, take a moment to rerun cat /etc/mtab). The output
should look similar to this:

Attached devices:

Host: scsi2 Channel: 00 Id: 00 Lun: 00
Vendor: DELL Model: PERCRAID RAID5 Rev: V1.0
Type: Direct-Access ANSI SCSI revision: 02
Host: scsi3 Channel: 00 Id: 00 Lun: 00
Vendor: SanDisk Model: Cruzer Mini Rev: 0.2
Type: Direct-Access ANSI SCSI revision: 02

8. Notice that the thumb drive is on scsi 3. To bring this together a bit more, execute
tail -n50 /var/log/messages

Jan 14 15:07:38 A1ESX2 sshd(pam unix)[3938]:
session opened for user root by (uid=0)

Jan 14 15:17:57 A1ESX2 kernel:

Initializing USB Mass Storage driver...

Jan 14 15:17:57 A1ESX2 kernel: usb.c:
registered new driver usb-storage

Jan 14 15:17:57 A1ESX2 kernel: scsi3 :

SCSI emulation for USB Mass Storage devices
Jan 14 15:17:57 A1ESX2 kernel: Vendor:

SanDisk Model: Cruzer Mini Rev: 0.2

Jan 14 15:17:57 A1ESX2 kernel: Type:
Direct-Access ANSI SCSI revision: 02

Jan 14 15:17:57 A1ESX2 kernel: VMWARE SCSI Id:
Supported VPD pages for sdb : Ox1f OxO

Jan 14 15:17:57 A1ESX2 kernel:

VMWARE SCSI Id: Could not get disk id for sdb
Jan 14 15:17:57 A1ESX2 kernel: :VMWARE: Unique Device
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attached as scsi disk sdb at scsi3, channel 0, id 0, lun 0
Jan 14 15:17:57 A1ESX2 kernel:

Attached scsi removable disk sdb at scsi3, channel 0, id 0, lun 0O
Jan 14 15:17:57 A1ESX2 kernel:

scsi register host starting finish

Jan 14 15:17:57 A1ESX2 kernel:

SCSI device sdb: 1000944 512-byte hdwr sectors (488 MB)
Jan 14 15:17:57 A1ESX2 kernel:

sdb: Write Protect is off

Jan 14 15:17:57 A1ESX2 kernel:

sdb: sdbl

Jan 14 15:17:57 A1ESX2 kernel:

scsi register host done with finish

Jan 14 15:17:57 VA1ESX2 kernel:

USB Mass Storage support registered.

. The USB thumb drive should be the first unused SCSI device on your system; in most

cases it will be /dev/sda1. Being that ESX Server is already using devices sda1 through
sdail, you can eliminate the default settings as the mount point. However, look at the
third-to-the-last line from the messages output. The thumb drive is listed as sdb1.
Mount the thumb drive by executing the following command:

mount /dev/sdb1 /mnt/usb/thumbdrive
List the contents of the drive:
1s /mnt/usb/thumbdrive

When you're done using the device, be sure to use the umount command to unmount
the USB device before unplugging it. If you need help with the umount command, use
the manual pages, man umount. To have devices mounted each time the system reboots,
place mount commands in the rc.local file at the end of the file:

umount -f /dev/sdb1

Scripting ESX Server USB Connectivity

You can further simplify the management of USB devices by using several small Perl scripts.
Placing the requisite USB commands in a Perl script will allow you to connect or disconnect
devices on demand. You'll have to use a text editor, such as Vi (discussed in Chapter 5), and
have a grasp on the Perl scripting basics. We'll continue showing how to work with a USB
thumb drive in this example.

You really need to know only a few things to be dangerous with Perl:

Perl stands for Practical Extraction and Reporting Language and was created by Larry
Wall in 1987.

Scripts should end with a . pl extension.

The first line of the script begins with the shbang line, which points to the Perl binary,
#!/usr/bin/perl -w.You can find the path by executingwhich perl at the CLI.
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¢ All statements end in a semicolon (;).

e Comments begin with pound sign (#).

* Use a backtick (") to invoke using shell commands.

* You must set permissions on the script to execute, chmod +x scriptname.pl.
 Verify that permissions are correctly set to 755, 1s -1 scriptname.pl.

* You can execute scripts by calling the script name at the CLI. If necessary, include the
current directory by preceding the script name with a ./, asin ./scriptname.pl.

Writing a script to mount a USB thumb drive is just a matter of adding the correct ESX
Server commands to the file and setting permissions. If you aren’t up to speed on the best
practices for error checking and control, then you may want to get a good Apress book on Perl,
such as Beginning Perl, Second Edition, by James Lee (Apress, 2004). The scripts in this section
invoke all requisite Linux modules to connect and disconnect from the USB bus without mod-
ifying the modules. conf file.

Follow these steps:

1. Write the script using Vi:

#!/usr/bin/perl

#Script to mount USB thumb drive.
use warnings;

use strict;

"modprobe usb-ohci”;

"modprobe usbcore”;

"modprobe usb-storage”;

“mount /dev/sdb1 /mnt/thumbdrive’;
“1s -1 /mnt/thumbdrive’;

2. Change the permissions of the script:
chmod +x mountusb.pl
3. Verify the permissions:
1s -1 mountusb.pl
4. Execute the script:
./mountusb.pl
When you're done using your USB device, you can create another script to unmount the
device and unload the USB modules. Follow these steps:
1. Write the script:

#!/usr/bin/perl
#Script to unmount USB drive.
use warnings;
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use strict;

“umount /dev/sdb1’;
“rmmod -1 usb-storage”;
“rmmod -1 usbcore’;
“rmmod -1 usb-ohci’;

“1s -1 /mnt/thumbdrive’;

2. Change the permissions of the script:

chmod +x umountusb.pl

3. Verify the script permissions:

1s -1 umountusbcd.pl

4. Execute the script:

./umountusb.pl

Building Microsoft Virtual Server VMs

The administration of Microsoft Virtual Server is different from Virtual PC in that it’s performed
through the Administration Web site; in this sense, Virtual Server is a lot like ESX Server.

Creating a Virtual Server VM is an exercise you're familiar with when it comes to most
Microsoft software installs—it’s a straight shot from beginning to end. When creating a guest
VM, keep in mind all the best-practice information you learned from previous chapters, such
as creating a single directory to hold all VM files, naming all files after the VM, and using the
appropriate disk mode for the guest.

Follow these steps:

1.

To begin the creation, launch the Administration Web site by selecting Start » Programs
» Microsoft Virtual Server » Virtual Server Administration Web Site.

. Under Virtual Machines, select Create. In the Virtual Server Create window, you'll need

to supply all the information it takes to make the guest VM.

. For the VM name, be sure to stick with good naming conventions. If you're using good

naming practices, you may want to add a prefix or suffix to the name to note that it’s a
virtual machine. Oftentimes, in networks with large quantities of physical and virtual
servers, it can be difficult to differentiate between the two.

. Specifying the total amount of memory used in a VM can be tricky. Basically, you want

to allocate enough memory for the VM to be able to do 100 percent of its job without
overcommitting resources or straining the VM. To that end, give the VM the minimum
required by the guest OS. You can always add more memory later to alleviate perform-
ance problems. Many times, you'll find that a server can skate by on the minimum,
and others will have to be bumped up to industry best practices.

. Three options are available for a new guest VM in the hard disk category: Create a New

Virtual Hard Disk, Use an Existing Virtual Hard Disk, and Attach a Virtual Hard Disk
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Later. If you choose to create a new hard disk during the creation of aVM, you'll be
stuck with a dynamically expanding disk. This may be fine for a test or lab environ-
ment, but for a production environment, dynamic disk performance will prove
unsatisfactory. Therefore, if you're creating a production VM, choose Attach a Virtual
Hard Disk Later.

6. Network settings for the VM can be set to Not Connected, Bridged to the External
Network, or Internal Network. If the VM is to be a network resource, choose External
Network. Otherwise, choose Internal Network for a host-only accessible VM.

7. The Virtual Machine Additions area is just a reminder to install VM Additions. We’ll
discuss how to install these a bit later in the “Virtual Machine Additions” section.

8. After creating the VM, you'll be presented with the Status and Configuration window.
You now need to create a virtual hard disk for the VM.

9. From the far left column under Virtual Disks, select Create » Fixed Sized Virtual Disk.
You have the option of creating other disks with the Differencing, Linked, and Floppy
options. The Fixed Size Virtual Hard Disk window appears where you'll need to supply
the storage directory for the disk and the size. For the storage location, be sure to select
the directory you created to store all the VM files and create a directory for the disk.
After selecting Create, it will take a moment for the disk to be created, and it will take
even longer for large disks.

10. Select the name of the guest VM in the Status area and click Turn On. Install the guest
OS as you normally would.

To add virtual hardware or to reconfigure an existing VM, select Virtual Machines v
Configure » <VM_to_Modify>. The Configuration portion of the window lists the VM’s avail-
able hardware choices. We'll highlight the installation process for each option.

General Properties

The General properties page has the setting for the VM’s display name and the account set-
tings the VM runs under. If you choose to run the VM under a user account, Virtual Server
grants the ability to set the power-on status of a VM when Virtual Server starts, such as auto-
matically turning on the VM. Another option, Action When Virtual Server stops, allows you to
set the status of the VM when Virtual Server stops to these options: Save State, Turn Off Virtual
Machine, and Shut Down Guest OS. A notes section lets you list helpful information about the
machine that helps you manage the VM.

Virtual Machine Additions

Microsoft’s Virtual Machine Additions package increases the performance and flexibility of
guest VMs running on Virtual Server and are installed after the guest OS is up and running.
Installing the tools is a two-part process: first, the tools need to be made available to the guest
by selecting Install Virtual Machine Additions; second, the Virtual Machines executable needs
to be launched from within the VM. The tools are available to the VM via an ISO. If you have
autorun enabled, the installation will start automatically. If you were diligent in optimizing
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performance and disabled autorun, you can find the executable (setup.exe) on the system’s
first virtual CD-ROM drive. The installation takes only a moment and a couple clicks.

You can programmatically install Virtual Machine Additions using an unattended mode
with setup.exe and its command-line options. Table 6-2 lists the command-line options you
can use during an unattended install when using setup.exe. You should use the command in
the format setup.exe -s -v"/qn [Reboot=ReallySuppress]"”. In addition, you can install the
software by activating the executable from within Windows Explorer and using the wizard.
You can download Virtual Machine Additions from Microsoft’s Web site at
http://www.microsoft.com/downloads.

Table 6-2. Virtual Machine Additions

Option Action Performed

-S Runs setup program without a GUI
-v Passes options to Msiexec.exe

/qn Runs Msiexec.exe without a GUI
Reboot=ReallySuppress Prevents reboot after installation

If aVM created with Virtual PC is moved to Virtual Server, be sure to reinstall Virtual
Machine Additions. Reinstalling the software ensures that the moved guest VM is using the
server version of Virtual Machine Additions and avoids any conflicts related to versioning.
The enhancements you can expect to experience from installing Virtual Machine Additions
include the seamless use of the mouse from the guest window to the host, increased perform-
ance, host-to-guest time synchronization, and optimized video drivers.

Memory

The Memory option allows you to increase or decrease the amount of available RAM by using
a slide control or by entering the memory size. You can make adjustments in 1MB chunks.

Hard Disks

The Hard Disks Properties option directs Virtual Server to the location of the guest VM’s hard
drive or adds a hard drive. Within this option, you also have the ability to set virtual disks as
undo disks. Being that the Hard Disks Properties dialog box is used only to point to *.vhd files,
refer to the “VMware Virtual Disk Drive Geometry” sidebar. If you're creating a new virtual
disk, you have the option of creating a dynamically expanding, fixed, differencing, linked,

or floppy disk. After creating a disk, you must use the absolute path and the filename.

CD/DVD

In addition to being able to use the host’s CD/DVD drives, you can also specify ISO images
for aVM to mount. Like virtual hard disks, for ISO images, you need to specify the absolute
path to the image. You can add as many (up to four) CD/DVD drives as there are free IDE
channels. If you want to add drives to mount ISO images, you can use Virtual CDrom; refer
to the “VMware Virtual Disk Drive Geometry” sidebar that covers this tool.
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SCSI Adapters

The SCSI Adapter Settings screen adds, removes, and sets the properties of SCSI adapters for
virtual hard disks. Short of being able to change the adapter ID, there’s not much more to it.
If VMs are going to be clustered, you'll need to check the option to share the adapter; it’s dis-
abled by default. The virtual SCSI bus is shared to facilitate the quorum needed that provides
the software failover support between the clustered VMs. For more information on clustering,
refer to Chapter 9.

Network Adapters

The Network Adapters screen provides an interface to add or remove NICs. When creating an
additional NIC, you can set it to be connected to an existing external network, internal (host-
only) network, or not connected. If you like, you can let Virtual Server generate a MAC for the
VM, or you can specify your own.

Scripts

The Scripts Properties dialog box is where you can add scripts that take action based on the
current status of the VM in question. By default, scripts are disabled. To enable scripts, select
Virtual Server Scripts from the upper-right corner of this screen. You can enable scripts on
the host or on VMs attached to the host. For the host, you can supply scripts that process
command-line actions when the system starts and stops. This is useful for shutting down
VMs and initializing them. The guest VM scripts generally run when a VM changes power
states, gets low on disk space, or receives physical hardware errors.

Note Several handy scripts for Virtual Server are available for download from Microsoft’s Script Center
Script Repository at http://www.microsoft.com/technet/scriptcenter/scripts/vs/default.mspx.
Scripts are available for managing disks, networks, tasks, and VMs. This site is well worth checking out if you
don’t want to reinvent the wheel!

Floppy Drives

For the virtual floppy drive, you can use the host’s floppy drive or an ISO image. If your system
doesn’t need a floppy drive, disable it for performance reasons. Like virtual hard disks and
CD/DVD drives, for ISO images, you need to specify the absolute path of the file.
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COM Ports

Any given VM can have up to two active COM ports. If you don’t need COM ports, leave them
disabled. For the COM port, it can be the host’s physical port, a text file, or a named pipe. One
valuable use for named pipes with the COM port is for debugging Virtual Server. To debug a
VM, follow these steps:

1. Download and install the kernel debugger from Microsoft’s Web site at
http://www.microsoft.com/whdc/devtools/debugging/installx86.mspx.

2. Edit the boot.ini file of the guest VM, and append /fastdetect/DEBUG /DEBUGPORT=COM1/
BAUDRATE=115200 to the OS boot statement under [operating systems]. If you want,
you can copy the existing statement and then append the debug line.

3. Configure COM1 of the guest VM to use a named pipe: \\.\pipe\com1. Don't check the
Wait for Modem option.

4. Connect Microsoft’s kernel debugger to the COM port by executing
kd -k com:port=\\.\pipe\comi,pipe,resets=0,reconnect from the CLI

LPT Ports

Allowing a guest VM to connect to the host’s parallel port is a matter of changing the default
option of disabled to LPT1. Once again, if you don't need the support of legacy devices, such
as parallel ports, don’t enable them on guest VMs.

Managing Server-Class VMs

Managing VMs in a production or test environment is no different than doing the same in
traditional physical systems; you'll need to continue to adhere to the same best practices you
probably already use, such as backing up, installing antivirus software, monitoring log files,
renaming VMs, and performing routine maintenance. In the following sections, we’ll discuss
backing up, copying, and moving VMs. In addition, you'll further examine VM configuration
files, which you started looking at in Chapter 4.

Modifying VM Configurations: Renaming and Moving

Though we thoroughly cover backup strategies for VMs in Chapter 7, we'll briefly introduce
you to backing up VMs and their configuration files in this chapter. In addition, you'll look at
modifying VM configuration files.

When you first begin experimenting with VMs, you'll soon realize at some point it
becomes necessary to rename a guest VM, its configuration file, and its virtual disk file. You'll
generally find yourself in this position when you're forced to move a VM from a test environ-
ment to a production environment. To ensure the integrity of the VM and a smooth transition,
you'll first need to back up your VMs virtual disk and configuration files, rename them as nec-
essary, and then move them to the new host. Whether you're renaming a Microsoft Virtual
Server or VMware GSX/ESX Server VM, you can complete the procedure in a few steps.
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Renaming a VMware GSX Server VM

Prepping VMware GSX Server to accept a new name for a guest VM is a straightforward
process. The VM must be powered down and not in a suspended state before proceeding with
the renaming procedure:

1. Remove the VM from the console inventory by selecting the Management tab of the
VM to be removed. Right-click the tab, and select Remove from Favorites, which won't
delete any files related to the VM to be renamed. Close the GSX Server interface.

2. Locate the VM directory containing the guest’s VM configuration file and virtual hard
disk file(s). If you used the default installation directory and named the installation
directory after your VM, the path to your VM will be similar to C: \Documents and
Settings\user\My Documents\My Virtual Machines\<VM Directory>. Rename the
directory and the *.vmx file to exhibit the new name.

3. Though you could simply rename the virtual disk *.vmdk file as well, you should use
the vmware-vdiskmanager command. Using this command renames the file but also
correctly sets the name of the VM within the virtual disk file’s Extent Description area.
Here’s the command:

vmware-vdiskmanager -n old virtual disk name.vmdk w>
new_virtual disk name.vmdk

The typical header of a *. vmdk file follows. If you manually change the name of virtual
disk files, the disk will retain its old name in the Extent Description area.

# Disk DescriptorFile
version=1

CID=fffffffe
parentCID=ffffffff
createType="monolithicFlat"

# Extent description

RW 8388608 FLAT "test-flat.vmdk" 0
# The Disk Data Base

#DDB

ddb.virtualHwVersion = "3"
ddb.geometry.cylinders = "522"
ddb.geometry.heads = "255"
ddb.geometry.sectors = "63"
ddb.adapterType = "buslogic"

4, Using a text editor, edit the *.vmx file to reflect the name change. You'll need to
modify two lines: the virtual disk configuration line and the display name line. For
example, a change may look similar to scsi0:0.fileName = "<New Name.vmdk>" and
displayName = "<New Name>".

5. Start GSX Server, and open the renamed VM by selecting File » Open Virtual Machine.
You'll be asked if you'd like to generate a new UUID. If you need to maintain the MAC
address for your VM, select Keep the Existing Identifier; otherwise, select Create New
Identifier.



CHAPTER 6 I/ DEPLOYING AND MANAGING PRODUCTION VMs ON ENTERPRISE SERVERS 199

Copying and Moving VMware GSX Server VMs to Other Hosts

Copying and moving GSX Server VMs is virtually identical to doing the same for VMware
Workstation. Before beginning the copy or move process, make sure you have a good backup
of the guest VM in question. If something runs awry, you'll want to quickly recover to make a
second attempt.

After confirming you have a good backup, ensure your user account has sufficient privi-
leges to complete all tasks. Next, you'll need to complete a few preliminary tasks before
moving the guest VM:

1. Power down the guest VM to be moved. Make sure it’s not in a suspended state; moving
a suspended VM is a recipe for disaster.

2. Close the VMware GSX Server application.

3. Ensure a transfer medium exists for moving the VM’s files. Assuming your VM can fit
on a CD or DVD, you can use this type of medium, or you can use a mutually accessi-
ble network share. If the guest is going to be placed on a new network host, the easiest
way to move the files is over your existing network, going point to point. With the pre-
liminary procedures checked off the to-do list, you can safely move the guest VM.

Note The less a VM is shuttled across a network, the less likely you'll introduce errors into a VM’s
configuration files and virtual hard disk.

4. Ensure that the new host system has sufficient resources for the added load of the VM
to be moved and is not running.

5. Create a directory on the new host for the guest’s files. (If you're just moving the loca-
tion of the guest VM to a different directory on the current host, simply create the new
directory in your desired location and locate the VM'’s files within the new directory.)
Remember to create directories with meaningful names for your VMs and then store
all related configuration information in the VM’s directory. Many administrators name
the directories after the VM itself.

6. Make sure the guest VM is powered down. Next, you'll need to find all the files on the
current host and copy them to the new host in the directory you just created. Files
you’ll minimally be concerned with are as follows:

¢ The configuration file, *.vmx
¢ The virtual disk files, *.vmdk

7. Start VMware GSX Server, select File » Open, browse to the VM’s configuration file
(*.vmx) in the directory you created, and then select Open. Take a moment to check the
VM Settings editor to verify that every device is properly configured and is pointing to
the correct file location.
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Note When you power on a VM moved from its original installation directory, you may be asked if
you want to regenerate the UUIDs for the VM. If the VM is a copy, select Yes. If the VM has been moved,
select No. Regenerating the UUID changes the MAC address of the guest VM.

8. Check to make sure the VM name, configuration file, and redo log file are all correctly
set. You can find this on the Options tab of the VM Settings editor.

9. Select Power » Power On. If your guest VM fails to properly initialize, make sure you
copied every file from the source host, and then double-check that all settings are
pointing to the correct locations. If you need to rename your VM, refer to the “Renam-
ing a VMware GSX Server VM” section.

Using VMware Universally Unique Identifiers (UUIDs)

When you move a VM, you'll want to concern yourself with the system’s UUID. VMware uses
the UUID to generate a MAC address for a VM. The UUID is based on the host’s SMBIOS
UUID and on the installation of the VMware application and is specifically hooked to the
*,vmx file’s home directory location the first time the guest VM is booted.

Note SMBIOS presents motherboard management and diagnostic information to a computer system and
its software. You can read more about the SMBIOS specification at http://www.dmtf.org/standards/
smbios.

If you move the location of the guest, VMware will know that the initial install directory
has changed because on each boot it compares the value of the UUID.LOCATION entry in the
configuration file to the value of UUID.BIOS. If the directory has changed, the UUID is changed,
which in turn changes the system’s MAC address. Typically, this may not be a problem, but if
you're using route maps based on MAC addresses, you may soon find that communications
cease. In addition, if you use software that uses SMBIOS (UUID.LOCATION) to identify servers,
communications will get interrupted. Lastly, if you're issuing IP addresses based on MAC
address, your guest VMs won't be able to communicate if the UUID changes. You can find the
UUID settings for any given VM in its configuration file. They’re generally nested within the
Ethernet settings. The following bit of code is from a VM'’s configuration file. Notice that each
128-bit value matches for uuid.location and uuid.bios.

Etherneto.addressType = "generated"
uuid.location = "56 4d 7e 42 db dc 5c fb-e9 6f d3 cd ef 07 47 da"
uuid.bios = "56 4d 7e 42 db dc 5c fb-e9 6f d3 cd ef 07 47 da"

Foreseeing this issue, VMware configures its applications to ask you if you want to keep
the UUID after a virtual machine has been moved. What's the right choice for you? The answer
is, it depends. VMware suggests that if the VM is a copy, create a new UUID. Conversely, if the
VM has moved to a new location, keep the existing UUID. Make sure no duplicate MAC
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addresses appear on your network, because hosts identify each other via MAC address. If
duplicates exist, network errors will occur. If you want to permanently change the behavior of
the UUID warning, you have the option of always keeping or replacing the UUID each time
the VM moves.

Renaming a VMware ESX Server VM

Like GSX Server, the VM to be renamed on ESX Server must be powered down before proceed-
ing with the renaming procedure. Also, make sure you have a backup of the VM. Assuming
you're using a default installation of ESX Server and best-practice naming conventions, the
configuration files for VMs will be in the /root/vmware/ directory, and the virtual hard disks
will be in the /vmfs/vmhba:x:x:x:x/ directory.

In case you're wondering what the syntax of the VM’s HBA settings is (vmhba), we'll slip
that information in here. Let’s use vmhba0:0:0:5 as an example. The first zero represents the
first SCSI adapter loaded by the VMkernel Module Loader. The second zero represents the
adapter target number. The third zero indicates the LUN. The fourth number indicates the
partition number; if the number is set to zero, it indicates the use of the entire hard disk.

Best practices dictate that renaming VMs includes the host, configuration file, and virtual
hard disk. By naming files and directories after the host, you reduce administrative overhead.

Note If you're not comfortable with the command line, you can rename files using the Manage Files
option from within the MUI.

Follow these steps:
1. After changing the host name within the operating system, power down the VM.

2. Atthe command console or in a terminal session, rename the *. vmdk file using the mv
command. Be sure to change your present working directory to /vmfs/vmhba:x:x:x:x/.
If you're unsure of the variables in the vmhba settings directory, list the contents of the
/vmfs directory using 11 /vmfs.

3. Change your current working directory to the location of the VM’s configuration file,
cd /root/vmware/<old name>/, and rename the configuration file. You can also use the
Manage Files option found in the MUI to rename the disk:

mv <old name.vmx> <new_name.vmx>

4, Edit the *.vmx configuration file using the Vi editor to reflect the name change, vi
<new_name .vmx>. Modify each line, as in the example that follows, making the old VM’s
name reflect that of the new:

displayName = "<new_name>"
checkpoint.cptConfigName = "<new name>-6dda118a"
scsion:0.name = "vmhba0:0:0:5: <new_name>.vmdk"
scsion:0.fileName = "vmhba0:0:0:5: <new_name>.vmdk"
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5. In the MUI, remove the VM. You won't have to worry about losing configuration files
for disk files because they’'ve been renamed.

6. At the command line, register the renamed VM with ESX Server:
vmware-cmd -s register </root/vmware/<new _name>/new_name.vmx>

7. Before running the VM, verify the name changes by selecting its Option tab and select-
ing Click Here under Verbose Options. If necessary, change each verbose option to
reflect the new name.

Importing Workstation and GSX Server VMs into ESX Server

Sooner or later you'll need to move a VM from GSX Server to ESX Server. Regardless for the
reasons for the move, you'll want to make sure that enough free space is available on the desti-
nation SCSI device to receive the virtual disk files (*.vmdk), that paths are correct, and that
permissions are set. Follow these steps:

1. Verify that the amount of free space on the new host is sufficient to hold the guest VM’s
virtual disk to be moved by executing vdf at the command line. The virtual disk will be
imported into one of your VMFS partitions. Is there room for it?

2. The disks to be imported will need to be available from the Service Console. This
means you'll need to copy the files from GSX Server to a non-VMFS partition on the
ESX Server, or you can connect to a network share with the files. Being that files are
less likely to become corrupt with fewer moves, you're probably better off directly con-
necting to the GSX server hosting the disks to be imported. To do this, create a share
and copy the VM to be moved into the new directory. Set permissions on the share
as necessary. On ESX Server, create a directory in /mnt to connect to GSX Server (for
example, mkdir /mnt/import). From ESX Server’s console, connect to the GSX Server
share using the mount command:

mount -t smbfs -o username=administrator,workgroup=<domain>,
password=123456 //RemoteServer/RemoteShare /mnt/import

Note If you're running Workstation or GSX on Linux, you can use ssh and scp to copy files between
the two servers.

3. Using the vmkfstools command, import the VM’s disk. Notice that the filename stays
the same but that the disk extensions change. The vmhba_number option is the VMFS
partition to be imported to on ESX Server:

vmkfstools -i </source/filename.vmdk> vmhbaX:X:X:X:<filename.dsk>

4, Create a new VM with the same host name and virtual hardware as the original VM.
Specify the newly imported disk for the VM’s hard drive. Lastly, edit the VMs Verbose
Options settings to match any of the original VM options that are vital to your produc-
tion environment, such as the MAC address.
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Moving or Copying VMware ESX Server VMs to Other ESX Hosts

It may become necessary to move an ESX Server VM when equipment goes bad, when leased
equipment must be returned, or when upgrades are made. Some administrators have multiple
copies of the same VM on several servers for redundancy purposes. In the event of hardware
failure or an OS crash, downtime is significantly reduced because the solution merely needs to
be turned on. Moving or copying an ESX Server VM from one ESX Server requires you to copy
the VM’s virtual disk, copy its configuration file, and register it with the new host.

Note VMware recommends that virtual disks not be directly moved between VMFS network shares. The
virtual machine to be copied should first be exported from its VMFS volume using vimkfstools to the local
file system and then moved. VMFS is a proprietary file system, and disk corruption can occur with a direct
network move.

Follow these steps:
1. Power down the VM to be copied or moved.
2. Export the VM’s virtual disk using vmkfstools with the -e option:

vmkfstools -e </Disk Destination.vmdk>ws
vmhbaX:X:X:X:<VM_Soruce Disk Name.dsk>

For example:
vmkfstools -e /export/vmi.vmdk vmhba0:0:0:5:vmi.vmdk

3. List the contents of the export directory to verify the export. The vmkfstools command
will create files 2GB in size in the destination partition:

11 /export

Tip You can use ESX Server disks exported with vimkfstools in VMware GSX Server and Workstation.

4, VMware ESX Server enables ssh by default. You can use the Secure Copy (scp) com-
mand to send files between the servers securely because the data will be encrypted.
In our example, you'll use two options: -rp. The -p option preserves modification and
access times as well as the modes of the files to be copied. The -1 option recursively
copies the entire directory. When you execute the command, you'll have to supply the
password of the user specified in the scp command:

scp -rp /<VM Source Directory> UserID@Remote Server:w
/<VM Destination Directory>

A typical production example of the command looks like the following:

scp -r /vmtest root@®10.100.2.11:/vmtest
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5.

Now that the virtual disk has been copied to the new destination, it’s time to copy over
the VM’s configuration file. The example here assumes you used a default install of ESX
Server. Be sure to change your directories as necessary:

scp /root/vmware/vmtest/vmtest.vmx root@®10.100.2.11:w=
/root/vmware/vmtest/vmtest.vmx

. All the necessary files for the VM should now be on the new host server. Import the

VM’s virtual hard disk into ESX Server using the vmkfstools command:

vmkfstools -i </vmtest.vmdk> vmhbaX:X:X:vmtest.dsk

. Register the VM’s configuration file with the MUI using the vmware-cmd command.

After registering the VM, verify the VM’s configuration before running it. Be sure to
look at the Verbose Options area on the Options tab:

vmware-cmd -s register /root/vmware/vmtest/vmtest.vmx

Renaming a Microsoft Virtual Server VM

Renaming a VM for Microsoft Virtual Server follows approximately the same process as Virtual
PC. The VM must be powered down and not in a suspended state, the virtual hard disk file and
configuration file will need to be renamed, and edits to the configuration file must be made.
Follow these steps:

1.

Launch the Virtual Server Administration Web site, and select the VM to be renamed
from under Status. Select Turn Off.

. Because you may not be using the default directory structure to store virtual disks for

guest VMs, select Edit Configuration under Status. Note the location of the *.vmc file
and the location of the *.vhd file in the Virtual Hard Disk Properties section.

. After collecting the VM’s configuration information, select Master Status from the side-

bar, select the VM in question, and select Remove from the pop-up menu.

. Locate the VM directory containing the guest’s VM configuration file and virtual hard

disk file from the information collected in step 2. Rename the directory containing the
VM’s files, the *.vhd file, and the *.vmc file to exhibit the new name of the VM.

. Using a text editor, edit the *.vmc file to reflect the name change. You'll need to modify

three lines: the virtual disk configuration lines and the display name line:

<absolute type="string">C:\VirtualServerVMs\vmstest\vmstest.vhd</absolute>
<relative type="string">.\vmstest.vhd</relative>
<name type="string">vmstest</name>

. Launch Virtual Server, and select Add from under Virtual Machines. Specify the

absolute path of the renamed VM. Include the name of the configuration file and
the *.vmc extension.
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7. Under Configuration, select Hard Disks. Supply the absolute path to the renamed
virtual disk file. Include the name of the configuration file and the *.vhd extension.

8. If the VM is a copy of an existing VM, be sure to delete the Ethernet MAC address value
from <ethernet card address type="bytes">MAC ADDRESS</ethernet card address>
to avoid having duplicates on your network. On initialization, Virtual Server will create
a new unique MAC.

Copying and Moving Virtual Server VMs to Other Hosts

Microsoft recommends two methods for backing up its VMs. The first method is to treat the
VM like a typical physical server or workstation to be backed up. For instance, if you're using
QiNetix or Backup Exec in your backup environment, load the backup agent on the VM and
include it in your existing backup process. The advantage to using the first approach is that
you won't have to create any new administrative processes to accommodate new guest VMs.
The second method for backing up Microsoft Virtual Server VMs is to back up virtual hard disk
and configuration files of powered-down VMs. Backup software will treat the VMs as if they
were just a group of normal files. During the backup process, you'll want to specifically back
up the virtual hard disk image file (*.vhd), the configuration file (*.vmc), and the saved state
file (*.vsv) if the VM is suspended. The advantage of the second approach is that the entire
state of a VM can be restored by using a few files.

Caution Be careful when backing up VMs in a suspended mode because the System State is saved to
memory in two locations: partly in the *. vhd file and partly in the *. vmc file. Restoring a VM in suspend
mode can and generally does create an unstable VM. If possible, avoid this approach.

When it comes time to move a guest VM between hosts, power down the VM to be moved
and locate two files: the virtual hard disk file (*.vhd) and the VM configuration file (*.vmc).
Before initiating the move, make sure you have a good backup of the VM to be moved. If the
move process fails, you'll want to be able to rapidly revert to your existing guest VM configura-
tion. After creating and confirming you have a good backup, ensure that your user account
has the necessary privileges to complete all tasks. Then follow these steps:

1. Power down the guest VM to be moved. Make sure that it’s not paused; moving a
paused VM is a recipe for disaster.

2. Close the Microsoft server application.

3. Ensure that a transfer medium exists for moving the guest’s files. Assuming your VM
can fit on a CD or DVD, you can use this type of medium, or you can use a mutually
accessible network share: copy the files to the network share and then move them to
their final destination. If the guest is going to be placed on a new network host, the
easiest way to move the files is over your existing network, going point to point.
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4, Make sure the new host system has sufficient resources for the added load of the VM
to be moved. Next, make sure Microsoft Virtual Server is correctly licensed and config-
ured on the new destination host machine and not powered on.

5. Create a directory on the destination host to receive the guest VM files. (If you're just
moving the location of the guest VM to a different directory on the current host, create
the new directory in the desired location and locate the VM’s files within the new
directory.) When creating directories for VMs, use meaningful names to store all
configuration files and information: name the directories after the VM for easier
administration.

6. Ensure that the guest VM is powered down. Now, find all the files for the guest VM to
be moved on the current host and copy them to the new host in the directory you just
created. Files you'll minimally be concerned with are *.vmc, which is the configuration
file, and *.vhd, which is the virtual disk file.

7. Launch Virtual Server, and select Add from under Virtual Machines. Specify the
absolute path of the renamed VM. Include the name of the configuration file and
the *.vmc extension.

8. Under Configuration, select Hard Disks. Supply the absolute path to the renamed
virtual disk file. Include the name of the configuration file and the *.vhd extension.

9. If the VM was moved, it will need to retain its MAC address; you don’t need to regener-
ate its MAC address, as in the copy process. If the VM is a copy of an existing VM,
be sure to delete the Ethernet MAC address value from <ethernet card address
type="bytes">MAC_ADDRESS</ethernet card address> to avoid having duplicates on
your network. On initialization, Virtual Server will create a new unique MAC. If the
guest VM being moved is from Virtual PC to Server, be sure to reinstall Virtual Machine
Additions.

VMWARE VIRTUAL DISK DRIVE GEOMETRY

VMware lists the drive geometry for virtual hard disks near the top of *. vmdk files. You shouldn’t open or edit
a virtual disk file because of the possibility of introducing errors and rendering the disk unusable. If warnings
pique your interest and make you want to do things you’re not supposed to, then experimenting with virtual
disk drive geometry will be exciting for you. A typical *. vmdk file will have several entries regarding the
virtual disk, including cylinders, heads, sectors, and the adapter disk type. For example:

# Extent description

RW 268435456 SPARSE "ide.vmdk"
# The Disk Data Base

#DDB

ddb.virtualHWVersion- = "3"
ddb.geometry.cylinders = "16383"
ddb.geometry.heads = "16"
ddb.geometry.sectors = "63"

ddb.adapterType = "ide"
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Most of the information regarding the disk is clear, save for the RW in the extent description. The
number appears to be a description of the virtual hard disk’s size. For instance, 268435456 is a decimal rep-
resentation of the octal number 2000000000. If you drop the last seven zeros, you'll be left with the number
200; 200 octal is equal to decimal 128—the size of the VM’s virtual hard disk in gigabytes. To clarify the pre-
vious example, the following RW extent descriptions are calculated for you to further demonstrate the
relationships between the IDE RW decimal value, octal value, and drive size:

IDE RW Decimal Value Octal Value Drive Size in GBs
2097152 10000000 1
4194304 20000000 2
6291456 30000000 3
8388608 40000000 4
20971520 100000000 10
41943040 200000000 20
62914560 300000000 30
83886080 400000000 40

Manually changing the drive geometry will allow you to reduce or increase the size of a disk without
using third-party software, such as Norton Ghost or MaxBlast. To figure out what to set the RW, cylinders,
heads, and sectors to, create a new drive the size you desire and view its drive geometry. Change the set-
tings on the drive to be resized to match; using a good hex editor, such as WinHex, will be invaluable in
modification process because dynamic disk files can be gigabytes in size—Notepad isn’t going to cut it.
Next, remove the virtual disk from the guest VM, remove the VM from the MUI, and then close the virtualiza-
tion application. Reopen VMware, and add the VM back and its disk by creating a new disk and specifying
the existing disk as the type.

Being that you'll experience varying degrees of failure (less so with SCSI virtual hard disks), don’t
expect to resize a production drive using this technique and have it work for long. For production VMs, be
sure to use reputable third-party utilities to move bootable systems from disk to disk. More information is
available about drive geometry on VMware’s Web site at http: //www.vmware . com/support/esx21/doc/
esx21admin_migrate other vms.html#1049351; the site covers how to modify drive geometry using
the vmkfstools command with the —g option.

Working with VMware GSX Server and
ESX Server *.vinx Configuration Files

In general, manually changing a VMware configuration file isn’'t necessary and isn’t recom-
mended. If you need to make changes, be careful of typos and accidental deletions. VMware
recommends making changes through the Virtual Machine Console. Poor editing of a configu-
ration file can render a VM worthless. Every virtual machine has a *.vmx configuration file that
contains the settings for the VM. You can locate the file with the aid of the Virtual Machine
Editor. The Options tab displays the location of the VM’s configuration file. You'll now look

at some more options found in a configuration file that we didn’t cover in Chapter 4.
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You can control virtual device behavior by changing the device’s value. Values range from
simple TRUE/FALSE options to directory path statements. For instance, the configuration file
will list devices as not being present if they have a status of FALSE. Look at the following snip-
pet from an ESX Server VM’s configuration file regarding system disks. The first two scsi
statements tell ESX Server that the VM has the LSI SCSI adapter enabled for the hard disk
listed in the fourth line. If you want your VM to discontinue using the disk, set the value in the
third line to FALSE. The remaining statements control the properties for the virtual CD-ROM
and floppy disk drive. If you want a better level of performance for the VM, set the value in
the fifth line to FALSE; the CD-ROM should be enabled only when it’s needed. The *.filename
values for the floppy and CD-ROM drive are the mount points for each device.

scsio.present = "TRUE"

scsio.virtualDev = "vmxlsilogic"
scsion:0.present = "TRUE"

scsin:0.name = "vmhba0:0:0:5:vmiprint1.vmdk"
ide0:0.present = "TRUE"

ide0:0.fileName = "/dev/cdrom"
ide0:0.deviceType = "atapi-cdrom"
floppy0.startConnected = "FALSE"
floppy0.fileName = "/dev/fdo"

In the following configuration example, the first two lines are fairly self-explanatory; you
can edit the first line to change the VM’s name in the MUI The second line is the amount of
memory allocated to the VM in megabytes. It’s important the guest0S option correctly reflects
that of the VM'’s OS. VMware makes optimizations based on the value setting. Other values you'll
see include 1inux and netwware. In the fourth line, RemoteDisplay.depth controls the color depth
of aVM. Increasing the color depth to 24 bits can negatively impact performance. Conversely,
if you can get away with 8 bits, use 8 as the value. The fifth line controls the performance of a
VM when it has the keyboard and mouse focus, and the sixth line controls performance when
a different VM has focus. You can set priority.grabbed to normal or high, and you can set
priority.ungrabbed to normal or low. If you want guest VMs to respond better in the console,
you can set priority.grabbed to high; however, this will negatively impact the performance
of the other VMs. In a lab environment, you may want to set priority.ungrabbed to low to boost
the performance of the VM that has focus to decrease latency. The tools.syncTime statement
configures a VM to either synchronize with the host’s clock or not. If you want your VMs to use
NTRB, it’s safe to set this option to FALSE.

displayName = "vmiprint1"
memsize = "384"

guest0S = "winNetStandard"
RemoteDisplay.depth = "16"
priority.grabbed = "normal"
priority.ungrabbed = "normal"”
tools.syncTime = "FALSE"
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After creating a snapshot of a VM, several lines are added to its *.vmx configuration file.
Most of the lines deal with how the snapshot will be treated for the VM’s power cycles. How-
ever, one particular statement of interest is gui.restricted. The gui.restricted line enables
the restricted user interface. This option hides the toolbar, hides all functions on the Power
menu and Snapshot menu, prohibits changes to virtual networking settings, and denies
access to the VM Control Panel.

gui.restricted = "FALSE"

The undopoint.action statement directs VMware to do one of several things with a snap-
shot, such as keeping changes or reverting to its original state. Table 6-3 lists its options.

Table 6-3. undopoint.action Statement Values

Value Action

autoRevert On power down, reverts to original state of snapshot
autoCommit Automatically updates snapshot on power down

prompt On power down, prompts user what to do with snapshot

Several additional undopoint statements are created when a snapshot is taken. Looking
at the first line, resotreFromCheckpoint, this statement instructs the application to keep its
current state when set to FALSE or to revert to a snapshot when it’s set to TRUE. The second
line, checkpointedOnline, will have a value of TRUE if the snapshot was taken while a guest
was running. The third line, protected, will have a setting of TRUE if the snapshot is designated
as locked in the console. A locked snapshot prevents it from being updated.

undopoint.restoreFromCheckpoint = "FALSE" Revert snap when true
undopoint.checkpointedOnline = "TRUE" Snapshot taken while 0S running.
undopoint.protected = "FALSE" True for locked snapshot

The location of the undo log is denoted in the VM’s disk redo statement. You can place
the redo log in the same directory as the virtual disk, .\, or you can direct it to any network or
local resource:

scsion:0.redo = ".\12gbscsi.vmdk.REDO_a00356"

Note Using redo logs, you can share virtual disk base images. This is handy for setting up many servers that
are similar in nature, such as Web servers. An excellent article on this is available at http: //www.vmware.com/
support/reference/common/disk_sharing.html. The article details how to create the base image and
the corresponding redo log files.

209



210

CHAPTER 6 ' DEPLOYING AND MANAGING PRODUCTION VMs ON ENTERPRISE SERVERS

The last thing we want to touch on in this section are the Ethernet settings. In the follow-
ing *.vmx code, a single Ethernet adapter is configured for the VM and is noted as being
present by TRUE in the first line. The second, third, and fourth lines describe the VMs connec-
tion type, the adapter’s name, and the network in which to connect. The fifth line informs you
that a unique MAC (line 8) has been generated for the VM rather than being statically assigned
(static). The etherneto.generatedAddressOffset line calculates the UUID for the VM that
generates the MAC address. After a MAC address is generated and a duplicate address is found
to exist, the offset value is added. VMware will continue to check for duplicate addresses and
continue to add the offset until a unique MAC address is derived. To generate the next avail-
able MAC address, the offset number (represented in decimal) is added to the last byte of the
MAC address (represented in hex). In the eighth line, the da hexadecimal is equal to 218 deci-
mal. Add the offset from the ninth line to 218 to arrive at the next value for the last byte of the
second MAC address, 238 decimal or EE hexadecimal.

Etherneto.present = "TRUE"

Etherneto.connectionType = "monitor dev"

Etherneto.devName = "vmnico"

Etherneto.networkName = "Networko"

Etherneto.addressType = "generated"

uuid.location = "56 4d 7e 42 db dc 5c fb-e9 6f d3 cd ef 07 47 da"
uuid.bios = "56 4d 7e 42 db dc 5c fb-e9 6f d3 cd ef 07 47 da"
etherneto.generatedAddress = "00:0c:29:07:47:da"
etherneto.generatedAddressOffset = "20"

Working with Virtual Server *.vmc Configuration Files

Virtual Server’s configuration file is similar to Virtual PC’s. The file is stored in a text-editable
XML format. It’s used to store a guest VM’s configuration information and can be manually
edited. Before editing the file, be sure to make a backup of the file in case you enter errors
during the editing process.

One necessary change you'll want to make to the configuration file is the VM’s MAC
address to avoid duplicates on your network. Unlike VMware’s use of the UUID to help man-
age MAC addresses, Virtual Server will passively “allow” duplicates to occur if you're making a
copy of aVM to run concurrently with the parent image. If you're just moving the VM, it’s not
necessary to change the MAC address.

To change the MAC address, find the section of the configuration file containing the
text string <ethernet_card address type="bytes">0003FFD6C41F</ethernet card address>.
Remove the 48-bit address from the string and save the file. In our example, the MAC address
is 0003FFD6C41F. On the VM’s next boot, Virtual PC will see that the MAC address has been
removed, and it will generate a new MAC address for the VM. You can also change the MAC
address of a VM by using the Administration Web site and editing the network adapter properties.

Other entries in the *.vmc configuration file you may want to experiment with are the
settings to change the name and location of the *.vhd configuration file (ide_controller),
screen size and resolution (video), RAM allocation (memory), and mouse behavior (mouse).
Because the file is a text representation of the Virtual Machine Options and Settings dialog
box, you can programmatically add or remove devices on dozens of machines with little
scripting effort.
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Note If you want to add virtual devices to a guest VM and are unsure of the settings in the *. vmc file,
create a VM and remove all the devices. Next, add the device in question, and look at the changes made to
the *.vmc file.

Performing Command-Line Management

In Chapter 4, you looked at two CLI executables, vmware.exe and Virtual PC.exe.We also cov-
ered basic keyboard shortcuts. In the following sections, you'll look at a few other commands
for VMware: vmware-vdiskmanager and vmkfstools. You'll also learn about Virtual Server’s
msiexec.exe.

VMware

The vmware-vdiskmanager utility for Windows hosts allows you to manage, modify, and create
virtual disks from the command line. You can also use the command in scripts for automating
virtual disk management tasks, such as breaking large virtual disk files into chunks to be
exported to DVD. Additionally, you can use the command to increase the size of a virtual disk
beyond what it was initially created at without adding an existing disk or using third-party
disk imaging products. If you find a need to revert a VM'’s preallocated disk to a dynamic disk,
then vmware-vdiskmanager is the command for you; you may find yourself in this situation
when you need to add VMs to a server and no disk space exists. Examples of how to use the
command follow:

* To increase the size of an existing virtual disk, use vmware-vdiskmanager -x 20GB
virtual disk name.vmdk.

* To convert a preallocated disk to a dynamic disk, use vmware-vdiskmanager -r
virtual disk source.vmdk -t 0 virtual disk destination.vmdk.

* To create a virtual IDE disk, use vmware-vdiskmanager -c -t 0 -s 80GB -a ide
virtual disk name.vmdk.

* To rename a virtual hard disk, you must first remove it from the VM to which it’s
attached; use vmware-vdiskmanager -n old virtual disk name.vmdk
new_virtual disk name.vmdk.

Note VMware discusses shrinking and defragmenting virtual disks and other handy options of
vmware-vdiskmanager on its Web site at http://www.vmware.com/support/gsx3/doc/
disks_vdiskmanager eg gsx.html#1088627.
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The vmkfstools command for ESX Server allows you to manage, modify, and create virtual
disks from the command line. Because both vmkfstools and vmware-vdiskmanager allow you to
increase the size of a virtual disk, there’s no benefit in allocating more space to a virtual disk
than necessary. The hazard in overcommitting disk space is that you can’t reduce the size of the
disk in the future. Our treatment of the vmkfstools in this section is by no means exhaustive;
VMware discusses this command at length on its Web site in each virtualization application’s
administration manual. You can find ESX Server’s manual at http://www.vmware.com/support/
esx21/doc/esx21admin_vmvkfstools.html#999999. The syntax for the command is
vmkfstools <options> <path>.

* To create a new virtual disk, you need to specify the size and name of the disk with
vmkfstools -c <size in megabytes>m vmhbax:x:x:x:<virtual disk name>.dsk.

e To import a virtual disk into a VMFS partition, use vmkfstools -i
<virtual disk source>.dsk vmhbax:x:x:x:<virtual disk destination>.dsk.

¢ To export a virtual disk from VMFS partitions for use on GSX Server or Workstation, use
vmkfstools -e <destination disk name>.vmdk vmhbax:x:x:x:<source disk name>.dsk.

o To list VMFS virtual disks, use vmkfstools -1 vmhbax:x:x:x.

Before making changes to a VMFS virtual disk, such as increasing a virtual disk, the VMFS
volume needs to be writable. To do this, power down all VMs accessing the volume and exe-
cute vmkfstools --config writable. To grow a disk, you need to use the -X option. After
increasing the disk, the file system may need to be modified to see the new larger disk:

vmkfstools -X <number of megabytes to grow to>m

The option to display virtual disk geometry with vmkfstools is -g. This option becomes
handy when an import from GSX Server to ESX Server fails because of the difference in how
ESX Server and GSX Server handle drive geometry. Before importing a disk, you should view
the current geometry of the disk in GSX Server before importing it to a VMFS partition:

vmkfstools -g <GSX virtual disk>.vmdk
After the import, run the command again on the newly imported disk:
vmkfstools -g <ESX virtual disk>.dsk

If the drive geometry doesn’t match, you can correct the problem by specifying the
correct information in the configuration file by adding a drive geometry entry:

scsi <adapter-id>:<target-id>.biosGeometry = "<cylinders>/<heads>/<sectors>"
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Microsoft

You can install Microsoft Virtual Server using the Microsoft Installer, msiexec.exe. This is
valuable for deploying Virtual Server by using group policies or performing an unattended
installation. The syntax for the command has several parameters and options:

msiexec.exe {/i|/a} "msifile" [ALLUSERS=value] [PIDKEY=value]
[ SERVICESSTARTUPMANUAL=value] [WEBSITEDEFAULTPORT=value]
[{INSTALLDIR=value | TARGETDIR=value}] [ALLUSERS=value]
[NOSUMMARY=value] [/qb | /gn | /qr | /qf] [/1 logfile]

Table 6-4 details the common configuration parameters.

Table 6-4. Virtual PC Microsoft Installer Options

Option Action Performed

/i Installs Virtual Server.

/x Uninstalls Virtual Server.

/a Installs Virtual Server on the network share.

/q Sets installation user interface: /gn for none, /gb for basic,
/qr for reduced, /qf for full.

/1 <File> Provides the installation log file path.

PIDKEY=<KeyWithoutDashes> This is the Virtual Server product key without dashes.

SERVICESSTARTUPMANUAL=<Number> Automatically starts using 0. Does annual start using 1.

YOUBSITEDEFAULTPORT=<Number> Specifies the Administration Web site port. This default is 1024.

INSTALLDIR=<Path> This is a custom installation directory.

TARGETDIR=<NetworkShare> This is the location of the installation package when used
with /a.

NOSUMMARY=1 Suppresses summary page.

You can perform an unattended installation for a user called test by executing the example:

msiexec.exe /i "Virtual Server 2005 Install.msi”
ALLUSERS="test" PIDKEY=<KeyCode> /qn

If you want to install Virtual Server for all users, drop the ALLUSERS option:
msiexec.exe /i "Virtual Server 2005 Install.msi" PIDKEY=<KeyCode> /qgn

If you want to deploy Virtual Server using group policies, you'll need to invoke the admin-
istration option, /a, and specify a directory from the group policy that will read the installation
files, TARGETDIR. You can create a log file for each install by using the -1 option and pointing it
to a network share:

msiexec.exe /a "Virtual Server 2005 Install.msi"
PIDKEY=<KeyCode> TARGETDIR=<NetworkShare> /qn /1 <NetworkShare>
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Using the Windows System Preparation Tool

The Windows System Preparation Tool (Sysprep) allows you to prepare OS images for auto-
mated deployment scenarios, such as rolling out successive VM servers on a single host or
creating VMs for quick setup in a lab environment. Microsoft suggests that if you use the
Sysprep tool that you use group policies to reset security settings. In this section, you’ll learn
how to use Sysprepped VMs:

1. Locate a copy of the Sysprep tool; you can download it from Microsoft’s Web site at
http://www.microsoft.com/downloads. Additionally, you can use a search engine to
locate it. Make sure you have three files: Sysprep.exe, Sysprep.inf, and Setupcl.exe.
Sysprep.exe prepares the VM for imaging, and Sysprep.inf is a file containing any
configuration settings the VM image requires for its first boot. Setupcl.exe is a setup
wizard.

2. Create aVM, and install the operating system. As the system administrator, install any
hotfixes, patches, and service packs.

3. Create a secondary account, such as SysprepAdmin, and place it in the Administrators
group. Log off and then back in with the new admin account.

4, Install all applications and any necessary updates. Make any necessary customiza-
tions, such as tweaking the desktop, configuring Internet Explorer, installing printers,
and so on.

5. Off the root of aVM'’s hard disk, create a directory labeled c:\sysprep. Copy Sysprep.exe
and Setupcl.exe into it. You'll copy Sysprep.inf into the directory after you create it in
step 10. Under the Sysprep directory, create a directory titled drivers. You'll need to use
the drivers directory if you're using virtual devices that the OS doesn’t recognize, such as
the LSI controller. If you're using it, create a directory under drivers titled DiskController
and place the LSI driver in it. The driver directories should have only the device driver
and related *. inf and *. cat files. Avoid placing any *. exe files in the directories. You'll
later use these directories in the Sysprep.inf file.

6. Log off and back on as the system administrator. Add the secondary administrator
account profile from step 3 to the Default User profile in the Control Panel. Grant
the Everyone group access to the profile. Now, delete the secondary administrator
account. Copying the profile ensures all VM users have the profile configured from
step 4. Removing the secondary administrator account removes any security risk
the account has associated with it.

7. Take a moment to optimize the VM. Remove all unnecessary overhead, such as frivo-
lous programs, temporary files, accessories, and icons. You may even want to run the
Disk Cleanup Wizard and defragment the hard drive.

8. Before running Sysprep.exe, make sure the VM to be imaged isn't joined to the domain.
At the CLI, run Sysprep.exe from within its directory from step 5. On the System Prep
Tool screen, select Use Mini Setup and Detect Non-Plug and Play Hardware from under
Options. Select Reseal to start the process. You can pass several additional command-
line options to the executable. To get help with the command, see Table 6-5, or execute
sysprep.exe /2.
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Table 6-5. Sysprep Command-Line Help Options

Option Action

/forceshutdown Forces a shutdown of VM that fails under normal command usage.

/noreboot Doesn't shut down after running.

/nosidgen Doesn't generate new SID on reboot. This isn't useful for making
multiple copies of VMs.

/pnp Reenumerate all devices in VM. This is helpful if you're using legacy
devices.

/reboot Reboots the VM rather than shuts down, and starts mini-setup.

9. After completing the Sysprep process, shut down the VM and make an image of it. Like
physical computers, you can create a bootable ISO of the VM, or you can make a copy
of the VM’s directory. The copy option reduces working time. Be sure to name the
directories of the new VM after the VM itself. Also, make any necessary name changes
to the *.vmdk and *.vmx files.

10. You can use Setup Manager, Setupmgr . exe, to create the Sysprep.inf file. The exe-
cutable should come with the Sysprep package downloaded from Microsoft. Launch
the executable, and answer each question in the wizard. If you leave something out,
you’ll have to supply the information during the initial boot. When using Setup Man-
ager, be sure to select the Sysprep setup option, the correct OS of the VM, and an
unattended install. You'll basically be supplying all the information that’s normally
supplied during a typical installation of a Microsoft OS.

11. Start the new VM. On boot, the mini-setup wizard executes and uses the settings from
the Sysprep.inf file to configure the VM.

12. Rename and join the VM to your domain or workgroup as necessary.

Monitoring VM Performance

When looking at how to maintain high levels of performance for your VMs, you'll need to stick
to the tried-and-true methods of performing a baseline analysis and then follow up with peri-
odic maintenance reporting to find system and network trends. For Windows systems, you'll
be working with System Monitor and dealing with guest VM counters. Microsoft includes spe-
cial counters for Virtual Server as does VMware for GSX Server. You'll also look at ESX Server’s
built-in performance monitoring Web site and the esxtop command. When creating a baseline
for the host, you'll look at four main categories: CPU, RAM, disk, and network bottlenecks.

Monitoring ESX Server Performance

ESX Server installs performance-monitoring capabilities by default. vmkusage presents historical
data on Web-based graphs, and esxtop displays real-time processor statistics for ESX Server;
you'll look at vmkusage first and then esxtop.

To harness the power of vmkusage, you'll need to activate it by executing vmkusagectl
install at the command line. By default, vmkusagect1 will run once a minute through cron. It
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gathers information from /proc and stores gathered information in a database. The information
is viewable by opening a Web browser and pointing it to https://<ESX_SERVER IP>/vmkusage.
Each guest VM is listed along with its CPU, memory, network, and storage statistics. Graphs for
each VM resources are listed below the general statistics of the VM. Sometimes vmkusage doesn't
properly graph collected information. If this is the case for you, blow away the database and
reactivate vmkusagectl:

vmkusage -regroove
vmkusagectl uninstall
vmkusagectl cleandb
vmkusagectl install

Note You can use two commands with the performance tools in ESX Server, vmkusage and vmkusagectl.
They both perform identical functions save for a few options that may work only with vmkusage, as in
-regroove. If an option doesn’t work with one command, try the other; in addition, you may have to try
options with and without a preceding dash. You can get help with each by supplying either vmkusage -help
or vmkusagectl support.

Table 6-6 lists common options to use with vmkusagectl.

Table 6-6. Popular vmkusagectl Command Options

Option Action Performed

graph Creates guest VM graphs.

hyper Polls every 10 seconds and updates every minute. Runs regroove and uninstall first.
monthly Creates monthly graphs using larger databases. Runs regroove first.

nograph Doesn't create guest VM graphs.

regroove Deletes databases and starts over.

verbose Loquaciousness is rewarded with copious verbiage.

Use the following to get the default capabilities of vmkusagectl and graph:
vmkusagectl install graph

Use the following to poll more frequently to gather more graph data:
vmkusagectl install hyper graph

Use the following to generate monthly graphs:

vmkusagectl install monthly graph
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Another command you can toss in your bag of tricks for monitoring ESX Server is the esxtop
command. It displays utilization statistics of each physical process and installed memory. In
addition, esxtop monitors disk and network bandwidth for each physical disk and physical
network adapter. The esxtop command has many options available; you can get help by using
the manual pages at the command line, man esxtop.

Note The first output line displayed with esxtop displays several statistics, including uptime, worlds,
and load average. The term worlds refers to VMkernel running processes. Three world types exist: System,
Service Console, and Virtual Machine. Load average is important because you can quickly determine the
CPU load. A load average of 1 means that the server’s physical CPU is completely utilized. A load average of
2 means the physical server needs twice as many processors. A load average of .5 means the CPU is half
utilized. Be sure to read the man pages on this to get a feel for the historical display.

While esxtop is running, you can pass several commands to it interactively to toggle infor-
mation on and off. Table 6-7 lists the commands you'll need to gather baseline information
regarding the CPU, memory, disks, and networking information. To get an idea how the inter-
active commands work, run esxtop and toggle all options off and toggle each on individually.

Table 6-7. esxtop Interactive Commands

Interactive Command Action Performed

Toggles display of ESX Server CPU information
Toggles additional fields
Toggles display of ESX Server memory information

Toggles display of ESX Server swap information

Q T 3B +H 0O

Toggles display of ESX Server disk information

5

Toggles display of ESX Server network interface information

You can also pass a handful of command-line options to esxtop upon execution. The
command options are particularly important because they help you automate data gathering
by limiting the data collection window and dumping the results to a text file. Table 6-8 lists the
delay (d), iterations (n), and batch (b) options.

Table 6-8. esxtop Command Options

Option Action Performed
d Updates delay in seconds (5 is the minimum)
n Performs n updates and then exits

b Sends output to other programs, scripts, or a text file
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If you were creating a baseline and wanted to use esxtop to run for five minutes at thirty-
second intervals and finally dump the data to a file for further processing, you'd need to execute
esxtop d 30 n 10 b > esxdatadump.txt. Being that you're redirecting output to a file, you won't
see screen updates.

Now that you've captured your baseline data, you'll need to create a baseline worksheet
for historical trending purposes—there’s nothing like management wallpaper to build your
case for additional networking equipment. In the worksheet, you'll want to minimally record
CPU, RAM, disk, and network averages. Over time, you should be able to graph server usage
trends and determine the growth characteristics of the network. Without historical data, infor-
mation from esxtop is meaningless.

You can identify a host CPU bottleneck by examining load average. A load average of 1
means the server’s physical CPU is completely utilized. A load average of 2 means the physical
server needs twice as many processors or fewer guest VMs. A load average of .5 means the
CPU is half utilized. Ideally, you'll want to utilize about 60-80 percent of the physical CPU
(PCPU). Loading up the processor beyond this can cause excessive paging during high utiliza-
tion periods, which significantly impacts performance. If you have high utilization levels,
look at each VM’s logical CPU (LCPU) to determine the resource hogs. You can find the virtual
machine ID in the MUT’s Display Name field. Use this number to identify a VM listed in the
VCPUID field from the esxtop output. Three columns of data are available for each VM:
%USED, %READY, and %EUSED. The %USED field is the percentage of the physical CPU being
used by the VM. The %READY field is the percentage of time a VM is ready to run but can't get
scheduled. VMware suggests that this number shouldn't exceed 5 percent. The %EUSED field
represents how much a VM is saturating the physical CPUs. A high CPU saturation level is a
good indicator of a resource hog—you may need to move this VM to a less-utilized server or
add processors.

To determine if a bottleneck exists with memory, first look at the total amount of free
system memory; if this number is relatively low and a fair amount of swap memory is used,
you should install more RAM. Determining memory bottlenecks for guest VMs requires that
you compare the maximum memory used (the %MEM column) with swapped memory uti-
lized (the SWPD column). To see the swapped memory field for aVM, press the F key while
esxtop is running and select R. You can expect to see some memory swapping, but excessive
or a consistent increase in usage over time can indicate that the system needs more physical
memory.

Identifying network bottlenecks is a matter of knowing the physical constraints of your
hardware and network. With the performance thresholds known, you can compare these
to the NIC information in esxtop. As a baseline approach, the sum of MbTx/s and MbRx/s
shouldn’t approach anywhere near the full duplex rating for the server’s NIC. If you find that
the average throughput is consistently high, you may need to add faster network adapters or
even add a server to handle the load.

Identifying hard disk bottlenecks requires you to know the performance characteristics
of the host’s controller card and have first verified that a memory bottleneck doesn't exist.
Excessive memory swapping can create a disk bottleneck. Like a network adapter, the value
for MBr/s and MBw/s shouldn't consistently be pegged at the hard disk controller’s rating, and
the r/s and w/s values shouldn't be pegged as specified by the manufacturer. If either entry is
consistently reaching near the hardware’s threshold, you can try to alleviate the bottleneck
by first defragmenting hard drives and then turning to a hardware solution, such as using
faster controllers with more disk interfaces.
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Monitoring VMware GSX Server Performance

VMware GSX Server has performance counters that can be managed through the host’s Per-
formance console application. Unfortunately, the counters are available only for Microsoft
hosts. You can, however, monitor the performance of Linux VMs. The performance counters
included with GSX Server allow you to monitor memory usage, virtual hard disk access, and
VM network traffic. To track the performance of a VM, it must be powered on. The VMware
performance counters track the status of the virtual machine proper and rnot that of the
guest OS.

Creating a baseline report for GSX Server should include processor, memory, disk, and
network recordings. You should generate the baseline report when the host is first configured,
and you should regenerate the report at regular intervals. Having historical data for the base-
line measurement will help you identify trends and troubleshoot resource-related problems.
Your report should include the minimum, maximum, and average values for all the counters.

Identifying CPU bottlenecks requires that you add a few extra counters to your baseline
report. The counters to add from the host are %Processor Time, Interrupts/Sec, and Processor
Queue Length. If Processor Time is consistently greater than 90 percent, you guessed it—you
have bottleneck. This value should be around 60-80 percent to handle usage spikes. Inter-
rupts/Sec will vary widely based on the CPU in your system. Based on your hardware, you'll
have to dig around on the Internet to find a number for an alert value; for example, you can
consider 3000-4000 to be a bottleneck for Pentium processors. On average, Processor Queue
Length should be less than two: the queue is where data piles up when the CPU is overloaded.
If you find that the host has a bottleneck, you can add more processors or remove VM guests.

You can identify disk bottlenecks by looking at Virtual Disk Reads/Sec, Virtual Disk
Writes/Sec, Host Physical Disk Reads/Sec, Host Physical Disk Write/Sec, Host Physical Disk
Queue Length, and Host % Disk Time. Because data is being essentially passed from the guest
VM to the host, the Disk Reads/Sec and Disk Writes/Sec counter should share approximately
the same values. Identifying hard disk bottlenecks requires you to know the performance
characteristics of the host’s controller card and have first verified that a memory bottleneck
doesn't exist. Excessive memory swapping can create a disk bottleneck. The value for these
counters shouldn’t be redlined near the hard disk controller’s rating as specified by the manu-
facturer. The Physical Disk Queue Length indicates disk requests waiting to be serviced. In
general, physical systems should have a value of less than 2. If any of the counters consistently
reach the hardware’s threshold, you can try to alleviate the bottleneck by first defragmenting
hard drives. You may need to provide a hardware solution by upgrading to faster disk con-
trollers with more disk interfaces.

Memory bottlenecks should be nonexistent with the price of memory being so inexpen-
sive; however, that doesn’'t mean you shouldn’'t monitor memory. The counters that should be
minimally monitored are Percent Guest Physical Memory Touched, Host Memory Available
MBytes, Host Memory Pages/Sec, and Host Paging File % Usage. Percent Guest Physical Mem-
ory captures the percentage of simulated physical memory recently used by the guest. If a VM
touches its maximum memory setting, it may be memory starved. To verify this, check the
duration the VM uses as the maximum amount of memory; if the touch times are high relative
to running time, you'll want to allocate more RAM to the VM. The Host Memory Available
MBytes counter reveals the amount of physical memory for running processes. This number
should average no less than 5-6MB. Host Paging File % indicates page file usage. If the per-
centage is consistently greater than 90 percent, it’s time to add more memory.
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Identifying network bottlenecks is a matter of knowing the physical constraints of your
hardware and network. With performance thresholds known, you can compare these to the
counters that can help identify network bottlenecks. The counters of interest here include
Network Bytes Sent/Sec, Network Bytes Received/Sec, and Host Network Bytes Total/Sec. The
aggregate sum should be well within the published throughput constraints of your hardware.
If the total is consistently high, you may want to add faster network adapters or add more of
them; you can also look for improperly configured speed/duplex hardware settings.

Monitoring Virtual Server Performance

Monitoring Virtual Server guest VM performance is similar to that of a physical server, and the
process for creating a baseline is the same. Most of the counters included with Virtual Server
generate a cumulative total of the resources being monitored since the host or VM was pow-
ered on. Cumulative totals are good for looking at trends of disk usage over time or at total
network throughput over time. Being able to target bottlenecks requires you to use the host’s
counters or use the limited output of Task Manager.

Note Rather than using the counters made available with the install of Virtual Server to monitor hard
disk space usage, you can write a script that queries your domain servers and reports the data through
a Web page. To get you started, read the “Monitor Disk Space on Multiple SQL Servers” article at
http://www.databasejournal.com/features/mssql/print.php/3296731.

The most useful Virtual Server counter for baseline and trend analysis is the CpuUtiliza-
tion counter. It provides the percentage of CPU resources allocated per VM. This counter
shouldn'’t reach and remain at 100 percent utilization. If it does, then either the host resources
are overcommitted or a process is misbehaving. If this problem occurs from overcommitted
resources, you can solve the problem by adding more processors or by offloading guest VMs to
other underutilized servers. If it’s a runaway process, Task Manager can help you identify the
culprit.

You can identify disk bottlenecks by looking at Physical Disk Reads/Sec, Physical Disk
Write/Sec, Physical Disk Queue Length, and Host % Disk Time. Identifying hard disk bottle-
necks requires you to know the performance characteristics of the host’s controller card and
have first verified that a memory bottleneck doesn’t exist. Excessive memory swapping can
create a disk bottleneck. The value for these counters shouldn’t be redlined near the hard disk
controller’s rating as specified by the manufacturer. The Physical Disk Queue Length indicates
disk requests waiting to be serviced. In general, physical systems should have a value of less
than 2. If any of the counters consistently reach the hardware’s threshold, you can try to allevi-
ate the bottleneck by first decreasing hard drives. You may need to provide a hardware solution
by upgrading to faster disk controllers with more disk interfaces.

Memory bottlenecks should be nonexistent with the price of memory being inexpensive;
the counters that should be minimally monitored are Memory Available MBytes, Memory
Pages/Sec, and Host Paging File % Usage. The Memory Available MBytes counter reveals the
amount of physical memory for running processes. This number should average no less than
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5-6MB. Host Paging File % indicates page file usage. If the percentage is consistently greater
than 90 percent, it’s time to add more memory.

Identifying network bottlenecks requires you to know the physical constraints of your
hardware and network. With performance thresholds known, you can compare these to the
counters that can help identify network bottlenecks. The counter of interest here is Network
Bytes Total/Sec. The total should be well within the published throughput constraints of your
hardware. If the total is consistently high, you may want to add faster and/or additional net-
work adapters or look for improperly configured speed/duplex hardware settings.

Performing Fault Monitoring and Fault Tolerance

We'll now introduce you to a few sample fault-monitoring and fault-tolerance strategies for
VMware to prepare you for the forthcoming enterprise management chapter. In Chapter 14,
we'll cover additional fault-tolerance issues in greater detail. Two approaches exist for the fault
monitoring and fault tolerance of your VMs; the first approach uses free scripts available in
VMware’s Scripting API (available at http://www.vmware.com/pdf/Scripting API 215.pdf),
and the second method uses VirtualCenter. VirtualCenter provides a robust built-in monitor-
ing system that performs certain actions given defined circumstances.

VirtualCenter uses a central console so you can access and manage all your VMs from
one location. In addition to extensive logging and performance graphing, new servers can be
quickly deployed with the Instant Provisioning Deployment Wizard. It’s a template-based sys-
tem capitalizing on VMware’s standardized virtual hardware. The Virtual Infrastructure SDK
integrates with third-party software to capitalize on existing applications. If you want to learn
more about VirtualCenter, please visit VMware’s Web site.

The Scripting API has scripts to start all VMs, list all VMs, create and commit a redo log,
and enumerate a VM’s IP. Two scripts from the API are of particular interest: status.pl and
hb_check.pl. The status.pl script returns the power status of a VM, and hb_check.pl monitors
the heartbeat of a VM at a given interval in seconds. If the heartbeat isn’t detected, the script
will stop the given VM and start a new VM based on the supplied configuration file.

You can use the first script, status.pl, to verify the power state of a VM, and then the out-
put can perform a particular action. For instance, the script comes in handy during backups
when a VM is required to be shut down. If the script finds the VM in a powered-on state, a sec-
ond script can be called to gracefully power off the VM. Once the backup is finished, the VM
can be restarted either by passing commands from the backup application or by scheduling
actions with the at command.

The hb_check.pl script is especially exciting because you can use it with little modification:

1. Download and save the script to a directory on your server.

2. Edit the VmPerl scripting directory statement to match that of the running VMs.

3. Execute the script at the CLI. If you don't specify an interval, it will default to 30 seconds:
./hbcheck.pl <VM Config To_Check> <VMConfig To Start> <Interval in Seconds>

If the script doesn’t detect a heartbeat within the interval specified, it will attempt to stop
the VM and then start a new VM in its place. If you don’t want to specify a different configura-
tion file, specify the same configuration file option for Config to Check and Config To Start
to restart the failed VM.
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Summary

In this chapter, you learned how to properly configure and install server VMs. We also covered
techniques for monitoring production VM resource utilization and scripting basics for fault
monitoring and fault tolerance. In the next chapter, you'll learn how to recover a failed virtual
server and to properly plan and test VM deployments. Additionally, we’ll cover backup alter-
natives, including using network backup agents, online snapshots, and offline “flat-file”
backups.



CHAPTER 7

Backing Up and Recovering
Virtual Machines

For virtual machines running in a production environment, backup and recovery is just as
serious as for all the other servers on the network. When running servers inside VMs, you'll be
faced with several new challenges, as well as advantages, when planning and implementing a
backup strategy.

In this chapter, you'll explore the process of planning for and administering backup and
recovery operations on VMs and VM hosts. Along the way, you'll see the different approaches
you can take to secure VM data, which include the following:

e Traditional agent-based backups
* Non-agent-based backups

e Flat-file backups

Also, many organizations have embraced the idea of maintaining a warm standby VM
server that can be brought online if a primary server fails. This approach, for many organiza-
tions, may mean that data is unavailable for a few minutes following the loss of a server. If you
can't afford to cluster all your systems, or if some of your applications don’t support clustering,
then you may find this approach to be a perfect fit. Since the focus of this chapter is purely on
VM backup and recovery, we'll walk you through the process of maintaining a standby VM
server in Chapter 14.

Optimizing your backup strategy often means much more than simply installing software
and letting it do its magic. Oftentimes, custom scripting is required to get the backup results
you desire. Because of the importance of getting your virtual infrastructure to work around
your needs (instead of the other way around), we'll also show you several scripting ideas to
both enhance and automate the backup, recovery, and availability of your VMs. Let’s start
with the most common production backup method today—running agent-based backups.
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Performing Traditional Agent-Based Backups

As VMs perform write operations, some data winds up in the host system’s physical memory
before it’s passed to a virtual disk file on the hard disk. This architecture is common in both
the VMware and Microsoft products, and as a result, neither vendor supports online backups
of virtual disk files. Instead, both strongly recommend you install backup agent software on
the VMs in order to back them up, as opposed to running a single backup agent on the host
system.

Installing backup agents on your VMs is the only surefire way to guarantee the reliability
of backing up their virtual disk files. Keep in mind, however, that there’s more to a VM than
just its disk files. Each VM has configuration files too, and these files should be backed up by
a backup agent running on the VM’s host system.

Note All the major backup vendors, including EMC (Legato), Veritas, CommVault, and Computer Associ-
ates, have performed testing at some level with their backup agents and virtual machine software. You
should find that the backup agent will behave as if it’s running on a physical system, with no awareness
of the VM software that’s hosting the virtual machine.

If you don't have an enterprise-class backup software suite but still need to run VMs 24/7,
then you could use the backup tool included with each OS to back up your running VMs. For
example, you could use Windows Backup to back up Windows VMs and could use the dump
command to back up Linux VMs. Each of these scenarios is described later in the “Performing
Non-Agent-Based Backups” section, but first let’s take a look at agent-based backups.

Running Backup Agents on VMs

Running backup agents on VMs is the preferred method for backing up virtual disks, according
to both Microsoft and EMC. A backup agent is software that runs as part of a backup software
application, allowing you to back up a system either over the LAN or through a storage network
to backup media.

When backing up VMs, several considerations will directly affect backup and recovery
performance. When planning your backup infrastructure to include VMs, you have three pri-
mary architectural choices:

* Backing up over the LAN
* Backing up to the host

* Backing up directly to storage (local or SAN-attached storage)

Let’s first look at the traditional LAN backup configuration.
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Backing Up over the LAN

Most organizations today employ LAN-based backups. With this technique, backup data is
sent over a network from the system being backed up to a system acting as a media server. The
media server provides a physical interface between the systems being backed up and the stor-
age hardware, such as a tape library. Figure 7-1 shows this configuration.

Virtual Machines

VM Host

Media Server

==sunas Vjrtual Network Library

=3 Backup Data

Figure 7-1. Backing up a VM over the LAN

With a LAN-based backup architecture, you could either network the VMs directly to the
media server using bridged networking or have the VMs connect using a host-only network
and route through the host to the media server. If the VMs are routing through a host system,
remember that the media server will also need a static route present (or have the LAN router’s
route table updated) so that the media server can route back to the virtual machine. If routing
isn’'t one of your strengths, then we recommend going with bridged networking to connect
your VMs to the media server since this is the easiest scenario to configure.

Caution You can’t use NAT to connect VMs on a private network to a media server. While the VMs could
communicate to the media server through NAT, the media server wouldn’t be able to directly communicate
with a VM on its private IP address.
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For those of you who want to have their VMs on a private host-only network, then let’s con-
sider a sample configuration. Assume the VM being backed up in Figure 7-1 has an IP address of
192.168.2.11/24. Now consider that the VM’s host system has IP addresses of 192.168.2.1/24 (vir-
tual interface) and 172.16.1.20/24 (production LAN interface). Finally, let’s assume the media
server has an IP address of 172.16.1.19/24. For the backups to work between the VM and media
server, both systems will need to know how to route to each other. With the VM, this should be
easy since you could just assign it the gateway address of 192.168.2.1. However, the media server
may already have a default gateway on the production LAN with no knowledge of your private
host-only network. If this is the case, you can assign a static route to the media server so that it
knows how to reach the VM’s host-only network. For the VM to reach the private network, its
data will need to go through the production LAN interface of the VM'’s host system. So, at this
point, you have all the information needed for creating a static route on the media server, which
includes the following:

¢ Destination network: 192.168.2.0
¢ Subnet mask: 255.255.255.0

* Gateway address: 172.16.1.20

If you need a quick refresher on classless interdomain routing (CIDR) notation, remem-
ber that it's a means to represent a subnet mask as a single decimal value. So, the /24 that
follows each IP address represents the number of consecutive binary 1s in the subnet mask.
Since there are 8 bits in an IP address octet and since there are twenty-four 1s, you have three
sets of eight consecutive 1s. If you convert eight consecutive 1s (1111111) from binary to deci-
mal, you get 255.

Note If you're still craving more information on binary numbering, routing, and TCP/IP subnetting, point
your Web browser to http://www.learntosubnet.com.

With this information now in hand, you can configure static routes on the media server.
You do this using the route add command on either Windows or Linux systems. Here are sam-
ple commands to run if the media server is running on either a Windows box or a Linux box:

* Windows: route add - p 192.168.2.0 mask 255.255.255.0 172.16.1.20

e Linux: route add -net 192.168.2.0 netmask 255.255.255.0 gw 172.16.1.20

With the potential routing issues now behind you, you should have connectivity between
your VM and the media server. If both systems allow ICMP requests, you should be able to run

ping commands to test for the network connectivity between the two systems (for example,
run ping mediaserver from the VM).
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Tip If your backup software’s architecture includes a central management server that initiates and
manages all backup and recovery operations, ensure that network connectivity also exists between each
VM and the management server.

At this point, you should be ready to install backup agents from your backup software
vendor inside the VMs and to perform backups. With this architecture, it’s likely that the LAN
may become a bottleneck for backup data streams. For example, a 100Mb/sec LAN provides
for 12.5MB/sec (100Mb + 8) of bandwidth, which translates to 45GB per hour (12.5MB x 60
seconds x 60 minutes). Although this may seem like a pretty large number, it can be signifi-
cantly reduced if multiple backups are running simultaneously and having to share the
bandwidth of the media server’s network interface. One alternative to solve a network bottle-
neck is to upgrade the network to 1Gb/sec or higher bandwidth. Another alternative is to
configure the VM host system as a media server. We'll cover that option next.

Backing Up to the Host

When VMs are configured to back up directly to the host, no backup data has to traverse the
production LAN. Figure 7-2 illustrates this configuration.

Virtual Machines

Library
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=3 Backup Data

Figure 7-2. Backing up a VM through the VM host
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In this configuration, the VM host is configured as a media server in your existing backup
infrastructure and connects to physical backup devices such as a tape library either through a
SCSI connection or through a storage network. Figure 7-2 shows a library SCSI attached to the
VM host.

This configuration offers fast backups when compared to pushing backup data over a
production LAN, and it may also allow other LAN-based backups to run faster, with VM back-
ups no longer running over the LAN. The only disadvantage to this approach is that you'll
need to connect the VM host to a backup storage device, which may involve purchasing addi-
tional storage resources or reallocating existing resources.

With this type of backup architecture, you should first configure the host system as a
media server in your existing backup network. We prefer to configure the media server first
because the installation of your backup software may require a reboot. Also, you may need
knowledge of the media server installation while installing the backup agent software on the
VMs. Once you have the media server configured, you can then install the backup agent soft-
ware on each virtual machine.

Backing Up Directly to Storage

Neither Virtual PC 2004 nor Virtual Server 2005 supports connecting VMs to storage devices
such as tape drives or libraries either through a SCSI bus attached to the host or through a
SAN. Hard disks are the only device located on a SAN that Virtual Server supports. All other
storage devices can’t be accessed by Virtual Server 2005 VMs. Basically, this means that if
you're hosting VMs using either of the Microsoft virtualization applications, configuring your
VMs to perform network-based backups—either internally to the VM host or over the LAN—
is your best backup option.

VMware Workstation, GSX Server, and ESX Server all support connecting VMs directly
to SCSI or Fibre Channel storage devices, such as tape drives and libraries. You can find more
information on using the Generic SCSI Device hardware resource to create this connection in
Chapter 6.

With support for other storage devices, you can configure a VM to be its own media server
and thus back up directly to a local SCSI or Fibre Channel storage device. Figure 7-3 shows
this configuration.

In backing up directly to a storage device such as a tape drive, you don’t have any network
bandwidth contention, whether on a logical host-only network or over a physical LAN. This
approach offers the best possible performance but requires the additional storage resources
to allocate to the VMs you want to back up. If your backup platform supports dynamic drive
and library sharing in a SAN, then you may find backing up VMs directly to storage on a SAN
to be the perfect solution.
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Figure 7-3. Backing up a VM directly to a storage device

If you're now sold on using your backup software to back up a VM directly to a storage
device, here’s the general procedure to make it all work on VMware GSX Server:

1. Add the storage device to the VM as a generic SCSI device.
2. Start the VM, and make sure it can see the storage device.

3. Install your backup application’s media server software, and configure the storage
device for use with your backup software.

4. Install your backup application’s backup agent software on the VM.
5. Back up the virtual machine.

Although installing and running backup agents on VMs protects their virtual disk files, you
still need to protect each VM’s configuration files. You do this by backing up the host system.
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Running Backup Agents on the Host

Running backups on the host system serves two general purposes:
 Secures each VM’s configuration files

 Secures the host system’s data, drivers, and configuration to prepare for a system failure
or disaster

Caution Running an open file agent such as St. Bernard Software’s Open File Manager on the host
system won’t guarantee reliable backup of open virtual disk files and thus should be used with extreme
caution. You should perform frequent test restores to verify the validity of a virtual disk file backed up via
an open file backup agent.

Caution Windows Server 2003’s Volume Shadow Copy Service doesn’t support online snapshots of
virtual disk files, so this service shouldn’t be used as a method of backing up VMware, Virtual PC, or Virtual
Server virtual disk files.

In terms of setup, installing a backup agent on a VM host is no different from installing an
agent on any other server on your network. With agents securing the data on the VM virtual
disk files, remember that you don’t even need to have your backup agent attempt to back
them up. This means that if your backup agent supports filtering, you can filter out all virtual
disk files from the backup, thus preventing the backup agent from even attempting to back up
avirtual disk file.

If you don't plan to install backup agents on your VMs, another alternative is to power
down the VMs prior to backing up the host. When a VM is powered down, its virtual disk files
are no longer locked by the VM application and thus can be backed up safely. Later in the
“Performing Flat-File Backups” section, you'll look at ways to automate powering down run-
ning VMs so that they can be backed up without needing a backup agent installed on them.

Now that you've seen how to protect VMs using enterprise backup applications, let’s look
at the tools operating systems have available for stand-alone local backups.

Performing Non-Agent-Based Backups

If you're running VMs in a small or home office, purchasing enterprise-class backup software
may not be an option. Instead, you may find that the backup tools included with each VM’s
operating system are well-suited for supporting your backup needs. In this section, you’'ll
examine tools for backing up the two most popular virtualized operating systems: Windows
and Linux.
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These tools support the three most popular backup types:
* Full (normal): Backup of all files on a disk
* Incremental: Backup of all files that have changed since the time of the last backup

* Differential: Backup of all files that have changed since the time of the last full backup

Full backups are the most popular backup method for VMs, as they secure every file on a
virtual hard disk. If you have a small tolerance for data loss, or if you don't have the media to
support daily full backups, you may need to mix incremental or differential backups with the
full backups. One popular approach is to run a full backup every Saturday and run incremen-
tal backups Monday to Friday. This means that if a virtual disk failed, you'd lose no more than
one day’s worth of data. If you need even better protection, you could run a weekly full backup
on Saturday, differential backups daily (Monday to Friday), and incremental backups every
four hours. This means that the most data ever lost would be four hours. The drawback to this
approach, however, is that it would involve running backup jobs (the incrementals) during
business hours, which can slow down server performance during the time of the backup. In
this approach, you'd need to restore that last full backup, the last differential backup, and
every incremental backup that occurred after the time of the last differential. Since a differen-
tial backup copies all files that have changed since the time of the last full backup, any earlier
(prior to the time of the last differential) differential or incremental backups wouldn’t be
needed for recovery.

With backup strategy, there really is no single answer. You have to decide on your organi-
zation’s tolerance for data loss and use that as a baseline to determine the frequency and types
of backups to run on your VMs.

With a baseline for backup strategy under your belt, you'll now learn how to use Windows
Backup to secure data.

Caution If you're using a local tool to back up your VMs or host system, use extreme caution when stor-
ing backup data in a single file on the host system. If the host system’s hard disks are corrupt or become
damaged, you’ll lose not only your original data but your backup as well! A best practice when backing up to
afile is to store the backup file on another server by specifying either a UNC path or a network file system
(NFS) mount point as the location for the backup file.

Using Windows Backup

Windows Backup (formerly called NT Backup), shown in Figure 7-4, is a tool that has been
included with the Windows operating systems as far back as Windows NT. You can run this
tool as either a GUI application or a command-line utility; it supports backing up data to
removable media devices such as tapes or to a single file on a hard disk. This flexibility gives
you plenty of options when backing up VMs.
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Figure 7-4. Windows Backup

Note The procedures outlined in this section are for a Windows Server 2003 virtual machine. The proce-

dures for other Windows operating systems will be similar but may not be exactly the same.

To perform a backup with Windows Backup, follow these steps:

1. To open Windows Backup, click Start » All Programs » Accessories » System Tools »

Backup.

2. If the tool opens in wizard mode, you'll need to answer a series of questions to start the
backup. If the tool doesn’t open in wizard mode, proceed to step 3.

3. Once the tool opens, click the Backup tab.

4. Next, select the disks (or specific data) to back up. You do this by checking the box that

corresponds to the data to be backed up. You'll see that the GUI behaves similarly to

Windows Explorer.




5.

6.

7.
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Now browse to or enter a destination for the backup data in the Backup Media or File
Name field.

When you're satisfied with your selections, click the Start Backup button.

To begin the backup, verify that all your selections are accurate in the Backup Job
Information dialog box, and then click the Start Backup button. If you want the backup
job to run at a later time or on a recurring basis, you can click the Schedule button at
this time to schedule when the job should run.

Tip To back up all the data on a virtual machine, in wizard mode you’d select the Back Up Everything
on This Computer option. If the tool starts in standard mode, click the Backup tab and then select the My
Computer check box. At a minimum, you should always back up all pertinent data drives, the boot drive,
and the system drive, as well as the system state.

With the default options selected, Windows Backup will always perform a full backup. If
you want to perform either an incremental or a differential backup, in step 7 you'd need to
click the Advanced button in the Backup Job Information dialog box and then select the
appropriate backup type in the Backup Type drop-down menu.

You can use the same tool to restore data by following these steps:

1.

Open Windows Backup by clicking Start » All Programs » Accessories » System Tools
» Backup.

If the tool opens in wizard mode, you'll need to answer a series of questions to start the
restore. If the tool doesn’'t open in wizard mode, proceed to step 3.

Once the tool opens, click the Restore and Manage Media tab.

Next, expand the appropriate media item (such as a file or tape), and select the data to
restore (see Figure 7-5).

Now click the Start Restore button.

In the Confirm Restore dialog box, click OK. The restore job should run and complete.
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Figure 7-5. Selecting data to restore using Windows Backup

At this point, you have the general procedures to use Windows Backup to back up and
recover data stored on VMs. Keep in mind that you can still use two of the architectures men-
tioned in the previous section as methods for saving backup data. For example, you could
store backup data in a file saved on a mapped network drive located on another physical
server on the network. This will allow you to get your VM’s backup data off the VM host. Since
one of the primary purposes of backing up data is to protect against system failure, it’'s never
a good idea to store a VM’s backup data on its host system.

One other alternative with Windows Backup is to add a generic SCSI storage device to
your VM (VMware only) and back up the VM directly to the storage device. In this scenario,
you’ll need to carefully manage backup media to ensure that the host system doesn’t try to
use the same tapes being used by a VM. Otherwise, one system may overwrite backup data
generated by another system.

Now that you've seen the possibilities with Windows Backup, next you'll look at using dump
and tar to back up Linux volumes. If you're interested in running Windows Backup from the
command line, you can refer to the “Performing Flat-File Backups” section later in this chapter.

Backing Up Linux File Systems

The dump command has been around practically forever, dating back to early Unix operating
systems (beginning with AT&T Unix version 6). This command allows you to perform full and
incremental backups to a local storage device or volume or to a remote mount point. tar is
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another popular tool that can package files and folders for transferring over a network and for
performing backups. In the following sections, we’ll cover how to back up your Linux VMs
using either dump or tar. Also, you'll see how to use the cron daemon to create an automated
backup schedule for your Linux VMs. Let’s get started by looking at dump.

Backing Up with dump
Listing 7-1 is a shell script that uses dump to perform a full backup of a VM named W2KFS1.

Listing 7-1. Backing Up with dump

#!/bin/sh

#

# Filename: LinuxVmDumpBackup.sh

# Purpose: Uses dump to back up a VM to Tape Drive 0. This script performs
# a full backup of a VM's hard disks.

#=======================================================================
# ==== Assign variables ====
DriveToBackup="/dev/hda2" # Name of drive to back up

BackupDestination="/dev/nrft0" # tape drive 0, tape not rewound after bu

# ==== Run the backup=====
/sbin/dump ouf $BackupDestination $DriveToBackup

In the script, the DriveToBackup variable identifies the drives to be backed up, and the
BackupDestination variable defines the target backup device. This script will perform full
backups of a virtual machine. You can refine this script to perform incremental backups fol-
lowing a full backup by changing the dump level specified in the dump command. A level of 0
indicates a full backup. The values 1 to 9 in the command sequence indicate incremental lev-
els. For example, the following are the script modifications necessary to run a full backup on
Sunday and incremental backups from Monday to Friday:

* Sunday full: /sbin/dump Ouf $BackupDestination $DriveToBackup

* Monday incremental: /sbin/dump 1uf $BackupDestination $DriveToBackup

* Tuesday incremental: /sbin/dump 2uf $BackupDestination $DriveToBackup

* Wednesday incremental: /sbin/dump 3uf $BackupDestination $DriveToBackup

e Thursday incremental: /sbin/dump 4uf $BackupDestination $DriveToBackup

* Friday incremental: /sbin/dump 5uf $BackupDestination $DriveToBackup

With this approach, you'd have six versions of the script with the only difference in each
version being a single line in the script. After the Friday backup completes, you'd want to
insert a new tape in the drive to be used by the next backup cycle, starting on Sunday.

To restore data backed up with dump, you need to use the restore command. To perform a
complete restore of all data on a tape, use the following syntax:

restore rf <backup device>
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Following the earlier example, run this command:
restore rf /dev/nrfto

Another popular method of using restore is to run the command in interactive mode. To
run a restore in interactive mode, you use this syntax:

restore if <backup device>

In the previous backup example, you'd run restore if /dev/nrfto to start the interactive
restore.

Using this approach, the command will show you an index of data backed up on a tape
and allow you to select the files and folders you want to restore. When looking to restore just
a few files or folders, this method is popular. Let’s look at an example of an interactive-mode
restore. Assume you need to restore a file named contactinfo.doc from the /data/marketing
folder. Prior to running the restore operation, first navigate to the directory in which you want
the files restored to; in this example, you'd run cd /data/marketing. Next, insert the tape that
contains the data to be restored into the tape drive. Finally, run the following commands to
recover the file:

#restore if /dev/nrfto
restore >ls

data/ misc/

restore >cd data

restore >ls

./data:

marketing/ /sales /service /support
restore >cd marketing

restore >ls

./marketing:

brochure.doc contactinfo.doc suggestionlist.doc
restore >add contactinfo.doc

restore >ls

./marketing:

brochure.doc *contactinfo.doc suggestionlist.doc
restore >extract

Notice that after you add the contactinfo.doc file to the recovery list using the add com-
mand, you ran the 1s command in the marketing folder, and the selected file (contactinfo.doc)
was preceded with an asterisk (*). This indicates the file has been selected for recovery. Once
you run the extract command, all files selected for recovery will be restored at that time.

While dump has been a popular backup tool, tar has significantly grown in popularity,
primarily because of its reliability, ease of use, and flexibility. Next, we’ll cover how to use tar
to protect your VMs.

Backing Up with tar

tar is another popular tool for backing up data. With tar, you can back up a VM’s contents
into a single file. Listing 7-2 shows a script that uses tar to back up aVM’s root directory and
associated subdirectories to an NFS mount point.
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Listing 7-2. Backing Up with tar

#!/bin/sh

#

# Filename: LinuxVmTarBackup.sh

# Purpose: Uses tar to back up a VM to an NFS mount point. This script performs
# a full backup of the root directory and filters out /tmp, /proc, and /mnt.

# ==== Assign variables =
VMName="FS1" # Name of VM to back up

Today=$(date +'%m-%d-%y") #Loads current date as mm-dd-yyyy into variable
DirToBackup="/" #Specifies to back up root.
NfsPath="mediasrv1:/data/Backup" #Specifies NfsPath to back up to

#Name of backup file. Includes date stamp.
BackupDestination="/mnt/backup/"$VmName"-"$Today".tar"

#Name and location of backup log file
BackupLog="/mnt/backup/"$VmName"-Backup_Log "$Today".log"

#Directories to exclude from backup

Excludelist="--exclude /proc --exclude /mnt --exclude /tmp"

#==== Mount backup folder ====

mount -t nfs $NfsPath /mnt/backup

=+
< |

# ==== Run the backup=====
tar -cpvf $BackupDestination $DirToBackup $Excludelist >&$BackupLog

#==== Unmount backup folder ====
umount /mnt/backup

In this script, you back up the root (/) folder while excluding the /tmp, /proc, and /mnt
folders. The NFS mount point is mounted to /mnt/backup. This folder must be created before
the script runs for the first time. The output backup file that’s created will include information
on the VM’s name as well as the date that the backup was performed. This is useful if you
intend to back up several VMs to the same location. In the sample LinuxVmTarBackup.sh
script, if the backup was executed on December 20, 2004, the output file would be named
FS1-12-20-2004.tar. The backup’s associated log file would be named FS1-Backup_Log
12-20-2004.1og.

To restore a tar backup file, you use the extract (x) option in place of the c option. For
example, to extract a tar backup archive back to the root (/) directory, you run the following
command:

tar xpvf /mnt/backup/FS1-12-20-2004.tar --overwrite

This command extracts the FS1-12-20-2004.tar archive to the root folder. The
--overwrite option causes the tar command to overwrite like files during the restore
operation.

Now that you've looked at both tar-based and dump-based backups and restores, we’ll
cover how to automate the backup process with cron.
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Note Another excellent free Linux backup tool is the Advanced Maryland Backup Disk Archiver (AMANDA),
which automates network-based backups of Linux hosts to a central media server. This is similar to the
approach for backing up using backup agents. You can download a free copy of AMANDA and read more
about this excellent product at http: //www.amanda.org. In Chapter 14, we’ll show you an example of
using AMANDA to configure backups to run across several systems.

Automating Backups with cron

By using the cron daemon, you can automate the execution of scripted backups. This gives
you the ability to set up your backup schedule and let it take care of itself. Jobs executed by
cron are stored in the /etc/crontab file. By default, the file contains the following lines:

SHELL=/bin/bash
PATH=/sbin:/bin/:/usr/sbin:/usr/bin
MAILTO=ro0t

HOME=/

# run-parts

01 * * * * root run-parts /etc/cron.hourly
02 4 * * * root run-parts /etc/cron.daily
22 4 * * 0 root run-parts /etc/cron.weekly
42 4 1 * * root run-parts /etc/cron.monthly

In this file, the purpose of the first four lines is to declare variables that establish cron’s
working environment. The run-parts section is where you can schedule tasks to run. By
default, hourly, daily, weekly, and monthly tasks are already configured. Any scripts stored
in the /etc/cron.hourly folder will run on the first minute of each hour, and scripts in the
/etc/cron.daily folder run each day at 4:02 a.m., by default. Using these folders gives you an
easy means to have several scripts execute simultaneously with a single line of code in the
crontab file. To understand how the time and date settings are configured, let’s examine the
crontab file format illustrated in Figure 7-6.

* * * % *  Geriptto Run

T A
Minute (0-59)

Hour (0-23)

Day of Month (1-31)
Month (1-12)

Day of Week (1-7)
Shell Script Name

Figure 7-6. crontab file text format
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The first five positions (separated by spaces) in a line of the crontab file specify the day
and time to run the script, and the sixth position indicates the script to be executed. The *
wildcard can represent all instances of a value. So, if you wanted a backup script job to run at
1 a.m. every day, you'd use the values 0 01 * * * With the day of the week parameter, the
value 1 represents the first day of the work week, which is Monday. Sunday equals 7.

Now let’s consider the required line in the crontab file that’s needed to execute the
LinuxVmTarBackup.sh script. To perform this task every Friday night at 11 p.m., you'd add
this line:

0 11 * * 5 /root/scripts/LinuxVmTarBackup.sh

Think you've got it now? Take a look at the last default line in the crontab file shown earlier.
When do the scripts located in the /etc/cron.monthly folder run? If you want to test yourself,
don’t read the next sentence until you have an answer! Okay, if you came up with the first day of
each month at 4:42 a.m., you're correct!

As you can see, cron can be invaluable in automating the backups of your VMs.

Tip cron is a powerful tool, and in this section we merely scratched the surface of its capabilities. For more
information on cron, point your Web browser to http://www.redhat.com/docs/manuals/enterprise to
download the Red Hat Enterprise Linux System Administration Guide.

Performing Flat-File Backups

If you don't plan to install backup agents on your VMs and don't plan to run local independent
backups on each VM, then performing flat-file backups is your best alternative. The technique
of flat-file backups originated as a way to back up databases without having to use a backup
agent. When a flat-file backup is performed on a database, the database first shuts down (is
taken to an offline state), and then its related files are backed up. Shutting down the database
prior to backup guarantees that you'll be able to back up all the data contained within the
database’s related files. When a database is online, the database application locks the data-
base’s related files so that normal backups aren’t possible. The only reliable way to back up
an online database is by using a backup agent that’s supported by the database application.
So, if you relate a VM’s disk and configuration files to a database’s data and log files, you
have the same problem with backups as you would with databases. You can't just run a backup
of the host system and expect to reliably back up running VMs. Not only does each VM appli-
cation lock virtual machine files while VMs are running but also the VMs use physical memory
as a buffer for writes to virtual disk files. This means that not all the data that a VM thinks is
inside a virtual disk is actually in the virtual disk file on the host. So, backing up a virtual disk
file while aVM is running could mean that you're backing up a corrupted disk, which will be
useless when you attempt a restore.
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Now that you've seen why you shouldn't try to back up a running VM directly from the
host, let’s look at the procedure for running a flat-file backup. To perform this backup, you
must follow three general steps:

1. Shut down the VM.
2. Back up the VM’s related files.
3. Startup the VM.

Normally, all VM files reside in a single folder, so backing up the offline VM should include
simply making a copy of aVM’s folder.

Caution If aVM is configured to map one of its hard disks to a physical disk on the host system, you
must be sure to include the disk in the VM’s backup definition. For example, if a VM’s configuration and a
single virtual disk file are stored in the E: \VMs\NT4Srv folder but the VM also maps a disk to the host’s
F drive, you must back up the F drive on the host as well as the E: \VMs\NT4Sxv folder when the backup
job runs.

If you're running VMs in production, it’s likely you'll want the VM to be offline for as little
time as possible. With this in mind, the easiest way to automate a VM shutdown, backup, and
startup is by using a script. In the following sections, we’ll cover how to script flat-file backups
of the following VM configurations:

* VMware Workstation on Windows

* VMware Workstation on Linux

* VMware GSX Server on Windows

* VMware GSX Server on Linux

* Microsoft Virtual PC 2004

* Microsoft Virtual Server 2005

Each section details scripts for automating the backup process, so you can just turn to the

section that’s right for you, depending on the virtual machine applications in your environ-
ment. We'll start by looking at scripting flat-file backup jobs for VMware Workstation.

Tip If you want to schedule Windows batch scripts to run on a recurring basis, you can do so using the
Scheduled Tasks system tool. This tool allows you to select a schedule pattern in which to run a job and
also gives you the ability to supply user credentials under which to execute the job. This prevents you from
having to code the user credentials inside the script.
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Running VMware Workstation Flat-File Backups

Workstation VMs lock their configuration file while a VM is open, so to fully back up a VMware
VM, you must not only power down the VM but also close the specific VM you plan to back up.
Lucky for you, VMware Workstation provides an easy method for automating this. To configure
aVM to automatically close once it’s powered down, perform the following steps:

1. In the Workstation U], click the VM you plan to back up. Then click the VM menu, and
select Settings.

2. In the Virtual Machine Settings dialog box, click the Options tab.

3. Under the Options tab, click the Power setting, and then check the Close After Power-
ing Off or Suspending box (see Figure 7-7).

4. Click OK to close the Virtual Machine Settings dialog box.

X

Virtual Machine Settings

Hardware | Options |

| Settings Summary Fower options

| Bl Gereral W2k Pra : [ Powser on after opening this virtual machine
. D Power [ Enter full screen mode after powering on

| 2 Shared Folders Enabled | Close after powering off or suspending

| | & Snapshot |

[ B Guest isolation Drag and drop enabled Fower Controls

d M 1M I e —
| . Advance ormal/Marma Power D =]
00 SuspendVirtual Machine
[ Poweron / Resume Yirtual Machine
@ Heset S v

Run Wkware Tools scripts

[] &vfter poweering on

[] &sfter resuming

[] Betare suzpending
[] Eefore powering off

T T

Figure 7-7. Selecting for the VM to automatically close when powered down

In the next sections, we'll begin by looking at backing up Workstation VMs running on
Windows operating systems and finish with a look at backing up Workstation running on
Linux.
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Running VMware Workstation on Windows Flat-File Backups

One of the easiest methods to script backup jobs on Windows operating systems is using
tried-and-true batch scripting. We've selected this method for the examples in this book
because of its ease of use and overall adoption in the field. Since many of the administrators
we encounter run both Windows and Linux operating systems inside VMs, we'll provide exam-
ples of scripting flat-file backups for both operating systems. In each example, backups are
executed using the ntbackup.exe command-line utility. Both of the batch files covered use a
core set of variables to establish a source and destination for the backup. For your own use,
you need to change the variables to suit your specific environment. Here’s a quick overview of
each of the variables that will be used:

e VMName: Host name of VM to be backed up

* VMFolder: Location of VM’s files on the host system

e VMXPath: Full path to VM’s configuration file

* Today: Current date formatted as mm-dd-yyyy (used to date stamp backup files)

* BackupFolder: Backup data destination folder (create this folder prior to running
backup)

* BackupkFile: Filename of backup job (stamped with current date)
* JobName: Friendly name for job (stored in backup file)

* Description: Description of job (stored in backup file)

With the variables now under your belt, let’s look at backing up a Windows VM running on
aWindows host.

Backing Up aWindows VM

Listing 7-3 shows a batch file that can be used to automatically shut down a Windows virtual
machine, back up its files, and then start it up.

Listing 7-3. Backing Up a Windows VM on a Windows Host

:: Filename: WinVMWSWinBackup.bat

: Purpose: Automates the backup of a virtual machine by shutting down the VM,
:: using ntbackup.exe to back up the VM's files, and then automatically starting
:: back up the VM. This script backs up a VM named W2KFS, which is located in
:: the E:\VMs\W2KAS folder. You would need to alter the VM name and paths for
:: this script to run in your environment.

:: Set Variables
set VMName=W2KFS
set VMFolder= E:\VMs\W2KAS
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set VMXPath= E:\VMs\W2KAS\W2KFS.vmx

set Today=%Date:~4,2%-%Date:~7,2%-%Date:~10,4%
set BackupFolder=G:\Backup\%VMName%

set BackupFile=%BackupFolder%\%Today%.bkf

set JobName=%Today% Full Backup

set Description=Starting %Today%

11 Stop WM Using shutdown.exe (requires UNC path to VM)
12 On W2K and earlier hosts, shutdown.exe requires installation of the resource kit
shutdown.exe /m \\%VMName% /s /t 0

11 Wait for WM to shut down (uses ping -n <seconds> to the loopback address
:: to create a delay)180 seconds = 3 minute delay.
ping -n 180 127.0.0.1 > nul

:: Back up WM
IF NOT EXIST %BackupFolder% md %BackupFolder%
ntbackup backup "%VMFolder%" /J "%JobName%" /D "%Description®" /F "%BackupFile%"

11 Start VM (path to VMware.exe file must be specified)
"D:\Program Files\VMware\VMware Workstation\VMware.exe" -x "%VMXPath%"

In this example, a VM is backed up to a local drive on the system. If you wanted to back
up the VM to a UNC path, you'd need to change the BackupFolder variable. For example, to
direct backup data to the \\Max\Backups share, you edit the BackupFolder variable line so that
it reads set BackupFolder=\\Max\Backups\%VMNameZ%.

Notice that the ping command is used in the script for the purpose of creating a delay.
The —n parameter for the ping command specifies the number of echo requests to send. Each
echo request will take approximately one second, so using this command gives you a simple
means to insert a delay into the script. An alternative to using ping is to use the Sleep.exe
resource kit tool.

After the VM shuts down and the batch script waits the allotted time, the ntbackup.exe
command executes to back up the VM. Control isn't returned to the batch file until ntbackup.exe
completes the backup job, so there’s no need to insert a delay into the batch file following the
ntbackup.exe command. The last line of the batch file uses the VMware.exe command to start
the VM. You'll see almost identical logic in the next script, which will perform a flat-file backup
of a Linux VM.

Backing Up a Linux VM

The toughest aspect of scripting a Linux VM flat-file backup on a Windows host is having to
gracefully shut down the VM prior to backup. To do this, you must send a remote shutdown
command to the Linux VM. To do this securely, we decided to use one of the many available
secure shell (ssh) tools available for Windows operating systems.

We selected the PenguiNet shareware software to perform the remote ssh connection
and shutdown command. You can download this tool from http://www.download.com. With
PenguiNet, you can create a profile that includes all the ssh connection settings and com-
mands to run during the ssh connection. This allows you to fully script a remote shutdown in
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a batch file without having to include any confidential information in the batch file. For exam-
ple, the username, password, system name to connect to, and commands to run are all
embedded in the profile.

In PenguilNet, you can create connection profiles using the connection profiles toolbar in the
PenguiNet GUL Figure 7-8 shows the connection profile used in our WinVMWSLinuxBackup.bat file.
When you click the Send Commands button in the Connection Profiles dialog box, you can enter
commands to automatically run once the session is established. Figure 7-9 shows these settings.

&' Connection profiles - PenguiMet

§ Default Login | ssH | Appearance | Sound | nput | options |
Q- Shutdawn

-:-;'J_é Profile name |Shutd0Wﬂ |

Host |192.168.0,30 |

Terminal bype [Jutrs

Username |rnc-t |

Password |"‘******* |

|:| Confirm on connection

Send commands. ..

[ § dd ][ E-4 clone ] [ B Delete ]
[3.2 Connect ] ﬂiCP ] [ Close ] [ Cancel

Figure 7-8. PenguiNet shutdown profile settings

& Send commands - PenguiNet

wWaik faor. ., ..khen send Add
[roobt@FS1 rook]# shutdown -k 0
Edit
Remove

ke l=>

[ O ] [ Cancel ]

Figure 7-9. PenguiNet shutdown profile Send Commands settings
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Once you've created the profile, you must turn the profile into a shortcut so the batch
file can use it. You can create a shortcut to the profile by simply dragging the profile from the
PenguiNet GUI and dropping it into any folder in Windows Explorer. Once this is done, you
can use the command referenced by the profile shortcut in the batch file. Listing 7-4 shows a
batch file that remotely shuts down a Linux VM, backs it up, and then restarts the VM.

Listing 7-4. Backing Up a Linux VM on a Windows Host

:: Filename: WinVMWSLinuxBackup.bat

:: Purpose: Automates the backup of a Linux virtual machine by shutting down

:: the VM, using ntbackup.exe to back up the VM's files, and then automatically
:: starting back up the VM. This script backs up a VM named LinuxFS1, which is
:: located in the E:\VMs\LinuxFS1 folder. You would need to alter the VM name
:: and paths for this script to run in your environment.

:: Set Variables

set VMName=LinuxFS1

set VMFolder=E:\VMs\LinuxFS1

set VMXPath=E:\VMs\LinuxFS1\LinuxFS1.vmx

set Today=%Date:~4,2%-%Date:~7,2%-%Date:~10,4%
set BackupFolder=G:\Backup\%VMName%

set BackupFile=%BackupFolder%\%Today%.bkf

set JobName=%Today% Full Backup

set Description=Starting %Today%

: Stop WM Using PenguiNet.exe to issue shutdown command
"D:\Program Files\PenguiNet\PenguiNet.exe" profnum://4278190084

::Wait for VM to shut down (uses ping -n <seconds> to the loopback address
11 to create a delay) 180 seconds = 3 minute delay.
ping -n 180 127.0.0.1 > nul

:: Back up WM
IF NOT EXIST %BackupFolder% md %BackupFolder%
ntbackup backup "%VMFolder%" /J "%JobName%" /D "%Description%" /F "%BackupFile%"

:: Start WM (path to VMware.exe file must be specified)
"D:\Program Files\VMware\VMware Workstation\VMware.exe" -x "%VMXPath%"

As you can see, this batch script is almost identical to the Windows VM backup script. The
primary difference with this script is the methodology used to remotely shut down the Linux
VM. Since the Windows shutdown.exe command couldn’t be directly run against the Linux VM,
we launched PenguiNet to run a remote shutdown command via an ssh connection. Next,
we’ll cover backing up VMs running on a Linux host system.
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Running VMware Workstation on Linux Flat-File Backups

In this section, we show how to use shell scripts to automate the backups of VMs running on a
Linux host running VMware Workstation. As with the previous section, this script will shut
down the VM, back it up, and then restart the VM.

Here’s a quick overview of each of the variables that will be used:

e VMName: Host name of VM to be backed up

* Today: Current date formatted as mm-dd-yyyy (used to date stamp backup files)

* DirToBackup: Location of virtual machine’s files on the host system

e VMXPath: Full path to VM’s configuration file

» NfsPath: Backup data destination folder (create this folder prior to running backup)

e BackupDestination: Path and filename of backup job (stamped with current date)

* BackupLog: Name and location of tar backup log file

Listing 7-5 shows the shell script that will shut down a Windows VM, back it up to an NFS
mount point using tar, and then restart the VM. The shutdown command is issued via a remote
ssh connection from the host to the VM. Since Windows doesn’t natively support ssh, you’ll

need to install it on the Windows VM. Since ssh is natively supported by Linux, this script can
also be used to back up a Linux VM running on a Linux host.

Tip You can download the free OpenSSH ssh server application for Windows at
http://sshwindows.sourceforge.net. OpenSSH is also packaged for Windows Services
for Unix and can be downloaded at http://www.interopsystems.com.

Listing 7-5. Backing Up a Windows VM on a Linux Host
#!/bin/sh
# Filename: LinuxVmWSBackup.sh

# Purpose: Uses ssh and shutdown.exe to remotely shut down a Windows VM. Then uses
# tar to back up the VM. When the backup completes, the VM is restarted.

# ==== Assign variables ====

VMName="W2KFS1" # Name of VM to back up

Today=$(date +'%m-%d-%y") #loads current date as mm-dd-yyyy into variable
DirToBackup="/data/vms/W2KFS1" #Specifies to back up W2KFS1 folder
VMXPath="/data/vms/W2KFS1/W2KFS1.vmx"

NfsPath="mediasrv1:/data/Backup" #Specifies NfsPath to back up to

#Name of backup file. Includes date stamp.
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BackupDestination="/mnt/backup/"$VmName"-"$Today".tar"
#Name and location of backup log file
BackupLog="/mnt/backup/"$VmName"-Backup_Log "$Today".log"
#==== Shutdown VM ====

ssh $VMName shutdown -h 0

#==== Mount backup folder ====
mount -t nfs $NfsPath /mnt/backup

# ==== Run the backup=====
tar -cpvf $BackupDestination $DirToBackup >&$Backuplog

#==== Unmount backup folder ====
umount /mnt/backup

#==== Restart WM ====
/usr/bin/vmware.exe -x $VMXPath

You may have noticed that this script is similar to the one used in the “Backing Up with
tar” section of this chapter. The primary differences with the script are the lines added to shut
down and start the VM. To stop the VM, an ssh connection is established to issue the shutdown
command. To restart the VM, the vmware.exe command-line tool is used. The -x parameter
starts the VM specified in the $VMXPath variable.

Now that we've covered VMware workstation backups, we’ll cover VMware GSX Server.

Running VMware GSX Server Flat-File Backups

VMware GSX Server products, being built for production, offer much more to aid in backing up
your VMs. To begin with, GSX Server allows you to configure VMs to gracefully shut down when
they’re stopped. All that’s required is to install the latest version of VMware Tools in the VM and
to configure the VM to shut down the guest when powering down. To configure the VM power-
off settings, you need to perform these steps prior to running any scripted backups:

1. In the VMware Virtual Machine Console U], click the VM you plan to back up. Then
click the VM menu, and select Settings.

2. In the Virtual Machine Settings dialog box, click the Options tab.

3. Under the Options tab, click the Shutdown drop-down menu, and select the Shut
Down Guest power-off option. Then check the Close After Powering Off or Suspending
box. Figure 7-10 shows both of these settings.

4. Click OK to close the Virtual Machine Settings dialog box.
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Virtual Machine Settings

Hardware | Options

Startup/Shut...
Advanced

Settings Surnmary

B General w2k IFS-Backup

[> Pawer Ewit after power off/suspend
B Snapshot

3 Permissions

rarmalMarmal

FPower options
] Pawer an after apening this virtual machine
[ Entes full screen mode after powering an

Cloze after powering off or suzpending

Power Contrals
Shut Down Guest ~
00 SuspendVirtual Machine

[> Power on / Resume Yirtual Machine

@ Restart Guest A

Run %Mware Toolz scripts
[ after powering on

[] atter resuming

[ Before suspending

[ Before powering off

0K H Cancel H Help

Figure 7-10. Selecting GSX VM power-down options

Notice that the previous steps also had you configure the VM to close when powered
down. This is required to unlock all VM files so that they can be backed up. Once the VM
options are set, all that’s left is to put together a script to automate its backup. In the next

two sections, you'll see how to script backups on both Windows and Linux hosts.

Running VMware GSX on Windows Flat-File Backups

Since GSX Server can gracefully shut down either aWindows VM or a Linux VM with a single
command, there’s no difference between scripting a backup for either. Prior to looking at the

backup script, let’s first examine the purpose of each variable that’s used:

e VMName: Host name of VM to be backed up

backup)

VMFolder: Location of virtual machine’s files on the host system
VMXPath: Full path to VM'’s configuration file
Today: Current date formatted as mm-dd-yyyy (used to date stamp backup files)

BackupFolder: Backup data destination folder (create this folder prior to running

* BackupFile: Filename of backup job (stamped with current date)

* JobName: Friendly name for job (stored in backup file)

* Description: Description of job (stored in backup file)
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The script uses the VMware-cmd. exe tool, which is located by default in the Program Files\
VMware\VMware VmPerl Scripting API folder on the host system. The syntax of VMware-cmd
used in this section’s script is as follows:

VMware-cmd <path to vmx file> <start | stop>

As you can see, the syntax is relatively simple. Following the command, you need to spec-
ify the path to the VM’s configuration file and then use the start or stop parameter. Now that
you've examined the unique aspects of this script, refer to the script itself (see Listing 7-6).

Listing 7-6. Backing Up a VM on a Windows GSX Server Host

:: Filename: WinVMGSXBackup.bat

: Purpose: Automates the backup of a virtual machine by shutting down the VM,
:: using ntbackup.exe to back up the VM's files, and then automatically starting
:: back up the VM. This script backs up a VM named W2KFS, which is located
:: in the E:\VMs\W2KAS folder. You would need to alter the VM name and paths
:: for this script to run in your environment.

:: Set Variables

set VMName=W2KFS

set VMFolder= E:\VMs\W2KAS

set VMXPath= E:\VMs\W2KAS\W2KFS.vmx

set Today=%Date:~4,2%-%Date:~7,2%-%Date:~10,4%
set BackupFolder=G:\Backup\%VMName%

set BackupFile=%BackupFolder#\%Today%.bkf

set JobName=%Today% Full Backup

set Description=Starting %Today%

:: Stop WM Using VMware-cmd
"D:\Program Files\VMware\VMware VmPerl Scripting API\VMware-cmd" %VMXPath% stop

::Wait for VM to shut down (uses ping -n <seconds> to the loopback address
11 to create a delay) 180 seconds = 3 minute delay.
ping -n 180 127.0.0.1 > nul

: Back up WM
IF NOT EXIST %BackupFolder% md %BackupFolder’%
ntbackup backup "%VMFolder%" /3 "%JobName%" /D "%Descriptionk" /F "%BackupFile%"

:: Start VM Using VMware-cmd
"D:\Program Files\VMware\VMware VmPerl Scripting API\VMware-cmd" %VMXPath% start

Compared to VMware Workstation, scripted flat-file backups are much simpler with GSX
Server. The same holds true for GSX Server running on a Linux host, which you'll look at next.
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Running VMware GSX on Linux Flat-File Backups
Scripting GSX Server flat-file backups on Linux hosts is almost identical in theory to Windows
hosts. In fact, both use the vmware-cmd. exe tool to facilitate the backup. The only major differ-
ence is in the tool used to back up the data itself (tar with Linux and ntbackup with Windows).
Before getting to the script itself, we'll briefly define its variables:

e VMName: Host name of VM to be backed up

* Today: Current date formatted as mm-dd-yyyy (used to date stamp backup files)

* DirToBackup: Location of virtual machine’s files on the host system

e VMXPath: Full path to VM’s configuration file

* NfsPath: Backup data destination folder (create this folder prior to running backup)

e BackupDestination: Path and filename of backup job (stamped with current date)

* BackupLog: Name and location of tar backup log file

This section uses the vmware-cmd tool to stop the VM prior to backing up and restarting the
VM once the backup completes. Its syntax is identical to the Windows version of the tool. So,
for example, to stop a VM named Maill, you'd run vmware-cmd /data/VMs/W2KMail1/maill.vmx
stop. Aside from this command, you should see that the format and syntax of this script,
shown in Listing 7-7, resembles that of the tar backup script presented earlier in the chapter
in Listing 7-5.

Listing 7-7. Backing Up a VM on a Linux GSX Server Host
#!/bin/sh
# Filename: LinuxVmGSXBackup.sh

# Purpose: Uses vmware-cmd to remotely shut down a Windows VM. Then uses tar
# to back up the VM. When the backup completes, the VM is restarted.

# ==== Assign variables ====

VMName="W2KFS1" # Name of VM to back up

Today=$(date +'%m-%d-%y") #Loads current date as mm-dd-yyyy into variable
DirToBackup="/data/vms/W2KFS1" #Specifies to back up W2KFS1 folder
VMXPath="/data/vms/W2KFS1/W2KFS1.vmx"

NfsPath="mediasrv1:/data/Backup" #Specifies NfsPath to back up to

#Name of backup file. Includes date stamp.
BackupDestination="/mnt/backup/"$VmName"-"$Today".tar"
#Name and location of backup log file
BackupLog="/mnt/backup/"$VmName" -Backup_Log “$Today".log
#==== Shutdown VM ====

vmware-cmd $VMXPath stop

»

#==== Mount backup folder ====
mount -t nfs $NfsPath /mnt/backup

# ==== Run the backup=====
tar -cpvf $BackupDestination $DirToBackup >&$BackuplLog
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#==== Unmount backup folder ====
umount /mnt/backup

#==== Startup WM ====
vmware-cmd $VMXPath start

Now that you've tackled flat-file backups of the most popular VMware products, next
you'll explore scripted flat-file backups for the Microsoft VM applications.

Running Virtual PC 2004 Flat-File Backups

Although Virtual PC supports the command-line startup of VMs, it doesn’t support command-
line VM shutdowns. Because of this, performing flat-file backups of Virtual PC VMs requires a
little creativity. Since Virtual PC officially supports only Microsoft OS VMs, in this section we’ll
cover a batch script that will shut down a Windows VM, perform a backup, and then restart
the VM.

In the batch script we put together to back up Virtual PCVMs, we use shutdown.exe to
remotely shut down the VM and then use taskkill.exe to close the Virtual PC application.
This is needed because Virtual PC will hold a lock on its VM’s files while the application is still
running (regardless of the state of its VMs). After shutting down the VM and closing Virtual PC,
the script then uses the ntbackup.exe command-line tool to back up the VM. When the backup
completes, the Virtual PC.exe command-line tool restarts the VM. A few variables are used in
the script:

* VMName: Host name of VM to be backed up

* VMFolder: Location of VM configuration and virtual disk files

* Today: Current date formatted as mm-dd-yyyy (used to date stamp backup files)

» BackupFolder: Target location for backup

» BackupFile: Name of backup file (includes path loaded into BackupFolder variable)
* JobName: Friendly name of backup job, referenced by NTBackup.exe

* Description: Describes backup, referenced by NTBackup.exe
Now let’s look at the actual script (see Listing 7-8).

Listing 7-8. Backing Up a VM on a Virtual PC Host
:: Filename: VPCWinBackup.bat

:: Purpose: Automates the backup of a Virtual PC 2004 virtual machine by shutting
:: down the VM, closing the Virtual PC application, using ntbackup.exe to back up
:: the VWM's files, and then automatically starting back up the VM. This script

:: backs up a VM named W2KWeb, which is located in the E:\VMs\W2KWeb folder.

:: You would need to alter the VM name and paths for this script to run in your
:: environment.
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@echo off

:: Set Variables

set VMName=W2KWeb

set VMFolder= E:\VMs\W2KWeb

set Today=%Date:~4,2%-%Date:~7,2%-%Date:~10,4%
set BackupFolder=\\Dempsey\Backups\%VMName%
set BackupFile=%BackupFolder#\%Today%.bkf

set JobName=%Today% Full Backup

set Description=Starting %Today%

: Stop VM Using shutdown.exe (requires UNC path to VM)
11 On W2K and earlier hosts Shutdown.exe requires installation of resource kit
shutdown.exe /m \\%VMName% /s /t 0

::Wait for VM to shut down (uses ping -n <seconds> to the loopback address
:: to create a delay) 180 seconds = 3 minute delay.
ping -n 180 127.0.0.1 > nul

: Close Virtual PC Application and any child processes
taskkill /F /IM "Virtual PC.exe" /T

:: Back up WM
IF NOT EXIST %BackupFolder% md %BackupFolder%
ntbackup backup "%VMFolder%" /J "%JobName%" /D "%Description%" /F "%BackupFile%"

: Start WM
"Virtual PC.exe" -singlepc -pc %VMName’% -launch

Remember that tools such as shutdown and taskkill require administrative rights to exe-
cute, so this batch script should run under an administrator account. You can easily accomplish
this by configuring the script to run periodically using the Scheduled Tasks system tool and con-
figuring the option to run the script under a specific user account.

Running Virtual Server 2005 Flat-File Backups

Flat-file backups with Virtual Server 2005 are slightly more challenging compared to the
VMware GSX product line. This is because Virtual Server 2005 doesn'’t gracefully shut down
Linux VMs when powered down. However, it supports a graceful shutdown of Windows VMs.
Even without graceful shutdown of Linux VMs, Virtual Server supports automatically saving
the state of any running VM at the time the Virtual Server service stops. Furthermore, this
product supports automatically resuming a saved VM when the service restarts.

If the bulb is starting to flicker a little bit, it’s for a good reason. The built-in automatic
save and restart capabilities of Virtual Server make it easy to use a batch script to back up all
VMs on a single host system. If your preference is to back up each VM independently, then the
methodology for backing up the VM will change slightly. Virtual Server 2005 doesn’t have
native support for command shell administration; instead, it supports using COM for scripted
administration. What this essentially means is that backing up a single VM will require a script
written in a scripting language such as Visual Basic Script (VBScript) or Perl. To cover both the
“single VM” and “all VMs” backup scenarios, the next two sections will show you scripts that
will do each task. To back up all VMs, we’ll show you how to use a simple batch script, and to
back up a single VM, we’ll show you some VBScript code that will get the job done.
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Backing Up All Virtual Server VMs

The key to backing up all VMs on a Virtual Server host using a single script is to prepare the VMs
to automatically save their state if the Virtual Server service stops. Doing so will allow you to
automatically suspend all running VMs when Virtual Server stops, which will place each VM’s
related files in a state so that it can be successfully copied. To prepare the VMs for backup, you
need to set their default behavior for when Virtual Server starts or stops. To do this, follow these

steps:

1.

On the Virtual Server host system, click Start » All Programs » Microsoft Virtual Server
» Virtual Server Administration Website. If any VMs are running, shut them down
before proceeding.

. When the Web site opens, mouse over the Configure item under the Virtual Machines

menu, and select the first virtual machine listed.

. You should now see the status of the VM you selected. Scroll down the Web browser

window until you see the Configuration section of the page. In this section, click the
General Properties link.

. Now check the Run the Virtual Machine Under the Following User Account box. Enter

a username and password of an account with administrative rights under which to
start the virtual machine.

Now in the Action When Virtual Server Starts menu, select Always Automatically Turn
on Virtual Machine. In the Action When Virtual Server Stops menu, select Save State.
Figure 7-11 shows the settings described in steps 4-5.

Scroll to the bottom of the General Properties page, and click the OK button.

Repeat steps 2-6 for each additional VM on the server.
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Figure 7-11. Setting Virtual Server VM start and stop actions
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Once you've set the start and stop actions for each VM, you're ready to run a script to back
them up. The script used in this section to back up all VMs on a Virtual Server host uses the
following variables:

* VMRootFolder: Location of parent drive or folder containing all VMs
* Today: Current date formatted as mm-dd-yyyy (used to date stamp backup files)

* BackupFolder: Backup data destination folder (create this folder prior to running
backup), which can be alocal or UNC path

* BackupFile: Filename of backup job (stamped with current date)
* JobName: Friendly name for job (stored in backup file)

* Description: Description of job (stored in backup file)
With an understanding of the variables used, refer to the script (see Listing 7-9).

Listing 7-9. Backing Up All VMs on a Virtual Server Host

:: Filename: VS2005A11VMBackup.bat

:: Purpose: Automates the backup of all VMs on a VS 2005 host. VMs

:: must be configured to Save State when the VS service stops and to automatically
:: turn on when the VS service starts. After the service stops, ntbackup.exe is

: used to back up the root folder that contains all of the hosts VMs.

:: When the backup completes, the Virtual Server service is restarted, which in

:: turn resumes all saved VMs.

:: Set Variables

set VMRootFolder= E:\VMs

set Today=%Date:~4,2%-%Date:~7,2%-%Date:~10,4%
set BackupFolder=\\Zeus\Backups\VMs

set BackupFile=%BackupFolder%\%Today%.bkf

set JobName=%Today% Full Backup

set Description=Starting %Today%

:: Stop Virtual Server Service - Saves state of all VMs
net stop "Virtual Server"

: Back up VWMs
ntbackup backup "%VMRootFolder%" /3 "%JobName%" /D "%Description%" /F "%BackupFile%"

1. Start Virtual Server Service - Resumes all saved VMs
net start "Virtual Server"
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As you can see, this is one of the shortest scripts in the entire chapter, yet it’s one of the
most powerful. By taking advantage of the built-in save state and VM startup features of Vir-
tual Server, you're able to back up all VMs on the server with just a few commands. If you're
just interested in backing up one VM, you’ll see how to do that next.

Backing Up a Single Virtual Server VM

To back up a single VM running on Virtual Server 2005, you must first save the VM’s state.
This will quiesce the VM while the backup runs. Once the backup completes, the VM can be
restarted. Suspending the VM prior to backup will place the VM’s configuration and virtual
disk files in a fixed state so that they then can be reliably copied.

Unfortunately, Virtual Server 2005 doesn'’t allow you to directly administer VMs from the
command line, so for this specific task you'll use VBScript. This script uses the following vari-
ables, which you'll need to modify for it to successfully back up one of your VMs:

» strVMName: Identifies the name assigned to virtual machine to back up (visible in
Virtual Server’s Web UT)

* strVMFolder: Provides location of VM's files

* strToday: Defines current date formatted as mm-dd-yyyy

* strBackupFolder: Identifies location where backup data is stored
e strBackupFile: Stores name and full path to backup (.bkf) file

* strJobName: Defines friendly name for job (stored in backup file)
e strDescription: Holds description of job (stored in backup file)

¢ strNTBackupCommand: Stores complete backup command syntax that’s passed to the
0bjShell command shell object

* objVirtualServer: Provides connection to Virtual Server application
* objVirtualMachine: Provides connection to specific virtual machine
¢ objShell: Runs ntbackup.exe shell command from within script

e errBackup: Holds return code for ntbackup.exe command

With the variables out of the way, let’s look at the script (see Listing 7-10).

Note The methods used in this script are supported only on Windows Server 2003 or higher host systems.
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Listing 7-10. Backing Up a Single VM on a Virtual Server Host

" Filename: VS2005VMBackup.vbs

Purpose: Automates the backup of a single VMs on a host system
by first suspending the VM, then running the backup, and finally
resuming the VM.

Option Explicit

'Declare variables

Dim strVMName, strVMFolder, strToday, strBackupFolder, strBackupFile
Dim strJobName, strDescription, strNTBackupCommand

Dim objVirtualServer, objVirtualMachine, objShell, errBackup

"Load current date (formatted as mm-dd-yyyy) into variable strToday
strToday = Month(Date) & "-" & Day(Date) & "-" & Year(Date)

'Define Script Variables
strVMName = "W2K Srv"
strVMFolder = """E:\VMs\W2K Srv"""
strBackupFolder = "G:\Backup\VMs"
strBackupFile = Chr(34) & strBackupFolder & "\" & strVMName & " " & strToday

& ".bkf" & Chr(34) 'Chr(34) is used to include a quote in the string
strJobName = Chr(34) & strToday & " Full Backup" & Chr(34)
strDescription = Chr(34) & "Starting " & strToday 8Chr(34)
strNTBackupCommand = "ntbackup backup " & strVMFolder & " /3 " & strJobName & _

" /D " & strDescription & " /F " & strBackupFile

'Instantiate Virtual Server Object
Set objVirtualServer = CreateObject("VirtualServer.Application")

'Instantiate Virtual Machine Object
Set objVirtualMachine = objVirtualServer.FindVirtualMachine(strVMName)

'Save VM State
objVirtualMachine.Save()

'Instantiate command shell object
Set objShell = WScript.CreateObject("Wscript.shell")

'Use ntbackup.exe to back up saved VM
errBackup = objShell.Run(strNTBackupCommand,1,True)

'Restart VM
objVirtualMachine.Startup()
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Since the script saves the state of a running VM before backing it up, and since the save
state feature runs transparently to the guest OS, this script can back up any Virtual Server VM,
regardless of its installed OS.

At this point, we've covered all the primary flat-file backup scenarios for both Windows
and Linux VMs. Next, we'll cover a method for performing backups in real-time: online snap-
shots.

Taking Online Snapshots

Online snapshots are a feature supported in the VMware line of virtualization applications.
With online snapshots, you can create a point-in-time copy of a running virtual machine. With
an online snapshot saved, you can revert to the snapshot later. This gives you the ability to
create an image of a VM, make any changes you want, and with the click of a button roll the
VM back to the time of the last snapshot.

A disadvantage of this feature is that it's GUI-driven. If you want to do a snapshot, you
need to do it from the VMware management Ul Because of this, you shouldn’t look at snap-
shots as a way to replace the other backup methodologies already mentioned in this chapter
but rather as a feature that can aid in testing and training. In our opinion, whenever backups
are left up to humans to manually perform (instead of being automated), it’s just a matter of
time before a backup is skipped.

Although not necessarily a good choice strictly for backups, here are some reasons to use
the snapshot feature:

» Testing: Create a baseline VM, and then create a snapshot. After testing is complete,
revert the VM to the previously saved snapshot.

¢ Demonstrations: Take a snapshot before a software demonstration. Once the demon-
stration completes, you can power down the VM and revert to the saved snapshot.

* Training: You can walk students through a task and afterward revert to the beginning so

the students can practice.

Because of snapshots’ limited scope, VMware supports only a single saved snapshot per
VM, so you'll need to decide carefully when you plan to perform a snapshot.

Taking Snapshots

Taking a snapshot of a VM is a relatively simple process. Here are the steps to follow:
1. In the VMware management U], boot up the VM (if it isn’'t currently started).
2. With the VM running, click the Snapshot menu, and select Save Snapshot.
3. Wait for the snapshot to complete.

The snapshot information will be saved in the same location as the VM’s virtual disk files.
The snapshot files will have REDO as part of their extension, making them easy to identify.
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Recovering a Snapshot

Snapshot recovery is just about as easy as taking the initial snapshot. To recover a snapshot,
perform these steps while the VM is running:

1. Click the Snapshot menu, and select Revert to Snapshot.
2. If prompted to confirm that you want to revert to the saved snapshot, click Yes.
In a few moments, the system will be restored to the time of the last snapshot.

Although there’s no flexibility in the number of snapshots you can take (one), you can set
a few options in regard to how snapshots behave. Let’s quickly look at them.

Setting Snapshot Options

VMware allows you to set the following options for snapshot behavior:
* Disable all snapshots (not available if a current snapshot is saved).

e Lock the current snapshot, preventing any future snapshots accidentally taken from
overwriting it.

* Select how powering down the VM affects the snapshot. VMware will allow you to select
from the following power-down behavior options:

¢ Just Power Off: Do nothing to last snapshot (default setting).

* Revert to the Snapshot: Roll back VM’s hard disks to their state as of the last
snapshot.

¢ Update the Snapshot: Apply the current VM saved data to the snapshot (rolls
snapshot forward to current point in time).

¢ Ask Me: Causes a dialog box to be displayed when the VM is powered down,
allowing user to decide how to handle the snapshot.

To configure these options, follow these steps:
1. With the VM open in the VMware U], click the VM menu, and select Settings.
2. In theVirtual Machines Settings dialog box, click the Options tab.

3. Now click the Snapshot setting (see Figure 7-12). Make any desired changes to the
snapshot, and then click OK.

Tip If you want to exclude a particular virtual disk from a snapshot, configure the disk as an independent
disk. You can access this setting through the virtual disk’s advanced properties in the VMware Ul.
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Figure 7-12. Configuring VM snapshot options

Again, while snapshots are useful for training, testing, and demonstration purposes, they
shouldn’t be looked at as a substitute for VM backups. Now that you've examined all methods
for securing VM data, next we’ll cover the general procedures for recovering VMs.

Performing a Full System Recovery

The entire point of backing up data is to protect your organization’s data from loss stemming
from corruption, system or disk failure, or a natural disaster. Although understanding how to
reliably back up virtual machine data is critical, you shouldn't overlook the process for restor-
ing the data.

To prepare for recovery, a best practice is to ask yourself, can I rebuild my production
systems from scratch and have them configured exactly the same as they are now? Many
administrators answer “no” to this question, so if that’s your answer, you're not alone. To fully
rebuild your systems following a disaster, you need to know exactly how the systems were
configured. This configuration information includes the following:

* Host name
e TCP/IP configuration
* Disk drive configuration, disk configuration, and partitions (including SCSI IDs)

e Installed applications

Installed hardware
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With this information in hand, it's much easier to successfully recover lost data or sys-
tems. The method you choose to back up your VMs will ultimately dictate the techniques
you’ll use for recovery. In the next two sections, we'll present the methodologies for recovering
VMs backed up locally while online, as well as recovering VMs that were backed up directly
from the host via flat-file backups.

Restoring Online VM Backups

The process for restoring data from an online VM backup is nearly identical to the data recov-
ery process for physical systems. If you needed to restore a few files or folders, you'd use either
your enterprise backup product or a utility such as dump or Windows Backup to recover the
data. The processes involved in recovering files using dump and Windows Backup were outlined
earlier in this chapter.

When you're faced with completely restoring a VM from an online backup, the recovery
process is slightly more difficult. One of the major advantages of virtualization applications is
that they emulate nearly all VM system hardware (see Chapter 1). This means that if a VM’s host
system crashes, you can recover the VM’s backup data to a new VM running on a different host
system. With emulated hardware, it’s likely that the VM’s OS won't even notice the change.

Caution VMware has long noted that its hardware emulation doesn’t support moving a Linux VM from
a host with an Intel CPU to a host with an AMD CPU. Doing so will cause an irrecoverable kernel panic at
startup. This problem doesn’t occur when moving VMs with other installed operating systems between
hosts with different CPUs.

Let’s further discuss the scenario of a VM’s host crashing. This is equivalent to one of your
servers or workstations crashing. When this happens, the general recovery process involves
the following steps:

1. Reconfigure the system’s hardware as close to the failed system’s configuration as pos-
sible. This will include installed devices and hard disks. The number of disks as well as
the size of each disk should be equal to or larger than the number of disks on the origi-
nal system.

2. Power on the rebuilt system (VM), and reinstall the operating system. During installa-
tion, use the same host name and TCP/IP settings assigned to the original system.

3. Repartition and format the system’s hard disks to their original specifications.
4. If backup agent software was installed previously, reinstall the backup agents.

5. Use your local or enterprise backup software to perform a complete full system restore
from the VM'’s backup data. Note that all the examples used in this chapter involved
exclusively performing full backups. Since this isn’t practical in many environments,
your recovery may involve restoring a full backup and several incremental (or a differ-
ential) backups following the recovery of the full backup.

6. When the recovery finishes, restart the system.



CHAPTER 7 @ BACKING UP AND RECOVERING VIRTUAL MACHINES

Although we used the term VM throughout the previous steps, keep in mind that the
same steps apply to host system recovery. You'd start by reinstalling any necessary hardware,
and then you'd reinstall the OS, re-create the host system’s disk partitions, and then perform
the full system restore. Following the full system restore of the host, you'd finally need to
restore the data for each VM running on the host.

Restoring Flat-File VM Backups

Flat-file VM backups are much easier to restore than online backups, since the flat-file backup
includes the VM’s configuration files as well as its virtual disk files. Since virtual disk files are
always dynamically changing, you should have to restore just the most recent flat-file backup
of aVM in order to fully recover it. Following the restore of the VM files, you then power on
the VM and validate its operation. You may notice that some devices, such as the CD-ROM or
floppy drive, may not be present. This is likely because of the VM’s devices being mapped to
static drive letters on the host system that no longer exists. For example, if a VM was config-
ured to use the D drive on the host as the CD-ROM drive and, when the host is recovered, the
CD-ROM is assigned the letter G, the VM may not recognize the CD-ROM drive. To correct
this, just update the VM’s settings.

Summary

As you can see, with sound reliable backups, VM recovery is truly the easiest part of the data
protection process. When protecting VMs, one practice to avoid is to never test your backups.
Microsoft once stated that a backup administrator is only “...two failed recoveries away from
a pink slip.” When data is needed and you can’t recover it, you may be the one facing the ulti-
mate responsibility for the data loss. (Blaming the hardware vendor or power company
doesn’t always work!)

To aid in recovery, many organizations stage recovery servers that already have a base OS
installed. You can apply the same philosophy to VMs. Since VMs exist as merely collections of
files, it’s easy to save a virtual machine base OS installation to a DVD. With this approach, you'd
simply need to copy the base VM back onto a host server and then rename the VM to that of
the original. This can save you significant time when you need to recover data while under the
gun. Another approach with staged-recovery VMs is to create a base VM and run the Windows
sysprep tool on it. After sysprep runs, just shut down the VM and back it up to another location.
The next time the VM starts, the Windows mini-setup will run, and you'll then be prompted to
provide a name and TCP/IP information for the system.

When taking backup and recovery seriously, it's important to periodically practice restor-
ing your backup data. Just because a backup program told you that a backup was successfully
completed doesn’t mean the backup data will restore successfully. Many of us have had to
learn this lesson the hard way. You shouldn’t have to suffer the same fate as those before you!

This chapter marks the end of the general VM management section of the book. In the
remaining chapters, you'll be exposed to the many other aspects of virtualization in IT today.
If you're still thirsty for information on VMs, then turn to Chapter 11 or Chapter 14 for addi-
tional examples and advanced virtual machine configuration topics.
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CHAPTER 8

Using Virtual File Systems

In this chapter, we’ll focus on how to use virtual file systems. This chapter will introduce you
to two of the most widely used virtual file systems, Distributed File System (DFS) and Andrew
File System (AFS). We'll outline the considerations for deploying and managing these tech-
nologies in Windows and Linux environments. Because virtual file systems rely on other
services, we'll also cover other technologies, including Samba and Kerberos.

Introducing DFS

DFS creates a virtual view of shared directories on a network. It works by creating a namespace
with references to network shares and tracks file access. When a user requests a particular
resource, DFS matches the request with the correct server and directs the client to the resource.
To the end user, the process is seamless; folders look as if they’re stored on a single hard drive. For
administrators, a single virtual filespace means that servers can be swapped in and out of service
without impacting applications or the end user, because the virtual filespace remains constant
regardless of what'’s on the backend. As the DFS administrator, you have the ability to decide what
shared folders will appear in the DFS namespace, design the directory namespace hierarchy, and
define the names of the shared folders appearing in the namespace. Conveniently enough, secu-
rity is enforced by existing file system and shared folder permissions.

With DFS implemented on your network, you can make files from across a WAN more
accessible to users, experience a reduction in duplicative file storage, and experience an
increase in file availability with replication. Without DFS, you’ll have to browse the resources
on each server in a network to find what’s needed; if you have many servers, this can be a
cumbersome task and a documentation nightmare. Before jumping into the configuration
process, we'll introduce some DFS nomenclature and discuss DFS a bit further.

Note Running DFS across a WAN can negatively impact overall performance by adding unexpected
loads. Make sure sufficient bandwidth is available to support your implementation; newly implemented DFS
filespaces become quickly popular with end users!

Before reading the next few paragraphs outlining the structure and terms used with DFS,
be sure to associate the DFS terms with something you already know, such as DNS. Knowing
the hierarchical structure of DNS can aid in your understanding of DFS. For instance, the term
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root in DNS describes the beginning of the namespace, just as root in DFS describes the
beginning of the file namespace. Moreover, understanding that DNS is a logical structure
rather than a physical one will help you grasp the logical structure of DFS.

A DFS namespace refers to the virtual view of network resource shares on disparate
servers minimally consisting of a root, links, and targets. The namespace begins at the root
and maps to additional root targets; root targets are physical DFS host servers. The DFS root is
the beginning of the DFS namespace and generally refers to the whole namespace. Stand-
alone roots begin their UNC paths with the server name, and domain-based roots begin their
UNC paths with the domain name.

A root can map to additional root targets, which in turn map to shared folders on a differ-
ent server. We use the term DFS path to describe a UNC path that begins at a DFS root, and
root target refers to the actual server hosting the DFS namespace. Domain-based DFS roots
may have multiple root targets, and stand-alone DFS roots can have just one root target. A
stand-alone DFS namespace consists of a single root target having its information stored in
the host’s registry. A domain-based DFS namespace has its information stored in Active Direc-
tory. Domain-based DFS roots may have multiple root targets offering fault tolerance and load
sharing; on the other hand, stand-alone DFS namespaces aren'’t natively fault tolerant unless
you use clustering.

The last couple of terms you'll want to be familiar with are link and referral. The term
link is used in three ways. A DFS link is a component that lies in the DFS path and maps to
link targets. A link target is the mapped destination of a DFS link; it can be a UNC path or even
a shared folder. The term link referral describes the list of link targets for a given link. Referrals
are the target lists a client receives when accessing a DFS root or a DFS link, and root referral
describes the root target list for a DES root. The transaction between the DFS service and the
client receiving the referral lists is a transparent process, as is the name resolution process
used in DNS. Using dfsutil.exe /pktinfo, you can view the contents of the referral cache.
Unfortunately, the DFS tools aren't installed by default; therefore, you'll need to install the
Windows 2003 Support Tools to use the DFS Support Tools. The Support Tools are located on
the Windows 2003 CD-ROM in the \support\tools folder. Using the suptools.msi setup file,
follow the installation wizard. In addition to all the other cool tools, such as the Dependency
Walker, Network Connectivity Tester, Port Query, and Process Viewer, after completing the
install, you'll also have access to the following:

* The DFS dfscmd. exe command-line tool used for scripting DFS tasks related to roots,
links, and targets

* The dfsgui.msc DES snap-in that can be installed on Windows XP SP1 machines for
remote administration and can be used for configuring namespaces, targets, referrals,
and replication

* The dfsutil.exe command that’s the advanced DFS utility to help you in many DFS
administrative tasks, such as determining the namespace size, exporting/importing
namespaces, checking the site name/IP address of a computer, adding/removing root
targets, and updating site information for root servers

Note Though we’re discussing virtual file systems in this chapter, we’ll show how to configure AFS and
DFS on virtual machines.
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Implementing Windows DFS

Before implementing DFS, you need to be aware of the services it requires. Table 8-1 outlines
DFS dependencies. In addition, the DFS service requires several services to be running on
DFS root servers and domain controllers; for instance, root servers need the Server, Worksta-
tion, and Security Accounts Manager services.

Table 8-1. DFS Dependencies

Dependency Purpose

Active Directory replication Replicates DFS objects to all domain controllers

SMB protocol Vital for communications with root servers

RPC service/locator Needed for DFS tools to communicate with servers

DEFS service Required on root and domain controller servers for DFS to
function properly

Now that you're aware of the DFS dependencies, you should also be aware of the network
protocols and ports required to support DFS; being that you know Active Directory and SMB
are required, you have a good idea of the ports you'll need to deal with at the perimeter of
your network. They are as follows:

* Lightweight Directory Access Protocol (LDAP) (UDP/TCP 389)

e NetBIOS (UDP 138, TCP 139)

¢ RPC (TCP 135)

e SMB (UDP/TCP 445)

Implementing DFS touches all aspects of your production environment. To successfully
deploy DFES beyond the lab environment, you must completely understand Microsoft inter-
networking, including Active Directory and dynamic DNS. Moreover, you must know how to

wield the power of your firewall and routing technologies. When deploying DFS in your infra-
structure, Microsoft suggests you use this checklist:

e The PDC emulator is working.

e DNS and Active Directory replication are working.

e Firewalls don’t block DFS RPC ports.

» The DFS service is running on all domain controllers and root servers.

* Active Directory sites and site costs are configured, and the Bridge All Sites Links option
is enabled.

e Client computers aren’t running legacy operating systems and are domain members.

e The HKEY_LOCAL_MACHINE/SYSTEM/CurrentControlSet/Control/Lsa/restrictanonymous
registry entry isn't set to 2 for Windows 2000 Servers.
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We've tackled DFS nomenclature, DFS prerequisites, and some gotchas; you now have
enough information to be dangerous in the lab, so we’ll show how to perform a generic DFS
configuration. Once we get the basics out of the way, we’ll cover root replicas, replica DFS links,
load balancing, and fault tolerance.

Installing DES is easy; Windows 2000 and Windows 2003 install it by default. Before click-
ing through the basic setup, take a moment to think through the ramifications of end users
being able to see the root names and link names that will be used in your DFS environment.
To that end, you should be aware of these limitations:

¢ Roots can’t be nested within each other.

» Every DFS root must have its own shared folder.

¢ Server clusters shouldn’t share the same DFS root name as nonclustered roots.

¢ Domain-based DFS roots must have the same UNC share name and DFS root name.
¢ Domain-based DFS roots and domain controller shares shouldn’t use the same name.

The next thing you need to consider is whether you want to install a domain-based root
or stand-alone root; Table 8-2 lists the considerations.

Table 8-2. Domain-Based and Stand-Alone DFS Root Considerations

Domain-Based DFS Root Stand-Alone DFS Root

Requires Active Directory Doesn't use Active Directory

Uses File Replication Services (FRS) Doesn’t support FRS

Can have multiple root-level targets Limited to one root-level target

Achieves fault tolerance through FRS Achieves fault tolerance via server clustering

When using domain-based roots, you should limit DFS links to fewer than 5,000; on
stand-alone DFS roots, you should limit DFS links to 50,000. The disparity in the sheer num-
ber of links can be explained by the overhead of Active Directory generating significantly
larger amounts of network traffic. Before deploying DFS, a solid assessment of your WAN
should be your first priority.

Note Wnhen using Windows 2000 and Windows 2003 to create a DFS environment, you must use a
Windows 2003 operating system to administer DFS.

You'll begin the configuration process by creating a domain-based DFS root. Select Start
» All Programs » Administrative Tools » Distributed File System. On the Action menu, select
New Root. The New Root Wizard will launch and prompt you through the creation process.
As depicted in Figure 8-1, your first decision is to choose a domain or stand-alone root.
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Figure 8-1. DFS root type selection

On the Host Domain selection screen, you'll need to provide the DFS host domain,
and on the Host Server selection screen, you'll need to supply the FQDN of the DFS root
host. Next, as shown in Figure 8-2, you'll need to supply a unique root name for the DFS
root. Being that the Comments field isn’'t viewable by end users, make sure the root name
adequately describes the root to help in end-user navigation.
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Figure 8-2. DFS root name entry
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On the Root Share selection screen, create a directory to be shared; the DFS wizard will
take care of automatically setting up the folder and sharing it. Conversely, you can select a
predefined share if you want. The wizard will complete the install by summarizing your selec-
tions and present them to you, as shown in Figure 8-3. Review your selections, as it will be
difficult to “undo” a DFS deployment in the future. The entire creation process ends in an
uneventful finale where you're presented with the DFS interface and the configured filespace.

New Root Wizard |

Completing the New Root Wizard

You have successiully completed the Mew B oot Wizard.
V'ou have chozen to create a root with the following

zettings:

Cromair; testdomain. com
Host zerver: test bestdomain. com
Share name: testdomain. com
Root name: testdomain. com

To cloze this wizard and create the root, click Finizh.

< Back Cancel

Figure 8-3. New Root Wizard completion summary

In the event of server failure, you can make the namespace defined by the domain DFS
root available if you created additional root targets (replicas) beforehand; once again, the only
way to ensure availability is to minimally have two domain controllers and two root targets.
If you don't have two servers, the namespace will be unavailable when the server flatlines.

You can add root targets by selecting Action » New Root Target. The New Root Target
Wizard will walk you through the process. Removing a root target is just as easy; highlight
the target, and select Action » Remove Root. Yes, it really is that simple to create or remove
areplica of your root. Windows 2003 DFS is a significant improvement over Windows 2000.

When creating a DFS link, the directory specified must first be shared. If the share for the
directory doesn'’t exist, you can’t build a DFS link to it. When creating shares, be sure to use
good passwords, share permissions, and access control. To create a link, select Action » New
Link. As shown in Figure 8-4, enter the name for the link and the path, its UCN path, and the
referral cache timeout. The referral cache stores the link information on the client based on
the number specified in seconds. Setting the cache too high will keep clients from seeing
newly created links within a reasonable amount of time. Setting the time too low will create
unnecessary network traffic.
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Figure 8-4. Creating a DFS link

Connecting clients to a DFS namespace requires Windows 9x operating systems to install
the DFS client; later versions of Windows—such as Windows NT, Windows 2000, and Windows
XP—natively support connectivity to the DFS namespace. To connect, simply open My Network
Places, find the namespace root server, and locate the root target. You can create a shortcut on
your desktop to the DFS namespace just as you'd make any other shortcut. Assuming you want
to create a shortcut to the root, right-click the root target and select Copy. Next, right-click your
desktop, and select Paste Shortcut.

Tip You can make your domain’s DFS filespace more accessible by publishing it in Active Directory. To do
this, select your namespace root and then select Action » Properties from the menu. Click the Publish tab,
and check the Publish This Root in Active Directory option.

Clearly, there isn’t much to configuring DFS and being able to take advantage of a single
filespace in a network. However, don’'t be duped into believing it’s good enough to create a file-
space without some type of backup or redundant system. Take a moment to configure FRS for
your domain-based DFS initiative. When using multiple targets, you’ll have to decide on a
replication method for synchronizing data between the targets; you can replicate data doing
it manually, using third-party tools, or using FRS. It’s best to manually replicate static or read-
only data. The drawback to manual replication is that changes are updated infrequently.
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If you're implementing a stand-alone DFS deployment, you have no other option than to
manually replicate data by performing a simple copy or using a tool such as Robocopy. On
the other hand, FRS is used for domain-based DFS namespaces; it works by detecting changes
made to files or folders and replicating the entire file to the servers in the replica set.

You can set up FRS in a continuous mode (changes are replicated within five seconds
of a file being closed) or at scheduled intervals. One drawback to continuous replication is
that the circuits in a WAN can be completely utilized with replication data. Moreover, using a
scheduled interval to update data can leave replica sets unsynchronized for extended periods
of time, which causes multiple versions of a particular file to exist. When it comes time to syn-
chronize, FRS will use a conflict resolution process for changed files by permitting the most
recently updated version to be replicated in the replica set; this holds true for directory name
changes as well. If two directories are created in a replica set with identical names, FRS will
rename the most recently created folder.

You can maintain replication integrity by using the update sequence number (USN)
journal record to change files on replica members. When it comes time for you to decide on
a strategy for making critical data available, you'll want to read “Choosing an Availability Strat-
egy for Business-Critical Data” in the Windows Server 2003 Deployment Kit, which is available
athttp://www.microsoft.com/resources/documentation.

Note Nuview StorageX, documented in this book’s appendix, provides a distributed directory service
that focuses on performance. StorageX logically aggregates DFS storage and makes policies available for
automating administrative tasks, such as replication, client failover, capacity optimization, and reporting.

We've yapped enough about the benefits and drawbacks of FRS, so now we’ll cover how to
configure it for DFS. First open DFS, and select the domain DFS root or link to be configured
for replication. On the Action menu, click Properties and select the Replication tab. To initiate
replication, on the Action menu, select Configure Replication and complete the Configure
Replication Wizard.

Gaution FRS replica sets shouldn’t be configured on a volume managed by remote storage because of
severe performance impacts and data corruption.

If you want, you can also exclude files and folders by selecting either File Filter or Subfolder
Filter on the Replication tab and then selecting Edit. Type the filename of a file or folder name
you want to exclude from replication. Next, click Add to append the file or folder name to the
exclusion list.

This brings our discussion of DFS to a close; we've decided to concentrate on the Linux
integration aspects of DFS in this chapter, primarily because little of it has been documented
to date. You can find plenty of documentation for setting up DFS in Windows environments at
the Windows 2003 Server home page (http://www.microsoft.com/windowsserver2003).
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Implementing Linux DFS

Integrating Linux with Microsoft DFS and Active Directory requires you to install and configure
Samba on your server. Samba is an open-source implementation of Microsoft’s SMB and Com-
mon Internet File System (CIFS) protocols. Though SMB is primarily a network file-sharing
protocol, it also aids in several other important network tasks, such as network browsing, print-
ing, resource authenticating, and extended file attribute handling. CIFS is a dialect of SMB that
was implemented with Windows NT 4. Dialect refers to the message packets defining a particu-
lar version of SMB. If you break out a network analyzer, such as Network Instruments’ Observer,
you'll find that SMB lurks around the top two layers of the OSI model and relies on NetBIOS over
TCP/IP (NBT) for transport at the network layer. In this section, we'll first cover how to set up
Samba to act as a Kerberized domain controller serving DFS shares, and then we'll finish the
section by showing how to join the Samba server to an existing domain.

Before installing Samba, check to see if it’s installed on your Linux system:

rpm -ga | grep samba

If you see a list of packages, you may want to upgrade your system to the latest stable
version of Samba. The prerequisites for Samba vary, but you can look them up for your Linux
distribution at http://www.samba.org. For RPM distributions, in addition to having the devel-
opment environment installed, you'll need the following:

e krb5-workstation
e krbs-libs

e krb5-devel

e pam_krbs

e openldap

* openldap-clients

e openldap-devel

You can verify the installation of RPM prerequisites by querying the RPM database:

rpm -ga | grep openldap
rpm -qa | grep krb

Time synchronization is important for all computer networks. Windows and Linux OSs
require systems to have accurate time for Kerberos ticketing, NT LAN Manager version 2, and
event logging. The default configuration of Kerberos requires hosts to be time synchronized
within five minutes of each other. Active Directory uses Kerberos for authentication, where
the time is encoded on the client’s authentication ticket; using time as a constraint prevents
system attackers from reusing old authentication tickets. The Windows W32Time service uses
the Simple Network Time Protocol (SNTP) to synchronize system clocks and isn't as accurate
as NTP in regard to adjusting the clock. Registry settings for the Windows W32Time service are
in the HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Services\W32Time\Parameters subkey.
To synchronize your Windows 2003 authoritative time source with an external entity, you'll
need to use the w32tm command to add the time source:

w32tm /config /syncfromflags:manual /manualpeerlist:<NTP Server IP or FQDN>
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Now update the server:
w32tm /config /update

You can synchronize the clocks on Windows 9x and Windows NT systems using the net
time command:

net time \\<NTP_Server IP or FODN>> /set /yes.

You can time synchronize Linux systems by editing the /etc/ntp.conf file. Find the server
statement, and edit it so it has the IP address of your network’s NTP server:

SErVer XXX.XXX.XXX.XXX

You can additionally use the ntpdate command to synchronize the local clock with the
Windows W32Time service. To get an idea of the information obtained from an (S)NTP server
using the debug option, execute ntpd -d x.x.x.x. To set the time of your Linux box on boot,
edit /etc/rc.d/rc.local and append ntpdate to the file. Additionally, to avoid socket errors,
you should disable the NTP daemon.

ntpdate -s <x.x.x.x>

If you're using Windows XP as your VM host, you can enable SNTP for guest VM synchro-
nization by editing the registry entry HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\
Services\W32Time\Config. Set the AnnounceFlags DWORD value to 5. Next, enable the SNTP
server by editing HKEY_LOCAL _MACHINE\SYSTEM\CurrentControlSet\Services\W32Time\
TimeProviders\NtpServer\. Set the Enabled DWORD value to 1. Restart w32time using
net stop w32time & net start w32time.

If you're using a Linux host, edit /etc/ntp.conf to allow external host synchronization.
The first line in the file sets the host as the time authority, and the second line denies access to
everyone. The third line allows VMs on a given subnet the ability to synchronize, and the last
line is for the local host.

server 127.127.1.0

restrict default notrust lowpriotrap nopeer nomodify
restrict 192.168.100.0 mask 255.255.255.0 # local hosts
restrict 127.0.0.1 mask 255.0.0.0 # local config

Note For the best overall security and performance of your network, you should use an NTP server and
point all hosts to it. To properly build and secure an independent NTP time synchronization server for your
network, please refer to http://www.ntp.org. In addition, for a complete introduction to Microsoft’s imple-
mentation of NTP (Windows W32Time service), search Google for Windows Time Service or wintimeserv.doc.
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For this install of the SMB/CIFS protocol, we'll assume you don't have Samba installed, so
we'll proceed by showing how we compile our own binaries. If you want to see if you have Samba
installed, you can execute rpm -qa | grep samba. Download Samba from http://www.samba.org
and save it to a convenient location, or snag it at the command line using wget:

wget http://usil.samba.org/samba/ftp/samba-latest.tar.gz

After installing Samba, you should familiarize yourself with its three daemons, as listed in
Table 8-3.

Table 8-3. Samba Daemons

Daemon Primary Purpose

nmbd
smbd

Provides name registration and resolution and aids in network browsing

Manages file and print services and local authentication

winbindd Required for membership in aWindows NT 4 or Active Directory domain or in a

trust relationship

Now follow these steps:

1.

Extract the Samba download:

tar zxvf samba-latest.tar.gz

. You don’t want to be the unwitting victim of a maliciously altered Samba download, so

verify the PGP signature of your gzipped TAR file to confirm its authenticity. You may
need to browse the Samba FTP directory for the matching signature source file of your
download. We’ll show how to use wget to download the source file and the Samba pub-
lic PGP key to the extracted Samba directory, such as /root:

wget http://usi.samba.org/samba/ftp/samba-3.0.10.tar.asc
wget http://usi.samba.org/samba/ftp/samba-pubkey.asc

. Import the Samba public key into your system using GNU Privacy Guard (GnuPG).

GnuPG is a free replacement for Pretty Good Privacy (PGP). GnuPG doesn'’t use
patented technology and is open-source technology. PGP uses the patented Interna-
tional Data Encryption Algorithm (IDEA) block cipher.

gpg --import samba-pubkey.asc

. Verify Samba’s integrity by using gpg --verify <file signature> <file name.tar.gz>.

Your system should minimally respond with “Good Signature from Samba Distribution
Verification Key.”

gpg --verify samba-pubkey.asc samba-3.0.10.tar.asc samba-latest.tar.gz

273



274

CHAPTER 8 ! USING VIRTUAL FILE SYSTEMS

5. If the configure script isn’t present in the source directory in which Samba was

extracted, /samba-3.0.10/source, you'll need to build it using . /autogen. sh. If you
downloaded Samba directly from http://www.samba.org, the configure program
should be present. We'll show how to use it to build the binaries. Being that we want
our Linux server to be integrated into a Windows 2000 domain as a client with DFS
capabilities, we'll need to specify several additional programs. You may not need every
program we list here, but it simplifies the installation and configuration processes
later. Moreover, many of the applications in the list are installed by default; therefore,
be sure to research your Samba version ahead of time. For instance, Samba 3 includes
DEFS support. In a production environment, you'll want to install only what’s necessary
to satisfy your needs. Here's what we're installing:

e acl-support
* ads

e krbs

e ldap

* msdfs

* windbind

* smbwrapper
* smbmount

* utmp

. To get an idea of all the optional programs Samba makes available to you, execute

./configure --help.To configure your server, execute the following command:

./configure -with-acl-support -with-adse
--with-krb5=/usr/kerberos --with-ldap=
--with-msdfs --with-windbind -with-smbwrapper=s
-with-smbmount -with-utmp tee | config.log

Notice that screen output is being piped to a log file with the tee command. tee allows
configure to write to the screen and to the log file. If configure runs into errors, you
can easily skim the captured output to troubleshoot your distribution of Linux. You
can find additional information in config. log.

Note Make sure the DNS is properly configured. Samba and Kerberos depend on it to function
correctly. Without a properly configured DNS server, you’ll run into many problems that could have
easily been avoided.
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If you run into Kerberos errors during the make process, verify that your version of
Samba is compatible with the version of Kerberos you're attempting to use. If not, in

a unique directory (for example, /krb5), download a compatible version from MIT by
using wget. Strictly put, you don’t necessarily have to use Kerberos with Samba to serve
DEFS shares; however, you'll have to rely on Samba’s password files.

wget http://web.mit.edu/kerberos/dist/krb5/1.4/krb5-1.4-signed.tar

Tip Your VMs have the ability to revert to a previous state, which will save you a considerable
amount of configuration time in the event of a botched installation. Take a moment to create a
snapshot, redo log, or simple offline backup before starting major configuration changes—you'll
thank yourself.

. Extract the files from the downloaded TAR:

tar xvf krb5-1.4-signed.tar

. Extract the Kerberos tarball. The extraction process will build the directory krb5-1.4

and create the file krb5-1.4.tar.gz.asc.
tar zxvf krbs5-1.4.tar.gz

You can check the authenticity of your Kerberos download by using the detached PGP
signature from MIT’s Web site at http://web.mit.edu/kerberos/www and by using GPG.

Navigate to the src directory:
cd /krbstree/krb5-1.4/src
Run configure, and execute make:

./configure --enable-dns --enable-dns-for-kdc --enable-dns-for-realmw
--enable-kdc-replay-cache --enable-krb4 --enable-shared; make

Test the build by running the built-in regression tests:
make check
Finally, install the binaries:

make install DESTDIR=</Directory Path>

After completing the installation of Kerberos, you'll need to configure the master key
distribution center (KDC), which is responsible for issuing Kerberos tickets. For this, you’'ll
need to edit two configuration files, /etc/krb5.conf and /usr/local/var/krbskdc/kdc.conf (or
/var/kerberos/krbskdc/kdc.conf for Red Hat RPM-installed systems). Both files need to have
realm information correctly configured for host names and your realm name. You can satisfy
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the constraints of basic realm by substituting EXAMPLE .COM and example. com with your domain
name. Be sure to follow the case of the examples in each configuration file. Be sure that the
KDC sample entry matches the host name of the master KDC server.

Note For a complete discussion of the configuration of a Kerberos realm, refer to the “Kerberos V5 Instal-
lation Guide” at http://web.mit.edu/kerberos/www/krb5-1.2/krb5-1.2.6/doc/install.html. The
guide also includes instructions on creating a logging stanza for your configuration file and security best
practices.

Follow these steps:

1. Use the kdb5_util command on the master KDC to create the realms database. The -s
option creates the stash file for the master key. The utility will be in your installation
directory. This example is for Red Hat:

/usr/kerberos/sbin/kdb5 util create -s

2. You now need to create or edit kadm5.acl to tell kadmind who has administrative access
to the database. The file is in the format Kerberos principal permissions optional
target principal. For a simple realm, you can use wildcards to grant access, such as
*/admin@TEST.COM *.

3. Start the kadmind server:
service kadmind start

4. You'll need to add at least one administrative principal with kadmin.local to allow
remote access:

kadmin.local -q addprinc <username>/admin

5. You now need to create the kadmind keytab using the kadmin.local command with
ktadd. In a nutshell, this process gives administrators the ability to access the data-
base. Be sure the path used with ktadd reflects your installation. If you're working on
an RPM-based system, such as Red Hat, you may not need to perform this step. The -k
option saves the extracted keytab to the specified kadms. keytab file, which is also used
in the kdc. conf file. Type exit to escape from kadmin.local. Once again, be sure to use
the directories that reflect your installation, like so:

/usr/sbin/kadmin.local
ktadd -k /usr/local/var/w
krbskdc/kadms.keytab => kadmin/admin kadmin/changepw

6. Start the Kerberos daemons:

/sbin/service krbskdc start
/sbin/service kadmin start
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. Create host keys by adding principals with ktadd. Creating a principal for the master

KDC will allow you to move the master KDC to a slave KDC, so add it first:

/usr/sbin/kadmin.local
addprinc -randkey host/<FODN>

. To complete the configuration, create a keytab for the master KDC so it can decrypt

tickets:

/usr/sbin/kadmin.local
ktadd host/<FQDN>

. Now that Kerberos is installed and configured, you can add principals for network

hosts using kadmin.local. We'll use the recommended randkey command for the host
key:

/usr/sbin/kadmin.local
addprinc -randkey host/<FODN>

You can add principals for network users similarly by using kadmin.local. You'll need
to specify the password for the user in the creation process:

/usr/sbin/kadmin.local
addprinc <userid>

You can view the server’s list of principals in the database while using kadmin by exe-
cuting listprincs. In addition, you can test the server’s functionality by using kinit,
klist, and kdestroy, as outlined in Table 8-4.

Table 8-4. Kerberos Test Commands

Command Action Performed

kinit Obtains a ticket and stores it in the credential cache
klist Views the credential cache

kdestroy Destroys the cache

To configure an XP user and host machines to use a Kerberos 5 server, you'll need to
install the tools from the Support folder located on the installation CD-ROM to gain
access to the ksetup command. Next select Start » Programs » Windows Support Tools
» Command Prompt. The first statement configures computer account information,
and the second statement specifies the change password protocol. If your Kerberos
KDC doesn'’t allow password changes, users won't be able to change their passwords
using the three-finger salute.

ksetup /addkdc <DOMAIN_NAME> <FQDN_of KDC>
ksetup /addkpasswd <DOMAIN_NAME> <FQDN_of KDC>

The user’s local account must be mapped to use the Kerberos server as well:

ksetup /mapuser <username>@<DOMAIN NAME> <username>
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14.

15.

16.

17.

18.

19.

Configuring Linux systems and users to employ a Kerberos realm minimally requires
a Kerberos client and a valid krb5. conf configuration file. Typically, you can use the
same krb5.conf file as that of the server. For the Kerberos client, Linux systems using
RPMs need krb5-1ibs and krb5-workstation packages. Create the host account on
the KDC:

/usr/sbin/kadmin.local
addprinc -randkey host/<FQDN>

Extract the keys on the client by first using kadmin and then using ktadd:

/usr/sbin/kadmin.local
ktadd -k /etc/krbs5.keytab host/<FQDN>

Create the user account:

/usr/sbin/kadmin.local
addprinc <userid>

Note If you want XP services to use Kerberos 5 servers for authentication, refer to
“Kerberos Interoperability” in the Windows XP Professional Resource Kit or online at
http://www.microsoft.com/resources/documentation/Windows/XP/all/reskit/
en-us/Default.asp?url=/resources/documentation/Windows/XP/all/reskit/
en-us/prdp_log tjil.asp.Additionally, if you need more help with client configuration,
use Google to find the “Kerberos System Administrator’s Guide” online.

Depending on the directory you use to extract the files, you'll need to specify the root
directory of your Kerberos install for your Linux distribution to avoid errors with
configure in Samba, such as --with-krb5=/krb5-1.04.

Create the Samba binaries with the make command:
make | tee make.log

Run make install to install the compiled binaries.

Now that Samba is installed, you'll need to configure the service to start automatically.
You can do this in many ways, so we're merely offering one way. To start Samba as a daemon,
edit rc.local and add the command syntax to start Samba for your Linux distribution:

vi /etc/rc.d/rc.local
service smb start

Note For the comprehensive resource regarding Samba, refer to the “Official Samba-3 HOWTO
and Reference Guide.” It’s freely available in PDF from http://www.samba.org/samba/docs/
Samba-HOWTO-Collection. pdf.
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You must configure Samba prior to using it. Though this just entails creating and editing a
text file, configuring the service tends to be the tricky part for most Samba newbies (and veter-
ans!). Generally, most problems are a result of typos and not placing the file in the correct
directory. In general, you can place the file in /user/local/samba/1ib. Being that this directory
varies based on your particular installation, you should check your documentation. Conversely,
you can run testparm to find the expected installation point. On some Red Hat systems, you may
find that the file already exists in the /etc/samba directory. A simple configuration consists of
only a handful of parameters. Rather than giving a complete discourse on the Samba configura-
tion file, which is well beyond the scope of this book, we'll explain only the relevant parts.

In the first part, the configuration file needs to minimally consist of two stanzas: global
and dir_share. The basic setting instructs Samba to become a member of a workgroup, to
share the directory /data/share, and to give it alabel of dir share.

[global]

workgroup = DOMAIN NAME
netbios name = HOST NAME
security = share

encrypt passwords = yes
[dir_share]

comment = Shared Directory
path = /data/share

read only = no

oplocks = no

guest only = yes

Create the shared directory, and configure permissions to suit your needs. To speed up the
troubleshooting process, set permissions to give everyone complete access and control to the
directory. You can always tighten the security after you verify the functionality of the server.

mkdir /data/share
chmod 777 /data/share _name

For testing purposes, create a Samba user account for root with legacy authentication
using smbpasswd. The first user added initializes the encrypted password file. Test your Samba
configuration, and start the service. If you get errors, check your configuration file. If you
continue to get errors, revert your VM and start again.

smbpasswd -a root
testparm
service smb start

Now that the service is running, you can test the server’s ability to offer its share to the
network. The following command will enumerate any shares, the share type, and associated
comments:

smbclient -U root -L localhost

Take a moment to further test your VM-hosted Samba server by connecting to it from a
Windows VM. At the CLI, try to map a drive to the shared directory:

net use * \\<samba FODN>.x.x.x\dir share /user:domain_name\root
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If your host fails to connect to the Samba server, try substituting the IP for the host name
to eliminate issues with DNS. Verify that the directory share is created and the permissions
are set. Finally, make sure you're connecting to the share name and not the shared directory.

You can manage Samba from the command line or through a GUI. The traditional interface
is the Samba Web Administration Tool (SWAT). SWAT offers robust help and allows you to easily
configure the smb.conf file. SWAT is a daemon that runs under inetd or xinetd. For RPM installa-
tions, simply install your OS’s SWAT RPM and move onto configuring Samba. If you rolled your
own binaries, you'll need to edit the services file and add swat 904/tcp. You'll also need to con-
figure inetd.conf or xinetd. conf based on the type of superdaemon your Linux distribution
uses. For inetd.conf, add the following statement:

swat stream  tcp nowait root /usr/samba/swat swat

For xinetd-based systems, such as Red Hat, create a file titled swat and place it in
/etc/xinetd.d. The contents of the file need to contain the following:

# description: SWAT is the Samba Web Admin Tool. Use swat \
# to configure your Samba server. To use SWAT, \

# connect to port 901 with your favorite Web browser.
service swat

{
port = 901
socket type = stream
wait = no
only from = localhost
user = root
server = /usr/samba/swat
log on failure += USERID
disable = no

}

To use SWAT, you'll need to either reboot your VM or restart the superdaemons. Point
your Web browser to http://<FQDN>:901/. If you can’t use Samba with your host’s FQDN, fix
DNS before proceeding. Implementing SWAT will rewrite your existing smb. conf file, so back
it up first; for the sake of easing Samba administration, stick to either the CLI or the GUIL

Tip Whether you have an affinity for GUIs or the CLI, you’ll want to download and install Webmin for your
Linux system from http://www.webmin.com. Webmin provides a powerful modular-based Web interface
for system administration, including BIND, Samba, Apache, NFS, Clustering, Backup, and Virtualmin—just to
name a few.

With the basic install of Samba out of the way, we’ll show how to configure Samba as a
domain controller (DC). Samba is Samba—that is to say, it's not a Windows NT 4 DC, and it’s
not a Windows Active Directory DC. Samba performs functionally the same as an NT 4 DC and
can integrate with a Windows Active Directory domain. Domains offer security and facilitate
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using shared network resources by using single sign-on techniques. You set up security for
Microsoft and Samba domains through a security ID (SID). SIDs are generated when an
object, such as a user account, computer account, or group, is added to a domain. You can
further enhance security by using the SID in conjunction with access control lists (ACLSs).

Note At the time of this writing, you can join Samba to an Active Directory domain. However, Samba
doesn’t support Active Directory. Also, for more detailed information about SIDs and relative IDs (RIDs),
refer to http://www.microsoft.com/resources/documentation/WindowsServ/2003/all/techref/
en-us/Default.asp?url=/Resources/Documentation/windowsserv/2003/all/techref/en-us/
w2k3tr_sids how.asp.

Configuring Samba as a Windows NT primary domain controller (PDC) simply requires
adding domain supporting stanzas to the smb.conf file and creating a few directory shares.
Being that Samba doesn’t have the ability to communicate with a Microsoft backup domain
controller (BDC) to synchronize domain-based data, you should create only Samba BDCs.
Let’s look at an example PDC smb. conf file:

[global]

workgroup = DOMAIN_NAME

netbios name = HOST NAME

security = share

encrypt passwords = yes

domain master = yes

local master = yes

preferred master = yes

passdb backend = tdbsam

os level = 65

preferred master = yes

security = user

domain logons = yes

logon path = \\%L\profiles\%u
logon drive = H:

logon script = logon.bat

logon home = \\%L\%u\winprofile\%m
domain admin group = root administrator
time server = yes

The global section configures Samba as a domain controller and as a master browser; it
also handles logons. Additionally, the stanza directs the logon path for roaming profiles and
logon scripts, and it sets the home directory. The entries are all fairly self-explanatory; we do,
however, want to discuss a couple of lines in particular: logon path, logon home, logon script,
and domain master. Table 8-5 lists several variables that can be easily used in Samba’s configu-
ration file to aid in its administration of users.
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Table 8-5. Samba Configuration File Variables

Variable Function Performed

%1 Client’s IP address

%m Client’s NetBIOS name
%M Client’s DNS name

%u Username

%H Home directory of %u

%g Primary group of %u

%S Current share’s name
%P Current share’s root directory
%h Server’s DNS host name
%L Server’s NetBIOS name

The logon path statement is in UNC format and is required if you want to implement
Windows 2000 and Windows XP roaming profiles. The variables in the statement specify the
server name (%L) and the username (%u). The logon home statement is also in UNC format; it
specifies the server name (%L) and specifies the username (%u) for the user’s home directory;
%m defines the NetBIOS name. The logon script statement directs clients to use a login script
file. As a word of caution, the script needs to be in MS-DOS format. If you use Vi to create the
script, run the colon command :se ff=dos to set the format of the file before inserting script
commands. Alternatively, you could create the file on a Windows system and then copy it
to the Samba share. If a path is specified for the file, it’s relative to the path specified in the
netlogon stanza. In the example, we're using a batch file. The domain master = yes statement
sets the server as the PDC. If the value is set to no, it's a BDC.

The netlogon section is required by Windows clients during the logon process; without it,
logon attempts will fail. This section also directs the location of logon scripts and policy files.

[netlogon]

path = /netlogon
read only = yes
write list = ntadmin

The profiles section defines the share required by Windows 2000/Windows XP roaming
profiles. Being that profiles need to be updated by the user account, notice that read only is
set to no. This is opposite of the yes setting in netlogon.

[profiles]

path = /profiles

read only = no

create mask = 0600
directory mask = 0700
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The homes section generates a share for a user to connect. The share correlates to the
user’s home directory in /etc/passwd. This process doesn'’t create the home directory but
merely facilitates network connectivity and browsing.

[homes ]

read only = no
browseable = no
guest ok = no

map archive = yes

The dir_share section is a generic data share for users to exchange files; it can be labeled
as anything.

[dir_share]

comment = Shared Directory
path = /data/share

read only = no

oplocks = no

guest ok = no

The Samba configuration file in this section doesn’t necessarily employ best-practice
standards for security, and you should follow up by implementing access control options to
protect data and verify directory share permissions. If you're unfamiliar with how to control
access to Samba shares, set up roaming profiles, or troubleshoot the problems you'll run into,
refer to the “Official Samba-3 HOWTO and Reference Guide” online. Whenever you make an
edit to the Samba configuration file, be sure to restart its service.

Adding client VMs to the Samba domain requires that the VMs be registered with the
Linux host and the Samba service; this procedure is analogous to creating computer accounts
in a Windows domain. The registration process is similar to creating a typical user account,
save one caveat. Computer account names need to have the same name of the VM and end
with $. Follow these steps:

1. Create the Linux computer system account with the two parts Samba requires: the
username and user ID. In the following code, the -d option designates that home dir
be set to /dev/null, meaning that a home directory isn’t created. The -g option sets
the group the account will belong to; the default is 1. You can use the group ID to add
the identification of VMs from physical systems but using different numbers. The -s
option sets the account’s login shell to /bin/false, which prevents logins. The -M
option prevents the system from creating a home directory for the computer account.
Notice that $ is appended to the name.

useradd -d /dev/null -g 100 -s /bin/false -M <Computer Name>$

2. Create the Samba service account. You don't need to do anything special for this step.
The useradd command did all the hard work. Notice that the computer name ends
with $. Once you've created the computer account, you can join the VM to the domain
using the same methods you typically use for Windows-based operating systems.

smbpasswd <Computer Name>$:<Computer Name>$
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To provide some redundancy for a Samba PDC, you'll need to create a BDC. A Samba
PDC/BDC-configured network is more akin to an NT-type network. Communications between
the domain controllers is best performed by utilizing LDAP on the backend to synchronize
password databases. Configure your PDC as the master LDAP server and each BDC as slave
LDAP servers.

Creating a Samba BDC requires a bit of preparation:

1.

The domain SID must match on the PDC and the BDC. Execute net rpc getsidto
retrieve and store the SID in secrets.tdb.

. The LDAP administration password needs to be configured by executing

smbpasswd -w mysecret.

. The smb. conf file needs to reflect either the 1dap suffix or 1dap idmap.

. User database synchronization must take place between the PDC and BDC for both

local and Samba accounts; you can use the LDAP master-slave relationship for this.

. The netlogon share requires replication between the PDC and BDC. This a good task

for alogin script.

. For clients to find the domain controllers, you'll need to either enable NetBIOS over

TCP/IP or add the appropriate service records to DNS.

. You must edit the slapd. conf file to reflect the master LDAP and slave LDAP relationship.

If you're content with an NT-style domain and aren’t integrating your Samba servers into an
Active Directory infrastructure, and if you're unfamiliar with configuring LDAP for PDC and BDC
servers, many sites on the Internet have excellent, well-documented configurations. To start with,
however, visit http://www.samba.org/samba/docs/man/Samba-Guide/happy . html#ldapsetup.

Using Samba with Kerberos Authentication

You can now take Samba to the next level by using a Kerberos authentication server. To
configure this option, you'll need to modify the smb. conf configuration file to reflect the
name of the realm and the name of the authenticating server. In the global section, you
need to add realm = <Realm or Domain Name>, security = server, and password server =
<FODN_of Kerberos Server>.When you use a Kerberos server for authentication, you don’t
need to use the smbpasswd file; however, if you want nondomain members to log on, you'll
need the file. When you put it all together, your configuration file for Samba should look
similar to Listing 8-1.

Listing 8-1. Samba Configuration File

[global]

realm = <Realm or Domain_Name>
workgroup = DOMAIN NAME
netbios name = HOST_NAME
security = server
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password server = <FODN of Kerberos Server>
encrypt passwords = yes
domain master = yes

local master = yes

preferred master = yes

passdb backend = tdbsam

os level = 33

preferred master = yes

domain logons = yes

logon path = \\%L\profiles\%u
logon drive = H:

logon script = logon.bat
logon home = \\%L\%u\winprofile\%m
domain admin group = root administrator
time server = yes

[netlogon]

path = /netlogon

read only = yes

write list = ntadmin
[profiles]

path = /profiles

read only = no

create mask = 0600

directory mask = 0700

[homes ]

read only = no

browseable = no

guest ok = no

map archive = yes

[dir_share]

comment = Shared Directory
path = /data/share

read only = no

oplocks = no

guest ok = no

Adding Samba to Active Directory

Adding a Samba server as a member server to an existing Windows 2000 or Windows 2003
mixed-mode domain requires your VM to have an account in the domain. In addition, you’ll
need to add or alter several lines in the smb. conf file to use Kerberos authentication. You'll
need to configure the file to reflect the name of the domain and the name of the domain con-
troller. In the global section, you need to add realm = <Domain_Name>, security = ADS and
password server = <FODN_of DC>.When you use Active Directory for authentication, you don’t
need to use the smbpasswd file; however, if you want nondomain members to log on, you'll
need the file. When you put it all together, your configuration file for Samba should look simi-
lar to Listing 8-1. As you probably already noticed, this process is similar to Samba using a
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Kerberos server. The exception is the security = setting. In addition, being that Active Direc-
tory creates DNS records for KDCs, it’s not necessary to modify the kbr5. conf file to reflect the
name of the authenticating server.

Before attempting to add the system to the domain, ensure that your current account has
the ability to authenticate to it:

kinit <USERNAME>@<DOMAIN_NAME>

To create the computer account for your Samba VM, execute the net ads command with
administrative privileges:

net ads join -UAdministrator
Execute the net ads command again to join the VM to the domain:
net ads join "organizational unit"

Verify that your Samba VM is part of the domain by opening Active Directory Computers
and Users to see if the computer account exists in the organizational unit you specified. If you
run into problems, make sure you're using the correct case for your usernames, domain, and
passwords, because Kerberos is case sensitive.

Setting Up Samba DFS Shares

Samba has the capability to serve Microsoft DES shares. You know from our earlier discussion
that DFS makes files and directories appear to be in a single directory tree on a single server
when they're really distributed across many disparate servers. By aggregating many network
file resources in one file system, network users can more easily find documents by using the
single point of access DFS creates.

Being that you want to configure Samba to serve DFS shares, you'll first need to create a
DFS root directory on the server as a share point. You then need to modify the Samba configu-
ration file to offer the share.

The DFS share can be any directory on your Samba server. When creating the directory,
make sure it fits with your administrative practices. For simplicity, we’ll show how to create a
share off the / directory:

mkdir /dfs

The root user account should own the directory, and you should set the permissions to
755. If you created the directory using an administrative account other than root, use chown to
reflect root as the directory owner:

chown root:root /dfs
chmod 755 /dfs
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You can add subdirectories in the DFS share to grant users the ability to physically store
files on the Samba server:

mkdir /dfs/client files

Creating additional shares in the dfs directory will treat a shared resource like a normal
share. Being that creating simple shares isn't the purpose of DFS, we’ll now show how to use
DFS for what it’s supposed to do—logically group disparate network resources into a single
reference or directory tree. Linux groups shares by using symbolic links. You can think of a
symbolic link as a shortcut to a resource or as a pointer. You'll use the 1n command to create
the links. Before you start creating links, first edit the smb.conf file and add the requisite code
to enable DFS. For example, use vi /etc/samba/smb.conf. Be sure to substitute the correct
path for your particular install of Samba.

Now follow these steps:

1. Create a stanza in the configuration file defining the DFS root:

[dfs]
path = /dfs

2. Enable DFS by adding host msdfs = yes to the global stanza:

[global]
host msdfs = yes

3. Finally, restart Samba:
service smb restart
4. Tt’s best to create the symbolic links from within the DFS root directory:
cd /dfs
5. Create alink to a share on a file server called vmfso01 called data:
In -s 'msdfs:vmfsol\data' data
6. If you shared an entire drive on a server, you use the 1n command similarly:
1s -s 'msdfs:vmfsoi\d' vmfso1l-d drive
As you've probably observed, the usage is similar to UNC, and the command follows the
form 1In -s msdfs:<server name>\<server share> <link name>.The -s option means you're
creating a symbolic link. As a few pointers, remember to use lowercase letters when creating
shares, and don’t worry about some commands reporting DFS links as broken links, such as

the file command. Samba knows that DFS symbolic links are on remote systems and will
direct clients accordingly.
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For easy access to the DFS root, Windows clients can map a drive to the DFS root, and
Linux clients can mount the DFS root. From within Windows Explorer, select Tools » Map
Network Drive; then select the drive letter to assign and specify the UNC path. For Linux
clients, you can use the smbmount command:

smbmount //<samba_server>/<dfs root directory> /<local dfs mount point>es
-0 username=<username>

or the mount command:

mount -t smbfs -o username=<username> //<samba_server>/<dfs root directory>

Introducing AFS

AFS is the distributed file system research project started at Carnegie Mellon University from
which the modern commercial release of AFS has its roots. The project used Andrew in its name
to honor the school’s founder Andrew Carnegie. Like DFS, AFS is a client-server distributed file
system that presents a unified view of shared directories on servers and workstations without
regard for the physical location of shared resources. AFS is now supported by IBM Pittsburgh
Labs where a branch of the commercial AFS source has been released into the public domain
as OpenAFS for development and maintenance.

ArlaAFS is another free AFS product. You can read more about ArlaAFS by visiting
http://www.stacken.kth.se/projekt/arla/. ArlaAFS has several cool features but isn’t as
heavily documented as OpenAFS, so we'll base our discussions on OpenAFS.

Note You can compile AFS into Samba using the - -with-dfs option (--with-afs is an older implemen-
tation); don’t confuse this with Microsoft DFS, - -with-msdfs.

AFS relies on the typical client-server relationship, and several versions of the software
are available for varying operating systems, from Windows to Unix. The file servers utilizing
AFS are responsible for file storage, file management, file requests, and security. Clients in the
AFS architecture provide the end user with a way to interact with the system. A site running its
own AFS system is called a cell. Cells are independent of other sites and are governed by the
site administrator. An administrator can join a site cell to other cells where the local filespaces
are joined into a global filespace. End users accessing a global filespace still see a single view
of the file system and need to know only the location of a file within the file tree, not the loca-
tion of the file server housing the files; the namespace provided by AFS maintains a uniform
file tree no matter the access point of a user.

Every site participating in the global namespace agrees to follow the same set of naming
conventions for pathnames. Creating the AFS filespace requires you to consider the needs of
the Cache Manager and not just the layout of the file tree itself. When creating the namespace,
you should adhere to the following:

e Pathnames begin with /afs.

¢ The cell name is the second component is the /afs pathname, such as
/afs/<cell name>.
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e Tertiary and deeper levels in the AFS file tree are site administered. However, best-
practice conventions dictate several third-level directories, as listed in Table 8-6.

Table 8-6. Suggested Tertiary AFS Pathnames

Directory Purpose

common Shared access to all files and programs for all authorized cell users

public Reserved for lookup and read access to anyone having access to the filespace,
including foreign users

service Used to help cells coordinate sharing
sys_type  Storage for client and server binaries
usr Home directories local cell users

wsadmin Reserved for the package program, which facilitates client configuration and updates

A local cell or home cell refers to the cell an end user initially authenticates, and all other
cells are referred to as foreign cells. We'll later discuss how to make foreign cells visible in the
local file tree. Joining a global filespace doesn’t remove local administrative control or bypass
ACLs. Users must have the appropriate permissions to use information in other cells. Access
to the global filespace takes place through the user’s local Cache Manager. The Cache Man-
ager resides on the user’s computer and is responsible for retrieving files and maintaining the
cache.

An AFS server runs several services to make the distributed file system function properly:

» The file server is responsible for delivering, saving, and storing files for AFS clients.

¢ The authentication server maintains the authentication database, provides secure net-
work communications by verifying user identities, and facilitates identity verification
for participant transactions.

» The protection server controls access to directories and files for users and groups.

* The volume server manages volume tasks, such as moving volumes between servers
and balancing workload between participating systems.

¢ The volume location server maintains the volume location database that records the
location of volumes on file servers and creates the illusion of transparent file access for
clients.

» The backup server allows the administrator to back up volume data to tape by main-
taining the backup database.

* The basic overseer server monitors the other AFS services to ensure they’re functioning.
This service aids administrators in system administration.

» The update server distributes AFS software updates and configuration information to
file servers to maintain software release homogeneity.

» The salvager is used in the event of the file server or volume server failing to repair
inconsistencies.

* The NTP daemon synchronizes system clocks so that the AFS distributed database
functions correctly for all system participants.
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The main administrative unit in AFS is the volume. Volumes logically correspond to directo-
ries in the AFS file tree and group files stored in the tree’s directory on a single partition. A volume
is a conceptual container that’s used to store related files and resides on a system partition; it can
have space quotas applied. Volumes tend to be small in size to aid in administration, such as
backing up volumes or the state of volumes or replicating volumes to other servers to increase
availability. A mount point associates a directory with a volume, and the directory is referred to
as the volume’s root directory. A mount point is like a symbolic link in the AFS file tree that associ-
ates a volume with the files in a directory.

Performance for AFS is increased by using replication and caching. Replication places a
read-only copy of files on a different server. Read-only attributes afford AFS the ability to bal-
ance load across several servers. On the client side of things, caching temporarily stores the
location of AFS files. This increases performance because network requests don’t have to be
generated every time the client needs access to the same file; the local Cache Manger already
knows the location of the file and can fetch it for the end user.

AFS provides security by using mutual authentication and ACLs. This is the process of a
server and client proving their identity to each other by knowing something in advance, such
as a password. If a client isn’t on the list of permitted users, access is denied. In addition to
servers protecting resources using mutual authentication, users can create their own ACLs
to manage who has access to their personal files.

Before creating the first cell for your site, you should consider a few issues, such as the cell
name, differences between AFS and system file and directory security, volume administration,
and client-server administration.

Whether you choose to be a part of a global namespace or not, your first AFS cell should
adhere to standard naming conventions for several reasons:

* Changing the cell name later is difficult and administratively taxing.

¢ Your home cell name is the second component in the AFS pathname and is what makes
the cell unique in the AFS global namespace. Unique cell names avoid path and file-
space conflicts.

* Cell performance can be adversely affected because of the way programs and processes
work. For instance, some commands execute in the cell of the client computer’s mem-
bership.

* The cell name is involved with security because the authentication server uses the cell
name with the user’s password for encryption keys. Changing a cell name means the
authentication database passwords won't match passwords created by the login utility;
users will be locked out of the filespace until updates are made to every machine’s
ThisCell and CellServDB files.

As you know, ACLs provide file and directory security with AFS, and even the end user
can use AFS to grant or deny access. Unlike Unix-like operating systems, AFS doesn’t solely
rely on mode bits for security. AFS disregards directory mode bits and uses the first set of
owner mode bits for security in conjunction with the ACL. The ACL has seven permissions
that can be granted.
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Being that all the files in one directory inherit identical security settings from the ACL, if
strict security is required for a specific file, a separate directory must be created. AFS furthers
security using blanket permissions with system groups: system:anyuser (literally any user of
the filespace) and system:authuser (authorized filespace users only). The system:anyuser
group is excellent for making information publicly available to anyone visiting a filespace,
such as via notices or documentation, and system:authuser is good for making common
applications and general file resources available to local users, such as via text editors’ site
documentation.

AFS volumes should be created in a manner that eases administration. To that end, be
aware that a directory in the file tree can be mounted to only one volume. When creating vol-
umes, the directories at the top three levels of the file tree should be configured with separate
volumes. Though you can create as many volumes as you want, this however doesn’'t mean
every directory in the file tree needs its own volume. For instance, you wouldn’t necessarily
want the subdirectories a user creates within their home directory to be on separate volumes.

Note Wnen creating volumes, you'll see they’re assigned a space quota of 5000KB blocks. In addition,
the ACL of the volume’s root directory is set to grant all permissions to the system:administrators group.

When naming volumes, you should be aware of some restrictions; the following list is by
no means comprehensive, though:

¢ Including extensions, the maximum volume name length is limited to 31 characters.
e Read/write volume names can be 22 characters long.

* Don't manually add .readonly and .backup extensions to volume names. The volume
server automatically adds extensions.

¢ root.afs and root.cell must exist and be mounted at /afs.

Tip When naming volumes or dealing with OpenAFS in general, refer to the http://www.openafs.org
Web site for help. Complete installation and administration documentation is available with thorough expla-
nations and helpful advice.

Administering AFS servers requires you to take into account the four roles a file server
performs. If you have more than one server, you can distribute these roles across several
servers; otherwise, you'll configure a single server as a simple AFS server. Table 8-7 outlines
the four roles any server can perform.
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Table 8-7. The Four Roles of an AFS File Server

Role Responsibility

Simple file server Stores and delivers files to clients

Database server Runs replication processes: authentication, backup, protection,
and volume location

Binary distribution server Distributes server binaries to other servers

System control server Distributes common server configuration files to other servers

and is a time source

You can create a cell with a single server or a cell with a server for each AFS role. Creating
a cell with a single server will assign the file server and database server roles to the machine
and will be the focus of our AFS implementation.

You can redirect common client files to AFS to conserve disk space if necessary. More
important, you can manage client configuration files by using the package program that
defines global configuration settings. The package program compares a client’s hard disk with
a configuration file for differences and then updates the client’s disk by copying information
from AFS. In addition, you can direct the package program to delete files on the client and
reboot the machine if necessary. The package program employs a prototype file to determine
which files reside on the client disk and to identify those that are linked to the site’s AFS. Some
benefits of using the package program are all site machines are automatically configured and
reconfigured, and organization disk structures are maintained across a site.

Implementing AFS

AFS is an enterprise-class file system providing a common namespace without regard for
physical boundaries to its clients. In a really reductive sense, you can think of it as creating
your own file manager that spans all systems in the network. Files can be stored on disparate
physical machines and viewed as if they were available in the local file tree; moreover, the
administrator or the end user can apply a varying level of security measures to the system.
You can download OpenAFS from the Internet for Linux or Windows at
http://www.openafs.org/release/latest.html.

The following steps provide a basic overview of a Windows install; they’re followed by a
Linux installation and configuration overview:

1. When launching the executable, you'll be required to choose the default language
before it self-extracts and starts the installation wizard. Be sure you have an NTFS-
formatted partition available before continuing.
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2. You'll first be presented with the Choose Components screen; at a minimum, install
the AFS client and AFS server. If this is your first experience with OpenAFS, install all
the available options, as shown in Figure 8-5. You'll want to explore them later. In aVM
environment, you can always start over with little time penalty. If you're curious about
the purpose of each option, the Description field briefly explains them.

2" DpenAFS 1.3.7700 Setup o =101 x|

Choose Components
Choose which Features of OpendF3 1.3.7700 you wank ko install, 5

Check the components vou want to install and uncheck the components vou don't want to
install, Click Mext b continue.

Select components ta install: AFS Client

M3 Loophack Adapter
AFS Server

AFS Control Center
Supplemental Cocumentation (-
[] Software Development Kit (S0K) LI

e
— Description

| v

Space required: 15.6ME Position your mouse over & component to see ks

description.

[dullsaft Install Sywstem W, 02

< Back I Mext = I Cancel

Figure 8-5. OpenAFS component options

3. After choosing the default installation directory for OpenAFS, you'll need to specify the
location of the CellServDB configuration in order to contact the AFS file server. Use
the default for the server, Use Package CellServDB File.

4. Being that you don't have a preconfigured Cel1ServDB file, on the Cell Name Configura-
tion screen select Next.

5. On the AFS Credentials screen, leave the defaults and select Install. The installation
takes several moments, especially on a VM. Upon completion of the install, you'll be
asked to reboot your server.
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With OpenAFS installed, you can move onto configuring AFS for your Windows system
server. You may receive a message stating that AFS failed to start, which is fine, seeing how AFS
isn't configured. The configuration process starts with the AFS configuration wizard, which
automatically starts upon login. Select Next on the Quick Start screen, and follow these steps:

1. On the Cell and Server Information screen (see Figure 8-6), select This Will Be the First
Server in a New AFS Cell. For the cell name, you'll need to choose a unique ID, such as
your domain name, and supply a good server password. The AFS server cell’s principal
account uses this password. AFS servers obtain tokens as principals, and the authenti-
cation server’s ticket granting service (TGS) uses the password to encrypt tickets that
clients present during mutual authentication. If you have questions as to what you
should do, the Help button offers excellent information. For instance, you'll find that
you should choose a cell name fewer than 64 characters using lowercase letters ending
in a conventional suffix (.com, .edu, .mil, and so on). Underscores and numbers are
acceptable, but you should keep in mind the conventions of cross-platform operating
system portability.

AFSE Server Quick-Start Wizard e |
Cell and Server Information

AFS Server An AFS cell is a collection of gervers that provide a uniform

v o) e namespace for file access.
Quick-Start Wizard f
™ Make this host & server in an existing &4FS cell

& Thiz will be the first server in a new AF5 cel

— Cell Mame
Enter the name of the AFS cell.

LCell narme: apress.com

— Server Pazzword

3 ; Enter the pazzsword for the AFS principal. All AFS servers get
Current Step: tokens a3 this principal.

[ ——] M ame: |afs
e

Pazzword: Ixxxxxxxx

Cell and Server
Information

Werify passward: Ixxxxxxxx

Cancel | < Back | MHext = Help

Figure 8-6. Cell and server information
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2. The wizard continues the install with the Administrative Information screen, where
you must supply the information for the cell’s administrative account. As shown in
Figure 8-7, leave the default for the AFS user ID.

AFSE Server Quick-Start Wizard e |
Administrative Information

AFS Server The information below iz needed to create the administrative
Ly g t fiar thi Il
l:.:_h-l‘“-k ___5 tart ”' I:H]TI ACCOUnt rar [his new ce

—Account Mame and Paszward

M ame: admiry

HREHREHK

Pazzword:

HREHREHK

Werify pazsword:

—&AFS LD

Enter the uger [0 for the AFS adminigtrative account:

Current Step:

¥ sze the nest available AF5 UID
| — . -

e  Use this AFS LD IU 3,

Administrative
Information

Cancel | < Back | Hext = I Help

Figure 8-7. Administrative information

3. Being that you're configuring your system as the first server in the cell, the wizard will
continue the installation after you opt to configure your computer as an AFS file
server. You'll then need to verify that the server will also be configured as a database
server and backup server. If you configure the database server as a backup server, all
database servers must also be configured as backup servers.
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4. You'll next be required to dedicate one NTFS volume to the AFS partition creation
process; the AFS partition delivers files and programs to AFS clients. The two are
virtually the same except that the wizard installs specialized metadata for tracking
AFS structures. Ideally, the partition will be an unutilized volume on your server. As
depicted in Figure 8-8, you should end the AFS partition name with the server’s physi-
cal drive letter.

AFs®E Server Quick-Start Wizard i ﬂﬂ

Create an AFS partition on thiz File Server.

AR C ooy Thiz File Server will store and deliver files and programs ta AFS
o g S "_1 clients. For data stored on this system to be shared via AF5, at
(T MY (e MU RGO |=ast one MTFS volume must be dedicated as an AFS partition,

An AFS partition is phyzically equivalent to a NTFS volume, but it
alzo containg specialized metadata about the structure and
lozation of information on the partition.

A partition muzt be created since thiz iz the first AFS Server in the
cell.

Select the volume to uze for the partition:

Yaolume | MName [or Emor Meszage] | Size |
Za N Drive containg data E134 ..

Current Step: EEYE L Mew Volume 4034

... O o=——
i

AFS Partition AFS Partition M amme: .-"viu:eple

Cancel < Back | Meut = I Help

Figure 8-8. AFS partition creation

Note All AFS servers must have one partition designated for storing AFS volumes, and all AFS
volumes must be designated as AFS partitions. You can create AFS partitions only on empty
NTFS volumes.
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5. Select Next on the root.afs and root.cell creation screen. This is an automatic proce-
dure for the first server in the cell along with replicating the cell’s root volumes on the
next screen.

6. On the System Control Server screen, elect to make your server the system control server.
This provides the common configuration files to AFS server system control clients. When
you install the Control Center with the AFS server or client, you don't have to configure it.

7. The wizard will end with a summary screen, as shown in Figure 8-9, where you have
the ability make changes or continue the configuration. Assuming you're satisfied with
your choices, select Configure.

AFSE Server Quick-Start Wizard 3 ilﬂ

Configure thiz host into cell myafsdomain_local.

AFS Server That iz all the infarmation needed to configure the AFS Server an
ary = = thiz zyztem.
Quick-Start Wizard
The fallowing configuration steps will be performed:
* [Create the AFS partition
® Start the Databaze Service [includez Backup Server)

Start the File Service

Start the Syztem Contral Server

Create the roat volumes

* Replicate the root volurmes

Current Step:

.|
s To begin configuration of thiz computer, press the Configure

- button. To change the configuration steps to be performed. press
k n
Configure the the Back button.

Aystem

Help |

Cancel ¢ Back

Figure 8-9. Host cell final configuration screen

After you reboot your server, you'll need to create user accounts and AFS directories for
your clients to use. This process is straightforward and requires you to have a good plan in
place for your directory tree structure. You can start by creating the volumes listed in Table 8-6
for a best-practice implementation.
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Start by creating your first user. Select Start » Programs » OpenAFS » Control Center »
Account Manager. Log in with the admin password, select the Users tab, and click Create. As
shown in Figure 8-10, supply a username and password. You can leave the User ID selection
as the default. If the account is going to be an administrator account, you can add it to the
system:administrators group by clicking Groups.

Q Mew uzer in cell myafzdomain. local

Marme: Iehalter
Pazaword; I""’“"“"‘x
HE'EntEf:] Ixxxxxxxx

Uszer D & Automatically use the nest available user 1D [2)

" Uze a specific user 1D |2 =

Ok | Cancel | Help

Figure 8-10. Creating user accounts

When you're done creating user accounts, close the Account Manager, and select Start »
Programs » OpenAFS » Control Center » Server Manager. Log into the Server Manager (see
Figure 8-11), and select the Volumes tab. Create volumes for common, public, service, sys_type,
usr, and wsadmin. When creating the volumes, you can select Backup, which creates a copy of
the volume within the site and appends .backup to the volume name. If necessary, change vol-
ume quotas as well.

With a remedial configuration for testing AFS completed, you can move onto client connec-
tivity. You'll need to use the same executable as that of the server. However, you'll just install the
AFS client. As shown in Figure 8-12, on the Choose Components screen, select AFS Client, MS
Loopback Adapter, and Supplemental Documentation.
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P AFS Server Manager b =3l x|
Cell Wiew Help

Selected Cell: myafzdornain. local

AFS Tokens: admin [tokens will expire 5e47:45 PR 2/9/2005)

afsroot

|

(3 volumes |@ Partitionsl é8 Servicesl

Al volumes in cell myafzdomain. local;

Yalune | Fartition | Type |
root.afs afsroot: Avicepe Fiead W rite
root.afs. readonly afzroot: Avicepe
roat. cell afzront: vicepe Read write
root.cell. readanly afsroot: Avicepe

1| | 0

LCreate... | [elete Beplication...l Set Wunta,. |

Figure 8-11. The Server Manager

2. 0penAFS 1.3, 7700 Setup

Choose Components
“hoose which Features of OpenaFs 1.3, 7700 you want ko install, @

Check the components vou want ba install and uncheck the components you don't wank to
install, Click Mext to continue,

Select components ka install:

M5 Loopback Adapter
D AFS Server

[] &Fs Contral Center
Supplemental Documentation ]
[] software Development Kit (SDK) .

T le
Description

Space required; 12,2MB

[ < Back ” Mext = ] l Cancel

Figure 8-12. Client installation components
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Now follow these steps:

1. Install the OpenAFS software in the default location, and on the CellSrvDB Configura-

tion screen use the default setting for the Cel1SrvDB file.

2. On the Client Cell Name Configuration screen, shown in Figure 8-13, enter your cell’s
AFS name and leave the default options. The cell’'s name should be similar to your site’s
domain name, such as apress.com. Next, select Install on the AFS credentials screen,

and reboot your system upon completing the software install.

3. OpenfkS 1.3. 7700 Setup

Client Cell Name Configuration
Please enter the name For wour default cell: §

Enter AFS myafsdomain.lacal |
cell name:

‘ol may now configure some inskallation options that control how the AFS Client
behaves.

Enable AFS crypt security (Recommended)
Enable AFS Freelance client (Recommended)
Use DNS ta Search for Cell Servers

Use Integrated Logon

OEEE

[ = Back ” Mext = l [ Cancel

Figure 8-13. Client cell name configuration

3. Once your system reboots, it’s time to finish configuring the AFS client. An open lock

with a red X should be visible in your system tray. Double-click the lock to open the

AFS client; the interface should look similar to Figure 8-14.

& AFS Client :

Takens | Drive Letters | Advanced |

Cell: myafzdomain.local
Tokens: admin  [tokens expire 2:37:19 P 2/9,/2008]

™ Show a warning before these tokens expire

Dbtain Mew Tokens... | Dizcard These Tokens Help

Currently logged on to Windows Netwaorking as "Administrator” AFS Version 1.3 7700

Figure 8-14. AFS client configuration
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4, Select Add on the Drive Letters tab. We'll configure the client to use the H drive to
connect to the usr share on the AFS server. Notice that in Figure 8-15 we're using the
absolute path of the share on the AFS Path line. The Submount option will supply a
friendly name for the mapped drive letter. We chose the word home.

Map Drive Letter i x|

Yol can map drive lethers on pour computer bo paths in AFS,

For ingtance, if pou map O: as hafghacme comwsribob, then the files available in
AF5 as hafshacme.combusribobh™ will be wvisible in 0%

Drive Letter: IDrive H: 'I

AFS Path: I'\afs\m_l,lafsdnmain.Incal\usr'\ehaltel

Submount; Ihu:ume

¥ Bestore thiz mapping whenever | logon

QK I Cancel Help

Figure 8-15. AFS client drive mapping

5. Select the Advanced tab, and click Configure AFS Client. Make sure the cell name cor-
rectly reflects your AFS configuration. On the Preferences tab, add your server’s name,
and on the AFS Cells tab, add your cell. When you're done with the Advanced settings,
select the lock from the system tray and log in by requesting new AFS tokens, as shown
in Figure 8-16. When you're done, you should see the drive letter mapping in Windows
Explorer.

Obtain New AFS Tokens . x|

To obtain new AFS tokens, enter your &FS uzer name and the
pazsword for your AFS account. You can have tokens in multiple
AFS cellz simultaneously.

AFS Cell: Im_l,lafsdu:umain.lcu:al

Jszer Mame: Iehalter

Pazswaord: I’“‘*’“"“"‘1

(] I Cancel Help

Figure 8-16. Obtaining new AFS tokens
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Installing AFS for Linux Systems

To install AFS on a Linux system, you can download the software from the OpenAFS Web site.
If you're new to OpenAFS, your best shot at getting a server up and running is to install the
RPMs for your particular distribution of Linux. As a heads-up, we'll take a shotgun approach
to installing AFS and assume you're installing AFS in a test environment; you’ll have to think
on your feet and make operating system/path adjustments to the steps as we blast through
the configuration.

To get started, download all the packages for your flavor of Linux. If necessary, recompile
the AFS kernel for your distribution of Linux. Make sure your server has sufficient disk space
to be an AFS server for each role it will be playing. If you're setting up a VM as an AFS server,
you can always add virtual disks later. Before getting started, make sure you've created a dedi-
cated partition for AFS and mounted it as a directory in the format /vicepxx, where xx is one
to two lowercase letters. Also, start the AFS initialization script. If you decide to use the RPMs,
you'll need to recompile the AFS kernel for your distribution of Linux.

Note You may receive error messages during the configuration of your AFS server by using the -noauth
option. If this happens, continue with the configuration, because this is reasonable being that -noauth dis-
ables authorization checking. Additionally, make sure your systems are time synchronized using a reliable
protocol, such as NTP.

Follow these steps:

1. Verify that the necessary local directories for AFS to function were created during the
install process, and start the AFS initialization script:

1s /usr/afs

1s /usr/vice

1s /usr/vice/etc
./etc/rc.d/init.d/afs start

2. Create at least one AFS partition or logical volume. The partition should be mounted at
a directory named in the format /vicepxx, where xx is one to two lowercase letters. In
our example, we created a second VM SCSI disk for AFS:

mkdir /vicepa

3. Edit /etc/fst to map the directory to the AFS disk partition:
/dev/sdb1 /vicepa ext2 defaults 0 2

4. Create the file system on the partition:
mkfs -v /dev/sdb1l

5. Mount the partition:

mount /dev/sdb1 /vicepa
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Change to the bosserver script directory, and execute it with the -noauth option. The
-noauth option disables authentication to your cell and compromises security. Make
sure you adequately protect your system during this phase of the configuration process.
You can set your VMs to host-only mode or use a NAT device. If you unplug your patch
cable or disable your NIC, make sure name resolution continues to function:

cd /usr/afs/bin
./bosserver -noauth

The script creates several directories and sets the appropriate permissions on the
directories for the root user account. The directories created are as follows:

/usr/afs/db
/usr/afs/etc/CellServDB
/usr/afs/etc/ThisCell
/usr/afs/local

. Verify bosserver created /usr/vice/etc/ThisCell and /usr/vice/etc/CellServDB:

1s -1 /usr/vice/etc

. Assign your cell name to the AFS server:

cd /usr/afs/bin
./bos setcellname <server FQDN> <cell name> -noauth

. Use bos setcellname to set the cell name:

cd /usr/afs/bin
./bos setcellname <server FQDN> <cell name> -noauth

Issue bos listhosts to verify the name configuration:
./bos listhosts <server FODN> -noauth

Configure the four AFS database services to start: authentication server, backup server,
protection server, and VL server:

./bos create <server FQDN > kaserver simple /usr/afs/bin/kaserverw=
-cell <cell name> -noauth
./bos create <server FODN > buserver simple /usr/afs/bin/buserver=
-cell <cell name> -noauth
./bos create <server FQDN > ptserver simple /usr/afs/bin/ptserver=
-cell <cell name> -noauth
./bos create <server FODN > vlserver simple /usr/afs/bin/vlserver=
-cell <cell name> -noauth

Configure basic cell security, and create the authentication database for admin and afs.
You'll be asked to supply and verify the passwords for each after passing the create
command:

kas -cell <cell name> -noauth
create afs
create admin
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13.

14.

15.

16.

17.

18.

19.

20.

21.

Use kas setfields to enable the administrator to use privileged kas commands, and
then execute quit:

setfields admin -flags admin
quit

Add admin to the /usr/afs/etc/UserList file to use privileged bos and vos commands:
./bos adduser <server FQDN> admin -cell <cell name> -noauth

Use bos addkey to configure the server encryption key:

./bos addkey <server FODN> -kvno 0 -cell <cell name> -noauth

Execute pts createuser to create the admin protection database entry. You should use
the same local user ID for root as admin:

./pts createuser -name admin -cell <cell name> -id <AFS _UID> -noauth
Use pts adduser to add admin to the system:administrators group:
./pts adduser admin system:administrators -cell <cell name> -noauth

Run the bos restart command to restart the server processes with the newly created
encryption key:

./bos restart <server FQDN> -all -cell <cell name> -noauth

Initialize the file server processes, file server, salvager, and volume server, and verify
that they start:

./bos create <server FQDN> fs fs /usr/afs/bin/fileserver
/usr/afs/bin/volserver

/usr/afts/bin/salvager -cell <cell name> -noauth

./bos status <server FQDN> fs -long -noauth

Create the root.afs volume:
./vos create <server FODN> /vicepa root.afs -cell <cell name> -noauth
Use bos create to start the update server, making it a binary distribution point:

./bos create <server FQDN> upserver simple "/usr/afs/bin/upserver=
-crypt /usr/afs/etc -clear /usr/afs/bin" -cell <cell name> -noauth

Your AFS server is now configured as a binary distribution server, database server, file
server, and system control server. You can configure your server as a client machine to help
aid in administration. You'll need to perform several tasks to add AFS client functionality to
your server. Please keep in mind that you'll need to adjust virtually every step for the distribu-
tion of Linux you're using. We're merely providing you with an installation summary.
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Follow these steps:

1.

To begin, you'll need to download and install several packages from the OpenAFS
Web site: openafs, openafs-kernel, openafs-kernel-source, openafs-compat, and
openafs-client. If necessary, recompile the AFS kernel for your distribution of Linux.
Next, make sure PAM is configured to allow log in. Edit pam.d/login to reflect AFS’s
needs. Make sure you change the path of the statement to meet the requirements of
your operating system:

auth sufficient /lib/security/pam afs.so try first pass ignore root

. Execute ./configure and then make from within the open-afs-kernel directory.

. Copy the new module in the modload directory:

cp MODLOAD-XXXS/libafs-XXXS.o /usr/vice/etc/modload/

. From the modload directory, add the module to the AFS SymTable:

cd /usr/vice/etc/modload
./afsmodname -f SymTable -g libafs-XXXX.o

. Edit ThisCell to add your local cell information, or copy it from the server. You'll prob-

ably get better results by copying the file from the server to your workstation:

cp /usr/afs/etc/ThisCell ThisCell

. Add local cell information to the Cel1ServDB file. The format of the file is as follows:

>cell name #organization
IP_Address #machine FQDN

A typical example might look like the following:

>apress.com #Apress (home cell)
192.168.100.1 #db1.apress.com
192.168.100.2 #db2.apress.com

. Create alocal AFS cache file on your hard disk to increase performance for frequently

accessed files. Assuming you have enough memory, you could create the cache in
RAM. To take advantage of the file, you'll also need to initialize the Cache Manager:

mkdir /usr/vice/cache
# echo "/afs:/usr/vice/cache:25000" > /usr/vice/etc/cacheinfo

. Create the /afs directory for the Cache Manager to mount the filespace:

mkdir /afs

. Copy the afsd file from the /usr/vice/etc directory to /etc/sysconfig. Omit the .conf

file extension:

cp /usr/vice/etc/afs.conf /etc/sysconfig/afs
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10. Edit the afsd options file to set the startup values. You can adjust the startup values

11.

according to your needs, which will vary if you use a memory-based cache rather than
a disk-based cache. You'll need to refer to the AFS documentation to tweak this. If you
don’t perform this step, the Cache Manger will supply its defaults:

vi /etc/sysconfig/afs
-stat 3500 -daemons 5 -volumes 150

Initialize the AFS client, and log in:

./afs start
klog USERNAME

12. You should be able to navigate to the AFS filespace as you would any other directory

on your computer using cd.

To make a foreign cell visible in a local cell’s file tree, you must mount the foreign site’s
root.cell at the second level in the AFS file tree, mount AFS at /afs on client computers, and
add a database entry in Cel1ServDB for the foreign cell’s database server. Follow these steps:

1.

Use the s mkmount command to mount the cell’s root.cell volume at the second level:

fs mkmount <directory> <volume name> -cell <cell name>

. Make the afsd program mount AFS at /afs by using a text editor to modify cacheinfo.

The afsd program automatically mounts the first directory listed in cacheinfo. Failing
to mount clients at /afs will prohibit clients from viewing the filespace of foreign cells
that are conventionally mounted using best practices. The first entry in the cacheinfo
file looks like the following:

/afs:/usr/vice/cache:25000

. Add a database server entry to Cel1ServDB to client machines that need access to the

foreign cell’s filespace. One method is to use a text editor.
vi /usr/vice/etc/CellServDB
Remember that the format of the file is as follows:

>cell name #organization
IP_Address #machine FQDN

A typical example might look like the following:

>apress.com  #Apress (home cell)
192.168.100. #db1.apress.com
192.168.100.2 #db2.apress.com
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If you want to make your filespace visible to foreign cells, remember that foreign users
are granted default permissions of the system:anyuser group by a directory’s ACL. Generally,
the permissions are limited to 1 (lookup) and r (read). If you want to grant foreign users addi-
tional access, you can modify the directory’s ACL or give the foreign user a local account. In
addition, you should follow best practices and create the upper level of the AFS filespace as
suggested on the OpenAFS Web site. You'll also want to visit the OpenAFS Web site to read up
on how to increase security and increase the usability of your cell by making documentation
and binaries available to AFS clients.

Summary

In this chapter, we discussed how to configure and deploy your own custom filespace with
DFS and AFS virtual file systems. In addition, we covered how to integrate open-source oper-
ating systems with DFS in a Microsoft domain. We touched on basic security issues and best
practices for distributed file systems. In Chapter 9, you'll explore another common virtualiza-
tion technology used today, server clustering. We'll introduce how to deploy server clusters
and discuss server clustering management techniques.
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Implementing Failover Clusters

For many organizations today, data must be available practically every second of every day.
Unfortunately, computers, networks, and storage fail, no matter how much you pay for them.
This is where clustering comes in. Simply put, a cluster consists of two or more computer
systems acting and managed as one. Clients access the cluster using a single host name or
IP address, and one of the systems in the cluster answers their request. We'll explain cluster
configurations shortly.

The purpose of cluster technology is to eliminate several single points of failure. When
data availability is paramount, clustering is ideal. Consider the following single points of fail-
ure you can eliminate by using a failover cluster:

* Network card failure

* Processor failure

* Motherboard failure

* Power failure

 Cable failure

* Network failure

With a cluster, you can basically eliminate nearly any hardware failure associated with a

single computer. If hardware associated with one system fails, the other system will automati-
cally take over. Here are some of the typical reasons for implementing a cluster:

* To increase the availability of mission-critical applications such as Oracle database
servers and Exchange mail servers

* To increase the availability of file and print servers

* To reduce downtime caused by hardware failures and routine maintenance

In this chapter, we'll start by covering the necessary buzzwords you need to understand
when planning and implementing failover clusters, and then we’ll show you examples of
failover clusters on two popular OS platforms: Windows Server 2003 Enterprise Edition and
the Linux High Availability Project software running on Red Hat Enterprise Advanced Server
3.0. Since the point of this chapter is to get you familiarized and started with failover cluster-
ing, we won't cover every possible nuance and gotcha with failover clustering (countless books
that are hundreds of pages long already do this). Instead, we’ll show you how to successfully

implement both Windows and Linux failover clusters. 309
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Introducing Failover Clustering

Failover clustering typically employs some form of shared storage even though it'’s not a
requirement with Linux clusters. Shared storage usually exists on an external shared storage
bus (Fibre Channel, SCSI, or iSCSI), with access to the shared storage managed either by the
cluster service software or by Distributed Lock Manager (DLM) software. The technology that
determines how shared storage is accessed varies by OS and clustering application. Many OS
clustering technologies, such as Windows Server 2003 clusters, manage shared disk access
themselves. Others, often from third-party vendors, incorporate a DLM. To put all of this into
context, Figure 9-1 shows a simple two-node cluster.

Shared
Storage
Heartbeat

Node1 Node2

Figure 9-1. Two-node failover cluster

In Figure 9-1, two physical computers share a common storage source. Using the com-
mon shared storage makes data management in the cluster much easier. This is because with
data living in one central location, you don't have to worry about keeping data synchronized
on each node, assuming each node locally keeps its own copy of the cluster’s data. Most often
the shared storage has some form of built-in redundancy, such as with the use of hardware
RAID. With applications that require both read and write data access and high availability,
failover clustering is almost always a good fit. Shared storage can provide for the read/write
access to a central data store, and the clustering application or service can ensure that if a fail-
ure is detected, the second (or next) node in the cluster assumes control of the virtual server
being managed by the cluster.

If that last paragraph was a mouthful, let’s break it down a little further. Failover clusters
allow you to run one or more “virtual servers” on top of two or more physical computers. The
physical computers in the cluster are most often referred to as either nodes or real servers,
depending on the clustering application and operating system. The virtualized computer
running on the cluster is usually called the virtual server or virtual host. A virtual server is
controlled by only one node at a time. The node controlling the virtual server will lock the
shared disk resources used by the virtual server so that no other node in the cluster attempts
a write operation at the same time as the virtual server.
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Also notice that Figure 9-1 has a connection labeled heartbeat. This connection is typically
either an Ethernet connection via a crossover cable or a serial interface connection between
the two nodes. For larger clusters, the heartbeat is typically connected via a dedicated switch.

Defining Essential Terms

Like nearly all aspects of IT, clustering comes with its own unique vocabulary. The following
are the most common terms you'll hear:

Cluster communications: This is the means by which two or more cluster nodes com-
municate. Communications can occur through a private (cluster node-only) network
segment or mixed (cluster nodes and clients) network segment.

Cluster disk: This is the physical hard drive that’s shared by two or more cluster nodes
using a shared data bus, which can be a SCSI or a Fibre Channel bus.

Private disk: This is the hard disk on each physical node that’s used to store the node’s
OS, applications, and swap file.

Cluster node: This is the physical system participating in the cluster. The node is often
referred to as a real server (RS) in Linux cluster implementations.

Heartbeat: This is the periodic communication between cluster nodes using User Data-
gram Protocol (UDP) datagrams in order to determine if a node is running; each cluster
node will listen for the heartbeat of all other nodes. The heartbeat connection can be
established over the public LAN, a dedicated crossover cable, or a dedicated serial
interface connection.

Quorum resource: In Windows and Red Hat Linux clustering, this is the disk or disk
partition that contains the cluster’s management and configuration data and its recov-
ery log.

Virtual server: This is typically a collection of cluster nodes that appear as a single
server to clients. Like all network servers, a virtual server will have a network name and
IP address.

Failover: This is the process of a virtual server moving from one physical node in the
cluster to another. Failover is usually caused when another node in the cluster fails to
receive heartbeat packets from the virtual server’s active host node.

Failback: This occurs when a virtual server’s original or designated preferred host returns
online following a failure. When a failback occurs, a virtual server is automatically moved
by the cluster service back to its preferred host.

With an understanding of some of the terminology, you'll now examine the available clus-
ter architectures.
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Introducing Cluster Architecture

Failover clusters are characterized as either active-passive or active-active. The following sec-
tions describe the differences between these two configurations.

Active-Passive Clusters

In an active-passive cluster configuration, one node has complete control of the shared
resources, and the other node monitors the active node for failure. If the active node fails,
then a passive node will assume control of the shared resources, which typically is a disk stor-
age array, possibly incorporating hardware RAID. Figure 9-2 shows the basic configuration of
an active-passive cluster.

Shared
Storage

Active Passive
Node Node

Figure 9-2. Two-node active-passive cluster

Both nodes are always physically connected to the shared storage, but only the node that
controls the storage can access it. This is known as shared nothing architecture, which means
that no shared resources can be accessed by multiple nodes simultaneously. In other words,
only the active node can perform reads and writes to the shared disk. With the active-passive
approach, one cluster node does nothing except monitor the active node for failure. For some
organizations, this approach is more difficult to justify economically, since without a failure
the passive node does little more than consume electricity.

Active-Active Server Clusters

In an active-active cluster configuration, two or more cluster nodes actively host virtual
servers. Active-active clusters are usually an easier sell to the bean counters because each
node in the cluster is actively hosting a virtual server and isn’t merely sitting idle.
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Tip An easy way to think of an active-active cluster is as two or more active-passive clusters combined.

For example, suppose you want to have failover capability for both your Exchange and
SQL servers. You could store each server’s data on separate physical disks in a shared SCSI disk
array. Connect both servers to the array, and then install and configure the Microsoft Cluster
Service. You can then look at your SQL server as the standby Exchange server, and vice versa.
If one fails, the other server will act as both servers. In essence, you have an active-passive
Exchange server with node 1, for example, being the active node and an active-passive SQL
server with node 2 being the active node. When looking at the cluster as a whole, both nodes
are active, giving you an active-active cluster. Figure 9-3 shows this configuration.

SQL Data

SQL Logs

Ex Data

Ex Logs

Active: SQL Quorum Active: Exchange Quorum

Passive: Exchange Quorum Shared Storage Passive: SQL

Figure 9-3. Exchange-SQL active-active cluster

Introducing N-tier Clustering

Many cluster application vendors describe their cluster architectures as either N-to-1 or
N-plus-1. In an N-to-1 architecture, one node in the cluster is designated as the passive node,
leaving it available to handle failover if an active node in the cluster fails. Figure 9-4 shows

a three-node N-to-1 cluster. Notice that Nodel is active for Oracle and Nodez2 is active for
Apache. If either active node fails, Node3 will assume its role. In this architecture, Node3 is
always designated as the passive node, meaning that the primary active node returns online
following a failure, and the service will failback to the primary node. While this approach
offers simplicity, having automatic failback means that the failed service will be offline twice—
once during the initial failover and again during the failback.
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AN 0

Node1 Node2 Node3
Active Oracle Active Apache Passive

Fibre
Channel Switch

Shared
Storage

Figure 9-4. Three-node N-to-1 cluster

N-plus-1 clustering offers a different approach. With N-plus-1, a standby (passive) node
can assume control of a primary node’s service when the primary active node fails. However,
when the active node returns to service, it then assumes the role of the passive node. This
means that in time, the active node for each service managed by the cluster may be completely
different than at the time the cluster was originally set up. However, automatic failback isn’t an
issue with this approach, thus providing for better overall availability.

Working with Failover Cluster Products

Now that we've covered the general architecture of failover clusters, we’ll show a sample of
some of the available clustering products. Table 9-1 lists some of the most common clustering
solutions available for both Windows and *nix platforms.
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Table 9-1. Available Failover Cluster Products

Service/Application 0s Maximum Vendor URL
Number
of Nodes

Linux-HA 1.x Linux, 2 http://www.linux-ha.org
FreeBSD,
Solaris

Linux-HA 2.x Linux, 8 or more http://www.linux-ha.org
FreeBSD,
Solaris

Microsoft Cluster Service Windows Server 8 http://www.microsoft.com
2003 Enterprise/
Datacenter

Microsoft Cluster Service Windows 2000 4 http://www.microsoft.com
Datacenter Server

Microsoft Cluster Service Windows 2000 2 http://www.microsoft.com
Advanced Server

PolyServe Matrix Server Windows 2000/ 16 http://www.polyserve.com
2003, SuSE/Red
Hat Linux

Red Hat Cluster Suite Red Hat Enterprise 8 http://www.redhat.com
Advanced Server

Veritas Cluster Server AIX, HP-UX, 32 http://www.veritas.com

Solaris, Windows

As you can see, you have many choices when it comes to configuring failover clusters. While
the configuration steps of the various clustering products differ, architecturally they’re nearly
identical. With that in mind, next we'll cover some general cluster planning considerations.

Planning for Failover Clusters

Failover cluster planning begins with choosing the right model as the foundation for the
cluster service. Before getting to cluster model selection, let’s take a moment to review the
fundamental hardware requirements for failover clustering. The hardware requirements are
as follows:

* Atleast one external shared disk connected to each node through a PCI SCSI, Fibre
Channel controller (required in most commercial implementations), or iSCSI via a
Gigabit Ethernet controller

¢ Atleast one NIC (two recommended) in each node

* Appropriate cabling and termination for shared storage
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Note You must consider several issues when connecting cluster nodes to shared storage in a SAN.
Chapter 12 will discuss these issues in detail.

Take the following points into consideration when planning a shared storage configuration:

e For Windows clusters, each disk must be configured as a basic disk, with each partition
formatted using NTFS.

¢ Each SCSI drive and SCSI adapter must have a unique SCSI ID.
¢ All drives used by the cluster must be physically attached to each node in the cluster.

e Prior to installing the cluster service, power up each node individually and verify that
the node can access the shared storage.

Tip The SCSI ID on most host adapters is set to 7 by default, so you'll need to change the ID of the sec-
ond node’s adapter in two-node clusters with shared SCSI-attached storage.

When planning the cluster network configuration, consider the following:
e Each virtual server must have a unique host name.
¢ Each network adapter and virtual server should have its own static IP address.

» For Microsoft clusters, all nodes in the cluster must be joined to the same domain, and
a domain user account must be created for use by the Cluster Service.

Choosing the Right Model

Failover clusters are built using the format from any of five different models. The model you
choose will depend on the current and future needs of your organization. The following
sections will outline each model, its pros and cons, and how it’s best used.

Single-Node Model

The single-node model is the simplest of all cluster models. While the phrase single-node
cluster may seem like an oxymoron, trust us—it’s not. Figure 9-5 shows the concept of a
single-node cluster.
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Figure 9-5. Single-node virtual mail server cluster

The single-node model has the following advantages:

e It can be the first stage of an eventual multinode cluster implementation.

* It allows you to take advantage of a cluster service’s automatic-restart ability for failed
applications.

Here are some reasons why you wouldn’t want to use this model, though:

¢ No other nodes are available for failover.

e Ithas a single point of failure.

* You'd need to invest in external Fibre Channel or SCSI storage, even though internal
storage for a standard server is much cheaper.

Taking advantage of the automatic-restart ability of clustering will keep your applications
and services up more consistently. Also, if you're working with a small budget, the single-node
model could be the first step in the eventual rollout of a multinode cluster.

Gaution Not all applications can run in a virtual server on a single-node cluster. Always check the appli-
cation’s documentation, and test the configuration before placing the single-node cluster in your production

environment.
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Dedicated Secondary Node (Active-Passive) Model

The standard active-passive model provides the failover capability not found in the single-
node model. This model type was shown earlier in Figure 9-2.

As you can see, with this model, the active node manages all cluster virtual servers,
and the passive node stands by in the event the active node fails. Upon failure of the active
node, the passive node will then become active, servicing all cluster virtual servers.

This model offers the following advantages:

 Provides failover capability

* Removes a single node’s associated hardware as single points of failure

Here are two reasons why some avoid this strategy:

¢ The passive node doesn’t manage any cluster resources or groups until the primary
node fails.

 This requires investment in hardware that’s utilized only when the primary node fails.

Note Remember that all cluster nodes must meet the minimum hardware and software requirements of
all applications run in virtual servers. Each cluster node must have the hardware resources required to run
all applications that have the capability to failover to it.

Some have trouble justifying a server whose job is essentially to stand by in the event that
another server fails. Because of this, many implement active-active clusters instead, which
will be described momentarily.

Dedicated Secondary Node (Active-Passive) Split Model

The active-passive split model operates similarly to the standard active-passive model. The
primary difference between the two is that with the split model, the active node services both
clustered and nonclustered applications.

Applications that don’t support failover can’t use the cluster’s shared disks. Instead, all
application data must be installed on a cluster node’s local disk. Remember that with this
approach, if the cluster node fails, so does the application. However, some applications can’t
be clustered, and this approach allows you to get more use out of the active cluster node.

High Availability with Static Load Balancing (Active-Active) Model

Many prefer the static load-balanced active-active model because it entails running clustered
applications on each cluster node. This model makes it much easier to justify your cluster
expenses. Figure 9-3 earlier showed the typical active-active cluster configuration.

With active-active clusters, each node in the cluster must be able to take on the resources
required by virtual servers active in any other node. For example, if a clustered application
requires 256MB of RAM, each cluster node must have 256MB of available memory in case it
has to host the application. Remember that if a node fails, another node in the cluster may be
slowed down by having to service too many applications. However, most would rather have
two slow servers for a brief period of time than one failed server.
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Here’s a summary of the primary reasons for using the active-active cluster model:
* No servers are “wasted” as standby servers.

» Two applications can be statically load balanced over two nodes, as opposed to running
both applications on a single node.

» Multiple instances of the same application can be statically load balanced over several
nodes. This technique is helpful when a single server, no matter how large, can’t handle
the load placed on it by its clients.

* When all nodes are up, application performance is typically better than running multi-
ple applications on a single node.

The lone disadvantage to this approach is that all nodes must have adequate hardware
resources to assume the role of another node if needed.

Hybrid Model

As with other network concepts, the term hybrid implies a mix, or combination, of other mod-
els. The typical hybrid model involves active-active clusters that also service nonclustered
applications. This model allows you to use your cluster nodes as network servers for other
applications, as opposed to using them exclusively as a part of the cluster.

Once you've chosen your cluster model, your next course of action is to configure the
cluster node hardware.

Configuring Cluster Hardware

In a perfect world, when you build a cluster you'll start with new servers with identical hard-
ware configurations. While this isn't always possible, you should try to match the hardware
configurations of each node as closely as possible.

To begin, any PCI SCSI or Fibre Channel HBAs that connect to shared cluster storage
should be installed in identical PCI slots on each node. This is critical for clustered applica-
tions to see the data path to the shared storage the same way, regardless of which node the
application is actively running on.

Once the shared storage is configured, you should at this point validate that each node can
properly access the storage. You can best accomplish this by powering on one node at a time
and validating connectivity to the storage. You should also configure a mount path or drive letter
to the storage at this time as well. Each node must use the same mount path or drive letter to
access the shared storage in order for the cluster to properly function.

With the shared storage ready to go, your final task will be to configure the network. Ide-
ally, each node will have at least two network interfaces. One interface should be dedicated for
the heartbeat network, and a second interface should be configured for client access and for
failover of the heartbeat network. If the heartbeat crossover cable fails, for example, and the
cluster isn’t configured to use a second network for the heartbeat, each node may assume that
the other node is down and attempt to take control of the virtual server. This can result in both
nodes in a cluster trying to service the same virtual server and thus both writing to the same
shared storage. This problem is known as split brain and can be avoided by having at least two
potential networks for the cluster heartbeat.
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With the network and storage set up, your final task is to install and configure the cluster-
ing service or application to be used to provide for failover clustering. Next, we'll cover
configuring the Microsoft Cluster Service (MCS). Later, we'll show how to configure Linux
failover clusters.

Setting Up Microsoft Server Clusters

Microsoft refers to its implementation of failover clustering as server clustering. With so many
technologies in IT having so many different names, why not do the same with clustering? Well,
at least that’s how Microsoft sees it.

In the following sections, we’ll cover some of the vocabulary and configuration that’s
unique to MCS and will then show you the steps for setting up a Windows server cluster.
Finally, we’ll wrap things up by covering the general management of Windows clusters.

Looking Under the Hood

With the foundations of clustering behind you, you're now ready to dive a little deeper into the
service itself. The Cluster Service actually consists of several components, collectively working
as one entity. At this point, you're probably thinking, “Why should I bother with the details? I
just want to use the service!” If you like details, that’s great. If not, read this anyway. The rea-
son for being aware of the Cluster Service components isn't to help you now, necessarily, but
to make your life easier when things go wrong. We'll provide you with brief descriptions of the
core components of MCS.

Resources and Groups

Resources and groups are the principal elements of server clusters. Resources define objects
controlled by the Cluster Service. Some examples of cluster resources are as follows:

¢ IP address: Provides IP address of virtual server
¢ Network name: Provides virtual server NetBIOS name
 Physical disk: Defines access to shared disk for use by a virtual server

* Print spooler: Defines print queues for network-attached printers

Notice that with the IP address and network name resources, we used the term virtual
server. When you place an IP address resource and network name resource in the same group,
you have a virtual server. As long as the resources are online, clients on the network can access
shares and even ping the virtual server. Most of the groups you configure will be defined by
their virtual server attributes.

Now let’s get to groups. Resources that work in conjunction with one another are gener-
ally placed into groups. For example, when clustering SQL server, you place all SQL-related
resources, including an IP Address and Network Name, in a single group. This will give you a
SQL virtual server. Like resources are placed into a group because groups define failover. If
aresource in a group fails, then the entire group is moved to another node, where the Cluster
Service will attempt to restart all resources.
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Tip Since failover occurs at the group level, a best practice is to configure a separate group for each
virtual server. This way, the failure of one virtual server will not affect other virtual servers in the cluster.

Later when you learn about configuring server clusters, you'll see how groups and
resources appear in the Cluster Administrator tool.

Checkpoint Manager

The Checkpoint Manager is the service component that performs registry checkpointing. Reg-
istry checkpointing is the process that allows the Cluster Service to verify that a cluster-unaware
resource can successfully failover to another node. Cluster-unaware resources are typically
application components that don’t natively support clustering. You can use many cluster-
unaware applications in a server cluster by configuring the Generic Service resource. We'll
cover resource configuration shortly.

You've already read that configuration changes to the cluster are written to the quorum
log. Since the cluster can contain several nodes, all being online or offline at different times, it
needs a way to determine the updates written to the quorum log that are required by each
node. This is the other purpose of the Checkpoint Manager. By logging checkpoints against
the quorum disk, the Generic Service resource can easily update a node’s registry configura-
tion data as soon as it’s brought online, thus keeping the configuration of all nodes in the
cluster synchronized.

Communications Manager

The Communications Manager, also known as the Cluster Network Driver, is the service com-
ponent that’s responsible for managing node-to-node communications. The Communications
Manager directs the flow of heartbeat and remote procedure call (RPC) communications and
also ensures that each node in the cluster is notified when resources are brought online and
go offline.

Configuration Database Manager

Most cluster configuration information is stored in the quorum log and registry checkpoint
files on the quorum resource. In managing this information, the Configuration Database
Manager ensures that any new node joining the cluster receives the most recent cluster con-
figuration information.

Aside from managing information on the quorum resource, the Configuration Database
Manager also stores a cluster configuration database in the registry on each cluster node. The
configuration database stores information on the cluster, as well as all of its resources and
groups.

Node Manager

Each group can have a preference list that outlines the order of nodes it prefers to run on.
When a node fails, the Node Manager determines the node that will take ownership of the
group based on the group’s preference list.
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Resource DLLs

Resource dynamic link libraries (DLLs) provide a means for the Cluster Service to communi-
cate with other applications supported by the Cluster Service. Applications running on a
cluster are categorized as either cluster-aware or cluster-unaware based on how they interact
with the Cluster Service resource DLLs.

Cluster-aware applications use the Cluster application programming interface (API) to
communicate with the Cluster Service and its related resources. Cluster-aware applications
natively support failover. Cluster-unaware applications are those that aren’t coded to interface
with the Cluster API. To allow them to support failover, Microsoft provides a generic resource
DLL that the applications can use, provided they meet the clustering requirements.

Resource Monitor

A resource monitor is a component that provides for communication between the Cluster Ser-
vice and a resource DLL. By default, only a single resource monitor is run on each node, which
allows the node to communicate with the Cluster Service using RPCs. The Cluster Service is
designed so all cluster-aware applications can share a single resource monitor. Since each
resource monitor runs as its own process, the flaw in this architecture is that any failure by a
single process running inside the resource monitor can cause all processes running inside the
monitor to freeze. To prevent this, some third-party cluster-aware applications use their own
resource DLLs and are configured to run in their own resource monitor.

Other Service Components

The Cluster Service also has several other components worth mentioning. The following list
describes the remaining components:

* Event Processor: Starts the Cluster Service on each node and allows event messages to
be passed between cluster nodes

* Event Log Manager: Ensures that all cluster-related events are logged onto each cluster
node

¢ Failover Manager: Determines ownership of groups when a failover occurs

¢ Global Update Manager: Propagates cluster configuration updates to all nodes in the
cluster

¢ Log Manager: Writes cluster configuration changes to the quorum log on the quorum
resource

* Membership Manager: Tracks all members (nodes) in a cluster, and updates each node
when a node fails or comes back online

¢ Object Manager: Maintains a database of all cluster objects, including nodes,
resources, and groups

* Resource Manager: Starts and stops resources and initiates group failovers
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Before implementing a cluster, it’s best to plan for how the cluster’s resources and groups
should be configured. You'll look at these issues next.

Planning Resource and Group Configuration

While it’s a simple task, as you'll soon see, to create several resources and place them into
groups, prior planning can make you look smart down the road when the inevitable failure
occurs. You can break group configuration into seven phases:

1. Create a list of all server-based applications.

. Sort the list by which applications do and don’t support failover.
. Verify licensing.

. List all nonapplication resources where failover is desired.

. Document dependencies for each resource.

2
3
4
5
6. Make preliminary group assignments.
7

. Make final group assignments.

The following sections outline the considerations you must make during each phase.

Creating a List of All Server-Based Applications

In this phase, you document all applications running on each server that will participate in
the server cluster. Your initial reaction probably would be to document the applications you
plan on configuring for failover. The problem with this approach is that an undocumented
application running on a cluster node can consume memory that you didn’t consider during
planning. Remember that each cluster node must have substantial physical resources to
accommodate all applications that might failover onto it. If you have an application that isn't
clustered, running on a node consuming 100MB of physical RAM, you could run into prob-
lems during a failover. When you scope out the physical hardware requirements of each
cluster node, having each application documented alongside its approximate resource con-
sumption will allow you to arrive at accurate estimates. While the application vendor can
provide numbers on physical memory and storage usage, you'll most likely have to arrive at
information such as CPU and bandwidth consumption through load tests.

Sorting the List

Once you have the list compiled of all applications, you can then sort the list to differentiate
the applications that will use the MCS failover feature from all others. For any application to
support failover, it must be able to do the following:

e Communicate using TCP/IP

* Allow you to specify where its data is stored
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Some applications may support failover that don’t require 100 percent availability. Your
list should single out the applications that will be configured for failover from those that won't.

Verifying Licensing

Before configuring any application for clustering, you should verify its licensing requirements.
An application running on a single server will most likely require one license. If that same
application is configured to run on a two-node cluster, it might now need three licenses: one
license for each node and one license for the virtual server. As far as the OS is concerned, you
should also note the licensing currently employed. If per-seat client-access licensing is being
used, then the licensing is valid for clients accessing applications on either node. If the appli-
cation uses per-server or concurrent-use licensing, then you should ensure that ample
licenses exist to handle the peak load placed on the application from the server’s clients.

Tip Per-server licensing isn’t pooled between cluster nodes and can’t failover. Make sure you have ample
licenses on each cluster node, whether it’s an active or a passive node.

Listing All Nonapplication Resources Where Failover Is Desired

List the file shares and print spoolers you want to have failover capability. Remember that file
access and printer access still consume resources and need to be accounted for in order to
ensure accurate planning.

Documenting Dependencies for Each Resource

You must carefully outline relationships between resources. The required connections
between resources will allow you to make proper grouping decisions. For example, if you're
clustering an Exchange server, you want to make sure the Exchange services, network name,
IP address, and shared disks are all grouped together. Exchange can't run if it has no place to
store its data. This holds true for all other applications. When grouping resources, consider the
following guidelines:

e Each resource and all its dependencies must be grouped together.
e Each resource can be in only one group.

Since each resource can exist in only one group, you may find that your total number of
groups will be smaller than expected.

Note Physical disk resources are assigned by physical disk, not by disk partitions. This means that each
shared physical disk can reside only in a single group.
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Making Preliminary Group Assignments

With dependencies properly documented, your preliminary group assignments should already
be partially complete. At this point, don't forget yourself as the administrator. You have to man-
age these groups. Managing a few large groups is always easier than managing several small
groups. While you should try to avoid having too much in a single group, such as a file server,
IIS server, and Exchange server, try not to get too granular with your grouping either.

A common example of a means to conserve grouping is to group resources by depart-
ment, such as TrainingFileWeb, which could be a group encompassing file server and IIS
resources for the department’s intranet server.

Making Final Group Assignments

With preliminary group assignments in place, you should now work to name each group
based on its intended purpose. For example, you'd want to name a DHCP server group as
DHCPServer or name the group of resources for SQL server as SQLServer. While this may look
like common sense to you now, we can’t tell you how many groups we've seen named with the
default values of Disk Group 1, Disk Group 2, or Disk Group 3. Names like Disk Group aren’t
helpful.

Another common practice with final grouping is to note resource dependencies within
the group. Remember that if a resource fails, such as an IP address resource, everything that
depends on that resource will fail as well. A common practice of visually grouping dependen-
cies is to use a dependency tree. Figure 9-6 shows a sample tree. Notice that the print spooler
resource has three dependencies. This means that failure of the physical disk resource will
cause the print spooler to fail as well.

| Print Spooler Resource |

v v

Physical Disk Network Name
Resource Resource
IP Address
Resource

Figure 9-6. Print spooler resource dependence tree

Viewing dependency trees provides one more means of verifying the validity of your
group configuration choices. Now that you've looked at how to logically put together a cluster,
you'll see the actual steps involved.
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Installing the Windows Server 2003 Cluster Service

In this section, you'll look at the general procedure for configuring the Windows Server 2003
Cluster Service in a two-node environment.

Prior to installing the Cluster Service, you must first satisfy several prerequisites. To begin,
you must have the following:

* A configured and online domain controller.

¢ A cluster user account that’s a member of the Domains Admins global group or is at a
minimum set as a local administrator on each cluster node.

¢ Shared storage must be configured and online. Each node uses the same drive letters or
mount paths to access the shared storage.

¢ The cluster public and heartbeat networks should be configured.
The Cluster Service can operate with a single NIC for both public and heartbeat traffic;

however, two NICs are the recommended minimum. Once you've met the prerequisites,
you’re now ready to install the Cluster Service.

Caution Microsoft strongly recommends only one node be online during the installation and initial
configuration of the first cluster node. Once the first node is configured in the server cluster, then power up
each subsequent node and join it to the cluster.

To install the Cluster Service, follow these steps:
1. Power down all but one node in the cluster.
2. On Nodel, click Start » Administrative Tools » Cluster Administrator.

3. When the Cluster Administrator opens, you should see the Open Connection to Clus-
ter dialog box appear. In this dialog box, select Create New Cluster in the Action menu
and click OK. If you don'’t see the Open Connection to Cluster dialog box, in Cluster
Administrator, click File » New » Cluster.

4. The New Server Cluster Wizard should now open. Click Next.
5. Enter a name for the cluster in the Cluster Name field, and click Next.
6. In the Computer Name field, leave the default name selected, and click Next.

7. The Cluster Administrator will now analyze the cluster configuration. If all previous
steps were completed successfully, you should see nothing but checkmarks in this
window (see Figure 9-7). If a problem is encountered, the wizard will give you a general
description of the problem. Once you correct the problem, click the Re-analyze button
to perform the cluster analysis again. When the analysis completes successfully, click
Next.
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Figure 9-7. Successful cluster configuration analysis

. In the IP Address field, enter an IP Address for the cluster. In our example, we used

192.168.0.20. Once an address is entered, click Next.

. Now enter the username and password of the Cluster Service user account (created

earlier), and click Next.

View the settings in the Proposed Cluster Configuration dialog box, and click Next to
create the cluster. To change the location of the quorum disk, click the Quorum button.

This wizard will now create the cluster. When it finishes, click Next.

Click Finish to close the New Server Cluster Wizard window.

You should now see the cluster shown in the Cluster Administrator, with Nodel listed as
the only cluster node. Perform these steps to add a node to the cluster:

1.

Power up Node2. Once the node finishes booting, in the Cluster Administrator MMC
on Nodel, right-click the cluster object, select New, and then click Node.

. When the Add Nodes Wizard opens, click Next.

. You should now see the Select Computers window. In the Computer Name field, enter

Node2 (or whatever you set as the host name of Node2), and then click the Add button.
Then click Next.

. Once the wizard finishes analyzing the cluster configuration, click Next.
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5. Enter the password for the Cluster Service user account, and click Next.
6. Verify that the cluster configuration settings are correct, and click Next.
7. The wizard will now add Node2 to the cluster. When it finishes, click Next.

8. Click Finish to close the Add Nodes Wizard.

You should now see both Nodel and Node2 displayed in the cluster’s configuration. At this
point, the cluster is now online and ready for anything you can throw at it. At this point, you
can configure the cluster’s resources and groups and install any cluster-aware applications.

Using the Cluster Administrator

You can perform nearly all administrative functions using the Cluster Administrator. You can
run it locally on any cluster node or remotely on a Windows 2000, Windows XP, or Windows
Server 2003 system. When you open the Cluster Administrator, you have the ability to decide
which cluster you'd like to administer, allowing you to manage all clusters in your organiza-
tion without having to leave your seat. While technology may make us smarter, it also makes
us fatter.

Figure 9-8 shows the Cluster Administrator user interface. Notice in the example that
two groups exist. One group is Cluster Group, which is the default group that’s configured
when the Cluster Service is installed. This group hosts the cluster quorum resource and is
responsible for maintaining the cluster’s configuration. The second group is Mail and hosts
an Exchange 2003 virtual server. With the Mail group selected, you can see that the group
contains 11 resources. The group has two physical disks, network name and IP address
resources, and seven Exchange server resources.

=13l x|
=18 x|
& 2o x| B
CLUSTER1 | Skate | Cinier | Resource Type |
(30 Groups Cnline WODEL Physical Disk
Cluster Group m Disk 51 " : :
isk 5t Online MODEL Pheysical Disk,
& Mail ull Exchange HTTP Virtual Server Instance 100 (M...  Online MODEL Microsoft Excha...
o E;as?:urcgs i i u Exchange Information Store Instance (MAILY Online MNODEL Microsoft Excha...
Ng;; anrigUration u Exchange Message Transfer Agent Instance (M...  Online MNODEL Microsoft Excha...
{:l Active Groups Exchange M3 Search Instance {MAIL) Online MNODEL Microsoft Searc...
X m Exchange Routing Service Instance (MAIL) Online MODEL Microsoft Excha...
{:I Ackive Resources ) )
{13 Mstwork Interfaces m Exchange 54 Online MNODEL Microsoft Excha...
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Figure 9-8. Cluster Administrator Ul
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The first object displayed in the interface is the cluster itself. Figure 9-8 shows Cluster1.
Below the cluster are folders and placeholders for the cluster groups, resources, configuration,
and each node.

The Groups folder lists the groups on the cluster, as well as the status of each group. For
groups and resources, you'll see a down arrow next to an object that’s offline and an X accom-
panying a failed object. This graphical representation allows you to quickly scan to see that
your cluster is fully operational.

The next folder shown in the Cluster Administrator is the Cluster Configuration folder.
This folder allows you to do the following:

e View a list of resources that can be installed, such as IP address, DHCP, local quorum,
and so on

* View and configure networks used by the cluster

* View a listing and status of the network interfaces on each cluster node

Finally, the Cluster Administrator provides information on the operation of each cluster
node. Under each node object, you can do the following:

* View the active groups running on the node
* View the active resources running on the node

¢ Check the status of each network interface on the node

The Cluster Administrator is simple to use, so we won’t waste more of your time trying to
explain the obvious and will get down to business. Next, we'll give you step-by-step procedures
for performing some of the most common clustering administrative tasks.

Moving a Group

If you need to perform maintenance on a cluster node or simply want to test failover in the
cluster, then you'll need to know how to move a group. To move a group, you simply right-click
the group to be moved and then select Move Group. After doing this, you'll see each resource
in the group taken offline, then moved to the next node in the cluster, and then brought back
online. Once the move is complete, you'll see the name of the next node in the cluster listed as
the owner of the group.

Adding Resources to a Group

When you need to create virtual servers, this will involve adding resources to a group. To

have a virtual server, you need to start with a physical disk, an IP address, and the network
name resources in a group. If a physical disk is in another group, you can move the disk
resource into the new group by first taking the resource offline and then dragging and drop-
ping it into the new group. Note that groups can be created by right-clicking the cluster object,
selecting New, and then clicking Group.
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Now to add resources to a group, follow these steps:

1.

Right-click the group in which you want to add a resource, and click New and then
Resource.

. In the New Resource dialog box, enter a name and description for the resource, select

the resource to be created in the Resource Type drop-down menu, and then click Next.

. Now select the possible owners for the resource (by default all nodes are selected).

The list of possible owners will determine the nodes to which the resource’s group can
failover. Once you've selected the owners, click Next.

. If other resources must be online in order for the new resource to operate, then select

the appropriate dependencies from the Available Resources field and move them to
the Resource Dependencies field. When finished, click Next.

. Finally, you'll need to enter the specific resource’s parameters. This window will vary

by resource type. For example, for a new IP address resource, you'd have to enter an IP
address, subnet mask, and network interface for the resource. Once you've entered the
resource parameters, click Finish to create the resource.

. When the resource is created, it will appear in the group in an offline state. To bring the

resource online, right-click the resource and select Bring Online.

As you've seen, navigating the Cluster Administrator tool is relatively simple. The tough
part with clustering is always bringing the shared storage online and ensuring that it can be
seen the same way by each cluster node. With Microsoft clustering out of the way, next you'll
turn your attention to Linux clustering.

Tip For more information on Microsoft clustering, point your Web browser to http://www.microsoft.com/
windowsserver2003/technologies/clustering/default.mspx to access the Windows 2003 cluster-
ing home page. This site is loaded with clustering white papers and how-to articles.
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Setting Up Linux Failover Clusters

To set up failover clusters on Linux operating systems, you can go in three different directions:
purchase a clustering solution from a third-party vendor, purchase a clustering solution by an
operating system vendor, or use an open-source solution available on the Internet.

In the next sections, we'll cover failover clustering using the Red Hat Cluster Suite and
also show how to configure clustering using the leading open-source solution from the Linux
High Availability Project.

Setting Up the Red Hat Cluster Suite

For enterprise-class Linux clusters, many organizations have turned to Red Hat. With the Red
Hat Cluster Suite, organizations can deploy up to an eight-node failover cluster. Best of all, this
solution is fully supported and documented by Red Hat. While you can get some open-source
failover cluster products for free, many prefer the peace of mind that comes with using a pur-
chased and supported software product. Unlike with Red Hat Advanced Server 2.1, newer Red
Hat OSs don’t come with the cluster software for free. Instead you’ll have to buy it as a sepa-
rate add-on from Red Hat.

The Red Hat Cluster Suite offers pretty much everything you'd want in a failover cluster,
including the following:

e SCSI and Fibre Channel shared storage support
¢ Simple configuration and administration

e Shared cluster quorum

e Support for all major Linux applications

¢ Support for failover domains

Let’s examine these features in more detail.

SCSI and Fibre Channel Shared Storage Support

The Red Hat Cluster Suite supports both SCSI and Fibre Channel shared storage. This allows
you to configure a simple two-node cluster with a shared SCSI-attached storage array or scale
up to eight nodes by connecting to shared storage through a SAN. Also, with the SAN integra-
tion support, it’s easy to connect your Red Hat cluster to your existing storage infrastructure.

The Red Hat Cluster Suite also supports Global File System (GFS), which provides for bet-
ter integration with storage networks. GFS supports simultaneous reads and writes to a single
shared file system in a SAN. For more on GFS, turn to Chapter 12.
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Simple Configuration and Administration

Red Hat clusters can be quickly deployed and configured on Red Hat Enterprise Advanced
Server systems using the Cluster Configuration tool, which is shown in Figure 9-9.

Eile  Cluster Help
Cluster Mame: RHecluster Has Quorum

Status: Cluster is running
Members
MName = | Status

By 172.16.2.10 Active

© 1721621 Inactive

s

Services

Yy @ @ 7

Enable Disable Restart  Properties

Name  +|State |Member b Monitor | o tarts
Transition Interval

Running 17216210 21:07:38 Jan19

{}% http_VS Running 172.16.2.11 20:45:08  Jan1% 0 0

Figure 9-9. Red Hat Cluster Configuration tool

While we realize that many Linux enthusiasts scoff at the notion of GUISs, the bottom line
for many businesses is cost of ownership, and if a GUI tool leads to more reliable and faster
deployment of failover clusters, then so be it. In fact, Red Hat supports changes to its cluster .xml
configuration files only through the Cluster Manager. If you want to make changes via a text edi-
tor, you're on your own! Who would have thought this came from Red Hat five years ago?

Shared Cluster Quorum

As with Microsoft clusters, Red Hat failover clusters use a shared quorum drive to maintain
updates to cluster configuration information. This way, if changes are made to the cluster
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while one node is offline, the offline node will receive the updates as soon as it boots back up.
The availability of the shared quorum disk provides for much more reliable and easier-to-
manage clusters.

Supports All Major Linux Applications

The Red Hat Cluster Suite fully supports applications and services such as Oracle, Apache,
NFS, and MySQL. In fact, Red Hat even offers complete step-by-step procedures on how to
configure these applications and services to run on your Red Hat Linux cluster. This level of
support, as well as extensive documentation, for many makes the Red Hat Cluster Suite well
worth the price.

Support for Failover Domains

Failover domains act as containers for clustered services. Architecturally, they’re similar to
groups with Windows clusters. When you configure “restricted” failover domains, you can
assign ownership of a failover domain to specific nodes in the cluster. This gives you control
of how services failover in the event of a failure. Without configured failover domains, services
would arbitrarily failover to any available node in the cluster. This feature will give you much
greater control of how services and service failures are managed by the cluster.

Asyou can see, the Red Hat Cluster Suite is a robust clustering platform, with quite a bit to
offer. If you're looking for more information on Red Hat clustering, refer to the RH_Clustering.pdf
document located in the RedHat folder on the companion CD or point your Web browser to the
Red Hat Clustering home page at http://www.redhat.com/software/rha/cluster.

Using Linux-HA Clusters

Linux High Availability (Linux-HA) clustering is the result of the Linux High Availability Project
(http://www.linux-ha.org). This project started as the standard for two-node Linux failover
clusters, and at the time of publication is heading toward completing code to support up to
16-node or higher cluster configurations.

Linux-HA clusters can be configured on nearly any Linux distribution. Since we don’t
know which Linux distribution you have, in this section we’ll show how to configure a two-
node cluster using open-source software from http://www.ultramonkey.org. UltraMonkey
provides the software and documentation of Linux-HA on Red Hat distributions. Since this
particular cluster format can operate with or without using shared storage, you don’t have
to do any preparation to get each cluster node to properly see the shared storage in order to
install and configure the cluster service. If you want to synchronize data between local storage
on each cluster node, you can use tools such as Mirrordir, which you can download from
http://www.rpmfind.net. Another tool that provides for remote replication of file data is
Rsync, which is available at http://rsync.samba.org.

Note For sharing disk resources in a Linux-HA failover cluster, you can configure GFS on the cluster
nodes. GFS supports shared SCSI, iSCSI, and Fibre Channel storage. For more information on GFS, point your
Web browser to the Open GFS home page at http://opengfs.sourceforge.net.
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The key to operating Linux-HA clusters is Heartbeat. Heartbeat is the monitoring service
that will allow one node to monitor the state of another and assume control of the cluster’s
virtual IP address if the primary node fails. This setup will allow you to configure a simple
active-passive failover cluster. In the next section, we'll show how to configure a sample Ultra-
Monkey implementation of Linux-HA, which was installed on Red Hat Enterprise Advanced
Server 3.0. Figure 9-10 shows our setup.

192.168.0.11 192.168.0.12

RS1 RS2
Floating IP Address = 192.168.0.50

Figure 9-10. Linux-HA two-node failover cluster

This configuration could allow for the failover of Web servers, such as providing redundancy
and fault tolerance for an Apache HTTP server.

Initial Configuration

Before installing the high-availability software, you must first configure each node’s host name
and TCP/IP settings. With both hosts configured, you’ll then need to connect them to the
Internet to download the UltraMonkey software from http://www.ultramonkey.org. You'll find
a single folder available on the Web site to download all the Red Hat installation RPMs. Down-
load each available RPM for your Red Hat distribution before continuing.

Once you have the available software, you're ready to set up the cluster. The first step in
the installation process is to upgrade mkinitrd. To do this, follow these steps:

1. Assuming you're logged on and you’'ve downloaded the RPMs as root, change to the
/root directory.

2. Next, use RPM to install the latest mkinitrd package. For example, use rpm -hFv =
mkinitrd-3.5.13-1.um.1.1386.rpm.
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With mkinitrd upgraded, the next step is to upgrade the kernel. To do this, download the
kernel RPM from http://www.ultramonkey.org that’s appropriate for each node’s hardware
architecture and then use the RPM to install the kernel upgrade. Here are examples for differ-
ent host architectures:

e AMD Athlon: rpm -Fhv kernel-2.4.21-20.EL.um.1.athlon.zpm

* i686: rpm -Fhv kernel-2.4.21-20.EL.um.1.1686.rpm

e i586: rpm -Fhv kernel-2.4.21-20.EL.um.1.1586.rpm

With the kernel upgraded, you'll need to reboot each node for the changes to be applied,

but prior to doing so you can use the RPM to install the remaining packages to configure
Linux-HA.

Note The remaining packages to be installed depend on the following packages: per1-Digest-HMAC,
perl-Digest-SHA1, and perl-Parse-RecDescent. You can download these packages from http://
www.rpmfind.net and then install them using the rpm -Uvh command.

You can now install the remaining configuration and management packages that were
downloaded from UltraMonkey. These packages include the following:

* heartbeat-1.0.4-2.rh.el.um.1.i386.xpm

* heartbeat-ldirectord-1.0.4-2.rh.el.um.1.1386.xpm

* heartbeat-pils-1.0.4-2.rh.el.um.1.1386.rpm

* heartbeat-stonith-1.0.4-2.rh.el.um.1.i386.xpm

e ipvsadm-1.21-1.rh.el.1.1386.1pm

e libnet-1.1.0-1.rh.el.1.1386.1pm

* perl-Authen-SASL-2.03-1.rh.el.um.1.noarch.xpm

* perl-Convert-ASN1-0.16-2.rh.el.um.1.noarch.rpm

* perl-I0-Socket-SSL-0.92-1.rh.el.um.1.noarch.xrpm

* perl-Mail-IMAPClient-2.2.7-1.rh.el.um.1.noarch.rpm
* perl-Net-SSleay-1.23-1.rh.el.um.1.1386.rpm

* perl-XML-NamespaceSupport-1.08-1.rh.el.um.1.noarch.rpm
* perl-XML-SAX-0.12-1.rh.el.um.1.noaxch.xpm

e perl-ldap-0.2701-1.rh.el.um.1.noaxch.xpm
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You can install all the previously listed RPMs collectively using a single rpm -Uvh com-
mand by including each package as a parameter in the command syntax. Note that the
package versions listed were the most recent at the time of this book’s publication and may
have different version numbers by the time you download them.

Once all the packages are installed, run the reboot command to reboot each node. After
both nodes reboot, you'll need to copy the following files from /usr/share/doc/heartbeat-1.0.4
to the /etc/ha.d folder:

e ha.cf
¢ haresources

* authkeys

With the files in place, you'll now need to configure them. Let’s begin with authkeys.

Note When you edit these three files, each line will be commented out with a #, so editing the files is
merely an exercise in removing a few # statements and substituting the file’s sample parameters with
settings particular to your specific cluster.

authkeys File Configuration

You must configure authkeys to set the heartbeat authentication protocol and password for
each node. This file should be identical on both nodes. When you configure the file, you need
to set the authm parameter as well as the authentication method and password. In the sample
authkeys file shown in Listing 9-1, the most secure authentication method (SHA-1) was
selected, with a password of P@ssword!. We left in the file’s original comments, as they also
provide additional information on the configuration and content of the file.

Listing 9-1. authkeys

Authentication file. Must be mode 600

Must have exactly one auth directive at the front.

auth send authentication using this method-id

Then, list the method and key that go with that method-id

Available methods: crc shail, md5. Crc doesn't need/want a key.

You normally only have one authentication method-id listed in this file

Put more than one to make a smooth transition when changing auth
methods and/or keys.

HOoH H H HF H H H HE HF H HE H H R



CHAPTER 9 @ IMPLEMENTING FAILOVER CLUSTERS

#

#

# shal is believed to be the "best", md5 next best.

#

# crc adds no security, except from packet corruption.
# Use only on physically secure networks.

#

auth 2

#1 crc

2 shal P@ssword!
#3 md5 Hello!

Once authkeys is edited, your next task is to change it to mode 600. To do this, run the
command chmod 600 /etc/ha.d/authkeys. With authkeys configured, you can then move onto
configuring the ha.cf file.

ha.cf File Configuration

The ha. cf file establishes the names of the nodes in the cluster, as well the configuration of
the heartbeat packets. Listing 9-2 shows the content of our configuration file. In our sample,
we used the interface e0 for the heartbeat with nodes named RS1 and RS2.

Listing 9-2. ha. cf#

There are lots of options in this file. All you have to have is a set
of nodes listed {"node ...}
and one of {serial, bcast, mcast, or ucast}

ATTENTION: As the configuration file is read line by line,
THE ORDER OF DIRECTIVE MATTERS!

In particular, make sure that the timings and udpport
et al are set before the heartbeat media are defined!
A1l will be fine if you keep them ordered as in this

example.

Note on logging:

If any of debugfile, logfile, and logfacility are defined then they
will be used. If debugfile and/or logfile are not defined and
logfacility is defined then the respective logging and debug
messages will be logged to syslog. If logfacility is not defined
then debugfile and logfile will be used to log messages. If
logfacility is not defined and debugfile and/or logfile are not
defined then defaults will be used for debugfile and logfile as
required and messages will be sent there.

R E E E E E E R R E R E E R E E E E EEETE"

File to write debug messages to
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#debugfile /var/log/ha-debug

#

#

# File to write other messages to
#

logfile /var/log/ha-log

#

#

# Facility to use for syslog()/logger
#

logfacility localo

#

#

# A note on specifying "how long" times below...
#

# The default time unit is seconds

# 10 means ten seconds

#

# You can also specify them in milliseconds

# 1500ms means 1.5 seconds

#

#

# keepalive: how long between heartbeats?

#

keepalive 2

#

# deadtime: how long-to-declare-host-dead?

#

deadtime 30

#

# warntime: how long before issuing "late heartbeat" warning?
# See the FAQ for how to use warntime to tune deadtime.
#

warntime 10

#

#

# Very first dead time (initdead)

#

# On some machines/0Ses, etc. the network takes a while to come up
# and start working right after you've been rebooted. As a result
# we have a separate dead time for when things first come up.

# It should be at least twice the normal dead time.

#

initdead 120

#

#

# nice failback: determines whether a resource will
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automatically failback to its "primary" node, or remain
on whatever node is serving it until that node fails.

The default is "off", which means that it WILL fail

back to the node which is declared as primary in haresources
"on" means that resources only move to new nodes when

the nodes they are served on die. This is deemed as a
"nice" behavior (unless you want to do active-active).

HoH H HF H H H R H

nice failback on

#

# hopfudge maximum hop count minus number of nodes in config
#hopfudge 1

#

#

# Baud rate for serial ports...

# (must precede "serial" directives)

#

#baud 19200

#

# serial serialportname ...

#serial /dev/ttySo # Linux

#serial /dev/cuaa0 # FreeBSD

#serial /dev/cua/a # Solaris

#

# What UDP port to use for communication?

# [used by bcast and ucast]

#

udpport 694

#

# What interfaces to broadcast heartbeats over?

#

bcast etho # Linux

#bcast eth1 eth2 # Linux

#bcast 1leo # Solaris

#bcast le1l le2 # Solaris

#

# Set up a multicast heartbeat medium

# mcast [dev] [mcast group] [port] [ttl] [loop]

# [dev] device to send/rcv heartbeats on

# [mcast group] multicast group to join (class D multicast address
# 224.0.0.0 - 239.255.255.255)

# [port] udp port to sendto/rcvfrom (no reason to differ
# from the port used for broadcast heartbeats)

# [ttl] the ttl value for outbound heartbeats. This affects
# how far the multicast packet will propagate. (1-255)
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[loop] toggles loopback for outbound multicast heartbeats.
if enabled, an outbound packet will be looped back and
received by the interface it was sent on. (0 or 1)
This field should always be set to 0.

H oH H H H

mcast etho 225.0.0.1 694 1 0

Set up a unicast / udp heartbeat medium
ucast [dev] [peer-ip-addr]

[dev] device to send/rcv heartbeats on
[peer-ip-addr] IP address of peer to send packets to

HoH H HF B H

#ucast etho 192.168.1.2

Watchdog is the watchdog timer. If our own heart doesn't beat for
a minute, then our machine will reboot.

H oH O H R

#watchdog /dev/watchdog

"Legacy" STONITH support

Using this directive assumes that there is one stonith
device in the cluster. Parameters to this device are

read from a configuration file. The format of this line is:

stonith <stonith type> <configfile>

NOTE: it is up to you to maintain this file on each node in the
cluster!

HoH H H H H H H H H R

#stonith baytech /etc/ha.d/conf/stonith.baytech

STONITH support
You can configure multiple stonith devices using this directive.
The format of the line is:
stonith_host <hostfrom> <stonith type> <params...>
<hostfrom> is the machine the stonith device is attached
to or * to mean it is accessible from any host.
<stonith _type> is the type of stonith device (a list of
supported drives is in /usr/lib/stonith.)
<params...> are driver specific parameters. To see the
format for a particular device, run:
stonith -1 -t <stonith_type>

HoH HF H H H H H HF H OHE H H R
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# Note that if you put your stonith device access information in
# here, and you make this file publicly readable, you're asking
# for a denial of service attack ;-)

#

#

#stonith_host * baytech 10.0.0.3 mylogin mysecretpassword

#stonith_host ken3 1rps10 /dev/ttyS1 kathy 0
#stonith_host kathy rps10 /dev/ttyS1 ken3 0

#

# Tell what machines are in the cluster

# node nodename ... -- must match uname -n
node  RS1

node RS2

#

# Less common options...

#

# Treats 10.10.10.254 as a psuedo-cluster-member
#

#ping 10.10.10.254

#

# Started and stopped with heartbeat. Restarted unless it exits
# with rc=100

#

#irespawn userid /path/name/to/run

At this point, you're almost there. The last step is to configure haresources.

haresources File Configuration

The haresouzces file specifies the services or applications that failover from node to node
when the heartbeat isn’t detected. This file is crucial, as it will determine what services will
automatically start on the passive node when the passive node detects that the active node is
no longer available. This file will also specify the virtual IP address of the virtual server that’s
hosted by the cluster. While the file’s comments offer several examples, ultimately you'll prob-
ably just need to configure a single line of the file to allow for the proper failover of a service.
In our example, this was the line that was added to the haresources file:

RS1 192.168.0.50 httpd
Adding this line to the file accomplishes the following tasks:
* Specifies that RS1 is the default active node
* Configures 192.168.0.50 as the IP address of the virtual server

¢ Sets the HTTP service to start after a failover
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Listing 9-3 shows the complete haresources file, along with all default comments.

Listing 9-3. haresources

HoH HF H H HF H H HF H H HFH HFHHE HH R HFH R HFH O HF O HF O HF B HF O H H OB

<VERY

This is a list of resources that move from machine to machine as
nodes go down and come up in the cluster. Do not include
"administrative" or fixed IP addresses in this file.

IMPORTANT NOTE>
The haresources files MUST BE IDENTICAL on all nodes of the cluster.

The node names listed in front of the resource group information

is the name of the preferred node to run the service. It is

not necessarily the name of the current machine. If you are running
nice failback OFF then these services will be started

up on the preferred nodes - any time they're up.

If you are running with nice failback ON, then the node information
will be used in the case of a simultaneous start-up.

BUT FOR ALL OF THESE CASES, the haresources files MUST BE IDENTICAL.
If your files are different then almost certainly something
won't work right.

</VERY IMPORTANT NOTE>

We refer to this file when we're coming up, and when a machine is being
taken over after going down.

You need to make this right for your installation, then install it in
/etc/ha.d

Each logical line in the file constitutes a "resource group".

A resource group is a list of resources that move together from

one node to another - in the order listed. It is assumed that there
is no relationship between different resource groups. These
resource in a resource group are started left-to-right, and stopped
right-to-left. Long lists of resources can be continued from line
to line by ending the lines with backslashes ("\").

These resources in this file are either IP addresses, or the name
of scripts to run to "start" or "stop" the given resource.
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# The format is like this:
#
#node-name resourcel resource2 ... resourceN

HoH HF H H HF H H HF H H HFH HFHHEHH R HH R HFH O HF R HF O HF B HF O HF H OB

If the resource name contains an :: in the middle of it, the
part after the :: is passed to the resource script as an argument.
Multiple arguments are separated by the :: delimiter

In the case of IP addresses, the resource script name IPaddr is
implied.

For example, the IP address 135.9.8.7 could also be represented
as IPaddr::135.9.8.7

THIS IS IMPORTANT!!

The given IP address is directed to an interface that has a route
to the given address. This means you have to have a net route

set up outside of the High-Availability structure. We don't set it
up here -- we key off of it.

The broadcast address for the IP alias that is created to support
an IP address defaults to the highest address on the subnet.

The netmask for the IP alias that is created defaults to the same
netmask as the route that it selected in the step above.

The base interface for the IPalias that is created defaults to the
same netmask as the route that it selected in the step above.

If you want to specify that this IP address is to be brought up
on a subnet with a netmask of 255.255.255.0, you would specify
this as IPaddr::135.9.8.7/24 .

If you wished to tell it that the broadcast address for this subnet
was 135.9.8.210, then you would specify that this way:
IPaddr::135.9.8.7/24/135.9.8.210

If you wished to tell it that the interface to add the address to
is etho, then you would need to specify it this way:
IPaddr::135.9.8.7/24/etho
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And this way to specify both the broadcast address and the
interface:
IPaddr::135.9.8.7/24/eth0/135.9.8.210

The IP addresses you list in this file are called "service" addresses,
since they're the publicly advertised addresses that clients
use to get at highly available services.

For a hot/standby (non load-sharing) 2-node system with only

a single service address,

you will probably only put one system name and one IP address in here.
The name you give the address to is the name of the default "hot"
system.

Where the nodename is the name of the node which "normally" owns the
resource. If this machine is up, it will always have the resource
it is shown as owning.

The string you put in for nodename must match the uname -n name
of your machine. Depending on how you have it administered, it could
be a short name or a FQDN.

HoH HF H H HF H H HF H H HFH HFHHEHFH R H H R

g

#

# Simple case: One service address, default subnet and netmask

# No servers that go up and down with the IP address

#

#just.linux-ha.org 135.9.216.110

#

g

#

# Assuming the administrative addresses are on the same subnet...
# A little more complex case: One service address, default subnet
# and netmask, and you want to start and stop http when you get

# the IP address...

#

#just.linux-ha.org 135.9.216.110 http
g

#

# A little more complex case: Three service addresses, default subnet
# and netmask, and you want to start and stop http when you get

# the IP address...

#

#just.linux-ha.org 135.9.216.110 135.9.215.111 135.9.216.112 httpd
g
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# One service address, with the subnet, interface and bcast addr

# explicitly defined.

#

#just.linux-ha.org 135.9.216.3/28/eth0/135.9.216.12 httpd

#

g

#

# An example where a shared file system is to be used.

# Note that multiple arguments are passed to this script using

# the delimiter '::' to separate each argument.

#

#node1 10.0.0.170 Filesystem::/dev/sdal::/datal::ext2

#

# Regarding the node-names in this file:

#

# They must match the names of the nodes listed in ha.cf, which in turn
# must match the “uname -n* of some node in the cluster. So they aren't
# virtual in any sense of the word.

#

RS1 192.168.0.50 httpd

Once this file is configured, you're now ready to start the service.

Starting the Heartbeat Service

With the heartbeat parameters configured, you run the following command to start the
service on each node: /etc/init.d/heartbeat start. To test failover, run /etc/init.d/
heartbeat stop on the active cluster node. You can also disable the network service on the
active node. In a few moments the passive node will assume the IP address of the cluster
virtual server and will start the HTTP service. At this point, you have a working Linux failover
cluster!

Summary

As you've seen, failover clustering gives you the ability to run a virtual server on top of another
system. If the physical system hosting the virtual server fails, another system in the cluster will
assume control of the virtual server. For clients, this provides a high level of reliability to cru-
cial data. Now you have a server that isn't dependent on any one physical system to run.

With solutions available on both Windows and Linux and plenty of industry pressure to
offer more failover clustering solutions, it’s likely that clusters will become easier to deploy and
much more common in the coming years. Another form of clustering, load-balanced cluster-
ing, provides a different level of virtualization than with failover clustering. With load-balanced
clustering, a virtual server can be hosted by up to 32 nodes simultaneously, providing for a way
to handle a high volume of traffic that would normally be impossible for a single server to han-
dle. You'll look at this form of virtualization next in Chapter 10.
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Creating Load-Balanced
Clusters

Midsize to enterprise-class organizations employ load-balancing clusters to do just what
their name entails—balance a load. In case you're thinking “what?” right about now, let’s take
amore detailed look at load-balanced clusters. With load balancing, several physical comput-
ers collectively act as one or more logical computers for the purpose of distributing client
requests amongst multiple physical servers. In addition to distributing client requests, or a
server’s load, the load-balancing cluster also provides for fault tolerance of data access.

To further understand the role of load-balancing clusters, consider the following load-
balanced cluster implementations:

* Web servers

¢ FTP servers

e Streaming media servers

* VPN servers

e Terminal servers

Each of the previously mentioned load-balanced cluster implementations has the follow-
ing similarities:

* Clients require read-only data access.

¢ One server may not be able to handle the load presented by the client access.

e The availability of access is crucial.

When clients require read and write data access, such as with access to an e-mail server,
then failover clustering is typically implemented. Chapter 9 described this clustering configu-
ration. Aside from the type of data access load-balanced clusters provide, the way they allow
access is unique as well. With load-balanced clusters, you could have 30 servers in the cluster
all providing access to data simultaneously. With the typical failover cluster, only a single
physical server will serve as the data access point for the virtual server running on the cluster.

To provide for data access across multiple physical servers, load-balanced clustering requires
that each server, or node, in the cluster maintain its own local copy of the shared cluster data.
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Figure 10-1 shows a typical load-balanced cluster. Note that the figure shows several
physical computers acting as a single logical computer for the Web site
http://www.apress.com. Each computer in the cluster will communicate with each other to
decide which one will handle each specific incoming client request. When several client
requests come to the cluster at the same time, all nodes will assume a portion of the load. So,
if the load-balanced cluster has three computers, and nine client HTTP requests come to the
cluster, each node handles three requests.

WWW.apress.com

Node1 Node2
I I

.’.

H 7

//

7

/|
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Firewall2

Figure 10-1. Four-node load-balanced cluster

In the example shown in Figure 10-1, if you were to connect to http://www.apress.com,
you wouldn't be directed to a single server whose FQDN is http://www.apress.com. Instead,
although you logically connect to http://www.apress.com, you're actually transparently redi-
rected to one of the many servers that handle requests for the http://www.apress.com name.
In one instance, you may connect to the first node in the cluster. The next time you connect,
the third node in the cluster could answer your request.

One other feature that has added to the growing popularity of load-balanced clusters is
their ability to scale. When planning a load-balanced cluster, your initial estimates don’t have
to be perfect with regard to the number of servers you'll need to effectively balance a load.
As the load placed on the cluster grows, you can successfully balance the increased load by
adding nodes.

To truly appreciate the necessity of load balancing, in the next section you'll examine an
earlier technology that p